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Getting Started

This section is intended to provide users with an introduction to the STEP system and concepts. Additionally, it
provides detailed information needed to perform basic data maintenance tasks in STEP, including detailed
descriptions of the workbench interface and search functionality. While geared towards end users, the guide
provides information that is necessary for all users to understand as a foundation for more advanced topics.

This guide is centered around STEP Workbench, but the concepts and functionality presented are often
applicable to both the workbench and Web Ul interfaces. Because of this, it is helpful for users of either interface to
be familiar with the material in this guide. For documentation specific to the Web Ul, see the Web User Interfaces
guide.

The Getting Started guide contains the following sections.

Introduction: This section includes a terminology table and an overview of some basic STEP concepts.
This material should be understood prior to proceeding through the guide as it lays the foundation for the
subsequent topics.

STEP Workbench Ul: This section introduces the user to the workbench interface, as well as providing
detailed reference information for the various functions, including toolbar actions and menu options.

Object Maintenance in Tree: This section provides an overview of creating, editing, and deleting objects in
the workbench, as well as providing detailed information for working with particular types of objects.

Navigating and Searching: This section introduces the user to basic search and navigation functionality in
STEP Workbench, as well as providing detailed descriptions of the search criteria available on the Search
tab.

STEP Workbench Keyboard Shortcuts: This topic provides a list of keyboard shortcuts that can be used
in the workbench.
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Introduction

This section introduces the reader to basic STEP terminology and concepts. This information provides a
foundation that is key to understanding the subsequent materials.

o STEP Terminology: A table defining basic STEP terms, including links to topics with additional information.

» Basic STEP Concepts:Introduces some core concepts in STEP to facilitate understanding of the Getting
Started and System Setup guides.

« Object Super Types: Provides an introduction to the STEP object super types, including links to detailed
information for each type.
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STEP Terminology

This topic provides definitions for basic STEP terminology that is helpful to be aware of when reading the online
help. Links to additional material on related topics are also provided, when appropriate. This should not be
considered a complete list of all STEP terms as it is intended to cover only the more commonly used terms that
users are likely to encounter throughout the online help.

A
Definition Further
Reading
Action Type of business rule that can be executed to manipulate data or perform an Seethe
action. Actions can be executed by various processes and events within the Business
system. For example, at approval of an object, within a workflow (on entry to a Actions topicin
state, exit from a state, on the transition between tasks, or when a deadline has the Business
been met), as part of an import process, or from a bulk update process. Rules
documentation.
API see Public API Seethe STEP
API
Documentation
link on the Start
Page.

Approval | The process of pushing data from the Maintenance workspace to the Approved | Seethe

workspace in STEP. Approval can be associated with business logic that may Approval of
prevent approval or may perform automated data updates during approval. Objects topicin
Approvals are often the triggers for sending data to downstream systems. the Getting
Started / User
Guide
documentation.
Asset Any type of digital media, such as an image, Word document, PDF, Excel file, See the Assets
PowerPoint, JPG, GIF, etc. topicin the
Getting Started
/ User Guide
documentation.
Asset A process that exports assets from STEP to a file system. Conversion templates | See the Asset

Push
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Definition Further
Reading

can be applied to transform images, for example from high res to low res, Push topicin

resizing, applying color scales, etc., though assets can also be sent as-is to the Digital

make them available on the file system. Assets guide.

Assignee | The user or group to which a task is assigned for work to be performed within a Seethe
workflow. User states can be assigned directly to a named user or to a user Assigneesin
group. When a state is assigned to a user group the task is "offered" to all Workflows
members of that group. To perform the task associated with the state, a member | topicin the

of the group has to claim the task. Once a task is claimed it is no longer visible in Workflows

the group task list; only the person who claimed the task is able to see it. A user documentation.
may subsequently release a task back to the group.

Attribute | A characteristic or detailed piece of information related to a particular object. Seethe
Attributes can be one of two types, description or specification. Description Attributes topic
attributes are available on most object types in STEP, while specification in the System
attributes are only available on objects in the Primary Product Hierarchy. Setup / Super

User Guide
documentation.

Attribute | Groups attributes, reference types, and/or link types. Attribute groups can have | Seethe

Group sub-groups. Attributes
Groups topicin
the System
Setup / Super
User Guide
documentation.

Attribute | The value stored in a particular attribute on a particular object. Seethe

Value Attributes topic
in the System
Setup / Super
User Guide
documentation.
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B
Term Definition Further Reading
Bookmark | A placeholder created by the user that serves as a shortcutto a See the Bookmarks topic
previously viewed location. in the Getting Started /
User Guide
documentation.
Business | Automated piece of programming logic that may implement See the Business Rules
Rule customer-defined rules, such as validations, automatic updates, topic in the Business
notifications, data-driven workflow routing, etc. Also see Condition Rules documentation.
and Action.
C
Term Definition Further Reading
Calculated An attribute where the value is calculated according to a specific formula | See the
Attribute defined for this attribute. The formula may include static text, other Calculated
attribute values, information from references on the object, and a Attributes topic in
number of other options. the System Setup
/ Super User
Guide
documentation.
Category View in STEP that helps product managers and data analyststo getan | Seethe Data
Profile overview of an entire section of the Product Hierarchy through various Profiles topicin the
metrics that are displayed in dashboard format. Data Profiling
documentation.
Character Tag | An entry that begins with “<” and ends with “/>” such as <check/>. See the Tags topic
These tags represent characters that may not be found in the special in the System
character map in Unicode, or may be used instead of the Unicode Setup / Super
character. User Guide
documentation.
Claim The action that a user performs to take a task in a workflow out of a See the Claiming
group queue and assign to himself / herself. and Releasing
Tasksin
Workflows topic in
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Term Definition Further Reading
the Workflows
documentation.

Classification | A particular type of hierarchy that organizes groups of objects or assets. | See the

Objects are linked to classifications via references, and may have
references to multiple classifications. Also referred to as "yellow

Classifications
topic in the Getting

folders." Started / User
Guide
documentation.
Collection An object that holds a static set of objects, or a dynamic search criteria Seethe
that can be refreshed as needed to find the latest matching objects. Collections topicin
Using collections, the resulting data can be displayed, bulk actions can the Getting
be performed, or the objects can be exported. Started / User
Guide
documentation.
Completeness | A measurement within STEP, expressed as a percentage, to indicate See the Metric
Score the proportion of key data that has been completed for a particular Visualization topic
object. This key data is configurable, as is the weighting of importance. in the System
Setup / Super
User Guide
documentation.
Condition A condition is a type of business rule that evaluates to either true or See the Business
false, and does not change data. In relation with approval, a condition Conditions topicin
can act as validation for whether an approval action can be carried out. the Business
In relation to workflows, conditions can be used to prevent a transition Rules
from being taken if certain conditions are not met. documentation.
Context A specific filter placed on the system data. Each contextis a See the Contexts

combination of different dimensions such as language, country, and so

topic in the System

forth, for example, English US, French CA, or German DE. Data may Setup / Super
vary based on context. User Guide
documentation.
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D
Term Definition Further Reading
Data Model | Basic system configuration defining the allowable structures and See the System Setup /
make up of data within STEP. Consists of system setup data, Super User Guide.
including: dimensions, contexts, object types, reference types, keys,
component models, attribute groups, attributes, lists of values, units,
and tags.
Dimension- | An attribute that can have different values for different dimension See the Dimension
Dependent | points, where the actual value is determined by the context in which Dependent Attributes
Attribute the attribute is presented. topicin the System
Setup / Super User
Guide documentation.

Definition Further
Reading
Entity A group of master data that has a specific business meaning. Entities typically | Seethe
store product-neutral data in STEP according to client-specific groupings of Entities topicin
information, such as customers, employees, suppliers, and addresses. Entities | the Getting
are also often used to store reference data that is utilized within the system. Started / User
Entities can be grouped into a hierarchy using reference types that are only Guide

valid from an entity object to an entity object. A source object can be displayed | documentation.
as a child of the target object or the target as a child of the source.

Externally | A characteristic of an attribute or reference that can be setto 'Yes' or'No’. A See the
Maintained | 'Yes’ selection indicates that the data point is maintained externally, and a Externally
Attribute change in it does not trigger a change in approval status and/or a new revision | Maintained
on the STEP object on which the data was changed. A ’No’ selection indicates | Attributes topic
that the data point is maintained internally and a change in it has the potential in the System
to trigger a change in the approval status and/or a new revision on the STEP Setup / Super
object on which the data was changed. User Guide
documentation.
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Definition Further Reading
Function | A type of business rule that allows for input parameters to See the Business Functions
produce an output. These operations are side-effect free, and it topic in the Business Rules
do not change STEP data. documentation.
G
Term Definition Further Reading
Golden | Collection of data from a variety of sources, based | See the Survivorship in Match and Merge topic
Record | on matching, linking, and survivorship rules. The the Survivorship in Match and Link topic in the
Golden Record is considered the trusted data Matching, Linking, and Merging
record, compiled from the various source objects. | documentation.
GUI Graphical user interface. For STEP, this can be See the GUI Setup topic in the System Setup /
the workbench or Web Ul. A GUI Super User Guide documentation or the
Design Mode Basics topic in the Web User
Interfaces / Web Ul Getting Started
documentation.
H
Term Definition Further Reading
Hierarchy | A data structure composed of parents See the Object Type Hierarchy topic in the Object Types
and children. and Structures of the System Setup / Super User Guide
documentation.
Hotfolder | File system of folders where data can See the IIEP Receiver Methods in the Data Exchange

be dropped for automatic loading into documentation, Configuring an Asynchronous File

STEP, based on the particular Exchange Service in the Data Integration
configurations and/or code applied to documentation (), or Asset Importer in the Digital Assets
the hotfolder. documentation.
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Further

Reading

ID The unique identifier for all objects within STEP. It cannot be translated or
edited once created, and cannot contain special characters.
Image A series of parameters defining the way in which an image is transformed See the Image
Conversion | from the standard high resolution asset that exists in STEP to the required Conversion
downstream format. Several conversion options are available by default, and | Configuration
additional conversions can be added via configuration and/or extensions. topicin the
Note that conversions change assets as they are pushed from STEP, leaving | Digital Assets
the originating file unchanged in STEP. documentation.
Inbound Communication channel defining how data is received by STEP. Each Seethe
Integration | endpoint defines how data is received from an external system, specifying Inbound
Endpoint location, transport protocol, data to be exchanged and other configuration Integration
(IIEP) parameters. Endpoints topic
in the Data
Exchange
documentation.
Integration | Communication channel between STEP and external systems. See Inbound Seethe Data
Endpoint Integration Endpoint and Outbound Integration Endpoint. Exchange
(IEP) documentation.
Inheritance | The ability to make data available in the product or classification hierarchy to Seethe
lower nodes by linking it to a higher node in the hierarchical structure. Inherited
Attributes topic
in the System
Setup / Super
User Guide
documentation.
© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 15
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J
K
L
Term Definition Further Reading
Library Set of functions that can be reused in multiple business rules or other | See the Business
libraries. Libraries cannot be called independently and must be Libraries topic in the
referenced from other actions, conditions, or functions. Business Rules
documentation.
Link A parent/child relationship between objects within the STEP system. | See the Reference and
Link Types topicin the
System Setup / Super
User Guide
documentation.
List of A validation base type for an attribute that only allows a value to be See the List of Values
Values considered valid if it belongs to a respective list of pre-configured (LOVs) topicin the
(LOV) values assigned to the attribute. Also used to refer to the value list System Setup / Super
itself. LOVs are also referred to as 'Domains' at times. User Guide
documentation.
Localized | An attribute value that is set directly on an object and is not inherited See the Inherited
Value from any level above in the hierarchy. Attributes topic in the
System Setup / Super
User Guide
documentation.
M
Term Definition Further Reading
Mandatory | Indicates that the product and all its sub-products See the Mandatory Attributes topic in the
Attribute must have a value for the specified attribute in order System Setup / Super User Guide
for the object to be approved. documentation.
Multi- An attribute that can contain more than one value for | See the Editing Multi-Valued Attributes
Valued a specific object. topicin the System Setup / Super User
Attribute Guide documentation.
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Further
Reading

Object An element within the system, for example, a product, image, classification, See the Basic
attribute, workflow, business rule, etc. STEP
Concepts topic
in the Getting
Started / User
Guide.
Object A specific label for levels within a taxonomy, given to different elements within See the Basic
Type the system. Nearly every objectin STEP is labeled with an object type to help STEP
identify whatitis (i.e., a product or entity rather than an image, a TIF rather Concepts topic
than a PDF, etc.). This includes entities, products, product categories, in the Getting
alternate hierarchies, images and other assets, attributes, and LOVs. Through | Started/User
the use of object types, system administrators can control how rigid or loosely Guide.
defined the database will be in terms of object creation and where objects are
allowed to ‘live’ and/or be used. This labeling also becomes very important
when working with exported data so that each type of object in STEP can be
identified for special handling in web applications or other uses outside of
STEP.
Orphan A specification attribute that has a value, which has been deleted from / not See the Linking
Attribute linked to a product node or classification and is denoted by italics. Orphan
Attributes topic
in the System
Setup / Super
User Guide
documentation.
Outbound | Communication channel defining how data is sent by STEP. Each endpoint Seethe
Integration | defines how data is sent to an external system, specifying location, transport Outbound
Endpoint protocol, data to be exchanged and other configuration parameters. Integration
(OIEP) Endpoints topic
in the Data
Exchange
documentation.
© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 17
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P
Term Definition Further Reading
Postprocessor | A plugin component within the IEP framework that allows See the IIEP Configuration

STEP to act on the result of the import / export such as Flipper and the OIEP Output
starting workflows, sending notifications, etc. Templates Flipper topics in
the Data Exchange
documentation.
Preprocessor | A plugin component within the integration endpoint See the IIEP Configuration
framework that allows STEP to modify the message prior to Flipper and the OIEP Output
import / export. It can be used for various functionality such as | Templates Flipper topics in
pre-validation, format conversion, filtering, etc. the Data Exchange
documentation.
Primary Hierarchy that allows for different types of objects to be stored | See the Object Type
Product once in the database; each object within this hierarchy has a Hierarchy topic in the

Classification
(PPC)

unique ID / identifier and may have only one location within
the hierarchy. Also referred to as the 'blue hierarchy'.

System Setup / Super User
Guide documentation.

Product One of the object super types, referring to any object within See the Products topicin the
the Primary Product Classification (blue hierarchy). Getting Started / User Guide

documentation.

Product InDesign templates that determine what type of data will See the Product Templates

Template appear on a printed page, including the positioning and topicin the STEP Publisher
styling. documentation.

Product Data type used to model multiple variants of a similar object. See the Product Variants

Variant For example, T-shirts in various sizes and colors could all be topicin the System Setup /
variants of a single product. Super User Guide

documentation.

Proof View A tab in workbench or Web Ul that displays a product See the Proof View section
template view ('proof') of a selected node (typically a product) | of the STEP Publisher
without the user needing to access InDesign. documentation.

Publication One of the super types, referring to objects in the publication See the Publication

(green) hierarchy.

Hierarchy section of the
STEP Publisher
documentation.
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Term Definition Further Reading

Public API The set of server-side functions that have been exposed to be | See the STEP API
used in the business logic. This includes many functions to Documentation link on the
create, get, and set data, such as values and references. It Start Page.
also includes various methods for logging as well as sending
emails.

Purge Removal of an object from the database. Following purge, an | See the Revisions topicin
object cannot be revived. the System Setup / Super

User Guide documentation.

Definition Further
Reading
Queue | The mechanism within the IIEP framework that allows messages to be See the
processed in an asynchronous way. The queuing concept allows separating Background
processes from different integration endpoints as well as controlling the degree Processes and
of parallel imports (a queue size of one guarantees sequential import, while a Queues topicin
queue size larger than one allows parallel processing of multiple messages for the System
increased throughput where sequential execution is not required). Setup / Super
User Guide
documentation.

Definition Further Reading
Reference | An association between objects See the Reference and Link Types topic in the System
within the STEP system. Setup / Super User Guide documentation.
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S

Term Definition Further Reading

Special A character that cannot be found on a standard keyboard but See the Tags topic in the

Character can usually be found in the Windows character map. Example: System Setup / Super
Trademark Symbol - ™ User Guide

documentation.

State A step within a workflow to which a specific user, user group, or | See the Creating a
system can be assigned to complete the task(s) associated with | Workflow topic in the
the state. Workflows

documentation.

STEP Stibo Enterprise Platform master data software application that
provides business managers a single source database to store,
manage, and re-purpose product information for publication or
syndication.

STEP’n’design | STEP’s plugins for InDesign that allow data from the STEP See the STEP Publisher
database to be pulled onto pages. documentation.

STEPXML The native XML language for STEP, which can be used for See the STEPXML
importing / exporting STEP data, as well as transferring Format topic in the Data
configurations between STEP systems. Exchange

documentation.

Super type A major category of data within STEP including: Asset, See the Object super
Classification, Entity, Product, and Publication. See the specific | types topic within the
definition for each super type for additional information. Getting Started / User

Guide.

Superseded The 'Superseded' status displays with affected components and
serves as guidance to admin users selecting which components
to implement when configuring their Web Ul.

Super User A user that is given administrative privileges within the STEP See the Actions Sets
system. topic in the System Setup

/ Super User Guide
documentation.
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T
Term Definition Further Reading
Task The work and/or action that must be completed withina | See the Working with Tasks in
specific workflow state (whether by a user or via Workflows topic in the Workflows
automation). documentation.
Transition | The change of tasks from one state to another within a See Creating a Workflow in the
workflow. Workflows documentation.

Definition Further
Reading
Unique Key [ A unique key is a system entity that represents a specific objectinthe STEP | See the Unique
system. The entity is composed of one or more data points, whether utilized | Keys topicin the
as-is or in a combined and/or transformed format using a specified formula. System Setup/
There can be exactly one record for each object for each defined key. No Super User
two objects with the same unique key for an active key can exist. Guide
documentation.
User Rules that allow or restrict users from performing certain functions withinthe | See the
Permissions | system. Privilege Rules
topicin the
System Setup /
Super User
Guide
documentation.

Definition Further Reading
Validation | A characteristic of attributes that identifies the format of the See the Validation Rules topicin
Base accepted data for the attribute value, such as whether the the System Setup / Super User
Type value is a date, integer, fraction, text, LOV, etc. Guide documentation.
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Further
Reading

Web Ul A web-based interface to access the STEP database in order to read, edit, or | See the Web
download data and assets. Multiple Web Uls can be configured for each User Interfaces
STEP installation. topicin the

Web Ul
documentation.

Workbench | An interface for managing datain STEP, as well as carrying out administrative | See the STEP
functions. Workbench Ul

topicin the
Getting Started
/ User Guide
documentation.

Workflow Business process(es) modeled as a series of states and tasks that can be See the
executed by users and/or automatic processes within the STEP system. Workflows
Workflows prompt the next step of a process to be started, by either creatinga | documentation.
task for a user, or sending an alert. Workflows may contain a number of
process steps or tasks, as well as business logic.

Workspace | A set of independent ‘copies’ of the database objects that provides a revision- | Seethe
specific view of objects. Workspaces are organized into separate areas Workspaces
including Main and Approved. The Main workspace is where data topicin the
maintenance takes place. The approved workspace is a non-editable System Setup /
snapshot of data that has been determined to have been acceptable for Super User
publishing to downstream systems. Guide

documentation.
X
Y
Z
© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 22




T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Basic STEP Concepts

This topic introduces the reader to some fundamental STEP concepts that provide a foundation for the rest of the
material in the Getting Started / User guide, as well as the System Setup / Super User guide. The focus of this
topic is on data structures and data management, and is not intended to be an introduction to the full capabilities of
a STEP system.

Object Types Overview

Technically, nearly everything in STEP is an object, and object types must be defined for which instances of
objects can exist. Object types provide a specific label for levels within a taxonomy, given to different elements
within the system. Nearly every object in STEP is labeled with an object type to help identify whatitis (i.e., a
product or entity rather than an image, a TIF rather than a PDF, etc.). This includes entities, products, product
categories, alternate hierarchies, images and other assets, attributes, and LOVs. Through the use of object types,
system administrators can control how rigid or loosely defined the database will be in terms of object creation and
where objects are allowed to "live" and/or be used. This labeling also becomes very important when working with
exported data so that each type of objectin STEP can be identified for special handling in web applications or
other uses outside of STEP. Object types in STEP can largely be divided into two categories:

» Tree Object Types: Object types that make up the standard STEP hierarchies accessible on the Tree tab in
workbench. Many of these object types can be further grouped into five categories of object types, referred
to as the super types. Tree object types are defined in System Setup, but instances of the object types are
accessed within the Tree.

« System Setup Object Types: Also referred to as Basic Object Types. This category encompasses all of the
remaining object types that make up a STEP system. Among many other things, this includes attributes,
users, integration endpoints, workflows, and business rules. System Setup object types are defined in
System Setup, and instances of the object types are also accessed within System Setup.

More information on object types in general, including how to create and maintain object types, can be found in the
Object Types and Structures section of the System Setup / Super User documentation.

Object Super Types

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon' object type and an 'lllustration’ object type (along with any number of others) within the Asset
super type.

The object super types are:

1. Assets
2. Classifications
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3. Entities
4. Products
5. Publications

More information on the characteristics of the various super types can be found in the Object Super Types topic
within this guide.

Object Types Versus Object Instances

Two core capabilities for managing data in STEP are the Tree tab and the System Setup tab. In order to
successfully use STEP, itis critical to understand the differences between the functions available in these two
areas, specifically in relation to types of objects versus instances of objects.

Technically, everything in STEP is an object, including workflows, attributes, business rules, export and import
configurations, products, classifications, images, etc. However, the term "objects" is more generally used to mean
assets, classifications, entities, products, and publications. In other words, the super types are also all things that
you can find on the Tree tab in STEP. This section focuses on the differences between object types and object
instances for Tree objects, specifically those that fall into the super types.

For example:
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[ STEP Workflow ” Bookmarks " System Setup " BG Processes ” Search ]

#-{ 7] Assets

r_=| Configurations

-] Web Sites

=1 ] Acme Retail Web Site
Elr_=| Apparel

E
E

|| 18207-012
-] 18214-012
|l 18215012
-\l 18217-012
t |l 18217054
~[[5] Women's Apparel
- 7] Automotive
[-{_~] Building and Electrical Products

vl {Ji] Entity Root
-5 Publications
[I-{IT] Primary Product Hierarchy

EHIT) Products

r_=| Apparel
r_=| Footwear
-5 Safety
r_=| Hardware
r_=| Displays
r_=| Furniture
r_=| Automative
r_=| Building Products
Elr_=| Electrical & Electronics
|j Electronic Accessaries
E}Fj Wire & Cable
. [T Cable
=il Cable Items
- - 050-42151
E}|__=| Cable Sales Items
-] 7832-200

T ISTIBOSYSTEMS
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The objects and structures available in the Tree will vary based on your particular data model, but the concepts
described can be applied across any data model. Regardless of the specific names or structures, each node on
the Tree tab is an individual object that has a defined "place to live" within a hierarchy. A user can right-click on
many of these objects and have a 'New...' option, such as 'New Product' or 'New Classification’, allowing them to
create a new node in the hierarchy. For example, when right-clicking on the 'Apparel' object and selecting 'New

Product', a dialog appears with an option to create a 'Level 2' object.
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=[5 Products > Ittribute N
r_=| Apparel Y g
-7 Footwear [ 1 Create Product >
-5 Safety
r_=| Hardware
r_=| Displays
r_=| Furniture
B[ Automotive | 1D 411231
r_=| Building Prody
£ Electrical & El
. [#+{IT] Blectronig Create Cancel
=15 Wire & CA

Elr_=| Primary Product Hierarchy ‘ ‘ Mame

"Dbject Type

Marme

Typing a Name and clicking Create would create a new object as a child to the Apparel node. But what defines
that a 'Level 2' object can be created on this node? And that it is a Product (blue) object rather than an Entity (gray)
or Classification (yellow)?

The allowable structure of objects and hierarchies that are accessed in the Tree are defined in System Setup. To
continue with the above example, we can see that the defined object types and structures include a Primary
Product Classification that has a number of levels. A Level 1 can only have a Level 2 child, which in turn can only
have a Level 3 child. However, a Level 3 object type can have a number of child object types, including an ltem
Folder, Level 4, and a Sales ltem Folder. A Sales Item Folder is a child of a Level 3 object type, as mentioned, but
can also be a child to a Level 4. Similarly, a Sales Item can be child to multiple things, including a Sales Item Folder
and a Sales ltem Family.
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System Setup

= Object Types & Structures
rj Alternate Classifications
-- Assets
-3 Basic Object Types
&35 Commerdal Types
[ﬂ‘ Entity uzer-type root
[ Event Queus Object Types
E||__=| Primary Product Classification
i Discontinued Products
iﬁ‘ External Products
i Packaging Hierarchy
r_=| Primary Product Classification
E Product Overrides
E|r_=| Products

EIFj Level 1

E||__=| Level 2
E}Fj Level 3
B Il Item Folder

E} a Item
P Ml Open Item
=N Il [tem Family

= E Ttem

..... . Open Ttem
= r_=| Level 4
- Item Folder
E| ﬁ Ttem
S Wl Open Item

B -Jill Ttem Family

Iélaltem

[ STEP Workflow ” Bookmarks ]m[ BG Processes ” Search ” Tree

E} |__=| Sales Ttem Folder
El ll Sales Item

T ISTIBOSYSTEMS

..... . Dpen Item

- | Cpen sales Item
= 7] SalesItemFamily
B I_ Sales Ttem
..... |_ Open Sales Item
[=-[[7] Sales Item Folder
E} l_ Sales Item
..... l_ COpen Sales Item
B 7] SalesItemFamily
= ll Sales Item
..... | Open sales Item

e MASTER DATA MANAGEMENT

The object types defined in System Setup provide the "skeleton" for the allowable instances of objects that can be
created in the Tree. Itis important to understand that it is only the structure and types of objects that are defined in
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System Setup, but any number of instances of the defined types can be created in Tree. This is best illustrated by
viewing System Setup and Tree side by side, as shown below. Object instances are displayed in Tree, with red
text indicating the corresponding object type designations from System Setup.

System Setup

=i Object Types & Structures
B[] Alternate Classifications

-7 Assets

[

[ %’ Basic Object Types
F-45) Commerdial Types
£
£
E

(=[5 Primary Product Hierarchy| Primary Product Classification
E}E Products Products
E-{T) Apparel  Level 1
E}|“_=| Upper Body Wear Level 2
-] T-shirts Level 3
- il T-shirts Items Ttem Folder
il 88723-12 Item Family
. -l Cotton T-Shirts Ttem Family
B ﬁT—Shlrts Sales Items Sales Item Folder
4l 198623 Sales Item
|_ 188405 Sales Item
[T Head Wear Level 2
B[S Hats and Caps Level 3

- %’ Entity user-type root

- Event Queue Object Types

-} |__'=| Primary Product Classification

[+ Discontinued Products
%‘ External Products

i Packaging Hierarchy

1j Primary Product Classification
E Product Cverrides

=0 Productsl =il Hats and Caps Items Item Folder
=S Level 1 -\ (120170) Item
E||"_=| Level 2 E (120688)
=T Level 3 - (179653)
-l Ttem Folder E (179854)
=} ﬁ Item -\ (179856)
i {ff] Open Item - 103308
=} Bl Item Family - Blue Hat
Ttel
L ﬁ .ITID . g Blue Hat
o et pen Item -\ Gray Hat
r'_=| eve a Industrial Hard Hat
E} il [tem Folder E Ski Hat
- ﬁmo . = sk Helmet
E - F|:;enI L . (131625) Open Item
m Fami
Eﬁ e ¥ [#}-[[T] Hats and Caps Sales Items  Sales Item Folder
P Al Open Ttem Froomes Level 1
=T Shoes Level 2
E| |“_=| Sales Ttem Folder ; B- @Pumps Level 3
= l_ Sales Ttem ;

E--- Pumps Items Level 4
| E-jill Heels - High: 3" or higher Ttem Family

P |_ Open Sales Item
I'é| 17 SalesItemFamily
B |_ Sales Ttem
----- I_ Open Sales Item
=77 Sales Item Folder

Notice in the above screenshots that a Level 2 object exists in System Setup only once, but we see multiple
instances of itin Tree.

The same principles described for the Primary Product Hierarchy apply to all other hierarchies in STEP. For
example, an entity hierarchy could have a Customer object type with allowable children of Address and Contact
object types. The object types and structures are defined in System Setup, and instances of these objects can then
be created in Tree.
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System Setup Tree
EI{%' Object Types & Structures [L]i Entity Root
B[] Alternate Classifications =i [Customer Hierarchy |
-1l Assets =8 Customer A
-z Basic Object Types -4y Axel Kiers Vej 11
-85 Commerdial Types {8 Jesper Jensen
E} lﬁ' Entity user-type root -8 Customer B
' El ‘ Entity Root >ﬁ 3550 George Busbee Plwy
ﬂa All Customers . A=) John Smith
= 2 Customer | i 2 Customer C
- ~ 4% Address
{8 Contact

Note that object super types can only exist within their designated hierarchy types. To clarify, a product hierarchy
(blue hierarchy) can only contain object types of the product super type, while an entity hierarchy (gray hierarchy)
can only contain objects of the entity super type. It is possible to have the visual appearance of mixed hierarchies,
but this is accomplished via references rather than actual data structures. For example, products may appear in
the Tree to be within a classification hierarchy, but this is due to references on the object, as shown below.

18207-012 rev.0.2 - References

EF_:I Merchandising Hierarchy A (|| commercial || Tables || Category Profile State Log || Tasks
Elj Apparel Product H Sub Products ] References [ Referenced By " Images & C
S e Osommedprodctanene
& mageReferences
@ ltemReferences, Cassificaton
@
Reference Type w| » [Target >| >
» |Merchandising Link = %v [ Merchandising Hierarchy/Apparel fSpor tswear [T-shirts )(
[ Automotive > |Website Link + [y [7] Web Sites/Acme Retail Web Site/Apparel Mens Casual T-shirts and Sweatshirts | [
B severzes OSestenRefwenes okt
e [2] Pootwear € Ungrouped Classificationtinks
=i Smdecwods
|:—:|r‘_=| Web Sites .
B[] Acme Retail Web Site —
=[] Apparel @ Lnked Attributes from Product Hierarchy

B[ Mers Canl OlrkedAtbutes fom Cassbcation herarchy

Notice that the corresponding System Setup structure for the above does not include the product object types.

El r_=| Merchandlsmg Hlvararu::l'wI Root
LB rj Department

=8 r_=| SubDepartment

+[[Z] MerchandisingClass

EI r_=| Web Hierarchy Root
= ] Website Root

= T] Web Level 1

& |'_=| Web Level 2
----- [ WebLevel 3
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The true residence of the product objects is within the Primary Product Classification, with a visual display of the
product references into various classification hierarchies being just that: a visual display of references. However,
assets are an exception to this concept. Assets are not part of the Classification structure in System Setup, but do
in fact exist within this structure in Tree. Each asset must be linked in to one or more classifications, and this is the
only location in which they "live" in STEP. Each asset automatically has a reference applied to each classification
in whichitis linked. More information on references can be found in the Reference and Link Types topicin the
System Setup / Super User guide. More information on the various object super types and their characteristics
can be found in the Object Super Types topic within this guide.

Using the above information, the questions posed earlier in this topic can now be answered:

Why can we only create a Level 2 object under the Apparel node? Because in this particular data model
configuration the Apparel node is a Level 1 object type, and only Level 2 object types are allowed to be created
under a Level 1 object type.

Why can't we create an Entity or Classification under the Apparel node? Because only object types within the
same super type can exist within the same hierarchy. And even if this wasn't the case, the structure defined in
System Setup in this particular hierarchy only allows a Level 2 object type (of the product super type) under a Level
1 object type.
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Object Super Types

This topic provides an introduction to the STEP object super types. It will be helpful to have read and understood
the Basic STEP Concepts topic in this guide prior to reading this material.

Object types that make up the standard STEP hierarchies accessible on the Tree tab in workbench are referred to
as Tree Object Types. Many of these object types can be further grouped into five categories of object types,
referred to as the super types. This topic introduces the five primary object super types in STEP. Understanding
the differences between the various object super types is important when making decisions about how to model
datain STEP.

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typically modeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object types within each super type can be created. For example, a system may
use both an 'lcon' object type and an 'lllustration’ object type (along with any number of others) within the Asset
super type.

The object super types are:

Assets
Classifications
Entities
Products

o s~ o bdh =

Publications

Each is described below, along with links to more detailed information for working with the various super types.

Assets

The Asset super type is used to hold any type of digital media, including images, videos, documents, and text files.
Assets are organized within classifications, and can be linked to other objects in STEP using references.
Specifically, assets can be linked to objects of the Classification, Entity, or Product object super types. Upon
import, STEP populates some basic information about each asset, which can be viewed under the System
Properties flipper on each asset, but cannot be edited. Default asset icons vary by file type, and can be updated by
admin users.
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NEW! rev.1.1 - Images & Documents

MName > » |Value >
i @ ProductFolderlcon
ra Truck » D 111684
B[ Hlustrations * MName NEW!
B[] Installation Manuals > lobject Type Product Image
] Logos > Revision 1.1Last edited by USER4 on Fri Aug 19 14:42: 18 EDT 2016
I:}-r_=| MSDS Sheets ’ T
B[] Owners Manual > Approved J€ Never Been Approved
[T Product Images » [Translation Not Translated
] Product Videos > path Classification 1 root/Assets/Icons/NEW!
B Configurations
B-{] ETIM Hierarchy P
-] Index Words Mame > > |Value >
[EH-{{3] Merchandising Hierarchy > Gamma 122 0.45
B[] Suppliers 3 (Class abe Indexed color
B[] Web Sites + Colors TS
(- {jil] Entity Root » Colorspace sbe RGB
[]---ﬁ Publications > (Compression abe Zip
[-{IT] Primary Product Hierarchy > Depth il |1 (bits/sample)
[ Collections . Sl
=B eCaiangs. > Filename abe NEW!.png
{23 Recyde Bin » Format abe PNG (Portable Network Graphics image)
> Height 122 231,47 (mm)
> MIME Type abe imagepng
> Ppixel Height 12 556 (pixels)
> Pixel width [i:+ 657 (pixels)
> Samples |23 '3 (zamples/pixel)

For more information on working with assets, see the Assets topic within this guide.

Classifications

The Classification super type is used to build hierarchies and objects that bundle other objects into organized
groupings. These are represented by default with yellow folders in STEP, though these icons may be updated by
an admin user. For example, images, manuals, and icons could be uploaded to STEP as assets and stored in
appropriate subfolders under the 'Assets’ classification folder. Product objects could also be linked into
classifications to provide alternative categorizations of objects that vary from the product hierarchy structure.
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Assets rev.0.4 - Classification

[:_|r_=| Referenced By || Images % Documents || Tables || Status || Skate Log || Tasks
Elj Tlustrations Classification l Sub Products References
@ Description
Mame ¥ | » |Value >
i E Producticon
] ij STEPReferencesTab » D pEEEEIG
[#-[ ] Installation Manuals » MName Assets
B[] Lelcons > Object Type Asset Root
[+ Logos
E}'g MOSQDS Shests » Revision 0.4 Last edited by USER on Fri Dec 04 17:40:33 EST 2015
B[] Owners Manual > Approved + Approved on Fri Dec 04 17:40:33 EST 2015
[ Product Images > Mranslation Mot Translated
<[] Product Videos > Path Classification 1root/Assets
{7 Classifications
! . > isibility
{7 Configurations
r_=| Index Words * Purpose abi:
E|r_=| Merchandising Hierarchy
(-] Apparel
[—]r‘j Automotive
B Tires
(=1 Tire Accessories
A ] 4190 ND Ch

For more information on working with classifications, see the Classifications topic in this guide.

Entities

The Entity super type is used to create hierarchies and objects that do not require inheritance of data through
categorized groupings. Entities are commonly used to store customer, location, or person data, as well as to store
reference data. In addition, entities are used to store source data for golden records. Entities are represented by
gray folders and white and gray cubes by default, but these can be updated by an admin user, as is evident in the
screenshot below.

Tree

F-{ 7] Assets
r_=| Configurations
r_=| ETIM Hierarchy
-r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
Web Sites
=-{Ji Entity Root
E}% Customer Hierarchy
- 2 Customer A
-y Axel Kiers Vej 11
Jesper Jensen
[—]8 Customer B
>ﬁ 3550 George Busbee Plwy
John Smith
----- 8 Customer C

4 Key Accounts
=
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For more information on working with entities, see the Entities section of this guide.

Products

The Product super type is used to create hierarchies and objects that use inheritance of data for objects
categorized by similar characteristics. In STEP, products are represented by default with blue icons either as
folders or nodes, though these icons can be updated by an admin user. Upper nodes in a product hierarchy are
often categories and subcategories, with leaf nodes being actual objects. Whether an organizational folder,
sellable object, or something else, each node in the hierarchy is of the product super type, and all child objects are
able to inherit attributes and values from parental objects.

[#-{ 7] Assets
r_=| Configurations
r_=| ETIM Hierarchy
-r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
(- 7] Web Sites
i} Entity Root
-8 Publications
[=I-[IZ] Primary Product Hierarchy
E}|‘_=| Products
r_=| Apparel
r_=| Footwear
-] Safety
r_=| Hardware
r_=| Displays
E|r_=| Furniture
E}Fj Bedroom
E|r_=| Beds
E}‘ Beds Items
- - |{™ Comfy Bed
-a Comfy Foothoard
E Comfy Headboard
. |{™ Comfy Side Rail
-5 Beds Sales Items

[ STEP Workflow ” Bookmarks ” System Setup " BG Processes ” Search ]

For more information on working with products, see the Products section of this guide.

Publications

The Publication super type is used to create hierarchies and objects used for print publishing solutions, including
STEP Publisher, Flatplanner, and AutoPage. Publication objects are used to create templates used in print
solutions, as well as publications such as catalogs or pamphlets. Product objects can be linked into publication
hierarchies, meaning data from the product(s) will be reflected in the publication. Publication objects use green
icons by default, though these can be updated by an admin user.
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Tree
Elﬁ Publications
- B Templates
Elﬁ Autopage Publications
=@l Acme Wholesale Clothing
% Commercial Data
[E8 Caps and Hats

t- (B8 Jewelry

H- [l Accessories

[+ [E8 Gloves

- @l Beta Tools

[]--% Commercial Data
[ @8 Power Tools

[+ 8 Hand Tools

[+ @8 Toolboxes

[+ @8 Garden Tools
- [ Standard Publications
[+ Flatplanner Publications

£
E

AutoPage Publication Planner
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Shirts - Publication Section

Pagination Rules || Page Inspector Status || State Log Tasks

Publication Section I Plan " Publication Planner H Plan Motes " Financial Summary ]
@ Descripti
Mame >| > |value >
> ID 111845
* Name Shirts
> Object Type Section
> Revision 0.2 Last edited by USER4 on Mon Aug 29 11:40:21 EDT 2016
> Path Publications/autopage Publications/Acme Wholesale Clothing/Shirts
> Btart section on page 12
> Effective Date lin)
> Expiration Date lin]
» Bection Theme abe Shirts
* Circulation 123
* Cover Photo Shot Due n]
> FirstPageNumber 2
> LastPageMumber # P

For more information on working with publication objects, see the Publication Hierarchy section of the STEP
Publisher (InDesign) documentation.
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Accessing STEP System Information

The simplest way to access system information about your STEP installation is by clicking the About STEP link on
the Start Page.

STEP system information is useful for system troubleshooting and new project planning, as well as helping users
ensure compliance with their contracted license terms.

Though system information is also obtainable through the Admin Portal install.log or by running a Stibo Patch
Operations Tool (SPOT) command on the application server, clicking About STEP is the most straightforward way
to obtain this information. For more information on the install.log, see the Logs topic in the Administration Portal
documentation. For information on the SPOT command, system administrators may contact Stibo Systems.

‘About STEP' Page

When the About STEP icon is clicked, a new page is opened (e.g., http://[yoursystem]/about/step) that is
password protected to ensure that only STEP users have access to the information.

This ‘about' page displays the following information:

o System name

o STEP version, in a string that identifies the system by its baseline version that includes the major release
version number (e.g., 8); minor release number (e.g., .2); the maintenance patch version, if applicable (e.g.,
mp1); and the baseline creation date.

« Number of user accounts and the number of allowed user accounts. Standard STEP users that do not count
against the number of licensed users—such as DBA, STEPSYS, SERVICE, and SWADMIN—are not
included in the user count.

« The approximate number of products, classifications, assets, and entities. Object counts are approximate
because changes could be going on in the background while the page is being viewed. Also, for time purposes,
the quick approximation number is preferable to an exact count, which could potentially tie up system
resources for a prolonged time.

o The number of contexts, dimensions, and languages
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D STIBOSYSTEMS

MASTER DATA MANAGEMENT

= System name: doc-rel

= STEP version: 10.2-mp2-2021-08-18-13-51-12
= Detailed version information

= Number of user accounts (including suppliers): 64
= Number of supplier accounts: 7

= Allowed number of user accounts: 100

= Number of preducts (approx.): 900

= MNumber of classifications (approx.): 8000

= Number of assets (approx.): 500

= Number of entities (approx.): 7000

= Number of contexts: 12

= Number of dimensions: 2

= s InMemaory Enabled: false

= Number of languages: 10

The full version information of this system is available via snapshotspr file, please submit this file along with any support reguests,

If you are having any problems with the STEP system, please produce a diagnostics package instead. This can be done via the Administration page.

Detailed Version Information

A 'Detailed Version Information' hyperlink is also included that opens a new page (e.g., http://
[yoursystem]/about/version) where you can access information about the add-on components, customizations,
and hotfixes applied to your system. If your system contains none of these, only the current baseline version of the
systemis displayed.

[ |STIBOSYSTEMS

s MASTER DATA MAMAGEMENT

= Baseline version: step-10.2-mp2-2021-08-18-13-51-12
= Add-on components: wikimetadata-7.0.7
value-generator-7.0.4
user-anonymizer-7.0.7
ui-search-7.0.11
ui-product-editor-7.0.19
ui-basket-7.0.14
syndigo-7.0.5
local-logate-7.0.14
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System Snapshot and Diagnostics Package Links

Below the bullet list, additional information is provided to assist users who need to access more complete system
information for support purposes.

Provided is a snapshot.spr link where you can download a snapshot file that contains full system information,
including installed bundles, metrics, and differences to previous snapshots. This file is intended to be submitted to
Stibo Systems along with support requests. For more information on snapshots and their contents, see the Tools
topic in the Administration Portal documentation.

Also included is a link to the Administration Portal page, in case you need to produce a diagnostics package. This
package is generated and uploaded to Stibo Systems from the 'Send Diagnostics' tab. For more information, see
the Send Diagnostics topic in the Administration Portal documentation
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STEP Workbench Ul

The screenshot below shows a basic view of the STEP Workbench. Though system customizations and variable
access permissions may result in a slightly different view, the basic elements in this view of the workbench's Main
Window will be present for most users. The key elements of workbench Ul are numbered and defined below.

Important: A one-time install of the STEP Workbench Launcher needs to be done on each client workstation
before opening workbench. STEP Workbench users do not need Java installed separately on their computers.
After installation, the workbench will launch via conventional means. For details and directions, click on the
Workbench Launchers icon, accessible on the Start Page.

0
F ! doc-dev - userj@https://doc-dev.stibo.com - STEPworkbench — O x

File Edit View Mavigate Format Maintain Window ﬂelpl

[T comext nginis. < | € > G 0t |ar—produtacare [ (2] (3 (0] (ot oore | >
2

r_=| Assets
r_=| Configurations

i Index Words

@ Publications

r_=| Primary Product Hierarchy
@ Collections

- eCatalogs

[STEP Workflow ” Bookmarks [S;{stem Setup ” BG Processes ] Search

@ Mo Object is Selected

) ®...l
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I Note: The STEP Workbench is a Java client. STEP's backend is AdoptOpenJDK.

10.

11.

12.

13.

. The Menu Bar contains a collection of various tools for users to perform actions in the workbench. For more

information, see the Menu Items topic in this documentation.

The Toolbar contains actions that help with the view and navigation of the workbench. For more information,
see the Toolbar topic in this documentation.

The Tree tab navigates users to the object tree in the workbench. For more information, see the Tree Tab topic
in this documentation.

The Search tab provides access to the advanced search functionality of the workbench where users can filter
results, save these results as a collection, export these results for external use, or perform bulk updates on
these results. For more information, see the Search Tab topic in this documentation.

The BG Processes tab contains all of the background processes occurring in the STEP instance. For more
information, see the BG Processes Tab topic in this documentation.

The System Setup tab contains all of the administrative actions to set up the workbench to maintain data. For
more information, see the System Setup Tab topic in this documentation.

The Bookmarks tab contains all of the bookmarks that are saved by the user. For more information, see the
Bookmarks Tab topic in this documentation.

The STEP Workflow tab contains all of the workflows currently associated with STEP. The toggles can be
flipped to show the states associated with each workflow. For more information, see the STEP Workflow topic
of this documentation.

Selecting an object in the workbench populates the Object Editor pane with fields and actions based on
associated permissions and validity for the selected object. For more information, including the hide (Ed) and

show (BJ) buttons, see the Object Editor topic in this documentation.

System Information. At the very top of the STEP window, important information about the user's STEP
system is listed. The first element displayed is the name of the STEP system, then the user ID, followed by the
URL of the STEP system being accessed.

Thumbtack - The default is unpinned (fg), but allows users to pin () the right-hand side of the window.

Once pinned, a user may navigate to other items in the Tree while the information in the right side of the screen
remain unchanged. One such use case can be seen with adding objects to the Flatplanner basket. To see this
example, see the Adding Objects Manually to the Basket topic in the Flatplanner documentation.

STEP connection status displays the status of STEP's connection to the internet. When the connection is
strong and STEP is ready to run normally, the status will read 'Ready.' Other statuses that may appear are:

» Reading. STEP is requesting information from the database.
« Lost Connection to. STEP has lost connection to the server.

o Reconnected to. STEP has reconnected to the server after a lost connection. May alternate with the Lost
Connection to status if the connection to the internet is lost for a significant period of time.

Connection strength is a small graph illustrating the connection strength between the user and the server,
also know as the 'Network Latency.' If a user hovers their cursor over the graph, a hover-over display will
appear showing how fast data is traveling between the server and the user as measured in milliseconds.
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BG Processes Tab

The BG Processes tab shows all active and inactive background processes (BGPs). Activity such as an import,
export, bulk-update, collection creation, etc., generates a background process and a log and informs users if the
process was successful. In the event of an unsuccessful background process, an error message is displayed
showing the reason for failure.

Background processes are based on the type of activity, for example 'Approve recursively,' 'Bulk update,' 'Create
Collection,' 'Download Report,' as well as 'Translation,’ 'Translation Import,' and 'Unique Key Processes' shown in
the image below.

BG Processes

100703, en-US > German, Tue Jul 05 1201

-8 Translation
% Queued Processes

/ Property > Value >
E}% Active Processes . =

.48 M_Item 180937, en-US > Danish, Tue Jul 05 12:44:23 +0530 207 0 >F

48 M_Item 180570, en-US > fr, Tue Jul 05 12:52:36 40530 2015 |Id BGP_180953

‘g‘é} M_Level2180569, en-US > Hebrew, Tue Jul 05 13:06:52 +0530 | Description 100703, en-US = German, Tue Jul 05 13:53:00 +0530 2015

-4tF [100703, en-US > German, Tue Jul 05 13:53:00 +0530 2015 )

Execution Server doc-dev

465 M_Level 1180971, en-US = fr, Tue Jul 05 15:26:00 +0530 2016

4% 180247, UK English > fr, Tue Jun 28 19:05:08 0530 2016 | Frogress I ERi

465 180247, UK English > German, Tue Jun 28 19:09:09 +0530 20 1¢| Status failed (I

485 130247, UK English = fr, Tue Jun 28 20:37:10 +0530 2016

Created Tue Jul 05 04:23:01 EDT 2016
485 100703, en-US > Danish, Wed Jun 29 09:44:09 40530 2016 ’ :
48 100703, en-US > Hebrew, Wed Jun 20 09:44:11 40530 2016 | = e vt et
485 100703, en-US > German, Wed Jun 29 09:44:11 40530 2016 | Finished Tue Jul 05 04:23: 17 EDT 2015
485 100703, en-US = fr, Wed Jun 29 09:44: 10 +0530 2015 e Om2s
485 100703, en-US > UK English, Wed Jun 29 09:44:11 40530 2015 :
. Time in Queus Om 14s
485 Listadsx, en-US = fr, Wed Jun 29 09:50:57 +0530 2016
48 List.xdsx, en-US > Hebrew, Wed Jun 29 09:50:58 +0530 2015 | of warnings g
405 List,dsx, en-US > German, Wed Jun 28 09:50:57 +0530 2016 |\ of errors b

485 180246, en-US > German, Wed Jun 29 10:13:54 +0530 2016

Execution Report
405 180561, en-US > fr, Wed Jun 29 10:42:25 +0530 2015 ki
485 M_Item 180570, en-US > German, Wed Jun 29 13:17:21 40530 |+ Analyse
-4 180575, en-Us > fr, Wed Jun 29 13:30:18 +0530 2016 * Logged on

48 M_Item 180570, en-US > fr, Wed Jun 29 14:27:31 +0530 2016
é,"ﬁ} 18202, enJS = fr, Wed Jun 29 16:46:00 ECT 2016

% Product hierarchy root, en-US = German, Wed Jun 29 16:51:00
é,ﬁ} Product hierarchy root, en-US = Hebrew, Wed Jun 29 16:51:00
48 M_Item 180570, en-US > fr, Thu Jun 30 14:09:42 +0530 2016
% M_Item 180570, en-US = German, Thu Jun 30 14:32:17 +0530 2

> Analyzing translation request

< Analysis selected 1 out of 1 nodes for translation

= Leaving query service

° Root node was specified. Will wait for user to accept analysis result
7 Parsed translation configuration

£

%"ﬁ} 100703, en-U5 = Danish, Thu Jun 30 19:00:20 +0530 2016
% 100703, en-US = Danish, Thu Jun 30 19:03:06 +0530 2016
% M_Item180571, en-US = fr, Fri Jul 01 09:40:21 40530 2016
48 M_Item 180571, en-US = fr, Fri Jul 01 09:48:39 40530 2016

%"ﬁ} M_Item180571, en-US = German, Fri Jul 01 10:16:56 +0530 20;
%"ﬁ% M_Item 180571, en-US = Danish, Fri Jul 01 10:24:04 +0530 201¢
% Ended Processes
- 8 Translation Import

]--% Unigue Key Processes

= Logged on
= Updating translation status
10 1 nodes will be exported for translation
1 Registering pending translation file "100703-100703.xlsx
12 ¥ml for translation: exceltranslation BGP 180963.7ip
12 Translation Export Completed
I 1< Export failed with exception: Optimistic locking errors were detected wta &
|12 Caught OptimisticVerificationException at Tue Jul 05 04:23:17 EDT 2y er
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A background process can be in the following states: queued, active, completed with errors, or ended. For details
on these states, see the BG Processes States topic in the System Setup / Super User Guide documentation.

For information on Background Process Queues, see the Background Processes and Queues topicin the
System Setup / Super User Guide documentation.

For information on initiating and monitoring BGPs in Web Ul, see the Background Process List Screen topicin
the Web User Interfaces / Web Ul Getting Started documentation.

BG Processes Displayed

In the BG Process tab, a user can choose to see only the BGPs that they have initiated, or with the appropriate
privileges, they can see all the BGPs run by any user. The display is selected by clicking either the "Two People
and Gear' button or the 'One Person and Gear' button highlighted in the image below.

L3

b AddItemsToCollection

b Analyze Change-Package
b Approve Recursively

i) Asset Integrity check

7 AssetDelivery

) Autopage Batch Service
) BGPTest

7 Bulk Update
b Category Profile Batch Processes

m

BG Processes

| ey B sy N ey O g S o R R oy RO oy A ey i
| I S [y S Ry i Dy b Ry L By LN R LN Ry N R BB sy

Two People and Gear () displays all background processes run by any user. This button is enabled by the
'View Background Processes of Other Users' setup action as defined in the Setup Actions topic of the System
Setup / Super User Guide documentation.

One Person and Gear () displays only the background processes run by the user who is logged in.

Background Process Tab

The Background Process tab in the editor contains:
« The Properties flipper includes who started the background process, an auto-generated unique identifier, the
type of BGP performed (export, import, bulk update, etc.), status (Succeeded, Failed), creation date and time,

start date and time, end date and time, time taken to process the request, number of warnings, and number of
error messages.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 42



[T1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Background Process [ Queue Info ]
@ Propertes

Property * |Value »
Started by LISER 1

Id BGP_180963

Description 100703, en-US = German, Tue Jul 05 13:53:00 +0530 2016

« The Execution Report flipper includes detailed information about the process. If the process failed, a
message displays the reason.

| 11 || 4 |1—s~uf9| I || M || Save... Truncate

« The navigation buttons are enabled when until the log reaches over 100 lines.
« Clicking the III button will navigate back one page.
« Clicking the III button will navigate to the beginning of the log.
« Clicking the III button will navigate forward one page.
« Clicking the ’T‘ button will navigate to the end of the log.

» The Save button allows the user to download the execution report. Click the 'Save' button to display the
'Save File' window. Browse to the download location, add a file name, and click the 'Save' button. The file
can be saved as a CSV or HTML file type. For larger files, CSV files can be zipped.
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¥y Save File >
Look in: Documents «| F -
€ >
File name:
Files of type: |5y (Zipped) e Cancel
CSV (Zipped)
CSW

« Truncate - This button is available only on the 'Ended Processes' node.

When the Execution Report becomes cluttered or only specific information is needed (errors or warnings),
truncating the report permanently removes the unneeded information. Click the 'Truncate' button to display
the 'Truncate execution report' dialog.

Important: Once execution report lines are removed via truncate they cannot be recovered.

[ Truncate execution report >

Mumber of lines to retain | 16

Execution report entry types to delete

[]Error
Info
[ ] Warning

QK Cancel

For example, assume the execution report has 50 lines and a user wants to see only 16 lines from the report
that are errors. With the settings shown in the image above, the user clicks the OK button and the execution
report retains only the first 16 error lines. All other lines are permanently deleted.

Queue Info Tab

The Queue Info tab in the editor displays the name of the queue being used for the process within the flipper title.
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Background Process

?

Position *> |Process Type * |Process Description * Process ID » |Started by > |Server * |Progress »* [Created »* [Started * |Finished * [Processing Time * [Time in Queus »
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The Bookmarks tab allows users to set bookmarks for any objects in the Tree and allows users to easily access
these objects without having to search or navigate the Tree.

A bookmark is a Uniform Resource Identifier (URI) that is stored to provide the user with a quick method of
retrieving the data at any time. Bookmarks may be accessed either by the menu selection Navigation >

Bookmarks or by the Bookmark tab.

File Edit View Mavigate Format Maintain Window Help

D Context |E @ Search

Processes

Search Below
Goto
Goto Mext

Back

N A

Forward

Ctrl+F

Ctrl+0G
Ctrl+E

Bookmarks

Find Similar Product

Bookmarks

21 Brand Logos (BrandLogos)
&4 Endcap Displays (22177)
5 Copy Writing State (100400}

(21 Export Configurations (stibo. EMConfigFolder)

W[ Syskem Setup ” Bi5 Processes ” Search " Tree
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Bookmarks are specific to individual users — just as in a web browser. This means that one user will not be able to
view the bookmarks created by another user.

To know more about the Bookmarks and maintaining Bookmarks, see the Bookmarks topic in the Navigation
and Searches documentation.
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Adding a Bookmark

Standard navigation Bookmarks are used to quickly access specific nodes in the Tree and System Setup
hierarchies. These bookmarks save the URL of the currently selected object. Any objects from Tree or System

Setup hierarchies can be added with the usage of Bookmarks functionality.

To save an object as a Standard Navigation Bookmark:

1. InTree, select the item to be bookmarked.

Tree

(8] ” Search ]

BiS Processes

2. Onthe Navigate menu, select Bookmark > Add Bookmark.
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@ Search

Search Below
> Goto
[>[> Goto Mext
Back

Ctrl+F

Ctrl+G
Ctrl+E

I €

I F
m Sub Proc

+].-[0) Customer Root

- () Customers

@) Entity Root

- (0) GDSN

ﬁ Publications

Eli Primary Product Hierarchy

. [T Products

£ Apparel

[+[[T] Upper Body Wear
i Head Wear

” Syskem Setup ” BG Processes " Search ]

Bookmarks

Forward » D
Y l=rms
9 Add Bookmark Ctrl+D |
. . @ Add Search Bookmark i
Find Similar Product |
* |Approved
» Translation

¥ Path

» Default InDesign ter
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- Category Specific At
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3. The new bookmark is displayed on the Bookmarks tab.

Bookmarks

(1 Brand Logos (BrandLagos)
id Endcap Displays (22177)
=5 Copy Writing State (100100)

b Apparel (18200)

| Export Configurations (stibo. EMConfigFalder)

4. Click the new bookmark.
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21 Brand Logos (BrandLogaos)

&2 Endcap Displays (22177)

= Copy Writing State (100100}

[0 Export Configurations (stibo. EMConfigFolder)

@ Apparel (18200) i———

5. Navigate to the Bookmarks main tab, and go to the Product tab on an object to view the bookmark data.

Bookmarks

21 Brand Logos (BrandLogas)

&4 Endcap Displays (22177)

I Copy Writing State (100100)

21 Export Configurations (stibo EMCanfigFolder)
&4 Apparel (18200)

Tree

W[ Syskem Setup ” BG Processes (8) ” Search "

STEP Warkflow

Apparel rev.0.3 - Product

Tables || Category Profile || Status || State Log || Tasks

b MASTER

1STIBOSYSTEMS

DATA MANAGEMEMNT

Product [ Sub Praducts ” References ” Referenced By ” Images & Documents }

?
Mame > ¥ |Value
» D 13200
» Name Apparel
» [Dhject Type Levell
> Revision 0.3 Last edited by USER on Thu Jul 30 11:..,
¥ |Approved x Last Approved on Thu May 21 14:58:...

* [Translation

Mot Translated

» Path

Primary Product Hierarchy Products/Apparel

> ity

El

* Country

ab;

> Gtate

E

» Gireet

at;

* Fip

123

§ sdeslenVaetgDescrptoss

Mame

22

Value

* Description, Long ahe

fawbieGow
Mame > » |Value >

* Bize abe

Bookmarks can also be created using a shortcut. Select the object and press Ctrl+D. The bookmark is created

automatically.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021)



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Removing a Bookmark

After saving a Bookmark, it may no longer be needed eventually. There is a right-click menu option that can
remove a selected bookmark.

Important: If user deletes a bookmark (Maintain menu > Delete), the object is deleted and is moved to the
Recycle bin.

No confirmation window displays before removing a bookmark.

1. Onthe Bookmarks tab, right-click the bookmark to be removed and click Remove Bookmark.

Bookmarks
21 Brand Logos (BrandLogos)

51 Export Configurations (stibo. EMConfigFolder)
& Copy Writing 100400

&4 Apparel (182 Edit Bookmark

| Remove Bookmark |

Copy To Clipboard

2. The selected bookmark is removed.

Bookmarks
5 Brand Logos (BrandLogos)

(3 Export Configurations (stibo. EMConfigFolder)
5 Copy Writing State (100100)

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 51



Editing a Bookmark

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Both Standard Navigation (the link to specific objects) and Search Bookmarks may be edited in the Bookmarks
tab. To edit a bookmark:

1.

2.

On the Bookmarks tab, right-click the bookmark to be modified and click 'Edit Bookmark.'

Bookmarks
(3 Brang! — i
31 Expo Edit Bookmark ronfigFolder)

& Copy Remove Bookmark

Copy To Clipboard

If desired, change the name of the Bookmark then click OK.

[1 Edit Bookmark

Mame |Primary Brand Logos (BrandLogos)

] Edit LRL

Pt

URL  |step: //dassification?editor =Classification&versionid=111511&cont

Ok Cancel

The name will be updated in the Bookmarks tab.

Bookmarks

rand Logos (BrandLogos)
&g Endcap Displays (22177)
= Copy Writing State (100100}

3 Export Configurations (stibo. EMCaonfigFolder)

The object URL can be edited only if the Edit URL checkbox is activated. In the below screenshot, the product

URL has been modified which points to a new product URL.
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[ Edit Bookmark o

Mame | Apparel (18200)

URL  |zstep: jjproduct?editor =Product&versionid=1115118&contextid=Con
Edit URL

QK Cancel

Similarly, 'Search Bookmark' can be edited by editing the 'Search URL,' if the 'Edit URL' checkbox is edited.

5. Click the OK button to save any changes to this bookmark.
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Copying a Bookmark to the Clipboard

Bookmarks are direct addresses to a specific object, such as a product, entity, or publication, in STEP. These
bookmarks can be shared to other users by copying the bookmark to the clipboard, and then pasting this
bookmark to a shareable medium.

1. Onthe Bookmarks tab, right-click the bookmark to be removed and click '‘Copy to Clipboard.'

Bookmarks

21 Brand Logos (BrandLogos)

01 Export Configurations (stibo. EMConfigFolder)
'J Copy Writing St Edit Bookmark

i Apparel (18200

Rermove Bookmark

I Copy To Clipboard I

N

Paste the copied URL of the bookmark (using Ctrl + V on Windows).

File Edit Format View Help

step://collection?editor=NodeCollectionfiversionid=111511&contextid=Context1&id=1081008workspaceid=Main

The copied URL can be pasted in the URL Field of STEP Workbench, and the user can search the respective
objects.

|E’ 6 O JRL |step:Hmllecﬁun?editor=NudeCnllecﬁun&uersionid=111511&mntexﬁd=Cuntext1&id= @ ﬂ
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Menu Items

The STEP Workbench menu bar provides access to many aspects of STEP's functionality. Some of the options in
these menus are also available via a right-click menu accessible elsewhere in STEP. For instance, users may add
a product to a product family by selecting the product family, and then selecting Maintain > Insert > Product in the
menu bar, but they may also perform the same action by right-clicking on the product family in the Tree. However,
some options, like changing the view target, are only available in the menu bar dropdown menus. Each of the
menu bar sections are detailed on subsequent topics.

[ doc-dev - userj@https://doc-dev.stibo.com - STEPwerkbench

File Edit View MNavigate Format Maintain Window Help

« File— The File menu provides access to import and export actions as well as general STEP Workbench tasks,
such as running bulk updates, changing passwords, and emptying the Recycle Bin. For more information, see
the File Menu topic.

« Edit — In addition to administration actions like copying and pasting, the Edit menu also provides access to
tasks like spelling checks, managing assets, and editing unique keys. For more information, see the Edit Menu
topic.

« View — The View menu contains options that change how data is displayed in the workbench. For more
information, see the View Menu topic.

- Navigate — The Navigate menu contains searching options and the ability to find similar objects. For more
information, see the Navigate Menu topic.

« Format — The Format menu allows for setting styles such as bold or italics and inserting character tags. For
more information, see the Format Menu topic.

« Maintain — The actions available on the Maintain menu pertain to data maintenance at the object level. Data
such as LOVs and attribute values can be merged. Data can also be forcefully deleted, duplicated, or
approved. Links and new objects can be created in this menu. For more information, see the Maintain Menu
topic.

« Window — The Window menu provides actions for changing the presentation of the STEP Workbench. For
more information, see the Window Menu topic.

« Help — The primary function of this menu is to link users to the online documentation. For more information,
see Help Menu topic.
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The file menu contains actions that are related to maintaining the workbench from a performance level, such as
cleaning the recycle bin, purging old revisions, scheduling bulk updates, as well as defining imports and exports.

Translate
Import
Export

@: Reports
Bulk Update

Schedule Category Profiling

Business Module Manager

Change Password

Ermnpty Recycle Bin

& &

Empty Recycle Bin Before...

Purge old revisions

Check integrity of external assets...

Pre-generate Thumbnail Cache...

Close Window
Exit STEPworkbench

H Save Ctrl+Alt+5

Each of the options on the File menu are defined below.

Translate

The Translate menu allows users to translate products, classifications, and names of images and documents,
product values, index words, LOVs (List of Values), units, attribute names, free text cells in tables in the

workbench, and to import translations.
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File Edit View Mavigate Format Maintain Window Help

Translate : Data Objects...

Import ; Setup Objects...

Export ; Manual Excel Translation Export
@: Reports ﬁ Import Translation...

Bulk Update : Change Translation

By selecting 'Data Objects' or 'Setup Objects,' the Request Translation wizard will display. This process results
in the creation of a translation file that will include either data objects (objects that contain usable customer
data) or setup objects (objects that help organize the data objects). See the Structured XML Translation
topic for data object translations and Structured Translation for Setup Objects in the Translations
documentation for more information.

The 'Manual Excel Translation Export' is best used for a specific set of use cases, namely when there is not
much content to translate, the translator does not have access to STEP, or the objects to be translated are

setup objects. For more information on performing a manual Excel translation, see the Starting a Manual

Excel Translation Export topic in the Translations documentation.

The 'Import Translation' allows users to select an external translation file.
The 'Change Translation' allows users to change configurations.

For more information on the translate functionality, see the Translations documentation.

Import

The Import menu contains actions for bringing data into STEP.

File Edit View Mavigate Format Maintain Window Help

Translate >|
Import }fg  Data..
Export i eCl@ss ..
@: Reports ﬂ Images & Documents...
Bulk Update 3 ) ]
Business Rule from Editable Format
Schedule Category Profiling

The 'Data..." option loads the Import Manager. For more information, see the Import Manager topic in the
Data Exchange documentation.

The 'eCl@ss' option launches the ECLASS Classification import wizard.ECLASS is used to group materials,
products, and services. For information on how to best use ECLASS and its importer, see the ECLASS
Format topic and the ECLASS Classification Import topic in the Data Exchange documentation.

The 'Images & Documents...' option, while on a Tree node that contains assets (images and documents), will
load the Import Images and Document wizard. For more information, see the Import Images and Document
Wizard topic in the Digital Assets documentation.
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» The Business Rule from Editable Format allows users to manually import business rule definitions in the
editable format described in the Version Control System Integration documentation.

Export

The Export menu contains actions for getting data out of STEP for external management.

File Edit View Mavigate Format Maintain Window Help

Translate >
Import b
Export : @ Data...
Fid Reports “@ Schedule Data Export...
Bulk Update g Images & Documents...
Schedule Category Profiling Compare System Setup Exports...

« The'Data..." option loads the Export Manager. For more information, see the Export Manager topic of the
Data Exchange documentation.

« The'Schedule Data Export..." allows you to create a data export that executes at a specific time or repeatedly.
This option starts the Schedule Data Export wizard. For more information, see the Scheduling a Data
Export topic in the Data Exchange documentation.

« The'lmages & Documents..." option, while on a Tree node that contains assets (images and documents), loads
the Export Images and Document wizard. For more information, see the Export Images and Documents
Wizard topic in the Digital Assets documentation.

» The'Compare System Setup Exports' option enables you to migrate systems and allows users to determine
which items should not be added to the new system. This option will compare two STEP XML files that are
exported from two STEP systems, such as a production system being compared with a development system.

Reports

Selecting 'Reports' option will load the Reports wizard.
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Translate m Reports %
Import
T Steps Report Settings
@‘: Reports | ], Report Settings Report Group
Bulk Update 2, Parameters [Assets P
Schedule Category Profiling | =+ Advanced Settings Report Name
Assets Either Linked or Not Linked to Products in PIM

Assets Lists

Report Description

Back Mext Finish Cancel

For more information on the reports wizard, see the Reporter documentation.

Bulk Update

Bulk updates allow you to perform one or more actions on multiple objects at the same time.

File Edit View Mavigate Forrnat Maintain Window Help

Translate *
Import >
Export ]
# Reports
Bulk Update : %] RunBulk Update
Schedule Category Profiling Schedule Bulk Update
I

o The 'Run Bulk Update' option will start the Bulk Update wizard.
o The 'Schedule Bulk Update' option will allow users to create repeatable bulk updates.

For more information, see the Creating a Bulk Update topic and the Scheduling Bulk Updates for
Collections topicin the Bulk Updates documentation.

Schedule Category Profiling

Category profiles (also called data profiles) are used to take a snapshot of data that would be displayed in the
category profile tab. This snapshot does not update as new changes are made. With this action, the 'Schedule
Category Profiling' wizard will display and users may schedule the updates of existing profiles and the ability to
copy profiles as well. For more information, see Generating, Updating, and Scheduling a Data Profile topicin
the Data Profiling documentation.
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Business Module Manager

A business module is a functional configuration which handles use cases based on common practices observed in
the industry. The Business Module Manager allows an administrator to install a pre-configured data model for a
business purpose, such as the 'sell side' of the product enrichment process, or the 'buy side' for the vendor data
onboarding process. Business module installation can include the creation of product objects types, classification
objects, lists of values types, etc. The 'Business Module Manager' option displays on the File menu for all users.
The install functionality is available for users who are assigned the 'Install Business Modules' setup action
privilege.

[ 1 Business Module Manager >

W
W

Select  * [Business Module Installed Version Latest Available Version > »

Install Cancel

For more information, see the Business Module Manager topic in the System Setup / Super User Guide.

Save

While saving in STEP Workbench is automatic, the Save option allows users to force a save without leaving a
field.

Change Password

During any session, any user may change their own password. Enter your current password in the 'Old Password'
field, then enter the new password twice in the 'New Password' and 'Retype Password' parameters. Click 'Save'
to complete the update or 'Cancel’ to leave the password unchanged.

[ 1 Change Current User Password >
Old Password
Mew Password

Retype Password

Save Cancel
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Empty Recycle Bin
This action purges the 'Not In Use' objects in the Tree Recycle Bin. For more information, see the In Use and Not
In Use Objects section in the Approval of Objects topic of this guide.

Elﬁ Recyde Bin

-\ 12121

it | Ttem2

ﬁ Item3

- Itemd
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Select the 'Empty Recycle Bin' option to display the Confirm Purge dialog. The number of items that will be
removed is displayed. Click 'Purge' to permanently delete the items, or 'Cancel' to leave the Recycle Bin

unchanged.
B sae
Change Password
% Empty Recycle Bin [—j [ Cenfirm Purge >
E R le Bin Before...
@ mpty Recycle Bin ore Are you sure you want to permanently delete these objects:
Purge old revisions
Assets: 38
Classifications: 2
Entities: 36
Products: §

Skip Analysis Cancel

This action is also available via by right-clicking on the recycle bin.

1| RTINS

- Recyde

-9
-9

Search in recycle bin

Empty Recycle Bin

Empty Recycle Bin Before...
Approve Deletion Recursively

Empty Recycle Bin Before
This action allows users to purge the recycle bin of anything created before a specified date.
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[ 1 Empty Recycle Bin Options x

Only purge objects deleted before: [2020-12-01 11:10:41 ||,..

Cancel

This action is also available via right-clicking on the recycle bin.

S8 RMTIERANTETTL MU

-5 Recyde

Search in recycle bin

@ Ermpty Recycle Bin

@ Empty Recycle Bin Before...
Approve Deletion Recursively

Purge Old Revisions

This is a global purge of revisions contained within a specified workspace. A further description of this functionality
is available in the Revisions section of the System Setup / Super User Guide documentation.

Check integrity of external assets...

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself. This
can reduce the size of the database significantly, and for DTP tools depending on having the referenced high-
resolution images directly available on the file system, replication from DB to file system of these images can be
avoided.

This option is disabled by default. To enable it, follow the steps defined in the Initial Setup for an External File
Structure topic of the Digital Assets documentation.

The 'Check integrity of external assets...' option is enabled on systems set up to store images in a file system and
notin the STEP database. If a Classification is selected, the user can click this menu item to see if allimages in the
selected classification have been successfully migrated from the database to the file system.

The integrity of the file system for storing digital assets can be double-checked by selecting one or more
classifications and then select 'Check integrity of external assets' in the File menu. This starts a background
process reporting if any assets are missing or have been changed against expectations.

When errors are found, the assets with wrong or missing content are added to a collection and the URL of this
collection is referenced directly from the execution report of the background process.

A check of approximately 10,000 asset files on standard hardware can complete after one minute. Thus, expect
that the integrity check might take some time on systems with many assets.
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Pre-generate Thumbnail Cache...

This option will generate thumbnail cache of images and documents manually. This action allows any selected
image or images in a classification folder to display as thumbnails without having to wait for them to generate.

For example, on the Image and Documents tab of a classification folder, if the image thumbnails are delayed in
displaying, then Pre-generate Thumbnail Cache from File menu can be run to generate them in a background
process.

For more information, see the Image Cache Processing Plugin Parameters and Triggers topicin the
System Setup / Super User Guide documentation.

This option is disabled by default. To enable it, ask an authorized user (one with the Setup Action = Maintain
System) to perform the following steps.

Under 'System Setup' tab, navigate to 'Users & Groups.'
Select 'System Settings' tab.
Go to 'Image & Document Settings' flipper.

Set 'Pre-generate thumbnail cache on upload' = Yes. On upload of image or document, the thumbnail will be
generated automatically.

A owbd =

For more information, see the 'Pre-generate Thumbnail cache on upload' section of the Images and Documents
Settings topic in the System Setup / Super User Guide documentation.

Close Window
This option closes the active workbench window.

Exit STEPworkbench
This will exit the STEP Workbench completely by closing all active windows.
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Edit Menu

The Edit menu allows for typical text editing actions, asset editing actions, unique key editing, and spell check.

5 Undo Ctrl+Z

([ Redo Ctrl+Shift+Z

3 Cut Ctrl+ X

@ Copy Ctrl+C

Paste Ctrl+V

[E Paste and Match Style  Ctrl+Shift+V

2 Paste Link Ctrl+L
Select All Ctrl+ &
Spelling >
Asset ¥
Edit Unique Key Values
Remove Row(s) Ctrl+Minus
Insert Row Ctrl+Plus

Undo

This action reverses the last action of the user.

Redo
Once an action is undone by selecting 'Undo’, a user can then select 'Redo' to repeat the action.

Cut

Standard 'cut’ operation to remove the selected characters.

Copy

Standard 'copy' operation to duplicate the selected characters.
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Paste
Standard 'paste’ operation to insert the copied characters at the selected point.

Paste and Match Style

Once something is copied or cut, this will paste with STEP styles associated with the copied / cut text. For more
information, see the Style tag section of the Tags topic of the System Setup / Super User Guide
documentation.

Paste Link

Allows the copied object to be linked into another object (e.g., linking an attribute into a second attribute group).
Creates a new instance of the same object (not a copy), just in a different location.

For example, if a user has an image for a product line that will live under multiple parents, the Paste Link action can
be used. The user selects the asset, and then selects another location that will serve as a parent object. The paste
link option can be used to create a link, giving this object two parents. This action will not work on products as
products can only have one parent.

Some considerations with this action are:

« an attribute must exist in at least one attribute group,
« ifthe data must be shown in the Web Ul, then an attribute for display purposes should be created

Select All

Standard 'select all' operation to mark all visible objects for another action, like copying or deleting.

Spelling

Allows a user to check the spelling of available text.

Automatic Spell Check
Asset Spell Check

Edit Unique Key Values
. z Mo Suggestions

When the 'Automatic Spell Check' option is selected, as users type, incorrectly spelled words are displayed in red
text.
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Mame * | > |Value >
* Family Description abe [This itmesis avalable in multi coolors
* Brand Name abe Hanes
* Product Name abe Hanes Beefy-T Short-Sleve T-Shirt

If the 'Automatic Spell Check' is disabled, then selecting the 'Spell Check' action while in a field checks that field's
spelling. If a user selects one of the incorrectly spelled words and navigates back to the Spelling menu, STEP will
offer possible spelling corrections.

Asset ; Spell Check

Edit Unique Key Values . Mame >| > |Value *
SoElen= * Family Description  |abe [This iimesis svalable in multi coolors

Remowve Row(s) Ctrl+Minus avalanche * Brand Mame abe Hanes

Insert Row Ctrl+Plus E"Jﬂilﬂhhl' »* Product Mame H: Hanes BEEFY—T Short-Sleve T-Shirt
zalable
aszailable

Asset

When an asset is selected in Tree, the 'Asset' menu shows various options to manage and change assets.

D e
Edit Unique Key Values External Viewer
) Replace Asset Content

Remove Row(s) Ctrl+Minus

Create Local Content of Aszet
Inzert Row Ctrl+Plus

Update System Properties

Delete Local Content of Asset

« The'Edit Asset' action will open the asset in the program that is associated with the selected file type, like
Adobe Acrobat for PDFs.

« The 'External Viewer' will open the asset in a program on the user's local computer.
« The 'Replace Asset Content' action will allow users to replace the asset with local assets.
« The 'Create Local Content of Asset' option initiates an asset push and downloads the asset.

« The'Update System Properties' action refreshes the asset's system properties in the 'Images & Documents'
tab of the asset.
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« After selecting the 'Create Local Content of Asset' action, the 'Delete Local Content of Asset' option is enabled
and allows a user to delete that downloaded asset.

Edit Unique Key Values

Unique Keys provide a special way of designating objects for identification outside of STEP. Selecting the 'Edit
Unique Key Values' action on an object with active unique keys will display the 'Edit Unique Key Values' dialog,
allowing users to edit any unique key related attributes on the object.

[ 1 Edit Unique Key Values e
Attributes
Mame » [ » [Walue >

* Receiver Product TM abe 561247451231

* GTIN Gi4

» Receiver Product GLM GLH

» Supplier Part Mo. 12a PA1-23211

coc

If there are no active unique keys for the selected object, then the following message displays.

[ 1 Edit Unique Key Values >

Mo unigue key attributes to edit

For more information, see the Unique Keys topic of the System Setup / Super User Guide documentation.

Remove / Insert / Add Options

At the bottom of the Edit menu are two options that will change based on the selected node or current view. The
following are a sampling of what may appear:

On attribute references

Remove Attribute Group  Ctrl+Minus
Add Attribute Group Ctrl+Plus

On the sub-products tab of a Product object
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Remove Row(s) Ctrl+Minus

Add Product Ctrl+Plus

On Lookup tables

Remove Row(s) Ctrl+Minus

Add Row Ctrl+Plus

The options will allow users to add or remove to the selected node as desired.
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View Menu

The View Menu's purpose is to change the way a user views objects in the STEP system. In this menu, users may
change the viewable workspace, context, and mode, add a filter, change the primary hierarchy, and other options
to customize the view to their needs.

Made >
Context »
Workspace >
Source >
Filter »
Prirnary Hierarchy >
Select version >
Mew View

Remove view >
Product views >

Show Source Context
Rotate Table

' Reload F5
Collapse Tree

Disable calculated values

Default Font Size

Choose User Display Sequence Attribute

Teggle Show Hidden Background Process Ternplates

Default Context ¥
Logs ¥
Mode

The 'Mode' sub-menu includes options that allows the user to view STEP data in a variety of ways, dependent on
the need. These options are mirrored on the toolbar. For more information, see the Toolbar topic in this
documentation.
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File View Mavigate Format Maintain Window Help

Mode ) 6 o
Context : )

Translation
Workspace

Workspace
Source Context
Filter ; Revision
Prirnary Hierarchy : Update

o Normal mode is the view where the majority of object maintenance occurs. From the toolbar, it is represented

with the E icon.
« Translation mode shows the split view of the different contexts for objects. To use the Translation mode,

select a Source context from the View menu. From the toolbar, it is the icon. Online Translation can be
done from this Translation Tab. Fields highlighted in green color can be translated within STEP from this
Translation Mode. For more information on translating data into other languages, see the Translations
documentation.

o Workspace mode shows a comparison of values between Main and Approved workspaces. From the toolbar,

itis the ﬂ icon. For more information on workspaces, see the Workspaces topic in the System Setup /
Super User Guide documentation.

« Context mode shows a comparison of values between different contexts. From the toolbar, it is the E icon.
For example, this will allow a user to view values for all languages or for all price versions. For more information
on contexts, see the Contexts topic in the System Setup / Super User Guide documentation.

« Revision shows a comparison of values between different revisions. From the toolbar, it is the - icon. If you
have selected any object in STEP, then switched to the revision view, it will show a comparison screen of the
two latest revisions. The latest revision is displayed in the first column and the older revision is displayed next.
These revisions are also listed under the Status tab in a product editor. For more information on managing
revisions, see the Revisions topic of the System Setup / Super User Guide documentation.

« Update shows a comparison between objects across workspaces (Approved and Main) and allows the user to
update the object in the current workspace from a source workspace.

Context

When an object is selected, 'Context' displays all available contexts in a dropdown. By selecting one of these
contexts, the viewed context for the current object and all other objects, is changed to the selected context.

Workspace
View i Byvigate Format Maintain Window Help
Mode >
Context >
gWurtspace P Main
— Approved
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Workspace shows all available workspaces. It is possible to change the viewed workspace and view objects as
they appear in different workspaces. In this example, there are only two workspaces: Main and Approved.
However, more can be added as desired. For more information on setting up and using workspaces, see the
Workspaces topic in the System Setup / Super User Guide documentation.

In the toolbar next to the context selector, a toggle icon (') allows you to switch between the Main and Approved
workspaces.

Target / Source

The 'Target' and 'Source' sub-menu allows users to choose alternative dimensions to show in the Context mode.
Depending on the view chosen, this function label changes from target to source.

« Inthe Translation view, this allows the user to select the source language.

Source > v UK English
All Languages
German
English
Danish

Hebrew

Spanish

« Inthe Workspace view mode, this allows the user to select the target workspace.

Target * ~  Approved

« Inthe Context view mode, this allows the user to select a single target as context or multiple contexts to

compare the content.
Target > v Danish DK
~  French Belgium
English LK
English US
French FR

Germany German
Global

|srael Hebrew

Other
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« Inthe Revision view mode, this allows the user to select a past revision(s), provided there is a recorded
change in STEP. If the revisions are older than the current session, the 'Other' option will display a window to
select necessary revision for comparison. When the Revision view is selected, the selected object will show
the current version and the immediately previous version. By using target, users may select specific revisions
for comparison.

Target * ~ 049 last edited by USER) on ThuJun 01 15:4%:09 EDT 2017
0.48 last edited by USERJ on Thu Jun 01 13:4%:08 EDT 2017
0.47 last edited by USERJ on Thu Jun 01 13:47:33 EDT 2017

Cther

« Inthe Update view mode, this allows the user to select the source workspace.

‘ Source * ~  MApproved

Filter
File View Mavigate Format Maintain Window Help
Mode ] v | 6
w Workspace ]
w
I
= Target
= .
5 Filter Hide Empty Values
i Primary Hierarchy Show Mandatory Attributes Only
o Select version Show Editable Attributes Only
D ) Show Legal Attributes Only
e Mew View

Select a view to filter out empty attribute values, show only mandatory attributes, show only editable attributes,
and/or show only legal attributes.

Primary Hierarchy

An object may be located in multiple hierarchies. When locating objects, there may be a reason that a user wants
the object's path to specify one of those hierarchies instead of all the applicable hierarchies. Changing this view
can be done by switching the primary hierarchy view used for workbench. This path is displayed in the object
details within workbench, but the path is also used when navigating to an object via a search results set.

For example, object 12345 is in a supplier hierarchy and a primary product hierarchy. When doing a search for
object 12345, upon clicking the 12345 link in the search results, User A wants the object to be displayed in the Tree
within the primary product hierarchy. User B wants to click on the 12345 link and be taken to the object within the
suppliers hierarchy. Both scenarios can be accommodated when each user sets their own view.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 72



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

iew Mavigate Forrnat Maintain Window Help

] Mode - v | e
Context
oh Workspace ¥ [m [mﬁ
"[ Target ? }im
Filter >| > |Value
g Prirnary Hierarchy Prirnary Product Hierarchy
E Select version Configurations

An objects' path can be changed based on the selected primary hierarchy. To change the display view, select
Primary Hierarchy from the View menu, and then select the desired hierarchy. For many, the Primary Product
Hierarchy will be the default selection.

In the below example, Object 0726222 is a product object type being viewed in the Primary Product Hierarchy.
This path echos the location of the object in the Tree tab.

rEIE Primary Product Hierarchy
E]|__=| Products
r_=| Apparel
r_=| Footwear
-7 Safety
E|r_=| Hardware
E E}Fj Tools
E|r_=| Task Lighting
=+ [I) Flashlights
=I-Jjiji Flashlights Items

» Path Primary Product Hierarchy Products/HardwareTools/Task Lighting /Flashlights Flashlights Ttems/0726277 ie—

Examples of how objects will be displayed can be seen with the Merchandising Hierarchy selection. Notice the
changed path and the object's location in the Tree tab.

-Li—_ITE Merchandising Hierarchy
(-] Apparel
rj Automotive
|'_=| Beverages
E}Fj Footwear
E|r_=| Women's Footwear
E}Fj Dress Shoes
[+-[I5) Stuart Weitzman Hispot

» Path Classification 1 rootMerchandising Hierarchy Footwear Women's Footwear [Dress Shoes 0726227 js—
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Select Version

Allows the user to set the default publication or version used for proofing.

New View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used.

Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in
Tree topic. A view allows a user to customize the attributes shown for more than one object, instead of displaying
all attributes for all selected objects.

Remove View

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used.
Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in
Tree topic. A view that is no longer needed can be remove with this menu option.

Product Views

Select multiple products from Tree to enable this option and display a multi-editor tab where a view can be used.
Views are not valid with non-product object types. Multi-Editors and views are defined in the Editing Objects in
Tree topic. The Product Views option displays all saved views.

Show Source Context

Attribute names may be translated. This option allows a user to view attribute values in both a foreign language
and in the source language.

Rotate Table

This will flip the selected table so that the columns become rows and vice versa. This is most often used in a multi-
product editor.

Reload

Retrieves updated information from the database including other users’ changes.

Collapse Tree
Collapses the folders in the Tree navigator.

Disable calculated values
Disables the automatic calculation of calculated attributes. This will make the STEP interface load faster.

If Disable calculated attributes is checked, calculated attributes can be rendered one-by-one by clicking the
Calculate button on a calculated parameter in the product editor.

= |CalculatedPrice B [Calu:ulate]
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Default Font Size

Allows the user to change GUI font.

Choose User Display Sequence Attribute
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Allows the user to select a user-specific Display Sequence Attribute. This option is different from the Attribute set
under Users & Groups in System Setup. For more information on using Display Sequence Attributes, see Display
Sequence Attribute topicin the System Setup / Super User Guide documentation.

IUser Display Sequence Attribute

[1 Select User Display Sequence Attribute

The system default display sequence attribute: DisplaySequence

DisplaySequence

Toggle Show Hidden Background Process Template
Once selected, any previously hidden Background Process Template will display.

Default Context

AttributeCompletenessScore
Completeness Score

PrintDisplaySequence
SmartsheetMandatory
TableSortOrder
VariantPriority

Sets the default context used when logging in.

Logs

Displays Workspace and System Setup logs.
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Navigate Menu

The Navigate menu offers options for moving around the workbench.

@ Search Ctrl+F
Search Below

Goto Ctrl+G
Goto Mext Ctrl+E

Back

4 A =

Forward

Bookmarks »

Find Similar Product

Search

The 'Search’ action accesses the 'Search’ tab, which displays along the left side of the workbench window. Using
the search functionality, users may perform a search of all of STEP objects. For more information on searching
within STEP, see the Navigating and Searching topic in this guide.

Search Below

Only after selecting an object will the 'Search Below' action become selectable. Once this option is selected, the
'Search' tab will perform populate with a 'Search Below' for that object. Click the Search button to perform this

query.

1

g v Reset Search
Show Details

| Mame

Goto

A quick way to jump to a particular object in the database based on the name, ID, or Unique Key value. A
dropdown displays multiple hits and allows the user to select the desired object.
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Goto | ID/Name - | T-5hirts

[ T-shirts (18202)

[l T-shirts Items (18203)

[T T-5hirts Sales Ttems (18205)
[ T-shirts (18208)

[ T-shirts (18454)

= T-shirts (253589)

Goto Next
When there are multiple 'Goto’ results (or typeahead results) from the 'Goto' function, the user can opt to select
'Goto Next' to continue on to the next hit/ result.

As seen with multiple items meeting the criteria for a Goto action, the 'Goto Next' action will cycle to the next object
in that list. This list is ordered by STEP IDs.

Goto Next will be disabled if the previous Goto command has not been used.

Back / Forward

The 'Back' and 'Forward' actions will function the same as most web browsers. 'Back’ allows userstogotoa
previously visited screen, and 'Forward' returns to the screen from which a user went back.

Bookmarks

The Bookmarks sub-menu allows a user to bookmark the currently displayed object or create and name a search
based on the selected object.

0% AddBookmark Ctrl+D
@ Add Search Bookrmark

()

Bookmarks

Find Similar Product

&g  T-shirts (13206)

Find Similar Product

The Find Similar Product option populates a search based on the attributes and its values of the selected product.
When this option is selected, a window will appear prompting the user to check off common attributes to search
for.

Important: Attribute values from calculated attributes and inherited attribute values are not searched
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[ Please Select Attributes >

[] Acreage Mame and Length

[] annual Sales Forecast, Maximum
[ ] annual Sales Forecast, Minimum
[] calculatedAttribute1

[ ] Category

[] child Count

[ ] Dimensions o

When the attributes are selected, click the 'Select' button, and the user is redirected to Search Tab, which is
populated with the Object type and selected attributes with its values.

[DbjectType = Product

|-Search: (BrandMame) = Hanes

[Searm: (BrandOwner) = HanesBrands

E Reset | Search |
Show Detailz

| Name 5]

After clicking the 'Search' button, the selected product(s) which match the search criteria are displayed.
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[ 5\
Object Type = Product Search Result Profiling
.
[Searm: (BrandMame) = Hanes 1 hit(s)
[Search Click links to narrow down search
[SEﬂr::h: (BrandOwner) = HanesBrands
E " Resst | sewch || ResultsbyObjectType
Displaying 1 of 1results Show Details Product {1} - exclude
Mame >

Il ltem Family (1) - =xclude

Results by Parent

[C]Products (3} - sxclude
Il T-shirs ltems (1) - exclude
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Format Menu

The Format menu contains items for stylizing and transforming text in the workbench.

Style »

Clear All Styles

Character Tag r
W Insert Special Character Ctrl+Shift+E

Style

This option allows setting either bold or italics. Users may create their own styles, which will show in this menu.

Forrat Maintain Window Help
Style l;B Bold
Clear All Styles £ ltalic
Style i BodyRowStyle
bold
Bold_C
BoldHeader
bolditalic

Character Tag
¥ Insert Special Character Ctrl+5Shift+E

BottomLeftCorner
BottomRightCorner
bullet

Cther Ctrl+Y

Users can apply style formatting to selected strings of text such as bold, italics, or custom style tags. The
secondary 'Style' menu contains a list of additional styles. Selecting any will change the selected text. To add more
styles to the list of options, see the Tags topic in the System Setup / Super User Guide documentation.

Selecting 'Other’ from the extended Style menu displays a bank of all the custom styles in the STEP system.
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Character Tag
%, Insert Special Character Ctrl+Shift+E

é [ Style b4

[ ] BodyRowStyle ”
[Jbold

[ ]Bold_c

[ ] BoldHeader

] bolditalic

[ ] Boldred

[ ] BottomLeftCorner

[ ] BottomRightCorner o

ok || cancel |

B Bold Ctrl+B

[T1STIBOSYSTEMS
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bold

BodyRowStyle
Bold_C

BoldHeader
bolditalic

BoldRed
BottomLeftCorner
BottomRightCorner

3 Other

Ctrl+Y

In this example, bullets are applied to the Long Description field. The word 'flash' is bold.

> Long Item Description |abe

Red carpet worthy pumps in scarlet suede is sure to turn heads. Metal disk details on the size will sparkle when the cameraﬁlﬂnsll.l
See product variations for other color offerings.|

Clear All Styles

This action clears all applied styles on the selected text.

Character Tag

The 'Character Tag' action allows for the insertion of custom-made character tags.
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i

Style
Clear All Styles

Character Tag

Insert Special Character Ctrl+5hift+E

T ISTIBOSYSTEMS

LineBreak
MoVersionPageMo
Emspace

ft

gt
It
multisep

phone

Cther Ctrl+R

e MASTER DATA MANAGEMENT

To learn more about editing character tags, see the Tags topic in the System Setup / Super User Guide
documentation. In the example below, a phone character tag is used, followed by a line break, and then a multi-
item separator.

» Long Item Description

F-]
abe:

Selecting 'Other' from the character tag menu displays a bank of all the character tags in the STEP system.

£

Clear All Styles

Character T.=.|\|;;|'9I

Insert Special Character Ctrl+5Shift+E

e [ 1 Insert Character Tag

EMSpace
EM Space
ft
gt

Discretionary Hyphen
Discretionary Linebreak
EM Space

pod

Cancel

LineBreak
MoVersionPageMo

emspace
ft

multisep

phone

e Other Ctrl+R
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This is an embedded character map. It shows the most recently used characters and offers a complete Unicode

character range.

Format

L5

Style

Clear All Styles

Character Tag
Insert Special Character Ctrl+5Shift+E
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Selecting the 'Insert Special Character' option displays a pop-up of the most recently used symbols.

| > '_ung Item Description

el ¢ |s

Other...

Enter

Selecting the 'Other..." option on this pop-up will generate another dialog that allows for selecting all of the special
characters, as well as changing the character set to choose from.

[ Insert Special Character

Most Recently Used Symbaols

@|£]%|

Pt

% &l Spedal Characters

IUnicode Character Block: |Basic Latin

Pt # % | & | '
Cl) | *|+ - /
0, 1 2|3 5,617
89 ; =|>|7?
@| A|B|C E F |G .
Insert Cancel
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Maintain Menu

Maintain menu provides the user to maintain STEP data by inserting, linking, merging, deleting, approving and
others. Some options, such as Customer MDM Monitoring and User Anonymizer, are only available if the
functionality is activated via a license and/or add-on component. Many options have additional options and are
explained below:

Insert -]

Link ]

Merge ]
> Delete

Force Delete & Purge
Unlink Object Type

Duplicate Ctrl+]

i i

Duplicate Recursively
Make Revision

Approval ]

Enable group for workflows

Revive

Revive Recursively
Truncate log...

CMDM Monitoring >
User Ancnymizer

Insert

The 'Insert' action allows the user to create an object based on the currently selected object. The options are
disabled based on the selection.
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Insert
Link
Merge

¥ Delete

Unlink Object Type

Duplicate

i i

Make Revision

Approval

Revive

Revive Recursively

Force Delete & Purge

Duplicate Recursively

Enable group for workflows

LW

BEEESRRc-EISR0O0LBS

Product
Clazsification
Clazsification Root
Mew Entity Mode
Entity Root

Mew Publication...

Mew Publication Group

Mew Publication Section...

Mew Page Template ...
Orphan Attribute
HAsset

Attribute

Attribute Group

List of Values
Dirnension
Dimension Point

Action 5et

Ctrl+5hift+P
Ctrl+5hift+C
Ctrl+5hift+R

Ctrl+Shift+0
Ctrl+Shift+A
Ctrl+Shift+T
Ctrl+Shift+]

Ctrl+Shift+L
Ctrl+5Shift+D
Ctrl+Shift+ M
Ctrl+5Shift+5

1STIBOSYSTEMS
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Truncate log... Mew Image Conversion Configuration...

Create Transformation Lookup Table

=,

Mew Event Queue

Mew AssetPush Event Queue

MNew AssetPush Configuration

STEP Workflow Ctrl+Shift+R
Background Process to Monitor Deadlines  Ctrl+ Shift+D

User
Group Ctrl+Shift+G
Mew Supplier

Create Package
Create STEP Workflow

Mew Business Condition

Ctrl+5hift+R

Mew Business Action
Mew Business Function

Mew Business Library

BREZLGE ke BE

Setup Group Root...

The following options are available in the Insert sub-menu:

« Product - If the user is within the primary product hierarchy, this option will create a new product beneath the
selected hierarchy.

« Classification — If the user selected a classification hierarchy, this option allows creation of a new
classification folder beneath the selected classification with the predefined classification object types.
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Classification Root — If the user would like to have a classification root to store images or configurations or to
link products in the classifications folder, this option creates a classification root with a set of predefined
classification root object types that are listed.

New Entity Node — If the user selected an entity root, this option will create a new entity object based on one
of the predefined entity types.

Entity Root — A new 'Entity Root' can be created in the tree hierarchy from predefined set of entity root object
types.

New Publication... — Allows the user to create a new publication. If the user has already selected a publication
hierarchy, then when this option is chosen, 'Create Publication' dialog will displayed with default object type
selected. The user must provide a name of the publication and 'Page Template,' 'Product Template,' and
'Publication Template' to create a new publication.

New Publication Group — Allows the user to create a new publication group within the selected publication
group. If a publication group is selected, once this option is chosen, ‘Create Publication Group’ dialog will
display with the predefined set of object type.

New Publication Section... — The user will get a wizard to create '"New Publication Section.' When selecting
this option, the 'New Section' dialog will display. Complete the Section Name and select the Page Template
from the dropdown list.

New Page Template... — Allows the user to create a new page template. After selecting a 'Publication Group,'
this option will display a wizard Create New Page Template in STEP.

Orphan Attribute — This allows the user to add an attribute as an orphan attribute to a product by searching or
browsing from System Setup tab. For information, see the Linking Orphan Attributes topic in the System
Setup / Super User Guide documentation.

Asset — Allows the user to create placeholder with ID and name for a new asset on the selected classification
folder. The user may choose an asset object type from the Create Asset dialog, then asset content can be
added.

Attribute — Allows the user to create a new attribute in the selected attribute group in System Setup.
Attribute Group — Allows the user to create a new attribute group in System Setup.

List of Values — Allows a user to create new list of values under Lists of Values Group / LOVs in System
Setup. User will be allowed to key in ID and Name in the Create LOV dialog.

Dimension — This option will create a new dimension. A user must select the 'Contexts' node in the System
Setup for this option to be available. For more information on dimensions, see the Dimensions and
Dimension Points topic in the System Setup / Super User Guide documentation.

Dimension Point — Allows the user to create new dimension point. A user has to select a dimension under
System Setup > Contexts > Dimension (for example 'Language'). The label of this option changes dynamically
based on the selection of dimension, so the option ‘Dimension Point’ is never displayed. For example, if the
user has chosen 'Language' as Dimension, this option will be labeled as 'New Language'.

Action Set — This option creates a new setup or user action. A 'Create Action Set' dialog displays with ID and
Name to be filled when user selects the option Action Set. Creating a setup or user action is based on which
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node is selected in System Setup. For more information on action sets, see the Maintaining Action Sets
topicin the System Setup / Super User Guide documentation.

New Image Conversion Configuration... — A wizard will display to create new image conversion
configuration and save it for reuse in the selected classification folder. For more information on image
conversions, see the Image Conversion Configuration topic in the Digital Assets documentation.

Create Transformation Lookup Table — Allows the user to create a transformation lookup table under the
selected classification. For more information, see the Transformation Lookup Tables topic in the Resource
Materials online help.

New Event Queue — The user can create a new event queue in System Setup. For more information, see the
Creating a New Event Queue topicin the System Setup / Super User Guide documentation.

New Asset Push Event Queue — The user can create a new asset push event queue in System Setup and it
will create a new event queue. The event queue can have any number of asset push configurations running
from it. For more on assets push events, see the Creating and Maintaining Asset Push Event Queues
topicin the Digital Assets documentation.

New Asset Push Configurations — A new asset push configuration will be created under the selected Asset
Push Event Queue. For more on assets push configurations, see the Creating and Maintaining Asset Push
Configurations topic in the Digital Assets documentation.

STEP Workflow — This will create a new workflow under System Setup > Workflows when the user first
selects "Workflows' in 'System Setup'. The STEP Workflow designer window will display. It is also possible to
create a workflow by right-clicking on the "Workflows' folder. For more information on workflows, see the
Workflows documentation.

Background Process to Monitor Deadlines — \When first selecting the System Setup > Workflows node,
this option starts a background process for checking STEP Workflow items that have exceeded their
deadlines.

User — Users are created by first selecting System Setup > Users & Groups > Group where the user will
belong. When a user selects a Group and select this option, the 'Enter New User' dialog displays. For more
information on users in STEP, see the Working with Users topicin the System Setup / Super User Guide
documentation.

Group - Groups are created by first selecting System Setup > Users & Groups > and selecting the necessary
node to hold the group. For more information on groups in STEP, see the Working with User Groups topicin
the System Setup / Super User Guide documentation.

New Supplier — Supplier users are created in System Setup > Supplier Group. A new supplier can be created
by first selecting the supplier group.

Create Package — Creates a package by first selecting System Setup > Change Package. After the user has
selected the change package option, a 'Create Change Package' dialog displays. Enter an ID and Name of the
Package. For more information on packages, see the Change Packages topic in the Configuration
Management documentation.

New Business Condition — Creates a new business condition under Global Business Rules in System

Setup. Business Conditions can also be created under Workflows in System Setup. For more information on
business conditions, see the Business Conditions topic in the Business Rules documentation.

New Business Action — Creates a new business action in System Setup under Global Business Rules.
Business action can also be created under Workflows in System Setup. For more information on business
actions, see the Business Actions topic in the Business Rules documentation.
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« New Business Library — Creates a new business library in System Setup under Global Business Rules.
Business libraries can also be created under Workflows in System Setup. For more information on business
libraries, see the Business Libraries topic in the Business Rules documentation.

o Setup Group Root... — Creates a new setup group root under System Setup. When the user selects this
option, the 'Create Setup Group Root' dialog displays with set of object types. The user may create a new
setup group root based on the object the object type selected.

Link
The 'Link' action provides a list of object or reference types for linkable actions. This menu will only show the
relevant options as active if it is possible on the selected object.

Insert »
Link : Product Ctrl+5hift+
Merge ; HAsset Ctrl+5Shift+F
Attribute to Classification  Ctrl+ Shift+Y
> Delete
Product to Classification  Ctrl+5hift+H
Force Delete & Purge
] ] Attribute to Product Ctrl+Shift+E
Linlink Cthiect Tune

Based on the source object there are different link options available with keyboard shortcuts shown in the above
screenshot.

« When a user selects a product hierarchy and clicks on Link > Product, the product is linked to the selected
product via a product reference type dropdown.

« When a user selects a product hierarchy and clicks on Link > Asset, the asset is linked to the selected product
via an asset reference type dropdown.

« When a user selects an attribute, it can be linked to classifications.
o When a user selects a classification, it can be linked to products.
o When a user selects an attribute, it can be linked to products.

For more information on linking your attributes to products, see the Creating a Product Attribute Link topicin
the System Setup / Super User Guide documentation.

Merge

Depending on the selected object, the user can merge attributes, LOVs, and LOV values. For more information,
see the Merging Attribute Values topic, the Merging Values in an LOV topic, or the Merging LOV Values in
Bulk topic in the System Setup / Super User Guide documentation.

Merge : Attribute Values
LOVs
¥ Delete
Values in LOV
Force Nelete & Purne
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Delete

In STEP, the 'Delete' action sends items to the Tree Recycle Bin. If the selected item for deletion contains child
objects, the user will receive a warning that these items will also be deleted. For more information, see the
Recycle Bin for Tree topic of this guide.

Force Delete and Purge

If an object is selected in the workbench, and 'Force Delete and Purge' is clicked, the Confirm Force Delete and
Purge dialog is displayed. Click the 'Force Delete and Purge' button to permanently delete the object and purge it
from the recycle bin without any further opportunity to cancel.

[ Confirm Force Delete and Purge *

After force delete and purge you cannot revive these objects again.
Force deleting and purging an object will NOT cause an Approve Deletion event,
Are you sure you want to permanently force delete and purge these objects:

Products: 1

Force Delete and Purge Skip Analysis

Unlink Object Type

When in System Setup, this option allows a user with the appropriate privileges to unlink the selected object type
from its parent.

Duplicate

This standard 'duplicate’ operation essentially copies and pastes in one click. Users may also right-click while
selecting multiple objects and duplicate each of them. A prompt will request a new ID when an auto ID is not set,
then automatically provides a different name. The user is also allowed to indicate if duplicate references should be
created.

Duplicate Recursively

A hierarchy can be duplicated when the user selects the top node in the hierarchy and clicks 'Duplicate
Recursively.' The ID should be editable for duplicate recursively.

In the below example, the ID is auto generated so the duplicate recursively background process will ultimately give
an error.
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Make Revision

MName »| * |value
> ID TconRoot
*> Mame Icons ] ]
[ ] Duplicate Recursively et
* Dbject Type Icons
> Revision 0.1 Last @ ID 214032 |
> oved
Appr v Arg Mew Mame |.ﬁ.]arm—13{2}| |
» Translation Mot Tral
s Path Classifid Duplicate references
» Wisibili
Isibiity Start Process with Description
s P be Storage
e — = Mame |Dup|iu:3te Alarm-13(2) |
» Catalog Group Theme abi
(o] o

Allows a user to force a revision on a product and provide a comment for explanation.

Approval

The approval options allow objects to be moved to the Approved workspace.

Approve Object
Partial Approve...
Check Approve
Approve Deletion

Approve Recursively

Ctrl+5hift+ ]

« Approve Object — Approves an object from the Main workspace to the Approved workspace and changes
the red X ( X ) to either a green checkmark (4§ ) or a yellow one ( 4 ). See the Approval of Objects section

of this guide for more information.

» Partial Approval — Approve selected parts of the unapproved changes on the selected object.

o Check Approve —The 'Check Approve' action allows the user to see if anything is barring successful
approval of an object. In the example below, mandatory values are missing.
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[ Unable te approve product >

Approve report for 18217-012
Unable to approve object due to missing mandatory values on attribute(s):
Brand Owwner

QK

« Approve Deletion — For an approved object to be removed from the Recycle Bin, the object must be
Approve Deleted. If a previously approved object is deleted, in the Recycle Bin it will have ared '(in Use)'
header:

20709 rev.0.9 Deleted (in Use)

Performing an Approve Deletion changes the header to 'Not in Use' and allows the object to be deleted.

20709 rev.0.9 Deleted (Not in Use)

For more information, see the In Use and Not In Use Objects section in the Approval of Objects topic of
this guide.

« Approve Recursively — Launches a workflow process that will approve the currently selected object and all
of its children.

Enable Group for Workflows

This is a disabled legacy option.

Revive

Revives a deleted object, either 'In Use' or 'Not In Use', from the Recycle Bin. For more information, see the In
Use and Not In Use Objects section in the Approval of Objects topic of this guide.

Revive Recursively

Revives a deleted object as well as all of its children, either in use or not in use, from the Recycle Bin. For more
information, see the In Use and Not In Use Objects section in the Approval of Objects topic of this guide.

Truncate Log

Once selecting an Event Queue or Asset Push Queue, this option will reduce the log to the most recent entries.
For more information, see the Event Queues topic of the System Setup / Super User Guide documentation.
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Customer MDM Monitoring

Selecting the 'Start background process for monitoring Customer Data Policies' option under Customer MDM
Monitoring will manually initiate any of the active data policies in the system. For more information, see the Data
Policies topicin the Data Governance documentation.

User Anonymizer

This option is available to admin users and is used to anonymize a deleted user within the object change logs,
revision logs, and workflow status logs. For more information, see the User Anonymizer topic in the System
Setup / Super User Guide documentation.
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Window Menu

The Window menu offers actions around the STEP Workbench window.

Mew PIM Window Ctrl+MN

Goto Window

D Goto Dashboard

Loom Window

New PIM Window
This action will create a new instance of the STEP Workbench.

Goto Window
This is a legacy option and no longer functions.

Goto Dashboard
This option will display the STEP Workbench dashboard.
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Hew ltem Creation by State Average Time in State Ohject Type Count

STEP Workflow profile is unavailable

STEP Workflow profile is unavailable

Profile generated Tue Jan 26 2016
15:03 in context ‘English US', workspace
‘Main’

W tam {79
M Sales Item {S9)
Itamm Foldar {25)

| _Fexmt | Average Object Completeness

Profile generated Tue Jan 26 2016
15403 in context ‘English US', workspace
‘Main’

W Yas {(8)
- 1)

No data available for context 'English
uUs’, workspace 'Main’, completeness
metric with ID ‘Completeness Metric B

M Lawved 3 {23)
B Lawved Z {Z1)
O chgant typas (105)
Translation Status

Profile generated Tue Jan 26 2016
15203 in context ‘English US', workspace
‘Main"

M Mot Transkated {222)

Humber of kems in Workflow State

STEP Workflow profile is unavailable

Zoom Window

This action will center the STEP Workbench on your primary display.
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Help Menu

The Help Menu has two options: 'Help' and 'About STEP".

&7 Help F1

57 About STEP

Help

The 'Help' option opens the STEP documentation in your default web browser.

If configured to authenticate, you will be prompted to enter a STEP username and password before online help is

displayed. To enable this functionality, the property
OnlineHelp.Documentation.Authentication.Enabled=true must be added it to the sharedconfig.properties

file. Authentication is disabled by default.

Please provide login credentials

Username*:

Password* :

¥ o o ) —

=]

“fou are here: Welcome fo Online Help

Welcome to Online Help

When you are done with online help, you should click the Logout button located on the far right of the online help
toolbar. Upon logging out, you will be taken back to the documentation login screen.
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If authentication is disabled, the Logout button will still display. In this scenario, clicking on the button will take you
to the STEP Online Help welcome page.

About STEP
The 'About STEP' option displays the workbench introductory window.
[1 About STEPworkbench =4
D MASTER DATA MANAGEMENT
Copyright ® Stibo Systems: All trademarks, service marks, and
logos appearing are proprietary to Stibo Systems or its licensors.
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Object Editor

When an object is selected from the left panel in STEP (e.g., Tree tab, System Setup tab, etc.), the right panel
displays details on the first tab for the selected object. The left panel can be hidden or displayed by clicking the hide

(E4) and show () toggle buttons.

The kind and number of tabs will vary depending on the selected object. However, all objects will have at least an
ID, Name, Object Type, Revision, Approved, Translation, and Path. These fields are called 'aspects.’

18207-012 rev.0.2 - Product
Commercial | Tables || Category Profile | Status || State Log || Tasks
Product [ Sub Products " References " Referenced By ]
% Description i
Mame *| » |Value

* 1D 153207

* Mame 15207-012

* [Object Type SalesItem

* Revision 0.2 Last edited by USER on Mon Jul 27 15:43:10 EOT 2015

* |Approved x Last Approved on Mon Jun 15 16:27:06 ECT 2015

* [Translation Mot Translated

» Path Primary Product Hierarchy Products/Apparel /Upper Body Wear T-shirts/T-Shirts L

* Condition 1

» Parent o T-shirts

> Status
@ Sales Ttem Marketing Descriptions

Mame > | » |Value »
. |The Hanes Beefy-T T-5hirt For over 35 years, it has set the standard for T-shirt comfort and quality.
» Description, Long abe Today it's better than ever, offering greater durability and less shrinkage than you'll get with ordinary
tees,

See the Object Maintenance in Tree topic within this guide and child topics for additional information on the
various object editors available in Tree.

Information on editing non-Tree objects can be found within the relevant sections throughout the STEP
documentation (e.g., information on workflow editors is available within the workflows guide).

For the product objects in STEP, users can create attributes (description attributes) along with aspects in the first
flipper called 'Description.' For more information about description attributes, see the Description Attributes
topicin the System Setup / Super User Guide documentation.
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Search Tab

The Search tab allows users to perform simple searches by typing directly into the default search field.

=

5

& EEE [ Reset H Search ]
Search Result Show Details

8 | [ ame 3

i

2

l

Users can also perform more complex searches by selecting and/or combining additional search criteria.

@ Search

=
Search

= Object Type

) _|E

m

@i Search Below M

Hails

Referenced fssets %l

Revised Objects Changed Since
Document Content

Search from List

Javascript search

Missing Mandateory Values
Unapproved

Product Override Search

Search in Publication Hierarchy
Referenced By

References

STEP Workflow

Sample Result

Translation Status

Unpushed or Failed Assets

[ STEP Workflow " Bookmarks ” System Setup ” BG Processes (2] ]
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Below Search Operations can be performed on the entire search result.

-Operations on Entire Result

JE E

For more information about search operations, see Search Operations on Entire Result topic in the
Navigation and Searches documentation.

For more on searching, see the Search section of the Getting Started documentation.
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STEP Workflow Tab

STEP Workflow is STEP's native functionality for structuring and to some extent automating processes around
objects in STEP. Typical examples are Product onboarding processes and change / governance processes.

The concept of STEP Workflows differs from the general concept of a workflow, in that STEP Workflows are data-
centric, meaning that each instance of a given Workflow always will be tied to an objectin STEP. As illustrated
below, technically, a Workflow Instance is a relation between a STEP object and a Workflow definition that also
exists as an object in STEP.

Done

W

Marketing Reject

Done

y
Workflow Instance w

Accept

A
STEP Object L4

Workflow Definition

The STEP Workflow tab has 2 sub tabs (Tasks and Profile).

Tasks

The Tasks sub tab is the primary interface for working with workflows in STEP Workbench.

1. Each workflow has a flipper that can be opened to display details about the workflow.

STEP Workflow

%

-

=

D

wAl |Fi|ter by Collection ||Z|
ﬁ Failure i
w | Initial 0
(%]
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2. Administrators can configure which states are displayed for each workflow. The number of tasks for the state

are displayed.

Profile

' Approve Recursively
G P

Filter by Collection

Search

Failure
Initial

CESEES

3. The Refresh button updates the data displayed for number of tasks in the workflow.

STEP Workflow

Profile
' Approve Recursively
el

Filter by Collection

Failure
Initial

[BS5E5 ” Search ” Tree

4. Clicking the Show All Items button displays all tasks in all displayed states, regardless of the assignee. Only

users with the STEP Workflow Administrator privilege have access to this button.

STEP Workflow

; @ Approve Recursively
5| |Z P

o

wil | (Filter by Collection

ﬁ Failure

ﬁ Initial

5. Clicking the Show All Items assigned to me or any group | am a member of button displays tasks directly

assigned to the user or any group that the user is a member of.
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STEP Workflow

B Prafile
; ' Approve Recursively
o
wil | Filter by Collection
ﬁ Failure ]
ﬁ Initial 0

6. Clickingthe Show All Items assigned to me button displays only tasks that are directly assigned to the user.

STEP Workflow

; @ Approve Recursively

5|3 P

o

wil | Filter by Collection

ﬁ Failure ]
ﬁ Initial 0

7. Click the ellipsis button (|...)) to allow users to filter the list of displayed tasks based on a Collection. For

example, if a user wanted only to see objects in the workflow where the Color Attribute = Blue, they can first
perform an Attribute search on the Search tab, then save the result as a collection, and use that collection to
filter the objects to display only those where Color is Blue.

STEP Workflow

@ Prafile

; o Approve Recursively

5|2 P

o

Wil | (Filter by Collection

E Failure ]
W

u | Initial 0
w
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Profile
STEP Workflow 4 New Item Creation Profile - By State - STEP Workflow profile i
Tasks m STEP Workflow profile
KPI_StatusTracking Configuration last edited by user on 2015-07-23 13:46: 21 On-demand data has not yet been generated for this profile
New Item Creation Profile - By Assign Edit configuration |Update on-demand data Copy to Clipboard ]
ew Ttem c’“tf“" Profile - By Stat State > ETEP Workfiow > [tems in State > [Average time in State
New Ttem Creation Profile - By Workflow > Copy Writing SalesltemCreation ii &1Days
» [Copy Writing Cluster SalesItemCreationMewBR, 4 123 Days
» [Copy Writing Cluster SalesItemCreation 11 &1Days
» [Copy Writing Ended e SalesItemCreationMewBR, 4 123 Days
» Digital Asset Cluster SalesItemCreationMewBR, 4 123 Days
» Digital Asset Cluster SalesItemCreation 11 &1Days
» Digital Asset Review SalesItemCreationMewBR, 4 123 Days
» Digital Asset Review SalesItemCreation 11 &1Days

Click a Profile link to see details of the configuration.

The Edit Configuration button allows you to modify the data being profiled.

The Update on-demand data button runs the profile and updates the data displayed.
The Copy to Clipboard button saves the data displayed to your computer's clipboard

o s~ b=

Once saved to the Clipboard, this data can be pasted into Excel for further analysis.

For information on how to configure workflows, see the Creating a Workflow topic.
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System Setup Tab

Schema objects are maintained from the System Setup tab. Examples of such objects are Attributes, Action Sets,
Contexts, LOVs, Object Types, Tags, Units, Users & Groups, Workspaces, Reference Types, and many more.
Most actions performed require Super User access. This is where the core components like integration endpoint,
STEP Workflow, Web Ul, business rules, etc. are created and configured.

System Setup

Ifl Attribute Groups

i--[3) Attribute Transformations
-- Action Sets

-- Contexts

-- Lists of Values [ LOVs

----- Gateway Endpoint

-[5] Global Business Rules

| Inbound Integration Endpoints
= Match Codes and Matching Algaorithms
Outbound Integration Endpoints
-5 Portals

----- Status Flags

A5 Workflow Profiles

Workflows

----- Derived Events

[+ Object Types & Structures
% Tags

- Units

rﬁa lsers & Groups

E‘h Reference Types

+” Workspaces

@ Table

[+ famy Keys

[ﬂ Event Queues
&#1-[B Component Models
ﬁ Recyde Bin

[

l STEP Workflow " Bookmarks ]W[ BG Processes ” Search ” Tree
=

Additional information on the System Setup objects and functions can be found throughout the online help. For
example, information on workflows is available in the Workflows guide, while information on integration endpoints
is available within the Data Exchange guide. Information for general functions that are not covered in
independent guides (e.g., attributes, references, users and groups) can be found in the System Setup / Super
User Guide.
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Toolbar

The features accessible on the STEP toolbar, (located beneath the menu bar), are geared towards navigating
between objects and viewing object data in different ways.

[ doc-dev - userj@https://doc-dev.stibo.com - STEPworkbench — O x

File Edit View MNavigate Format Maintain Window  Help

[T context [engishus | € < Crure nr=Pmduct&mntexﬁd=CnntextE ¥ 5] & coto [10/Name

Hardware rev.0.6 - Product

-] Article Groups Commercial || Tables || Category Profile || Proof View || Status || State Log || Tasks

|__=| Assets [ Sub Products " References " Referenced By " Images & Documents ]
|__'=| Bulk Update Configurations = Description

[ Classifications @ Description Attributes

--|‘_“=|Cor_1ﬁguraﬁons [ Iname s> [value > |

The various features available on the STEP toolbar are described below.

Stibo Systems Logo
[

Clicking the Stibo Systems logo allows the user to toggle between the STEP dashboard and the STEP
Workbench. For more information regarding the dashboard see the Global Dashboard section of the Data
Profiling documentation.

Context List

Context |English US -

'‘Context' acts as afilter that allows a user to view object data defined by, for example, country or language.

To select the context, the user clicks the dropdown and then selects the desired context from those listed. When
working in STEP it is useful to check that the context is properly set because viewing data in the wrong context is
likely to cause significant confusion. For more information regarding contexts, see the Contexts topic in the
System Setup / Super User Guide documentation.

Workspace Toggle Button

Located to the right of 'Context', the Workspace Toggle button, = , switches the user's view of a given object
between the 'Main' and 'Approved' workspaces. In the 'Main' workspace, object information is editable. In the
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'Approved' workspace, the user will see only those values that have been approved, and may not edit them. For
more information on workspaces, see the Workspaces topic in the System Setup / Super User Guide
documentation.

Navigation Buttons

¢>c

To navigate backward or forward to a previously viewed screen or to refresh the current screen's data, the user
can click the 'Back’, 'Forward', or 'Reload’ buttons, respectively. These buttons are located between the
'Workspace Toggle' button and the URL field. When clicked, these buttons behave in a way similar to most web
browsers' 'Back’, 'Forward', and 'Reload' functions.

Address Field

URL |sset?editor =AssetReferencedBy &contextid=Main

To maximize navigability of the STEP tool, all objects may be accessed via an in-tool URL. As with the URL bar in
a standard web browser, a product may be reached within STEP by pasting its unique URL into the URL bar. Itis
important to note that the STEP URL always begins with "step://", unlike web URLs which begin with "http://" or
"https:/I."

Viewing Mode Buttons
===l

STEP enables the user to view STEP data in a variety of ways, dependent on the need. When clicked, each of the
five 'View' icons that appear to the right of the URL field in the toolbar present STEP data in different ways. Below
are the five view modes described:

Normal mode

B

This is the default view of the STEP Workbench. With this view selected, users will see a listing of all relevant
attribute and metadata associated with that object.

Translation mode

With this mode selected, users can view all object-related data in up to two languages. The data is presentedin a
comparison display format. STEP automatically highlights in green those attributes that require translation. More
information of translations is available in the Translations documentation.
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Workspace mode

!

With the 'Workspace' view active, users can see object data as it appears in both the 'Main' and 'Approved
workspaces. This comparison view can be useful by allowing a user to view, at a glance, which values have
changed since the object was last approved. However, if the object is in 'Never been approved' status, only the
'Main' workspace will show when this view is active. For more information on workspaces, see the Workspaces
topicin the System Setup / Super User Guide documentation.

Context mode

B8]

With this view enabled users can view all of an object's data for two or more available contexts in a comparison
display format. The number of contexts viewable at one time is configurable. For more information regarding
contexts see the Contexts topic in the System Setup / Super User Guide documentation.

Revision mode

With this mode selected, users can view the current state of an object's data as well as all previous revisions in a
comparison display format. The number of revisions viewable at one time is configurable, but the current and
previous versions are shown as the default. For more information on revisions, see the Revisions topic in the
System Setup / Super User Guide documentation.

Goto Field

Goto | ID/Nzme w [

This field enables searching for specific objects. To quickly locate objects in the hierarchy by their ID, name, or key,
that data can be added into the 'Goto field' and searched on. When the desired item appears in this field, the user
can click on it, taking them directly to the object. For more information regarding the Goto field, see the Goto topic
in the Getting Started / User Guide documentation. For more information on keys, see the Unique Keys topicin
the System Setup / Super User Guide documentation.
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Tree Tab

This section contains information about how to create and remove local overrides and information about table
dimension points.

- 7] Assets
r_=| Configurations
r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
(-] Web Sites
E Publications
r_=| Primary Product Hierarchy
() Collections
[ﬁ eCatalogs
'ﬁ Fecyde Bin

T[ BG Processes (2) ” Search ]

The above hierarchies and their child objects can be navigated, edited, created, and deleted from the Tree.

The following table is an overview of the different elements of the Tree tab.

Object Description

Products Itis used to store actual product information. Alternative name is 'Blue folder

Classifications | Itis used to store assets (Images and documents), configurations, and link products.
Alternative name is 'Yellow folders' or 'Secondary classification.'

Index Words An Index structure needs to be created in STEP, in the same way as a ‘Classification
Hierarchy,” and products are linked into this structure.

Entities Itis used to store the party, supplier data, or contact information. Alternative name is 'White
folders.'

Publications Itis used to store print (Example: InDesign) documents and print related configuration like
templates, versions, commercial data, and dtp documents. Alternative name is 'Green
folders.'
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Object Description

Collections

Collections are containers for storing different sets of objects to perform bulk update or export
data.

eCatalogs

Itis used to create electronic product catalogs. An electronic product catalog is a data file
containing product and price information for a specific product selection. Alternative name is
STEP sync.

Recycle Bin

Deleted objects (products, assets, classifications, configurations and entities) are moved to
recycle bin from the Tree tab.

Itis used to create electronic product catalogs. An electronic product catalog is a data file containing product and
price information for a specific product selection. Alternative name is STEP sync.

For further information about objects in the Tree and how to work with them, see the Basic STEP Concepts and
Object Maintenance in Tree topics within this guide.
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Object Maintenance in Tree

Regardless of the particular object type or hierarchy that you are working with, the general principles of
maintaining objects in the workbench are the same, and are described in the All Objects section of this guide.
This includes general information on creating, editing, approving, and deleting objects.

Beyond the general object maintenance topics, additional information on working with specific object types in
Tree, including details about the various editors and functionalities available on them can be found in the
subsequent topics in this guide:

o Assets

« Classifications

» Collections

» Entities

o Products

« Recycle Bin for Tree

« Publications: Information about maintenance of objects in the green publication hierarchy is not covered in this
guide. Itis located in the Publication Hierarchy section of the STEP Publisher documentation.

A variety of components are also available for maintaining objects in Web Ul. For more information, see the Web
User Interfaces documentation. Additionally, objects are often created or maintained within workflows, or via
imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope of this
material, but additional information is available in the relevant guides throughout the STEP Online Help.
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All Objects

This section covers the basic functionality of creating, editing, and deleting objects in the Tree, as well as providing
an overview of the commonalities between the various object editors. Regardless of the particular object type or
hierarchy that you are working with, the general principles of creating and maintaining objects are the same.

Itis helpful if the Basic STEP Concepts topic in this guide has been read and understood prior to reading this
material.

A variety of components are available for creating and maintaining objects in Web Ul. For more information, see
the Web User Interfaces documentation. Additionally, objects are often created or maintained within workflows,
or via imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope
of this material, but additional information is available in the relevant guides throughout STEP Online Help.

The information below focuses strictly on the means for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in the Privilege Rules topic
in the System Setup / Super User documentation.

See the relevant section(s) below for detailed information on working with objects in the workbench:

« Approval of Objects

o Creating Objectsin Tree
» Deleting Objectsin Tree
« Editing Objectsin Tree
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Approval of Objects

This section introduces the user to the concept of approvals in STEP, and provides detailed information on how to
carry out approvals in the STEP Workbench. Approval of objects in the Web Ul is handled via addition of an
Approve action button to a screen.

Approval Overview

The datain STEP is logically divided into two workspaces named Main and Approved.

The Main Workspace is the editable 'draft' Workspace where data is initially born and enriched. The Approved
workspace holds approved data deemed ready for production.

Main Approved

nmp

Approval

In a typical setup, data from the Approved workspace is made available to downstream systems. Data cannot be
edited directly in the Approved workspace. Instead, data is reflected in the workspace via an operation called
approval.

Approvals can be carried out manually by a user, or programmatically by a business rule, import process, or other
operation.

The approval operation only applies to objects that are workspace revisable. These are:

« Product objects

» Classification objects

« Asset objects

« Entity objects configured to be workspace revisable

All other objects in STEP (like attributes, references, etc.) will be identical in the Main and Approved Workspaces
and changes made to these will be reflected automatically in both workspaces. These objects are known as being
'Globally revisable'.
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Detailed information on how to carry out approvals in STEP Workbench can be found in the Approving an
Object topic in this guide. This guide also contains a detailed description of the approval symbols that are visible in
the different object editors in the Approved Symbols and Messages topic in this guide.

In Use and Not In Use Objects

When an object is approved in STEP, it cannot be purged from the Tree Recycle Bin. This restriction prevents
approved objects that show on the Approved Workspace from being removed erroneously. This prevention is
done by way of the 'In Use' and 'Not In Use' indicators on the object records in the Tree Recycle Bin. For more
information, see the Recycle Bin for Tree topic in this guide or the Recycle Bin for System Setup topicin the
System Setup / Super User Guide documentation.

'In Use' objects cannot be individually deleted nor are they included in the Purge action. A user must perform an
Approve Deletion action on each 'In Use' item.

(160350) rev.0.8 Deleted (in Use)
[ Light-track - Proof Wiew || Status || State Log | Tasks
-] Luminaire hoist Images & Documents ” Commercial ” Tables |
] ~[2] Mechanical accessories for luminair [ Sub Products ” References ” Referenced By |
J:% -[Z] Mumber ftext label for house numbe
&z -] Pictogram for emergency luminaire
— [ Pillar for bollard Name > | > |value
ﬁ ~[[~] Sales Flyers * D 150350
i [T Suppliers Root > Name
=]
&l -] Support profile lightdine system -
>
b -] Test device for emergency power | LLETE £EE
— [T (160323) * Revision 0.8 Last edited by USE
% -2 (160324) * |Approved 3€ Last Approved on\
p [ ﬂ » [Translation Mazter
= ~[IT) (160363) . .
2l ﬁ 12-GGK79(2) » Path Primary Product Hierar
—— - ™ 12-GeK73(2)a(2) » Default InDesign template
% - | 18210 MB(2) » CalculatedAttribute 1 £ NjA-
18212LE
‘E E (2}_ » Child Connt 0

When an object that is not approved is deleted, it shows the 'Not In Use' indicator. This means it will be purged with
the 'Empty Recycle Bin' option and can be totally removed.
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a[ Syskem Setup ” BiS Processes " Search l

-7 Light-track

-] Luminaire hoist

-[Z] Mechanical accessaries for luminair
~[Z] Mumber ftext label for house numbe
-] Pictogram for emergency luminaire
-[Z] Fillar for bollard

~[Z] Sales Flyers

~[—] Suppliers Root

-] Support profile lightdine system
-] Test device for emergency power |
{7 (160323)

[T (160324)

~[I5) (160350)

E 12-GGK79(2)

-

- AT7F4m KA DY

€ 12-GGK79(2)a(2) rev.0.2 Deleted (Not in Use) =

Tables || Proof View || Status || Skate Log || Tasks
Referenced By Images & Documents " Commercial |
[ Data Containers ” Sub Products ” References |
@ A
Mame *| * |Value
* D 243318
* Mame 12-GGKF(Z)a(2)
* Ohject Type Itemn
* Revision 0.2 Last edited by L
* \Approved x Mever Been Apj
* Translation Mot Translated
* Path Primary Product Hie
* Default InDesign template

If an object that is approved is deleted, it will still appear in the Approved workspace until an Approve Deletion or
Approve Deletion Recursively action is performed.

The key difference with the System Setup Recycle Bin and the Tree Recycle Bin is that all of the System Setup
objects in the Recycle Bin are flagged with 'Not In Use' since nothing in the System Setup is constrained by
Approval status.
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Approving an Object

This topic describes how to approve an object in the workbench. When an object is approved, it moves to the

Approved workspace.

Data Ownership
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The concept of data ownership is very important in relation to approvals. For an object to be fully approved, all data
that the object owns must also be approved. When data changes, the object that owns that data is considered
'modified' and can potentially become 'unapproved.'

The figure below shows data owned by a Product object (the largest box).

Parent Product

Product
D

‘:ﬁ
4 MName
&

Local Specification

Attribute Values
%+ Description

Attribute Values

T

Local References
to other Products

Local References
to Entities

Local Linksto
Classifications

Local References
to Assets

Local Links to
Specification Attributes

o A Product owns its parent link (also true for Classifications, Entities and Assets).

» The Product owns local values, but not inherited Specification Attribute values. Thus, when these are modified
at an ancestor level, this will not affect the Product’s approval status. Also, the object's local values (that is,
assigned at the product level), will be approved.

o The Product owns all local References and Links for which it is the Source. When a Link or Reference is
modified, it is the Source that is changed while the Target is unaffected. Attribute values on the Reference /
Link are likewise owned by the Source object.

Approve an Object

To approve an object, right-click on the object and select one of the available approval options, or use the options

on the Maintain menu.
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Partial Approve...

Check Approve

Approve Recursively

Approve Objects is available when the Main workspace is selected.

Approving objects is available for:

o Classifications

o Products

« Images & Documents
« Entities (set up to be Workspace revisable)

Approve Object
Partial Approve...
Check Approve
Approve Deletion

Approve Recursively

Ctrl+Shift+)

The status of an object in the various workspaces can be viewed in the Status tab in the Workspaces field of the

relevant editor.
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18210 M B_EN rev.0.57 - Status

Fri Aug 26 11:12:09 EDT 2016 Mon Aug 29 12:06:58 EDT 2016 USER4 Auto Generated
*» 0.3 Fri Aug 19 14:13:58 EDT 2016 Fri Aug 19 14:13:53 EDT 2016 USERE Auto Generated
* 0.2 Tue Aug 02 09:15:20 EDT 2016 Tue Aug 02 09:15:44 EDT 2016 LUSERG Auto Generated
* 0.1 Fri Feb 13 11:36:39 EST 2015 Fri Feb 13 11:36:39 EST 2015 STEPSYS
P Workspaces

D » [Name » [Path >

» Main Main Main 0.57
» \Approved Approved Approved 0.53
» Merification Verification Verification 0.49

Once object editing is complete, and the object is ready for publishing, approving the object copies the current
object values into the Approved workspace.

Conditions to approve an object
« Objects must be approved from the Main workspace.

« An object cannot be approved if parent objects are not yet approved (approving must be done from the top
down in the hierarchy).

« A Reference or Link cannot be approved if the Target does not exist in the Approved Workspace, i.e., ifa
Product / Classification is referenced with another Product / Asset / Classification, then the referenced Product
/ Asset / Classification needs to be approved first before the actual Product / Classification is approved.

« If Attributes or References / Links are Mandatory, objects cannot be approved if there are no values / targets.

« Externally Maintained Attributes or References / Links are not under revision control. Values / references will
automatically be reflected in the Approved Workspace and modifying the data will not affect object’s approval
status.

« The user must have sufficient Approve privileges.

« To easily check differences in the Main and Approved Workspaces, select Partial Approve, as discussed
below.
« When approving, the object's revision number changes automatically.

« An entire hierarchy can be approved using the Approve Recursively option. For more information, see
Approving Recursively below.

Partial Approve

It is possible to approve an object that has a Reference / Link to another object that does not exist in the Approved
Workspace. In this instance, the object will become “partially approved”, meaning that the object and all data that
can be approved will be approved. However, the Reference / Link will not be approved. If the Target for the
Reference / Link is later approved, the Source will need to be approved again for the Reference Link to be updated
in the Approved Workspace.
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Main Approved

Classification only
in Main

Productsought 3 Product without Link to
approved E- Classification

Partial approvals can also be performed deliberately - both manually and programmatically. Specific Attributes,
References, Links, and the object Name can be selected for approval. The Attributes, References, Links and
Names are sometimes referred to as “part objects”. These part objects cannot exist in the Approved Workspace
without the object to which they belong. Thus, when the first part object is approved, the object will need to be
presentin the Approved Workspace.

Usage

Partial approval of selected elements of the object is particularly helpful in situations where certain elements of the
object need to be available for usage (in the Approved Workspace) before the rest of the object or its elements can
be approved.

For example, consider that there are two users who perform changes for a product and then approve the product.
If the product is completely approved, then it can be difficult to identify which user performed specific changes. In
this case, using the Partial Approve will allow the user to approve the changes performed only by him / her and
leave the rest of the changes to be approved by the other user who made those changes.

Approve partially
1. Inthe Tree, select the object you wish to partially approve.

2. Inthe Maintain menu, click Approval > Partial Approve. Optionally, right-click the selected object and click
Partial Approve.

3. This will bring up the Partial Approve dialog box:

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 118



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

[] Partial Approve >
Main Approved

[1/=3 [All Elements]

[ | =11 Attributes

[“1| =0 Attributes for Web UI Screensho

[ i.-[|T Hazmat ‘Yes Details. ..

Expand Al | | Colapse All |

Suppress Re-Translation

|Amuue5&lected||[hedc||ﬂa"rcel|

4. The user has to select the required element / elements (for example, attributes) and click on ‘Approve Selected’
button.

Partial Approve Compare View Dialog
The dialog shows which elements of the selected object have been changed since the last approval of the object.

Besides Name, Parent Object, and Default DTP Template, the type of elements listed are attributes, references,
and tables. For each element the values in Main and Approved Workspaces are listed.

For detailed information about the value for an element, click the Details...link. This displays a detailed view of the
element showing the values for the Main and Approved workspace:

[1 Partial Approval Compare View - Hazrmat *

Main Approved

In the above example, the value for the attribute Brand Name has changed. Values only present in Main
workspace are marked with a green background color. Values only present in Approve workspace are marked
with a red background color.

All elements are selected as default. To deselect all elements, click the checkbox next to the All Elements node.
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You can select the element(s) you wish to approve by clicking the check boxes next to each element. You can also
select a whole element group, i.e., Attributes by clicking the checkbox next to the element group.

To expand an element group click the + sign next to the element group. To collapse the element group, click the -
sign next to the element group. To expand all elements in the dialog, click the Expand All button. To collapse all
elements in the dialog, click the Collapse All button. To check if the selected elements can be successfully
approved, click the Check button. An Approve report will subsequently summarize the result of the check.

This functionality is also available in the Web Ul. For more information on this feature, see the Partial Approval
in Web Ul topic in the Web User Interfaces / Web Ul Getting Started documentation.

Clicking the Approve Selected button will approve the selected elements of the object and the Approve status of
the object will change accordingly. Normal Privilege rules apply to Partial Approve. For more information, see
Action Sets.

Suppress Re-translation

Normally, an approval of a translated Product in a source language will cause the Translation status of the
Product to be set to Re-translation needed. In the Partial Approval dialog this behavior can be suppressed by
clicking the Suppress Re-translation checkbox. All existing translation relations with status 'Up to Date' will
remain in status 'Up to Date'. This is especially used in cases where only minor changes are approved and no re-
translation is needed. For more information, see the Translations documentation.

Check Approve

If you are unsure whether or not you are allowed to completely approve an Object, you can run a Check
Approve.

1. Inthe Tree, click the Object to be approved.
The Editor shows the Object contents in Main and Approved Workspaces.

2. Inthe Maintain menu, click Approval > Check Approve, or right-click on the object, and then select Check
Approve option.

« If you only have changed attribute values for which you have the Approve privileges, a Complete Approval
Possible dialog box appears.

[ 1 Complete Approval Possible >

The object can be be approved completely

without errors,
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« Ifthe product cannot be approved due to multiple reasons, such as Mandatory values / References being
empty, then the report will provide details about the missing information, as shown below:

[ Unable to approve product x

Approve report for 18210 M B
Unable to approve object due to missing mandatory values on attribute(s):
Manufacturer Name

[ox ]

For example, consider a Product that has multiple attributes linked and has mandatory values and references
which needs to be approved after the changes have been done. In this case, scrolling down or switching between
tabs to check if the values are entered is time consuming; Check Approve will help the user to know if the product
can be approved completely with a detailed report.

Approve Recursively

Approving recursively is done from the Main menu by clicking Approve Recursively. Similarly, the Approve
Recursively can be done by right-clicking on the object.

Approving Recursively is available when a Main Workspace is selected.
Approving Recursively is available for:

« Classifications

» Products

« Images & Documents

« Entities (setup to be workspace revisable)

The status of an Object in the various Workspaces can be viewed in the History tab in the Workspaces field of the
relevant Editor.

Approving Objects recursively means searching for unapproved Objects linked to (or below) a selected hierarchy
node, and approving these Objects (copying them to the Approved Workspace).

This is useful and time saving e.g., when a lot of images have been imported and checked and should all be
approved.

To recursively approve in the 'Main' Workspace:
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1. Inthe Tree, select the hierarchy containing the Objects to be approved.
2. Inthe Maintain menu, click Approval > Approve Recursively.

A dialog box appears, listing the Name of the selected hierarchy node, contained Objects and status of
analysis.

[ Approve Recursively *

@ Finding Unapproved Objects (This might be time consuming)
Ohbject » |Classifications * |Products  » |Assets
18210 M B_EN 0 1 0

@ Empty mandatory links/values in Main workspace

Validator * |Classifications * |Products  * |Assets
Missing mandatory values 10 2 0
Missing mandatory links 0 0 0

< >

Start Process with Description
Name | approve 18210 M B_EN |

[ o« | SRS | cane

3. Optionally, type a name for the process.
4. Click OK button to start the approve process.

A dialog box appears displaying information on the process.
5. Click Go to process button.
The Process view opens, showing details of the process and a report of approved Objects.

The hierarchy will now have Approved status indicating that it is copied in the Approved Workspace.

Approval Feedback

When clicking Approve Object or Partial Approve, you might get different types of warnings, depending on your
Approve Privileges.
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If you have modified attribute values for which you have Approve Privileges and at the same time have modified
attribute values for which you do not have Approve Privileges, an Unable to Approve the Entire Object

dialog appears.

D Unable to approve product
PP P

TshirtQuantity
Attribute English
Short Ttem Description

Missing approve values privilege on attributes:

If you have modified attributes values and do not have Approve Privileges, then the option 'Approve' is disabled
in the right-click menu. If you have modified attributes values for which you do not have Approve Privileges, a

Missing privileges dialog appears.

D Missing privileges

on this object

it

You do not have suffident privileges to approve
any of the non-approved modifications performed

For more information about user privileges, see the User Actions topic in the System Setup / Super User

Guide documentation.

Partial Approve Feedback

If you have modified attribute values for which you have Approve Privileges, and at the same time you have
modified attribute values for which you do not have Approve Privileges, a Partial Approve dialog box appears.
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[ 1 Partial Approve x
Main Approved

(=1 [All Elements]

=1-C£11 Attributes

+-C71 Category Specific Attributes

=1 Display

=551 Manual Sequending Display

i...[|T short Ttem Description | T-shirt, short sleeve, Mens M, T-shirt, short sleeve, Mens M, Details. ..

Expand All Collapse Al

[ ] Suppress Re-Translation

| Approve Selected

Chedk Cancel

In the example above, the user will be able to approve all attribute values in Attribute Group Manual Sequence
and Category Specific Attributes. All attributes users do not have permissions for will not be displayed.

Approve Recursively feedback

1. InBG Processes, click Approve Recursively, open Active or Ended Processes, click the relevant process.

2. Inthe Background Process tab, open Execution Report.

¥ Execution Report

1 Recursive approval started on "235815" in context "English US
= Approved 0 classifications; 1 products; 0 assets; 0 entities..
* Recursive approval of 1 objects done. 0 warnings and 0 errars.

If there are any errors, the report will provide details about the error. If the process or approval was successful,

then the report will show 0 errors and 0 warnings.

The following example shows a missing mandatory attribute value, which caused the object to not approve.
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2 Execution Report
1 Recursive approval started on "235915% in context "English LS
= Approved 0 classifications; 1 products; 0 assets; 0 entities.; 1 errors
= Approve error report for 235915-2

I+ LUnable to approve object due to missing mandatory values on attribute(s): stepfattribute?id=Target_Attribute
= Recursive approval of 1 objects done. 0 warnings and 1 errors.

4 4l 1-50f5 [k [ Save... Truncate

Approve Recursively dialog

D Approve Recursively >

@ Finding Unapproved Objects (This might be time consuming)

Object » |Classifications * |Products > |Assets
183210 ME_EN 0 1 0

2 Empty mandatory links fvalues in Main workspace

Validator » |Classifications * Products  *> |Assets
Missing mandatory values 0 2 n
Missing mandatory links n 0 n

£ >

Start Process with Description

Mame | Approve 18210 MEB_EN

Skip Analysis Cancel

There are multiple options which are explained below:

« Finding Unapproved Obijects: This will analyze the hierarchy and then provide the count of the number of
Products / Classifications / Assets / Entities which are currently in unapproved status.

o Empty Mandatory Links / values in Main Workspace: This provides the details about the number of
mandatory links / references that are missing for the Products / Classifications / Assets / Entities.

« Start Process with Description: This option is used to enter the name for the Process before starting the
background process. This option is not mandatory but is recommended as entering an identifiable name
can be useful for review purposes.

« Skip Analysis: This option can be used in cases where the number of child products is large. The analysis of
the number of unapproved or missing mandatory values / References can be time consuming but will
provide the detailed report. By clicking this option, the analysis will stop and the user can proceed with the
approving recursively.
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For example, consider there are hundreds of products in a particular parent hierarchy. Selecting each product,
one at atime, and then approving them would be time intensive. In these cases, approving recursively will help
a user to approve all the products at one time.

Context Dependent Approvals

When an object is approved, that approval always happens in a specific context and will only be applicable to
data visible in that context.

To illustrate this concept, see the figure below in which object 'P' has values for two different attributes, Color
and Width, in the Main workspace. While Width is not dimension dependent, Color is, and has different
values in two contexts: 'Blue' in the English context and 'Bleu' in the French context. If the object is approved in
the English context, only the data visible in the English context will be reflected in the Approved Workspace.
Because of this separated approval, the object must also be approved in the French context to have it become
completely approved, indicated by a green checkmark in the approval status field. Until this approval across
contexts is done, the object in the English context will have the status 'Approved in Current Context on [date +
time]', indicated by a yellow checkmark, and the object in the French context will have the status of 'Last
Approved on [date + time]' (red X).

Main Approved

Width: 20 cm Width: 20 cm
Colar (EN): Blue Color (EN]): Blue
Color (FR): Bleu Color (FR):

If Color is set as a mandatory attribute in the French context but is left empty, then an empty mandatory
attribute warning will display when attempting to approve the object in the French context.

[ Unable te approve product ot
Approve report for (245934
Unable to approve object due to missing mandatory values on attribute(s):
(ColorAttv)

0K

All mandatory attributes will be checked upon approval to ensure none are empty in the context in which the
object is being approved. For example, in the first of the images shown below, the value added for the
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mandatory attribute 'Color' in the English context is 'Red'. The object can be approved in this context without
any issue. Note, however, that the approval icon is for the current context only (English), hence the partial

approval notation.

| I Context | English US

E Fashion Board
-l GDSN Products
i Packaging
E Product Overrides
El|j Products

[+-[15) Footwear

-3 Safety

--1‘_=| Apparel

El 1'_=| Hardware

Tree

E Thermal Valve_2
! -[[T] Task Lighting

n Setup " BiS Processes ” Search ]

&I € > O URL | tor=Product&versionid=206233&contexti

m Data Containers || Sub Products || References [_R

A
® Descripti
Mame *| » Value
* IO 245934
* Mame Thermal Valve
» Ohject Type Ttem
»_Revision 10,20 Last edited by USFR4 on Fr
» pproved @’f Approved in Current Contex
» Path Primary Product Hierarchy /Prod.
I » Color abe Red

When the viewing mode is switched from Normal to Context, the empty mandatory attribute alert is shown in

the French context.

|G € > (O URL [ MultProductiversionid = 206235 8contextid sContext Lid= 2458 34Bmorkspaced wtiain | [T] [2] 2
Thermal Valve rev.0.20 - Compare Contexts

o s | T
= | @ ERPackaong Lot T K
S ewiae i — o s 3
= % [ Footwear i il 245534
g [0 Safety > Hame Thermal Vahve
g % [ Apparel > Dbject Type :n:m Item
fgf' T ﬂm > Revision  0.20Last edted by USER4 on Fri Nov 16 09:56:52 EST 2018 j:.:mmma-.-m-m FriNov 16 09:56:5265T 2018 |
= o) > Path Primary Product HierarchyProducts Hardware Tools{Thermal Valve  Primary Product Hierarchy Products Hordware Tooks/(245934) |
§ = hermal vahe _2 e — et _.._.N.Eﬂw
: e -

When changes are made to both contexts and approved on both contexts, the object is fully approved,
garnering a green checkmark in both contexts.
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» [English US * [French FR. »
» D 245934 1245934
* Mame Thermal Valve
* Object Type Ttem [tem
* Revision 0.24 Last edited by USERE on Tue MNov 20 15:39:31 EST 2018 0.24 Last edited by USERE on Tue Mov 20 15:39:31EST 2018
> Paih rimary Product Hierarch Products Mardware MTools Thermal Valve Primary Product Hierarchv/ProductsMardware Tools/(245534)
* |Approved +" Approved on Tue Nov 20 15:39:31 EST 2018 +" Approved on Tue Nov 20 15:39:31 EST 20138
L =) ==

If a change is made in one context, e.g., changing the Color attribute value in the French context to '‘Blue,’ but
leaving the value for the Color attribute in the English context as 'Red,' then the object will regain full approval
once the object is approved in the French context.
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Approved Symbols and Messages

An object can contain both workspace revisable data and globally revisable data. The Approved symbols and
messages indicate the status of the workspace revisable data on a product, classification, image, or document.
The status can be viewed in the Approved field on these objects.

For details on the approval process, see the Approving an Object topic.

For more information on revisability, see the Revisions topicin the System Setup / Super User guide.

Approved Status Symbols

Approved Status

Symbols

b 4

Unapproved

Description

Revised data on product, classification, or images & documents in current
context is not approved.

For example:

« An object has never been approved.

» Revised data has been changed in current context without being

approved. Revised data includes attribute values, references, object
names, or tables.

Examples of changes to revised data include:

« A change in object name.

« A changed value on an internally maintained attribute.
« Ifan attribute has been linked to a product.

« Ifreference links to objects have been made.

Approved

Revised data on product, classification, or images & documents is approved in all
contexts.
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Approved Status Description
Symbols
o Partial Revised data has been approved in current context but a reference, object
Approved name, or value needs to be approved for the object to be approved in all
contexts.

If you view another context, then you typically see that:

« A dimension dependent reference is not approved.
« A dimension dependent value is not approved.
« A dimension dependent object name is not approved.

When all the dimension dependent references, attribute values, and object
names have been approved, the symbol changes from yellow Partial Approved
symbol to a green Approved symbol.

Approved Status Messages

Messages are displayed for workspace revisable data as follows.
Unapproved

When an object is newly created and never been approved as shown below:

MName »| * |value >
* ID 235915
* Mame 235915-2
* Dbject Type Active Products
* Revision 0.1 Last edited by USERE on Thu Oct 12 12:04: 10 EDT 2017
* |Approved x Mever Been Approved

When an object attribute / reference is modified, the status will show as 'Last Approved on' along with the date and
time as shown below:

MName »| * |Value »
* D 233915
* Mame 235915-2
* Dbject Type Active Products
* Revision 0.3 Last edited by USERE on Thu Oct 12 12:09:07 EDT 2017
* |Approved x Last Approved on Thu Oct 12 12:09:03 EDT 2017
Approved
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Mame Value »
* ID 235915
» Mame 235915-2
* Object Type Ttem
» Revision 0.31 Last edited by USER4 on Mon Jan 07 17:56:10 EST 2019
* Approved ( Approved on Mon Jan 07 17:58: 10 EST 2019

Partially approved
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When an object is approved in only some contexts the status displays as shown below:

Mame Value
> ID 235915
* Mame 233915-2
» Dbject Type Active Products
* Revision 0.5 Last edited by USERE on Thu Oct 12 12:13:20 EDT 2017
* Approved ¢~f Approved in Current Context on Thu Oct 12 12:15:13 EDT 2017
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Creating Objects in Tree

Regardless of the particular object type or hierarchy that you are working with, the general principles of creating
objects in the workbench are the same, and are described below. Tree icons are set during object type creation
according to preference and may be different in your system.

Objects can be manually created in the Tree via right-clicking or using the Maintain menu.

Create a new object via right-click

1.

Select a parent under which the new object should be created. Note that if the new object should be created as
aroot node on the Tree tab, the Maintain menu must be used (see below).

2. Right-click on the parent and select the appropriate 'New..." option. The options will vary based on the selected
parent. For example, note the differences between the available options on a classification and an entity, as
shown below.

E]i Entity Foot A

¢ T —
Coteshiten || g Keracunts [ NewEntity Node |

Selecting the right-click option will open a Create dialog, appropriate for the selected object super type (e.g.,
Create Assets for assets and Create Entity for entities). The options available in the dialog are based on the
data model defined in System Setup. For example, the Object Type selection will vary based on the allowable
object types under the selected parent, and ID will only be available for population if the object type being
created does not have autogenerated IDs applied.
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[ Create Asset > [ Create Entity *
Object Type CObject Type
@ Assets & | ®) Customer
() Auto Classification Rule Set
i ID CUS_114886
() Bulk Update Configuration "
Marme
1D
Create Cancel
Mame
Create Cancel

4. When an object type has been selected and an ID applied, the Create button will be enabled. Clicking Create
completes the creation of the new object, which is then accessible in the Tree. If a Name is not supplied, the
object will display in the Tree by the ID in parentheses. If a Name is supplied upon creation, the object will
display in the Tree using the Name entry. For example, two new objects have been added under Customer C
in the screenshot below. The first did not have a Name supplied, while the second did.

=i Entity Root
E}% Customer Hierarchy
8 Customer A
: 8 Customer B
E-8
L0y (ADD_114888)

Henry Magnus

Create a new object via the Maintain menu

From the menu in the upper left corner of the workbench, select Maintain > Insert and choose the appropriate
option. Note that it is required to use this method when adding a new root node to Tree. Additionally, note that the
available options differ based on the active selection when the menu is accessed. For example, the below shows
the available insert options when a classification has been selected, whereas the publication-related options would
be enabled if a publication object had been selected instead.
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File Edit View MNavigate Format  Maintain Window Help

|:_| Context  English US

r_=| Configurations

1‘_‘=| ETIM Hierarchy

r_=| Index Words

r_=| Merchandising Hierarchy
r_=| Suppliers

[#-[ 7] Web Sites

=i Entity Root

-0 GDSN

ﬁ Publications

r_=| Primary Product Hierarch
[#-(3 Collections

Iﬁ eCatalogs

'ﬁ Recyde Bin

[ STEP Workflow " Bookmarks ” System Setup ” BG Processes ” Search l

i &

S

Insert

Link

DD e

Merge

Delete
Force Delete & Purge
Unlink Object Type

Duplicate Ctrl+)

Duplicate Recursively

Make Revision

3 b D E=d=h-0-3 § R N N¥

Approval

Enable group for workflows

Revive

Revive Recursively

Truncate log...

Product

Classification
Classification Root

Mew Entity Mode

Entity Root

MNew Publication...

Mew Publication Group
Mew Publication Section...
Mew Page Template ...
Orphan Attribute

Asset

Attribute

Attribute Group

List of Values

Dirmension

Dimensicn Point

""" Workspace
Action Set

2
. &

MNew Image Conversion Configuration...

Create Transformation Lookup Table

L

Mew Event Queue

Mew AssetPush Event Queue
Mew AssetPush Configuration
STEP Workflow

Background Process to Monitor Deadlines

User

Group

Mew Supplier

Create Package
Create STEP Workflow

Mew Business Condition
Mew Business Action
Mew Business Library

@88 Setup Group Root...

Ctrl+Shift+P
Ctrl+Shift+C
Ctrl+5Shift+R

Ctrl+Shift+ O
Ctrl+Shift+ &
Ctrl+Shift+T
Ctrl+Shift+]
Ctrl+Shift+L
Ctrl+Shift+D
Ctrl+Shift+ M
Ctrl+Shift+W
Ctrl+Shift+5

Ctrl+Shift+R
Ctrl+5Shift+D

Ctrl+Shift+G

Ctrl+Shift+R

Many of the available options will only be enabled when an appropriate selection has been made on the System
Setup tab. For example, an attribute group must be selected for the Attribute or Attribute Group options to be

enabled.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021)

134




[T1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Deleting Objects in Tree

Regardless of the particular object type or hierarchy that you are working with, the general principles of deleting
objects in the workbench are the same, and are described below.

Objects can be deleted from the Tree by right-clicking on the object to be deleted, or via the Maintain menu when
the object to be deleted has been selected. In both cases, the Delete option is selected from the menu, and
deletion of multiple objects is supported using Ctrl or Command to multiselect.

7] Convert to Product-Override Maintain Window Help

Unlink product A

5 Cut Ctrl+ X e g
— i *
£ El‘@ Copy Ctrl+C Link
= H >
ﬁl E Paste Ctrl+V R
ﬁ H
g

.‘.r
|

Selecting Delete will open a deletion confirmation window, which will vary slightly based on the object selected for
deletion. For example, a classification provides an option to unlink child products rather than delete them, while
deletion of a product will automatically delete all child objects.

D Delete * D Delete b

Are you sure, you want to delete this object and its sub-objects? Are you sure, you want to delete this object and its sub-objects?

MName » \Wssets  * Sub-Product Count > [Classifications >
> Assets ID = AssefsRoot B9 0 71

W

Sub-Product Count
0

rSub Products

(®) Unlink

() Delete Delete | | Cancel

DEIEIE||CEI1CEI

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 135



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Clicking Delete will attempt to delete the selected object (and delete or unlink child objects as appropriate). A
confirmation window will appear detailing success or failure. Note that in order to delete an object, a number of
conditions must be met. For example, the object must not be referenced by any other object and must not be active
in any workflow. If the deletion conditions are not met, the confirmation window will display the errors, which must
be corrected prior to deletion of the object.

[ 1 Delete report >

Deleted 0 out of 1 objects. 1 object(s) could not be deleted due to the objections stated below.

MName >
ﬁ 12-GGKT99 ID = 100703

-Delete Objections

"12-GGK739" could not be deleted due to the reasons listed below:

step:/fproduct?id=18210 has a cross reference to the object being deleted step://product?id=100703, The
link iz visible in these workspaces Approved, Main.

step://product?id=18212 has a cross reference to the object being deleted step://product?d=100703. The
lirk is visible in workspace Main,

-Warning! If you use force delete, the below actions will be taken.

Cross references to objects being deleted wil be removed, These cross references will not be reconstructed, if the objects
are revived.

Force Delete Close

In some cases, a Force Delete option is available, though it is recommended to correct the data whenever possible
rather than forcing deletion. Also note that updates may need to be approved in order to take effect. For example,
if an object has been referenced by another and that reference has been approved, removing the reference must
also be approved (by approving the change on the referencing object) to resolve the deletion objection.

Once an object has been deleted, it is visible in the Recycle Bin for Tree, from where it can be revived if needed. In
order to fully delete the object, the deletion must be approved and the object purged. Following a purge, the object
cannot be revived.
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Tree
Elﬁ Recyde Bin - m
-["=] Smart Sheet Configurations -
= o]
@ GOSN
M
@ Japan ';J
@ Mexico M
- () MyCICs M
- [O] MyRegistrations * M
E {11150 > IC
a (11484 7 Purge
E (1148 Approve Deletion
- (1148
E E114BE Approve Deletion Recursively
E {abcde Revive
- g 12119 Revive Recursively
[

For more information on the Recycle Bin for Tree and the available actions, see the Recycle Bin for Tree topic
within this guide.

Alternatively, an object can be deleted and purged in one go using the 'Force Delete & Purge' option in the
Maintain menu. Choosing this option will bypass the Recycle Bin and is equivalent to completing a deletion and
purge all in one action. However, this option does NOT cause an approve deletion event in the system, so if
deletion events need to be recorded for output to downstream systems, this option should not be used.
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Editing Objects in Tree

Objects can be easily edited within Tree, and general principles for editing are the same, regardless of the type of
object. The available tabs will vary based on the object type selected, as well as other considerations such as data
model and licenses. Some tabs are common across the various object super types, while others appear only on
specific object types or subsets of object types. Additionally, some editors appear on more than one super type,
but have differing functionality based on the type of object that has been selected.

This topic covers the editing functionality available across the various editors, and provides links to additional
information for working with specific object types.

When an object is selected, the main portion of the screen displays a corresponding editor. The main editor for the
object is the first tab, which is Classification in the below example.

(=[] Assets Sub Products || References || Referenced By || Images & Documents || Tables || Status || State Log || Tasks

‘Cl omman
~[] Hustrations Mame | > |Value
[ Installation Manuals
> D IconR.oot
B[] Logos
-+[T] MSDS Sheets * Mame Icons
~+[Z] Owners Manuals > Dbject Type Tcons
mlfl :;’d“d Images vision 0.1 Last edited by Stibo Systems on Fri Jan 02 00:00:00 EST 1970
ideos
[ Configurations » \Approved " Approved on Fri Jan 02 00:00:00 EST 1970
[~ Index Words » [Translation Mot Translated
{2 Publications » Path Classification 1 root/Assets/Tcons
B Primary Product Hierarchy
i 5 Products > Wisibility
i Discontinued Products ||| > Purpose abe Storage for icons

All objects will have an ID, Name, Object Type, Revision, and Path field. Objects that are subject to approval
(known as 'workspace revisable') will also have an Approved field. ID cannot be changed once an object has
been created, so the field appears yellow, meaning it is not editable. Revision and Approved data is auto-
populated by the system, so these fields are also not editable. Conversely, object Name and Object Type can be
edited (assuming the user has privileges to do so), so those fields appear white.
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Some object types only support Description attributes, meaning all object data is accessed under the Description
flipper. For object types that support Specification attributes, data is organized by attribute group, and clicking the
magnification icon (indicated by a 1 in the screenshot below) will collapse or expand each group, allowing users to
focus on the relevant data. All attributes have a validation base type applied that determines the allowable data
that can be entered, and is indicated by the icon to the right of the attribute name below (2). Detailed information
on attribute validations is available in the Validation Rules topic in the System Setup / Super User guide.

To edit data, click in any editable field. Text attributes can be edited by typing directly into the field, while LOV
attributes will provide a dropdown from which users can select a value, as shown below (3).

Tree
Bi Products ~ m Sub Products || References || Referenced By || Images & Documents
Eli Apparel >
=H[T] Upper Body Wear 0
(=J-{75) T-shirts %
El‘ T-shirts Items MName *| > Value
P » Manufacturer's Part Mumber |abe 0090328342
-l Cotton T-shirts * Manufacturer Name abe Hats-R-Us
-E Mew Shirt * Country of Origin
. -jjill Polo T-shirt > Product Name Jabe
[#-[[T) T-5hirts Sales Items ® Category Specific Attributes
Ext-[I) Head Wear Mame alue
S= ;:;:;ear » Material abe Cotton/Polyester
[-{[T] Hardware : E:.?.Ic'r
+-{7] Displays > an_aw Folor |*
[T Furniture >
-7 Automotive L
[+-[1T] Building Products N~
[+-{1T) Electrical & Electronics > A
[/-{{7] Food and Beverage v > Ars
O = Wik L
dy XS
(WL
| o

Pressing the tab key shifts the focus to the next cell and Shift+Tab shifts the focus to the previous cell. Alt + F2
opens the Rich Text Editor, allowing the user to access styling options. For a complete list of shortcuts, see the
STEP Workbench Keyboard Shortcuts topic within this guide. The data fields available for editing will depend
entirely on the data model and will vary for each implementation.
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If an object is being edited that is workspace revisable (e.g., subject to approval), editing the object will change the
approval status (if the object had been previously approved). See the Approval of Objects topic within this guide
for more information on approvals.

Multi-Editors

Objects can be multi-selected for editing using Ctrl + click, or by Shift + Down / Up arrow keys. Additionally, objects
of the products and classification super types have a Sub Products tab that can be used for multi-editing.
Functionality for editing objects is comparable, regardless of how the multi-editor interface is accessed.

Right-clicking in any row header will expose the Rotate Table option which can be used to access the preferred
orientation of the data (Pressing F11 will also rotate the table if any cell in the table is the active selection.). Editing
in this manner allows for easy copy / paste of values between objects using Ctrl + C and Ctrl + V.

< Products
L L2 Ky Accounts A

m References || Referenced By
- [0 GOSN
i) Publications
(=T Primary Product Hierarchy
E‘i Products MName > [12-GGKF99 * [New Shirt >
Ei Apparel Mame 5 zma 12-GGK799 Mew Shirt
Eggpi;"t iear Object Type e Item Item
- ir
£ il T-shirts Items Revision R 0.13 Last edited by USER7 on W... 0.1 Last edited by USERE on Tue ...
a - Path Rotate Table Primary Product Hierarchy/Produ... Primary Product Hierarchy/Produ...
‘ Cotton T-shirts d Y ed ed : ed
a- Apprave Approv [ Rotates the current table}=d on FriOct 28 ... JC Never Been Approv
) N )
i Polo Tshirt [Translation Translation Mot Translated Mot Translated
i T-Shirts Sales Item Default InDesign template  » Default InDesign template
[#H-[IT] Head Wear Default Quark template » Default Quark template
#-{I7] Footwear UPC > UPC
B[] Safety EAN > EAN
#-{7] Hardware STIN > GTIN
#-{77] Displays « | | [Provider GLN > Provider GLM
s D > Completeness Score * Completeness Score

Right-clicking in any data cell will expose the Hide Equal and Mark Different options, which are especially useful
when working across multiple objects as they will hide all equal values, or highlight all different values,
respectively.
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Mame » |Ohject Type > R
- Al - w - Al - |-
Mame Ohject Type R
153217054 Sales Item 0.
18207012 Sales Item 0,
13214012 !
&% Cut Ctrl+X |
153215012 1
Copy Ctrl+C
153217012 o '
[B Paste Ctrl+V |
& Paste Link Ctrl+L
Rotate Table
Hide Equal
Mark Different

Additional options for viewing data are available using the View menu located in the upper left corner of the multi-
editors.

Product |P|'uduct 'ENEG | Sub Producks
*
>
>

View: Show all

Product views *

Mew View

I Edit view ¥

Remove view *

The default view option is to Show all which displays all data on the object, similar to what would be available in a
single-object editor. Additional options can be configured using the New View option. Clicking this opens a dialog
for users to enter a name of the view. Clicking OK in that dialog opens an Edit Filter dialog where the user can
select the attributes to be included in the view.
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[ Edit Filter o
{Legal Atiributes '-|| (®) Show only (") Do not show
i ~ Add i ~
Name Name
W TJFE' Re{“uue W TJFE'
Revision Revision
Fath Add Al Fath
Aoproved Aoproved
Transiafion RemoveAll Transiafion
InDesign Temolate InDesign Temolate
Annual Sales Forecast, Maximum Annual Sales Forecast, Maximum
Annual Sales Forecast, Minimum Annual Sales Forecast, Minimum
Category Category
Colar Colar
Completeness Score Completeness Score
Description, Long Description, Long
Description, Web Description, Web
= LNt O all=d 4 v = LNt O all=d 4 v
Update table setting
Save Cancel

The dialog defaults to having only "legal” attributes shown, meaning those attributes that are valid for the object, as
well as standard aspects of the object such as ID and Name. Note that object aspects are italicized, while
attributes are shown in standard text. By default, all available attributes and aspects are shown in both the left and
right panels. The dropdown in the upper left corner also has options to expose standard attribute search / browse
functionality, though typically the Legal Attributes selection is used as this prevents a user from defining an invalid
view. The 'Show only' and 'Do not show' radio buttons are applicable to the right panel, where the data for the view
is defined. The Add button is used when an attribute or aspect has been selected in the left panel and should be
added to the view (the right panel). The Remove button is used when an attribute or aspect has been selected in
the right panel that should be removed the view. The Add All and Remove All buttons are used to add or remove
all attributes and aspects from the view. Clicking Save stores the new view.

Once one or more views have been created, they are available for selection from the View menu under Product
views.

View: Show all

Productviews ¥ Streamlined View
Mew View Show all

Edit view H # Marme
Remove view ? * Dbjec
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An existing view can be edited using the Edit view option, and a view that is no longer needed can be removed
with the Remove view option.

Right-Click Editing Options

Additional editing options are available by right-clicking within the various editors. These include standard cut/
copy / paste options, as well as more exotic options which are briefly described below.

« Character Tag: Used as a quick option to add tags to attribute values without having to enter the Rich Text
Editor. Character tags that have been defined for the system will be available as sub-options to the Character
Tag selection. For more information, see the Tags topic in the System Setup / Super User guide.

« Edit: Used to open the Rich Text Editor for attribute values, allowing users to apply styles, formatting, spell
check, special characters, etc.

« Filter: Used to filter the displayed data under any flipper, by values, and is exposed by clicking the column
header. This can be especially useful when working with attribute groups with a large number of attributes in
them as it allows users to filter based on empty / populated, greater than / less than, etc.

« Footnote (Insert / Edit): Used to add an additional piece of information (e.g., a footnote) to an attribute value.
Footnotes are added / edited within the Rich Text Editor so using these options will open that dialog. Note that
footnotes are only supported for use in conjunction with STEP tables. Using footnotes within attribute values
that will output in something other than a table will not yield the expected results. For more information on
footnotes, see the Tags topic in the System Setup / Super User guide.

« Hide: Used to hide a particular row or column from view, and a hidden row or column is exposed by clicking on
the row indicator or column header.

« Hyperlink (Insert / Edit, Follow, End): Used for adding hyperlinks to attribute values. Highlight text within
the attribute value and select the insert option to provide a hyperlink to be assigned to the selected text. After
inserting, and with the cursor at the end of the hyperlinked text, use the end option. This ends the hyperlink so
that subsequent text does not become part of it. Use the edit option to edit a previously inserted hyperlink.
Select the follow option while the cursor is within the hyperlinked text to follow the hyperlink. For more
information, see the Tags topic in the System Setup / Super User guide.

« Inline Reference (Insert / Edit, Copy as): Used to add inline references to attribute values. Inline references
are used to re-use values present within another attribute, object Name, or ID. This avoids duplication of data
by maintaining the data only once, and re-using it from that source as needed. For example, a description
attribute may need to dynamically include the object Name, e.g., '[Name] is a great product!'. Detailed

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 143



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

information on working with inline references is available in the Inline References in Attribute Values topic
within this guide.

Insert Special Character: Used as a quick option to add special characters to attribute values without having
to enter the Rich Text Editor. Opens an editor allowing for selection of the most recently used special
characters, with an option to access a full Unicode character menu. For more information, see the Tags topic in
the System Setup / Super User guide.

Override: Used to manually populate a local value to override a calculated (derived) value. This option is only
enabled on calculated attributes. For more information, see the Calculated Attributes topic in the System Setup
/ Super User guide.

Recalculate: Used for on-demand display of calculated attribute values in the editor if they have previously
been disabled via the 'Disable calculated values' option in the View menu. For more information, see the
Calculated Attributes topic in the System Setup / Super User guide.

Rotate Table: Used to rotate the data display. As a right-click option, it is only enabled from row / column
headers when multiple objects are selected. For a single object, it can be used to rotate the data under a flipper
only via keyboard shortcut (Alt + F11).

Show All (Rows / Columns): Enabled after the Hide action has been taken, and exposes all hidden rows /
columns.

Sort: Used to sort data based on attribute value rather than attribute name or display sequence. This option is
exposed when a column header is selected, and requires a sort selection (Ascending, Descending, or None).

Style: Used as a quick option to add styling to attribute values (e.g., bold or italics) without having to enter the
Rich Text Editor. Styles that have been defined for the system will be available as sub-options to the Style
selection. For more information, see the Tags topicin the System Setup / Super User guide.

Additional Information

In addition to the main editors for objects, several other tabs / editors are available for editing objects, such as
References, Referenced By, etc. However, the available editors and functions within them vary based on the
selected object. Therefore, they are described in the context of the type of object being edited, in the subsequent
sections of this guide:

Assets
Classifications
Collections

Entities

Products

Recycle Bin for Tree

Publications: The publication hierarchy and its associated objects are detailed in the Publication Hierarchy
section of the STEP Publisher documentation.
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Inline References in Attribute Values

Inline references can be embedded in attribute values for attributes that have Text, Text (exclude tags),
Numeric Text, and Numeric Text (exclude tags) validation base types. An inline reference use case follows:

You are working with product objects whose model number is the same as their STEP ID (for example,
'12345'). On these objects there is an attribute called 'Product Description' that needs to dynamically reference
the object's model number within the text of the attribute. For a Product Description such as 'Acme lawn
mower, model number 12345, the inline reference to the STEP ID would populate '12345." Using an inline
reference in this instance helps to avoid duplication of effort—since the product's model number already exists
in STEP asits ID, there is no need for users to manually enter it a second time into the system.

Also, in many cases inline references are easier to use than calculated attributes and easier on system resources.
For example, it may be easier for users to use an inline reference to pullin a STEP ID than to create a calculated
attribute using the formula 'SteplID()'".

One attribute value can include several inline references. An inline reference can reference either a single attribute
or an attribute group.

Inserting an Inline Reference using Workbench

1. Select the relevant node. The corresponding editor appears.
2. Click on the leftmost tab within the editor, which is different depending on the object type (for example,
'Product’, 'Classification’, 'Images & Documents', 'Publication,’ and so forth).

3. Activate the Value field of the relevant attribute where you want to create or edit the inline reference. Or,
highlight the field, right-click, and select Edit to launch the larger value editor.

4. Place the cursor at the position in the Value field where you want to insert the inline reference, or place the
cursor on an existing inline reference to be edited.

5. Right-click, and then click Insert Inline Reference to add a new inline reference or Edit Inline Reference to
edit an existing inline reference.
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Spelling

Tables || Category Profile || Proof Vie 5 Undo change value of 'Bas
Product l Sub Products l {(f® Redo change value of 'Cou
Mame >| » |Value
» Manufacturer's Part Mumber |abe % Cut
» Manufacturer Name abs: Copy
* Country of Origin B paste
* Product Mame |ah: Cosmic Party Hat .
[E  Paste and Match Style
= Category Spedfic Attributes
= Attribute Group Style
@ Display Character Tag
Pame >| > |Value #.  Insert Special Character
» Basic Manufacturer Information ab:
* Long Item Description abt 5ui1ﬁm Insert Inline Reference
: b . .
» Manufacturer's Part Mumber a Edit Inline Reference
* Country of Origin

6. The Inline Reference dialog displays.

Inline Reference

Object Selection
Object

(®) Resolve To Object ID

() Resolve To Object Name

() Resolve To Attribute Value andjor Unit

Attribute Selection
Attribute

Attribute Mame(s)
Indude

Separator =
Attribute Value(s)

Aspect
Attribute Separator

Values(s) and Unit(s)

Cancel
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If you do not wish to return the name or ID of the current object and instead want to return a value or values
from another object in STEP, click the ellipsis button (|...)) to the right of the Object field. Ignore this field if you

plan to return value(s) from the current object instead.

« Click the ellipsis button (|...|) to display the 'Select Object' dialog, search for or browse to the object that holds
the value(s) that you would like to return, then click Select to choose the object.

Select Resolve To Object ID to return the value of the STEP ID of the chosen or current object.

Select Resolve To Object Name to return the value of the STEP Name of the chosen or current object.
Select Resolve to Attribute Value and/or Unit to activate the options in the 'Attribute Selection' portion of
the Inline Reference dialog.

Click the ellipsis button (|...|) to the right of the Attribute field to open the 'Select Attribute or Attribute Group'
dialog.

Search for or browse to the relevant attribute or attribute group for the inline reference, and then click Select.
For Attribute Name(s), check the Include box if the name of the attribute(s) should be included in the inline
reference.

In the Separator field, type a separator to be used between the name and value of the attribute. The default is
the equals sign (=). Note that the Separator field is not activated unless the Include box has been checked.

For example, if a single attribute is chosen, and the Include box is checked, the results will look as follows:

Inline Reference =

Object Selection
Object

() Resolve To Object ID
() Resolve To Object Mame

(@) Resolve To Attribute Value and/or Unit

Attribute Selection
Attribute | Manufacturer Name ¢ !

Mame ¥ * [Value

Attribute Name(s)

> Basic Manufacturer Information | abe Manufacturer Name=~Acme Party Supplies

Include
Separator | =

Attribute Value(s)
Aspect Values(s) and Unit{s) -
Attribute Separator

K Cancel
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15. Under Attribute Value(s), select the relevant Aspect from the dropdown list. Available options are 'Value(s)

16.

and Unit(s)," 'Unit(s),' and 'Value(s).'

In the Attribute Separator field—which is only valid when an attribute group has been chosen for the
Attribute selection—type in one or more characters to specify how the attribute values should be separated.
The default is the semicolon character without a following space (;).

The following screenshot shows:

1
2
3
4

(
(
(
(

~— ~—r ~— ~—

Inline Reference
Object Selection
Object
(") Resalve To Object ID
() Resalve To Object Name

{®) Resalve To Attribute Value and/or Unit

Attribute Selection

Attribute | Manufacturer Information
Attribute Name(s)

Indude

Separator

Attribute Value(s)
Values(s) and Unit(s) -

Aspect
Attribute Separator 9

OK Cancel

x

An attribute group called ‘Manufacturer Information' selected for Attribute
A separator of = placed between the attribute name and attribute value

An attribute separator of ; placed between each attribute within the group
How the attributes and attribute values resolve in the inline reference.

; Manufacturer Information
#1117 Name »| > |Value
» Manufacturer's Part Mumber |abe (121177
» Manufacturer Name abe JAcme Party Supplies
» (Country of Origin HONG KONG
* Product Name |ah'c' Cosmic Party Hat
7 Display \
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Mame

43

Value

A

>

W

Basic Manufacturer Informati

Country of Origin=HONG KONG;Manufacturer Name=~Acme Party
Suppliez;Manufacturers Part Mumber=121177;Product Name=Cozmic Party Hat

17. Click OK to complete the configuration of the inline reference.

Inline References and Multi-Valued Attributes

The Attribute Separator field in the Inline Reference dialog does not apply to the values of multi-valued
attributes. Instead, the separator for values of multi-valued attributes is handled by the <multisep/> tag
(multisep). The multisep tag is a Character Tag in System Setup and comes standard with STEP systems.
STEP stores the values of multi-valued attributes with the multisep tag between them, and this tag typically

renders as a forward slash (/).
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multisep/ - Character Tag

System Setup

> s A

% Style Tags ' Character Tag Definition

% Special Characters Name >l * |Value

=+ Character Tags > Name multisep
----- [¢3] BeforeLastDigitinNumerator > Edited By
----- E EndFraction » Chararter Tan yltisep
----- [¢3] FractionBar » Rendering /
..... E ft > Bnow Character 1ag B3
..... g it * Keyboard Shortout
----- [&3] IntegerToFractionse r ¥ snlo '
----- [e3] LineBreak rormat S
..... E It * [InDesign < 0x0000 =
..... I | > | Add Formatting

If a multivalued attribute is used in an inline reference, the rendering setup for the multisep tag will be shown
between each of the values. In the below example, the 'Country of Origin' attribute has four values. When
rendered in the inline reference, these four values are separated by the forward slash (/) character.

§ Display
MName >
COMG KOMG
- q TAIVWAN . -
» Country of Origin ———— -hreﬂm
EXICO

For more information on STEP character tags, see the Tags topic in the System Setup / Super User Guide
documentation.

Copying Attribute Values as Inline References

An alternate—and quicker—method of creating an inline reference is to copy the value of an attribute, then paste it
into the value editor of another attribute as an inline reference. This inline reference can then be edited like any
other inline reference.

1. Navigate to the attribute value that you would like to use as an inline reference and select the value editor field.
2. Right-click and select Copy as inline reference.

§ Display
Mame * | |Value

* Basic Manufacturer Information | abe S8 Cut Ctrl+X
» Long Item Description abe Product information: ; | m.

» Ma?uﬁmrer's F‘part Mumber abe 121177 Copy llia®
> [Country of rigin HONG KONG Copy as inline reference  Ctrl+]
» Manufacturer Mame abe Acme Party Supplies = Paste Ctrl+V
» Product Name abe Cosmic Party Hat 2 Ppaste Link Ctrl+L
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3. Navigate to the 'destination’ attribute value and select the value editor field.
4. Right-click and select Paste.

?

MName 3
» Basic Manufacturer Informati|abe 3 cut Ctrl+X
* L Item Description b
» I'*:;"!;Jﬁdcura's Part Murnber |abe IE Copy curlec
> Country of Origin Copy as inline reference  Ctrl+I
* Manufacturer Name abe | Paste Ctrl+V
% Fradi4 Blamee -L:

?
Mame *
* Basic Manufacturer Informati
* Long Item Description E
* Manufacturer's Part Mumber |abe [121177
* Country of Origin HOMNG KOMG
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Christmas Party Hat rev.0.11 - Product

Tables || Category Profile | Proaf View || Status | State Log || Tasks
Product [ Sub Products ” Refere ] . .
I Inline Reference
* Status
+ LRL ™ Obiject Selection
> Walue 1 B Object | |\ Cosmic Party Hat
2 Manufacturer Information I Resolve To Object ID
Name >| > |Value (") Resolve To Object Name
» Manufacturer's Part Mumber |abe
* Manufacturer Name abe: (®) Resolve To Attribute Value and/or Unit
» Country of Origin _ _
* Product MName |ah: Christmas Party Hat Attribute Selection
@ Category Spedfic Attributes Attribute | Manufacturer Name
- Atiribute Group Attribute Name(s)
¥ Display ] Indude
Mame » | » Walue l Separator
» Basic Manufacturer Informatifabe Party Supplies ¥
» Long Item Description abe Celebrate the holidays w Attribute Value(s)

Inserting an Inline Reference using Web Ul

Rich text editing allows users to enter and edit text within a web browser. Inline references can be inserted into an
attribute value using a Rich Text Editor (RTE) within a Node Editor.

Adding an inline reference in Web Ul is similar to adding one in the workbench. For instructions, see the Rich Text
Editor section of the Web User Interfaces documentation.
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Assets

This topic covers information specific to the asset super type that is important to know when working with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), see the
All Objects topic within this guide.

An asset is any product-related electronic file, such as images (liff, eps, jpeg, etc.), Word docs, Excel files, PDFs,
PowerPoint files, text files, etc. Images are a common asset so they will be the focus of this section. In most cases,
the terms “asset” and “image” are interchangeable.

Although any image can be loaded into STEP regardless of its quality or origin, it is important that a quality check
be performed by users with graphic arts knowledge. Ideally, this check occurs prior to importinto STEP so that
only approved images are available in the system.

Classification of Assets

Asset objects live in a classification hierarchy. The classification hierarchy for assets should be separated from
other classification hierarchies (e.g., those used for alternate structuring of products, import / export configuration
storage, etc).

The recommendation is to have one classification object type and instance for each asset object type. For
example:

System Setup

= Object Types & Structures [ Assets

|j Alternate Classifications |-_=| Icons

E-- Assets |‘_=| Hlustrations
Assets [ Installation Manuals
----- | Icon [T Logos
----- =] Tlustration |‘_=| MSDS Sheets
- ----- i Installation Manual rj Owners Manual
' ----- logn Logo rj Product Images
-] M5Ds [T Product Videos
o E Owners Manual
- ----- E Product Image
----- Product Video

Within the individual type-based classifications, additional levels can be modeled if necessary. A common option is
to work with a 2-level folder structure based on the first characters of the asset file name. For example:
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=[] Product Images
=1
B0
B 11
B[ 12
@913
] 14
9015
B0
2017
w1713
"E 1714
':.] 1719

With a structure like this, it is not intended that users should be browsing the hierarchy to locate assets. Instead,
assets are typically located via references from other objects and/or via searches. Note that STEP does not
require that the image hierarchy have multiple levels. Assets can be stored in a single folder (e.g., a flat structure).
However, this is not typically recommended as it can be impractical to navigate the hierarchy as the number of
assets increases.

Notice that the same asset object can exist below multiple different classifications. However, this functionality is
typically only used for cases where suppliers upload assets. These assets will initially go into supplier-specific
classifications and can subsequently also be linked into the primary asset hierarchy.

Asset File Type Designation

New asset object types are defined in STEP the same way any other object types are, via the System Setup tab.
One key difference between asset object types and other object types, such as products or classifications, is that
there are no parent-child relations between assets, as asset instances live in classification hierarchies.

Asset object types are defined in STEP Workbench System Setup under 'Object Types & Structures.' Apart from
the built-in generic type 'Assets', it will be a flat list of the different asset object types required for the setup. For
example:
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System Setup
=2 Object Types & Structures
rj Alternate Classifications
E} Assets
Assets
..... {} Imn

- ----- ﬁ lustration
- ----- i Installation Manual

foed Logo

b @ Owners Manual

- ----- E Product Image
- Product Video

On older STEP installations you will often see asset object types that are file-type specific. For example: JPG
Image, Word Document, etc. For newer installations, this file type approach is generally not used, and instead, it is
recommended to use object types that convey information about the asset's use (as shown above), rather than the
file type. This is done for clarity as it is often more important to understand the purpose of the asset. For example,
an asset is not just a PDF file, instead it is an Installation Manual, a Product Brochure or an Owner's Manual. One
advantage of the purpose-based setup is that it is possible to restrict reference types to point to the specific types
of assets and not just to generic file types.

With the move away from file type specific asset object types, asset object types cannot be applied automatically
when digital media files are imported into STEP as there is no 1:1 relationship between file types and asset object
types. Itis possible to have object types automatically applied upon import when a file-based approach is used, but
this functionality generally does not weigh up to the disadvantages of the approach.

Asset Objects and Digital Media Files

A fundamental point when dealing with assets is that there is no 1:1 relationship between asset objects and digital
media files in STEP. Thus, it is possible to work with asset objects that do not have "content", i.e., are not tied to
any digital media files. Furthermore, the content can be dimension-dependent so that an asset is tied to different
files in different contexts. Finally, an asset can have different content in different historical revisions.
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Product Object

Asset Reference “Primary Product Image”

Asset Object

IPG File

As explained in the next section, there are different options for how and where the actual digital media files are
stored. Independently of which option is selected, asset objects are stored in STEP and it is to these objects (not to
the actual media files) that relations are modeled (using references).

Image Variants and Handling

Different publishing projects impose various requirements on the use of images. For example, a high-resolution
image in STEP may be a TIFF. However, for the web, a jpeg is needed. Or, if the high-resolution image is an EPS,
a GIF may be needed instead of a jpeg.

To handle these scenarios, STEP can use the original high-resolution image to generate the needed image
versions based on a set of templates or image conversion pipelines. When using an image conversion, the images
in STEP must be of sufficient quality to allow these variations to be properly created.

More information on image conversions is available in the Image Conversion Configuration topic in the Digital

Assets guide.

More Information

For specific details about working with assets in the workbench, see the Maintaining Assets and Linking
Assets to Products topics within this guide.

For information on working with assets in Web Ul, see the Asset Handling in Web Ul topic in the Web User
Interfaces guide.

For information on importing, exporting, and managing assets, see the Digital Assets guide.
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Maintaining Assets

This topic covers information specific to the Asset super type that is important to know when working with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), see the
All Objects topic within this guide.

Creating Assets

The basic methods for creating an asset are the same as any other object type, as described in the Creating
Objects in Tree topic within this guide. However, there are a few considerations that are specific to assets that
users should be aware of when creating assets, which are described.

Assets are essentially placeholders in STEP, to which a digital media file must be associated. \WWhen assets are
created in STEP via import of a digital media file, this association happens automatically. However, when assets
are created using standard object creation methods in Tree (e.g., right-clicking on a classification folder and
selecting 'New Asset'), itis only the placeholder that is created. An asset created in this manner will initially have
no system properties and no content. For example:

Chihuahua rev.0.1 - Images & Documents

-7 Assets A BED SRS LT S [ References || Referenced By || Status || State Log || Tasks

> [ s R ——
r—=| Tustrations Mame ¥ | ¥ |Value *llasset has
[+~ Installation Manuals o content
I—_=| Logos > D 115303 -
[ 7] MSDS Sheets > Mame Chihuahua
r—=| Owners Manual * Object Type Product Image
=[] Product Images

EHj 1 * Revision 0.1 Last edited by USERS on Sun Jan 29 10:58:10 EST 2017

EI—:I 17 * JApproved 3€ never Been Approved
JE 123456 * [Translation Mot Translated

B ZE@ » Path Classification 1 rootfAssets/Product Images/1/12/Chihuahua

B4 * ProductsGaloreAttribute abe

B8 9

{9 Mo System Properties

A user can right-click on the asset and select Replace Asset Content to open a dialog where a digital media file
can be selected from the local machine. STEP will automatically read and populate the properties of the asset, and
a thumbnail of the digital media file will display. For example:
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Chihuahua rev.1.0 - Images & Documents

Images & Documents References || Referenced By || Status || State Log || Tasks

MName > » Value >
> D 115308
» MName Chihuahua
» Dbject Type Product Image
» Revision 1.0 Last edited by USERS on Sun Jan 29 10:559:56 EST 2017
» Wpproved x Mever Been Approved
* Translation Mot Translated
» Path Classification 1 rootfAssets/Product Images/1/12Chihuahua
» ProductsGaloreAttribute abe

@ SystemPropertes:

Mame | > Malue >
» Class abe True color
» Colorspace abe RGB
> Compression abe JPEG
» Depth i 8 (bits/sample)
> Extension abe [jpg
» Filename abe |130. PG
» Format abe JPEG (Joint Photographic Experts Group JFIF image)
» Height 123 [1151.46 (mm)
» MIME Type abe jmagefjpeg
* Pixel Height fl:: 3264 (pinels)
> Pixel Width il:: 2448 (pixels)
» Profile abe Custom EXIF, Custom XMP
» Samples i |3 (samples/pixel)
> Bize abe (2,270,288
> Ipload Time abe (2017-01-29 10:59:56
* Width 123 863,59 (mm)
» Horizontal DPI 122 |72 (dpi)
* Mertical DPL 122 (72 (dpi)

To avoid this two-step process, assets are often introduced in STEP via import (or specific transfer protocols for an
initial implementation). More information on importing assets is available in the Importing Assets section of the
Digital Assets guide.

Asset Editor

General information about editing objects in STEP is available in the Editing Objects in Tree topic within this
guide and is not repeated in this section. However, assets have some additional editing options specific to working
with digital media files, which are described.

Images & Documents

The Images & Documents tab is the primary workbench interface for assets. It has three sections, described
below.
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[ References ” Referenced By ” Skatus ” State Log ” Tasks ]
ame * |Value »

* D 115308

* MName Chihuahua

* Object Type Product Image

» Revision 1.0 Last edited by USERG on Sun Jan 29 10:59:56 EST 2017 Edit Asset

» \Wpproved 3 Never Been Approved External Viewer
» Translation Mot Translated Save to disk
> Path Classification 1 root/Assets/Product Images/1/12/Chihuahua Image Viewer

me ¥ |Value >

* Class abe True color

* Colorspace abe RGE

> Compression abe JPEG

* Depth 1 EE Fi{bits,-‘sample}

» Extension abe |jpg

* Filename abe |136.1PG

* Format abe IJPEG (Juint Photographic Experts Group JFIF image)

* Height 123 [1151.46 {mm)

* MIME Type abe image fjpeg

* Pixel Height il:: 3264 (pixels)

* Pixel Width iz 2448 (pixels)

* Profile abe Custom EXIF, Custom XMP

* Samples il 3 (samples fpixel)

» Size abe (2,270,283

* Upload Time abe |2017-01-29 10:59:56

> Width 123 363,59 (mm)

> Horizontal DPI 123 (72 (dpi)

» |'.|’Eftim| DPI 122 72 (dpi)

1STIBOSYSTEMS

DATA MANAGEMEMNT

1. The Description flipper contains the same basic information as other object types. Additional Description
attributes can be made valid for assets to support data such as keywords or asset descriptions. Specification
attributes cannot be made valid for assets.

2. The System Properties flipper displays data that is read automatically from the digital media file. This
information cannot be edited.

3. The asset thumbnail has a number of options available for editing assets. Additional right-click options are also
available when the asset itself is right-clicked from the Tree. All of the options that are specific to assets only
(accessible from right-click on the thumbnail or the asset) are described below.

» Create Local Content of Asset: Creates a local version of the asset specific to the current context. See
the Asset Dimension Dependencies section below for more information.
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« Delete Local Content of Asset: Deletes the content of an asset that is not dimension dependent. Deletes
the local (context-specific) content of the asset if the asset is dimension dependent. See the Asset
Dimension Dependencies section below for more information.

o Edit Asset: Opens the digital media file for editing in an external program, in addition to an Edit Asset dialog
in STEP. Upon completion of editing in the external program, click save within the program to store the
edited asset to a temporary directory. Then click OK in the Edit Asset dialog in STEP to have STEP retrieve
the edited file from the temporary directory and store this in the asset. Note that the media file will open in the
application associated with the file type. For example, for files ending with .xIs, Excel will automatically be
launched. This may be different from computer to computer. One user’s computer may open up EPS images
in Photoshop, while another user’s computer may open the same file types in lllustrator.

» Export Images & Documents: Opens the Export Images and Documents wizard to make selections to
export the currently selected asset(s). See the Export Images and Documents Wizard topic in the Digital
Assets guide for more information.

« External Viewer: Opens an external viewer for viewing the asset. This is comparable to the Edit Asset
function in that the program that is utilized is specific to the file type and the user's computer settings. It differs
in that any changes made to the asset in the external program are not saved back to STEP.

» Image Viewer: Opens an image viewer within STEP for the user to examine the actual asset (as opposed to
just the thumbnail).

o Push Asset(s): Initiates asset push for the selected asset(s). See the Asset Push section of the Digital
Assets guide for more information.

« Replace Asset Content: Opens a dialog for the user to select a digital media file for the asset. See the
'Creating Assets' section above for more information.

« Save to disk: Opens a standard save dialog allowing the user to select a location on their local machine to
save the digital media file to.

« Unlink asset: Only enabled if the asset has been linked directly into a publication, in which case it unlinks
the asset from the publication. See the Publication Hierarchy section of the STEP Publisher (Adobe
InDesign Integration) guide for more information.

References

The References tab displays the classifications that the selected asset is linked to, and allows for linking to
additional classifications using the Link to Classification link. Each asset must be linked to at least one
classification, but may be linked to many. Links can be removed by right-clicking on the row indicator and selecting
'Remove Link to Classification'. The Name of each classification displayed is hyperlinked for easy navigation, and
revision, approval, and translation statuses are also displayed.
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Chihuahua rev.2.0 - References

* Images & Documents Referenced By || Status || State Log || Tasks

ID > [Mame >

Ohject Type

» |Revision

W
W

Approved Translation

> B735 12

Aszet Level 2

0.3 Last edited by USERE ...

3 Last Approved on Thu... Not Translated

| W

Link to Classification

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). The
display of the Referenced By tab on an asset will vary slightly from system to system, based on the data model.

BT Assets

[T Icons

B[] Tustrations

[T Installation Manuals
[T Logos

[#-[] MSDS Sheets
[+ 7] Owners Manual

EH |“_=| Product Images

51
=

[ @ Chihuahua
w2
B4
w e
39

Reference Type | » |Source

123456 rev.3.1 - Referenced By

= Images & Documents || References Status || StateLog || Tasks

Image Display Sequence >

» [Thumbnail >

Caption 1 * |Caption 2

W

Primary Product Image +

&

v

Product Images +

};]F 18210 M B

> |Area Used

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a source for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User guide.
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2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what is
described for the Reference Flippers section above. The only difference is that this area displays references
that have not been placed in attribute groups for display purposes.

3. Used on Page: Displays publications that the selected object is used in. Additional information about working
with publications is available in the STEP Publisher section of the online help.

Status

The Status tab provides general information about objects, including revisions, translation status, and approval
status. For more information on these basic settings, see the Status Tab topic in the Products section of this guide.
For assets specifically, this tab also includes an Asset Push Status section that describes the status of assets for
the various asset push configurations on the system. For more information, see the Monitoring Asset Push topicin
the Digital Assets guide.

State Log

The State Log tab allows users to view the recent history of the object across all workflows in which it has been
entered. See the State Log Tab topic in the Workflows documentation for more information.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the
user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More
information on the Tasks tab is available in the 'Moving Tasks through a Workflow in Workbench' topic in the
Workflows guide.

Asset Dimension Dependencies

Individual asset object types can be made dimension dependent using the Dimension Dependencies parameter
on the object type. This configuration will only affect the STEP Name of assets, meaning that it allows for individual
assets to have a different name based on the indicated dimension dependencies (e.g., 'Red Hat' in English and
'Chapeau Rouge' in French when the dependency is Language).
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Icon - Object Type

Object Type References || Log
' Description

Mame * | » |Value
> D Tcon
> Mame Icon

> Last edited by

2017-01-29 12:07:47 by USERG

* Mame Pattern

> [ID Pattern [id]
* [con 'E
application/postscript
» MIME Types mage ftif
mage/tiff

» Dimension Dependendies Language;

» Reference Target Lock Policy Strict

Itis also possible to make the content of assets dimension dependent so that an assetin STEP can be tied to
different digital media files in different Contexts. This is configured using the Image & Document Settings >
Dimension Dependencies parameter in System Settings.

-5 Web Uls

(5] workflow Profiles
5 workflows
Derived Events

o Ohject Types & Structures
% Tags

-+ Uniits

@B
B\h Reference Types
++ Workspaces
@ Table

{E. Keys

Ii Event Queues
Component Models
-9 Recyde Bin

-

System Setup L 4 System Settings
[system settings [JR)

2= Classification Hierarchy Settings
% Image & Document Settings

» Dimension Dependencies

» Store assets and DTP documents in

Language;

Database

* DTP asset source

Asset Push

* Pregenerate thumbnail cache on upload

Mo

» Disable auto-deanup of thumbnail cache

Mo

» Transformation Lookup Tables follow asset dimension d...

M

» \izset Import Compatibility Mode

Simple

This setting is global, meaning it applies to all assets. Unless there is a very special reason for turning on asset
dimension dependencies, this should be avoided. As mentioned, the setting is global, meaning that special
procedures must be implemented for creating assets that are to have the same content in all contexts. Thus, if you
import a digital media file (and via this create an asset instance) in a context that does not use the top-level
dimension point for the dimension on which asset content depends, the content will be created only in the
dimension point the current context uses.

For additional information, see the Image & Document Settings topic in the System Settings documentation.
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Custom Asset Metadata

When importing assets into STEP, System Properties attributes can be automatically created in STEP on the
asset, and then populated with the image metadata detected on the incoming assets. The image metadata must
be formatted as either XMP (Extensible Metadata Platform) or EXIF (Exchange Image File). Determination of
which metadata attributes should be housed in STEP is configured manually.

In animage file, image metadata is stored as plain text in XML format. Based on the configuration file and import
shown below, the Creator, Subject, and Description metadata will be written to STEP. In the following sample,
some rows have been removed for brevity, as indicated by '...".

L[H <x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="Adobe XMP Core 5.3-c887 1.136881, 2018/86/1©-18:11:35 ">
2H  <rdf:RDF xmlns:rdf="http://wnv.w3.0org/1999,/82/22 -rdf-syntax-ns#">
<rdf:Description

rdf:about=""

xmlns:xmpMM="http://ns.adobe.com/xap/1.8/mm/"

=l M oW f W

E <dcicreator: —
= <rdf:5eq>»
9 <rdf:1i>0KL Photo:RM Style:RM</rdf:1i>
@ </rdf:Seqg>»
11 </dc:creator:
12% <dc:isubject: fem—

= <rdf:Bag>
14 <rdf:lizlucite</rdf:1i>
15 <rdf:lizbox</rdf:1i>
16 <rdf:lizchest</rdf:1i>
17 <rdf:liztrunk</rdf:1i>
18 </rdf:Bag>
19 </dc:subject>
<dc:description

<rdf:Alt:

<rdf:11i xml:lang="x-default">Lucite trunk</rdf:1i:

o <frdf:Alt>
</dc:description>

=@
THT

W R

L%

</rdf:Description>
</rdf:RDF>
< /% xmpmetas

(s3]
T

]
I

[ O S S T S T S R O e ]
1
T

[=:]

Prerequisites

The user should have a basic understanding of XML, the XML structure of image metadata, and XPath before
proceeding with configuration. The configuration file uses XML to define attribute names and the XPath query to
retrieve metadata. For more information, search the web.
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XMP Configuration File
The custom asset metadata configuration file uses the instruction 'XmpConfiguration' to define the name of the
system attributes being created in STEP and the XPath that defines how to retrieve the image metadata.

XPath is an XML query language STEP uses to search the XML within an image file and identify the desired
metadata. The XMP configuration file defines the XPath queries to be run against an image file being imported.

The following sample configuration file defines three metadata attributes (Creator, Description, and Subject), and
the XPath query required to find the corresponding metadata.

1] «<XmpConfiguration>
23 <XmpProperties allow="true">»
3

4 <XmpProperty

5 name="Creator” unit=""

6 xpath="/*[name(.)="x:xmpmeta"]/*[name(.)="rdf:RDF ]/*[name(.)="rdf:Description’ ]/*[name(.)="dc:creator"]/*[name(.)="rdf:5eq" ]/*[name(.)="rdf:11" ] />

7

8 <XmpProperty

9 name="Description” unit=""

18 xpath="/*[name(.)="x:xmpmeta"]/*[name(.)="rdf:RDF']/*[name(.)="rdf:Description’]/*[name(.)="dc:description’]/*[name(.)="rdf:Alt" ]/*[name(.)="rdf:1i"]"/>

11
12 <XmpProperty

13 name="5ubject” unit=""

e xpath="/*[name(.)="x:xmpmeta"]/*[name(.)="rdf:RDF' ]/*[name(.)="rdf:Description’ ]/*[name(.)="dc:subject’ [/*[name(.)="rdf:Bag’]/*[name(.)="rdf:1i']"/>
15

16 - </¥mpProperties»

17 b ¢ /XmpConfiguration>

In the above example, the 'creator' attribute is defined by the text:

name="Creator" unit=""

The XPath to find the creator metadata is defined by the text:

xpath="/* [name (.)="x:xmpmeta']/*[name (.)="rdf:RDF']/* [name
(.)="rdf:Description']/*[name (.)='dc:creator']/*[name(.)="rdf:Seq"']/*
[name (.)="rdf:1i"]"/>

Another example (an XML block in an image file and the XPath):

<x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="XMP Core 4.4.0-Exiv2">
<rdf:RDF xmlns:rdf="http://www.w3.0rg/1999/02/22-rdf-syntax-ns#">
<rdf:Description rdf:about=""
xmlns:iptcExt="http://iptc.org/std/IptcdxmpExt/2008-02-29/"
xmlns:xmpMM="http://ns.adobe.com/xap/1.0/mm/"
xmlns:stEvt="http://ns.adobe.com/xap/1.0/sType/ResourceEvent#"
xmlns:plus="http://ns.useplus.org/ldf/xmp/1.0/"
xmlns:GIMP="http://www.gimp.org/xmp/"
xmlns:dc="http://purl.org/dc/elements/1.1/"
xmlns:tiff="http://ns.adobe.com/tiff/1.0/"
xmlns:xmp="http://ns.adobe.com/xap/1.0/"
iptcExt:DigitalSourceType="http://cv.iptc.org/newscodes/digitalsourcetype
/digitalCapture"
xmpMM: DocumentID="gimp:docid:gimp:7620dabd-£f6a6-435f-a865-
ff3b8315b650"
xmpMM: InstanceID="xmp.11d:9c338c25-620b-4d53-adc7-c2a921b771cd"
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xmpMM:OriginalDocumentID="xmp.did:e19d764e-1731-46ca-9fel-
8c86d0b29d05"

plus:ModelReleaseStatus="http://ns.useplus.org/1ldf/vocab/MR-LPR"

GIMP:API="2.0"

GIMP:Platform="Windows"

GIMP:TimeStamp="1613727775463349"

GIMP:Version="2.10.22"

dc:Format="image/png"

tiff:0Orientation="1"

xmp:CreatorTool="GIMP 2.10">

<XmpProperty name="GIMP Version" unit="" xpath="/*[name(.)="x:xmpmeta']/*
[name (.)="rdf:RDF']/* [name (.)="'rdf:Description']/* [name (.)="GIMP:API'] |
/*[name (.)="x:xmpmeta']/*[name (.)="rdf :RDF']/* [name
(.)="rdf:Description']/@* [name (.)='GIMP:API']" />

Using an XMP Configuration File

1.

N o g~

Create and save a custom asset metadata configuration file using XmpConfiguration instruction as shown
above, that defines:

« the image metadata attribute name(s)
« the appropriate XPath to the required metadata on the image

Save the configuration file to the STEP server in the same directory as the sharedconfig.properties file.
Edit the sharedconfig.properties file and include the case-sensitive XMP.ConfigFile property as follows,
where 'customxmpconfiguration.xml' is the name of the configuration file created above.

XMP.ConfigFile = customxmpconfiguration.xml

Save the sharedconfig.properties file.

Restart the STEP server to apply changes to both configuration files.

Import an image that includes the metadata attributes defined in the XMP configuration file.
Navigate to the imported asset to view the metadata assets on the System Properties flipper.

Custom attributes are identified in the STEP asset editor by the text 'asset.' which is prepended to the attribute
name (for example, 'asset.Creator').

(Pmduct_SDT1l]l]1l]_]mage_l rev.1.1 - Ima

D |j Product Images . =
' System Properties:
Prm_gjrmum_m_ll Mame | > |Value »

» fasset, Creator 12a OKL Photo:RM Style:RM

- r_=| 4 > lasset.Description |12 Ludite trunk

--r_=|6 » lasset. Subject 12a |udite;box;chest;trunk

F-T] 8 > lasset.Title tza 50T 10010

r_=| A * Class abe True color
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Important: Custom coding by Stibo Systems can be used to allow attributes to be displayed in workbench
with names other than 'asset.[attribute name]'. For more information, contact your Stibo Systems
representative.
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Linking Assets to Products

If the asset’'s name can be matched to the product, then this function can be performed when the asset is imported.
If not linked at this time, there are two ways that the interface allows the link to be made: a) from the product or b)
from the asset.

There are three ways to link images to products:

o From the product
o From the asset

o Fromimport

Linking Assets to Products (From Products)
1. Select the product and then select the References tab.

I Product ” Sub Products l[ Referenced By ” Images & Documents ” Commercial ” Tables ” Category Profile ” Proof View H Status ” State Log ” Tasks l

2. Navigate to the Image References section of the References tab. Click on the + symbol to link the image to the
correct area. For this example 'Primary Product' will be used as it is the most common reference type made.

@ ImageReferences

Reference Type w| ¥ [Target * [Thumbnail
> |Brand Name Loge  + |k
» |Tlustration + 5
» PﬁmarvProduct...I + 1
> |Product Image + (i
* |Video + m

3. A search window displays.
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[ 1 Select Asset (Reference Type = Primary Product Image) >

Browse Search |

|'_=| Classifications

rj Configurations

|j Merchandising Hierarchy
|j Suppliers

-] Web Sites US

i Primary Product Hierarchy

&=

4. Search for and select the appropriate image. By selecting 'Primary Image,' it denotes that the image is the
exact representation of the product. Once a Primary Image has been linked to a product, a thumbnail of the
image will appear when the product is selected.

7

_F‘.EFeren::eType w| » [Target * [Thumbnail
> |Brand Name Logo  + |52 \

* | Tlustration + n

* |Primary Product Image EEME I
> |Product Image + (i

* |Video + m

Linking Assets to Products (From Assets)
1. Selectthe image in the Assets folder in the Tree. Then, select the References by tab.

[ Images & Documents " References ][ Skakus ” State Log ” Tasks ]

2. Ifitis not already open, click on the 'Image References' flipper to open it. Click on the + sign for 'Primary
Product Image' to link the image to the product.
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[ Images & Documents ” References ][ Stakus " Stake Log ” Tasks ]

|-¢

Reference Type w| * |Source * [Thumbnail
> |Primary Product ... | + |52
* |Product Image + m
7
Reference Type w| * |Source » »
7
Publication * |Version * |Page * |Area Used

3. Navigate to the Product in the pop up window, and select it.

Browse [ECET |

[ Select Asset (Reference Type = Primary Product Image) X

-] Assets
r_=| Configurations
r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
-7 Web Sites
Eli Primary Product Hierarchy
E}i Products
Eli Apparel
[+-[[T) Head Wear
E}i Upper Baody Wear
[=I-{I5) T-shirts
=il T-shirts Items
; E]i Hanes T-shirts

4. Selected image will be linked to the product. Once a Primary Image has been linked to a product, a thumbnail
of the image will appear when the product is selected as illustrated in the below image.
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Tree 20701 rev.1.4 - Referenced By
L:_|r_=| Assets Images & Documents || References Status || State Log | Tasks

-] (QAIcon)
-] Icons _
r_=| Tlustrations Reference Type v » [Source * [Thumbnail >
(-] Installation Manuals » lcal Green +
[+~ Logos
B[] MSDS Sheets _ .
: > (P Entity I +
B[] Owners Manual rimary ty mage nr
E}|'_=| Product Images

B L B 119613

g2 |

E g * [Primary Product Imaage | + n P Jinch heels

n h Red and Gold heels

Linking Assets to Products using the Import Manager

This method is best used for large amounts of products / assets linking. Ideally, you should already have a file in
Excel that has the products and desired Image ID set up according to how you want them to be after import.

1. Goto File and select Import, then Data. An 'Import Manager' window will appear. On 'Select Data Sources',

click the ellipsis button (E) next to 'Filename' and select your file.

1 Import Manager

Steps Select Data Source

1. Select Configuration Data Source File

2. 5elect Data Source
3. Select Format

Retrieves contents from files reachable from your local computer,

4, Map Data Filename | TnputFile., txt

5. Identify Objects

6. Identify Destination
7. Select Business Rules
8. Advanced Settings

| Back | | Next |

2. Proceed to the 'Map Data' step. Select a source column and click the Map button. Map the column holding IDs
to'ID', map the column holding the asset to be referenced to 'Asset Reference'. After selecting the 'Asset
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Reference' radio button, select the 'Primary Image' radio button. For more information on mapping, see
Inbound Map Data - Map in the Data Exchange documentation.

[1 Map <Name> to >
p

D
O Target ID Aspect 1D o
() Name

() Attribute

() Product Classification Link

() Product Reference

(7) Classification Reference () Brand Mame Loga

(™) Hustration

Entity Reference
O () Installation Manual

() Reference Meta-Data (7)1 M3DS
O parent () Owniers Manual
aren
(@) Primary Product Image:
() Object Type ) Product Image
() Variable © Video

() Multivalued Variable
() Overrides product
() add child to override

() Data Container

[ ] Mandatory

Cancel | | OK |

3. Click OK to close the Map To dialog.

4. Ifthe image IDs were not found or the import file data was not done correctly, then columns will appear in red.
For information on input files, see Asset Reference - Map Inbound in the Data Exchange documentation.
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[ Import Manager *
Steps Map Data
1. Select Configuration Source;
2. Select Data Source <ID> » |<Mame = *
3. Select Format 18210 18210 MEB
4, Map Data 18212 182121 B
5, Identify Objects s e
6. Identify Destination
7. Select Business Rules < >
8. Advanced Settings Resulke Map to:
ID=<ID> " rimaryProductimage AssetReference=<MName > @
13210
18212
18213
Auto Map | I Map | | Constant | | Remove | | Transform | | Generate Profile |
| Back || MNext | Finish | | Cancel |

STEPXML Import

It is also possible to link the images to product via STEPXML import. The following code snippet, shows an
example XML file shown below:

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ContextID="Context7" WorkspaceID="Main"
UseContextLocale="false">

<Products>
<Product ID="18210" UserTypelD="Item" ParentID="18209">
<Name>18210 M B</Name>
<AssetCrossReference AssetID="20584" Type="PrimaryProductImage"/>
</Product>
</Products>

</STEP-ProductInformation>
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Classifications

This topic covers information specific to the Classification super type that is important to know when working with
classifications. For general object maintenance information (applicable to all object types rather than specific to
classifications), see the All Objects topic within this guide.

Classifications are used to build hierarchies and objects that bundle other objects into organized groupings. For
example, images, manuals, and icons could be uploaded to STEP as assets and stored in appropriate subfolders
under the 'Assets' classification folder. Product objects could also be linked into classifications to provide
alternative categorizations of objects that vary from the product hierarchy structure.

Classification Editor

The primary editor for classification objects is the Classification tab.

T-shirts and Sweatshirts rev.0.3 - Classification

B 7] Assets Sub Products || References || Referenced By || Images & Documents || Tables || Status || StateLlog || Tasks
- "] Configurations '?
[#-{7] ETIM Hierarchy I
H > >
F-{7] Index Words Mame Value
[+-[ 7] Merchandising Hierarchy > ID 22586
B[] Suppliers » Name T-shirts and Sweatshirts
-] Web Site
7 Er‘jﬁ Ac:'n:ReE“ Web Site > Pbiect Type ebLevel 3
E‘ij Apparel » Revision 0.3 Last edited by USERY on Mon Dec 26 07:24:26 EST 2016
B |'_‘=| Mens Casual > pproved x Last Approved on Mon Aug 08 10:59:21 EDT 2016
""" - Caps > Translation Mot Translated
E| |_'_=| dl'tsald Sweatshirts
I_ 18207012 > Path Classification 1 rootf\Web Sites/Acme Retail Web Site/ApparelMens Casual/T-shirts and Sweatshirts
L....|_, 18214-012 > Misibility
""" l_ 18215-012 » Landing Page Copy abe
----- |_ 18217012
----- “o|lm) 18217054
-~ [2] Women's Apparel

This tab will display all description attributes that are valid for the classification. Note that only description attributes
are available on classifications (as opposed to products, which can also have specification attributes). More
information on description attributes is available in the Description Attributes topic of the System Setup /
Super User Guide.

Sub Products

When on a classification, the Sub Products tab is used to display objects of the product super type that are linked
into the classification via Product to Classification links. When the selected classification does not have product
children (e.g., classifications used to house assets or configurations), the Sub Products tab does not provide any
meaningful information.
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[H-[T] Configurations
[H-[ ] ETIM Hierarchy
-] Index Words
(-] Merchandising Hierarchy
-] Suppliers

=[] Web Sites

EH{7] Acme Retail Web Site

Elr'_=| Apparel
E]|"_=| Mens Casual

[+-[T] Automotive

[T Building and Electrical Products
[-{ii| Entity Root

[--(E) GDSN

[]---ﬁ Publications

(-] Primary Product Hierarchy

£

£

£

(5 Collections
H-[E3 eCatalogs
:I--ﬁ Recyde Bin

View: Show all w

T-shirts and Sweatshirts rev.0.3 - Sub Products

Classification References || Referenced By || Images & Documents || Tables || Status || State Log Tasks
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15207012 » 18214012 » 18215012 »|18217-012 »|18217-054
D > 18207 18214 18215 18217 100305
Mame » |18207-012 15214012 15215012 18217012 15217-054
Cbject Type > [Sales Item Sales Item Sales Item Sales Item Sales Item
Revision » 0.2 Last edited by USER o... 0.3 Last edited by USERL ... 0.4 Last edited by USERL ... 0.3 Last edited by USERL ... 0.22 Last edited
Path » |Primary Product Hierarchy... Primary Product Hierarchy... Primary Product Hierarchy. .. Primary Product Hierarchy. .. Primary Product
Approved > | € Last Approved on Mo... |3€ Last Approved on Mo... |3€ Last Approved on Mo... |3€ Last Approved on Mo... | Approved or
Translation > Mot Translated Mot Translated Mot Translated Mot Translated Mot Translated

Completeness Score

Classification 1 root | Web

Classification 1root | Web

Classification 1 root | Web

Classification 1 root | Web

Classification 1

Sites | Acme Retail Web Site Sites | Acme Retail Web Site Sites | Acme Retail Web Site Sites | Acme Retail Web Site Sites | Acme Ret
Category > || Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens Casual | || Apparel | Mens
T-shirts and Sweatshirts | T-shirts and Sweatshirts |  T-shirts and Sweatshirts | [T-shirts and Sweatshirts |  [T-shirts and Swe
18207-012 18214-012 18215012 18217-012 18217-054
Object Type » [Sales Item Sales Item Sales Item Sales Item Sales Item
Parent » |T-shirts T-shirts T-shirts T-shirts T-shirts
Product Variant Priority >
Released by >
Status >
LIRL >
< >
L Add Product

Data can be edited on the products linked into a classification from the Sub Products tab by clicking directly into
any editable field. Standard editing capabilities are available within this interface (as described in the Editing
Objects in Tree topic within this guide), including copy / paste functionality using Crtl + C and Crtl + V. Right-
clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and Mark
Different selections - all of which are self-explanatory and can be especially useful when editing multiple objects.
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T-shirts | T-Shirts Sales T-shirts | T-5hirts Sales
Itemns | T-shirts Items | T-shirts
a8 Ccut Ctrl+ X
Copy Ctrl+C
[B Paste Ctrl+V
8.97 e
$ &= Paste Link Ctrl+L
5000 Rotate Table
2000 Hide Equal
Mark Different
The Hane:
For over 2 Hide/Show Attributes
the stand:
comfort ar :
t's better REy
offeri
vt I
Cherride
Recalculate
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Two views are available using the Rotate Table option. As shown above, the view can be organized to have
attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Right-
clicking within the header field exposes different options than within the data fields, including options to add and
remove products.
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Selecting Remove Product deletes the product to classification link between the objects, but does not delete the
product itself.

Selecting Add Product opens a dialog allowing the user to browse hierarchies to select a product to link, as well
as specifying the link type to be applied.

D Select Classification Product Link >
E}l‘_=| Ipper Body Wear -

[+-[F Scarves

--|'_‘=| Sweaters

E-E5 T-shirts
-] T-shirts Items
=T T-Shirts Sales Items

-] 1009143

-l 198623

..... IL 183400

----- |.. [18207-011 w
== Details
Link TyPe | yebsite Link v

care

Note that the same functionality is available using the Add Product link at the bottom of the Sub Products editor.

References

The References tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has privileges applied, has objects visible in
other contexts, or has any linked attributes, that information can be viewed (and in some cases edited) on this tab.

The display of the References tab on a classification will vary slightly from system to system, based on the data
model. If the selected object has classification reference types for which the object is a valid source, those will
appear on this tab, in addition to the default flipper options.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 176



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

T-shirts and Sweatshirts rev.0.5 - References

-] Assets ~ Classification || Sub Products Referenced By || Images & Documents || Tables || Status || State Log || Tasks
= (5 Confraons Powe

r_=| ETIM Hierarchy
r_‘=| Index Words
[H-{5) Merchandising Hierarchy |

Reference Type w| > [Target > >

> |Classification Reference  + [

-] Suppliers Q@
F—Hj Web Sites &Ref&renc& Type v| » [Target »
Elj Acme Retall Web Site | » |Related Web Classification 4 \m [ Mens Tops. E
=[] Apparel
 Appledprivieges
&Wies to > |Action Set > |Attribute Group  » |Object Type > |Group > |Language > |Country >
» [[7] T-shirts and SweatshirtiClassify Products Merchandiser Managers/<ANY = <ANY >
Add Privilege
g
Mo Visible Objects in Other Contexts
: QoAb
P EIISZIT—OS‘} D > [Name » |Attribute Groups > |Mandatory * |Inherited from ¥
-[Z] Women's Apparel
[-[ ] Automotive ¥ [Color Color Apparel
&[] Building and Electrical Products > fize Size L
[]..i Entity Root i Link to Attribute

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created to the object selected in the dialog from the currently selected object that you are
standing on (e.g., current object = source, dialog selection = target). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User Guide.

2. Ungrouped Classification References: The functionality is identical to what is described for the Reference
Flippers section above. The only difference is that this area displays references that have not been placed in
attribute groups for display purposes. If all references that are valid for the selected object have been placed in
attribute groups, the Ungrouped Classification References flipper will not be present.

3. The Applied Privileges flipper allows users to apply privileges to the selected classification. Detailed
information on creating and editing privileges is available in the Privilege Rules section of the System Setup /
Super User Guide.

4. The Visible Objects in Other Contexts flipper displays subproducts that are visible in another context, which
is only applicable if classification hierarchies have been set to be dimension-dependent in System Settings.
See the Classification Hierarchy Settings topic in the System Setup / Super User Guide for detailed
information.

5. The Attributes flipper allows the user to view attributes linked to the classification, as well as to add new links
using the Link to Attribute link. When attributes are linked to a classification, they are available to be
populated on any objects of the product super type that reference the classification (assuming the attributes are
also made valid on the applicable product object type). The exact columns available will depend on the data
model and the attributes that have been made valid on the attribute links. Whether or not the various attributes
are editable will also depend on the setup of the data model. However, an ID and Name field are always
shown, with the attribute name being a hyperlink that can be used to navigate directly to the attribute. An
Attribute Groups column is also present, displaying the attribute group(s) that the attribute is in. A Mandatory
column is present and if checked, product objects that reference the classification cannot be approved until a

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 177



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

value has been provided for the attribute. Note that mandatory settings on the attribute itself apply globally,
while mandatory settings on the attribute link apply only to product objects that reference the classification at
which the attribute is linked (or reference a classification that is inheriting the link). More information on
mandatory settings is available in the Mandatory Attributes topic in the System Setup / Super User Guide.

If the attribute link is inherited (indicated by a green down arrow, =, in the row indicator), the 'Inherited from'
column will display the parental node where the attribute has been linked, which is hyperlinked for easy
navigation. More information on linked attributes is available in the Inheritance in the Product Hierarchy topic
within this guide and in the Attribute Links topic in the System Setup / Super User Guide.

Referenced By

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by a match code or is used by any publication, that information can be viewed on this
tab.

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

T-shirts and Sweatshirts rev.0.5 - Referenced By

Ellj Acme Retail Web Site # ||| Classification || Sub Products || References |BRELEGENHEGNHN [ Images & Documents || Tables || Status || State Log || Tasks
=[] Apparel ®
E-[7] Mens Casual
: Reference Type w| » |Source | >
|“_=| Caps
..... 7] Mens Tops Classification Reference  + \E_j.
Eide-haﬂSan.ls 7 Ungrouped Referenced by Products, Classifications or Entities
""" I— 18214-012 |Ref'erence Type v| > |Source >| >
----- |_ 18215-012
IL 18217-012 @ Used by Match Code Objects
----- |_ 18217-054 |ID > |NamE > |
i ----|;_=|t°Won;ens Apparel @ Used on P
O u. -mo ve ) |Pub|icah'on > |'Uersion » |Page > |.\'-\rea Used > |Page Type
[~ Building and Electrical Products

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User Guide.

2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what is
described for the Reference Flippers section above. The only difference is that this area displays references
that have not been placed in attribute groups for display purposes.

3. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match
code will display. For example:
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System Setup Find Similar - Match Code
EE Match Codes and Matching Algorithms s Match Code Values || Statistics Log
o Fdse] — '
. <] Find Similar
EE; Outbound Integration Endpoints MName >| > |Value
-£5) Web Uls » ID FindsSimilar
E‘E Workflow Profiles * Mame Find Similar
-5 Workflows :
(=] Derived Evens > Last edited by 2017-01-24 12:34:34 by USERG
%ﬂ Ohbject Types & Structures » [Category T-shirts and Sweatshirts (22586)
- Tags > Match Code Window Size 1
f=I-{ = [rshirts and Sweatshirts|  Used by Match Code Objects
-l 18214012 D > IName > [Edited by >
-\l 18215-012 > Findsimilar Find Similar  2017-01-24 12:34:34 by USER&

More information on match codes is available in the Matching, Linking, and Merging documentation.

4. Used on Page: Displays publications that the selected object is used in. Additional information about working
with publications is available in the Publication Hierarchy section of the STEP Publisher guide.

Images & Documents

The Images & Documents tab displays all assets that are child to the selected classification (e.g., all assets that are
housed within that classification). Note that assets can be tied to classifications in two ways: as child products, or
via image and document references. Assets are typically referenced to classifications only when the classification
contains non-asset children for which the asset is relevant. In any case, assets referenced to classifications are not
visible on the Images & Documents tab. This is in contrast to how the same tab functions for products, where the
tab displays all assets referenced to the selected product. However, for the displayed assets (those that are child
to the classification), the functionality available for interacting with the assets is the same as what is available for
referenced assets on a product, which is described in the Images and Documents Tab topic in the Products
section of this guide.

Tables

The Tables tab allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more information, see
the Tables guide.

Status

The Status tab provides information about the status of the object, including revision history, translation status, and
approval status. Products and classifications share a common Status tab, which is described in the Status Tab
topicin the Products section of this guide.
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State Log

The State Log tab displays the history of the selected object across all workflows. If the object has ever beenina
workflow, aflipper is displayed per workflow and the history of transitions of the object within that workflow can be
viewed. Detailed information on the State Log tab is available in the State Log Tab topic in the Workflows guide.

Tasks

The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the
user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow. More
information on the Tasks tab is available in the Moving Tasks through a Workflow in Workbench topic in the
Workflows guide.
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Collections

Collections provide a valuable tool for data maintenance tasks. Collections are containers for storing sets of
objects from Tree and System Setup, independently of their placement in the hierarchies. A collection can be
created via a search or import, and all objects in a collection can be updated at the same time. Collections and
collection groups are found in the Collections hierarchy on the Tree tab.

When multiple collections need to be grouped together, they can be put into a 'collection group'. Collection groups
can also hold other collection groups. See Creating Collections or Creating Collection Groups in this
documentation for more information on each topic.

Tree
r_=| Primary Product Hierarchy

-5 Collections
[+ [5] All PPH

=8

()

- [5] Copy Writing State
}@ Temporary Collections
—}-@ Tshirt Group

E@ Men's Tshirts

| B[ Size Medium

-5

For more on data maintenance of collections and collection groups, see the Maintaining Collections topic.

Temporary Collections

The Temporary Collections node is system-generated to store read-only collections created by a process, such as
bulk update background processes, exports, profiles, and Web Ul basket. The right-click menu on this node does
not allow manual creation of new user collections nor deletion of existing temporary collections.

Temporary collections created by background processes (BGPs) are deleted automatically via the case-sensitive
sharedconfig.properties file entry AutoDeleteBackgroundProcesses.AgelnHours.[processname]=[hours]
when the BGPs are deleted. In this setting, the [processname] designation is replaced with the name of the BGP
and the [hours] designation is how long to wait before deleting BGPs. For more information on this setting
property, see the Create a Background Processes Maintenance Plan topic within the System
Administration documentation.
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For example, running a bulk update BGP creates three temporary collections. Setting the
AutoDeleteBackgroundProcesses property with 'BulkUpdate' as [processname] allows the related bulk update
temporary collections to be deleted when the bulk update BGPs are deleted, based on the [hours] setting.

Manually deleting temporary collections is necessary when background processes have been manually deleted.
On the Maintain menu, click 'Force Delete & Purge' and select one of the following options:

« 'Purge collection contents' - removes the contents of the collection but does not remove the root node.
« 'Purge collection node' - removes the contents of the collection and also deletes the collection root node.

Dimension Dependency and Collections

Collections and search results are dimension dependent. A search in one context can display different objects
than the same search in another context.

The following example illustrates how creating a collection from search results can return different objects, based
on the dimension dependent values in the context being searched.

This search is performed in the 'English US' context for the value 'red' in the 'Color (Color)' attribute. The search
finds four objects with the value.

Context |English US v | (— (' URL |8id3=1799288contes
h

|’|m m References || Referenced By |
| ﬂ

Color (Color) = Red

&= Advanced
D * [Color »
5F | Reset || Search ||fame > ID Color
Displaying 4 of 4 results Show Details | ||12-GGK30 » 182922 Red
ame s || |[Mens T PEG * (179916 Red
Mens T POY * MT 18404 Red
Womens TPOY w Class  » 179928 Red

One of those objects has a translated value of 'rojo' for the language dimension point in the 'US Spanish' context.
the other objects have no value for the attribute.

_.'.|

€ 12-GGKB8O0 rev.0.9 - Compare Contexts Il comple=

Compare Contexts References || Referenced By
* |[English US * |[English Canada  * |English LK »Jus Spanish »
* D 152922 152922 152922 152922
* Mame 12-GGKE0 12-GGKE0 12-GGKE0 12-GGK30
* Calor Fed Red Fed Fojo
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Performing the search again in the 'US Spanish' context returns no records since the value of 'red' does not exist
for any of the records in the searched context.

Context |US Spanish i€ Cu | ===t ] Goto | 1DiNzme
< Search Result Profiling

[Search

Pcﬂlﬂr (Color) = Red ﬂ Search Result Profiling
& Advanced 0 hit(s)

B | Reset | | Search |

Displaying 0 of 0 results Show Details

[ Mame ¥]
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Creating Collections

In workbench, collections can be created in two ways:

1. Using the Search tab, perform a search, and create a collection of the results
2. Using animport file, create a collection of the contents

Regardless of how they are created, if a collection contains less than 10,000 objects, these can be inspected in the
Tree hierarchy by expanding the Collection node. The collection will be displayed in an entirely flat structure
regardless of any parent-child relations that may exist between the objects, and regardless of which parents /
children the objects have when viewed elsewhere in STEP.

In Web Ul, objects can be manually added to and removed from a collection. This functionality is not available in
the workbench.

Creating a Collection from Search
The most common way to create a collection is through creating a search. To do so, follow the steps below.

1. Navigate to the Search tab, enter in the needed search criteria, and click Search to verify the results. For more
on how to search, see the Navigating and Searching topic in the Getting Started / User Guide
documentation.

2. Click the Save as Collection button.
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Search Below
’VFIashIights Items (20359) ﬂ

5 -

Displaying & of & results Show Details
Mame

I Blue and Purple Flashlight /D = 174557
W flashlight case [0 = 129555

I Flashlight C Batteries [D = 170582

Bl Flashlights Ttems [0 = 20855

¥® pink Flashlight 1D = 19133

¥™ Red flashlight 1D = 174554

-Operations on Entire Result
5l GERL

| Save as Collection |

3. Select the appropriate parent in the collections hierarchy (either the top collections folder itself, or a collections
group folder), enter a collection name (the ID is autogenerated), and click OK.

[ 1 Save as Collection in Background Process X

Search

=15 Collections A
: [ Addresses
{5 alltems

- [F All PPH

- Details

Collection ID 411276

Collection Mame |Flashlights

Cancel

4. A background process runs, and the new collection is created and saved under the specified folder.
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Tree
i Primary Product Hierarchy
EI@ Collections
- (5] AllPPH
-- {5 Bottled Water

< § [asigs]
- {8 Blue and Purple Flashlight

-\ flashlight case

| Flashlight C Batteries
- i Flashlight Items

- { Pink Flashlight

- Red flashlight

5. Right-click the collection, and run any needed bulk update, or export the objects.

Creating a Collection from File Import

Collections can be created from a text or CSV import file containing STEP IDs of products, assets, or
classifications. Objects in the import file must already existin STEP as the import will not create or update objects,
only place them in a collection.

Important: If the import file includes only attribute values or unique keys of the products, assets, or
classifications to be added to the collection (and does not include the STEP ID), you must use the above steps
for Creating a Collection from Search.

To create a collection from a file:

1. Inthe Tree, right-click the Collections top node or a collection group to determine where the new collection will
be saved, and select Create Collection From File....
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r_=| Merchandising Hierarchy
r_=| Suppliers

-] Web Sites

- i Entity Root

-0 GDSN

ﬁ Publications

1‘_=| Primary Product Hierarchy

-5 Collection=
(-0 eCatalos Create Collection Group...
@ Recyde Create Collection From File...
¥ Delete
Search Below

In the Create Collection From File dialog, locate the file to be imported.

T ISTIBOSYSTEMS

The Collection ID is autogenerated
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[ 1 Create Collection From File *
Look in: Imports w ? =% [~
? D Product IDs
Recent Items
Desktop
Documents
This PC
@ File name: Product IDs. tct
Network Files of type: | All Files v
Collection ID 112706
Collection Mame |Mew Products
Products
Classifications
Assets
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3. Forthe Collection Name parameter, add a Name for the new collection.
4. Forthe File Contains parameter, select if the import file contains IDs of products, classifications, or assets.
5. Click OK to start a background process which will create the new collection.
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Creating Collection Groups

Collection groups are containers that can hold collections or other collection groups. Below are instructions for
configuring collection groups.

Creating a Collection Group

1. Depending on where you want the collection group to live, either right-click the top-level Collections node or an
existing collection group in Tree and select Create Collection Group....

[ Article Groups

|j Assets

|j Bulk Update Configurations
rj Classifications

rj Configurations

s* eClass 9.1

&[5 UNSPSC

- [Z] Web Sites US

@ ACME Customers

|j Primary Product Hierarchy
-5 Collections
G-I eCatalog & Create Collection Group...
ﬁ Recyde

51  Create Collection From File...
> Delete

Search Below

[ ” Bookmarks " System Setup " BG Processes ” Search ]

2. Inthe 'Create Collection Group' dialog enter a Name (ID is autogenerated) for the new group.
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F-{ 7] Assets

r_=| Configurations
r_=| ETIM Hierarchy
r_=| Index Waords

r_=| Suppliers

- 7] Web Sites

- i) Entity Root
(- [0) GDSN

ﬁ Publications
r_=| Primary Product H
=[5 Collections

+-E5 eCatalogs

'ﬁ Recyde Bin

a[ System Setup ” BG Processes ” Search ]

3. Click OK.

r_=| Merchandising Hierarchy

Collection Group

T ISTIBOSYSTEMS

% Description

Mame

* [D

> Mame

[1 Create Collection Group

]

411225

Mame |Mew_Products

Cancel
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Once created, collection groups can be selected to hold new collections, or more collection groups can be created
under them. For more on how to create collections, see Creating Collections in this documentation.

Tree
r_=| Primary Product Hierarchy

EI-iE Collections
[+ (5] All PPH

=8

()

- [5] Copy Writing State

}@ Temporary Collections

—}-@ Tehirt Group

=5 Men's Tshirts

. B[ Size Medium
- 12-GGKTS

----- B 12-GGKa0

- 18210 M B

ITl-..I%
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Maintaining Collections

Collections can be a valuable tool for data maintenance tasks, because they allow a user to group objects
independently of their placement in the hierarchies, and they can be updated. As an example, a set of objects with
data anomalies could be grouped in a collection via search criteria. Once the data is corrected, the objects with
updated information no longer meet the search criteria. Thus updating the collection automatically removes any
updated / fixed objects from the collection. In this way, only the objects that still need to be fixed are displayed in the
collection.

This topic addresses the various ways users can interact with and maintain collections.

o Delete

» Edit Search Criteria
« Export Data Below
o Refresh Data

o RunBulk Update
o Republish

o Search Below

Collections can also be maintained via the Web Ul. For more information, see the Collection Content Screen
section of the Web User Interfaces / Web Ul Getting Started documentation.

Delete

Clicking on the Delete option deletes the Collection node, but does not delete the objects within the Collection.
They will still reside under their original nodes in Tree and System Setup. All collections and collection groups
below a collection group must be deleted before the parent collection group can be deleted.

Important: If an object is deleted from the collection, then the same object will be deleted from the original
hierarchy placement in STEP as well. In this case, it would be best to just updated the collection through proper
maintenance of collections such as through an updated search or a bulk update.

To delete the collection node, right-click on the desired collection and select Delete.
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-3 Collections
G- [ Assets made with Search * [ID
[ [ Copy Writing State s Name
= [ Cotton T-shi| oz
'ﬁ 19710 M & Fun Bulk Update
E 15712 i Export Data Below
- 18213M  Republish...
E 18218 Refrech
E InDesign
- 8 Digital Asset Edit Search Criteria...
[ [ Flashlight C
- [ Group2 #_Delete
M. (=1 Darks Habke
< Search Below
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Additionally collections and collection groups can also be deleted from the Maintain menu, Delete option.

File Edit View Mavigate Forrmat Maintain Window Help

| I Context |English US Inzert ¥
Link *
" SLINCHNG FTooUCTs MErgE )

[#-[7) Electrical & Electr
r_=| Food and Bevera I}q’ Delete
r_=| Kitchen .
r_=| Party Supplies
G-Il Discontinued Product Unlink Object Type
T Product Qverrides
H

Tree

(s

F Delep-—=
orce De I|D

|}
elete a selection

=

[l

i

i

oAl

&) 41l Packaging aa Duplicate Ctrl+]
o

@ -l GDSM Products B Duplicate Recursively

E -3 Collections B

g' - [ Assets made with Sez Make Revision
= B (5 Copy Writing State
o] = |} Cotton T-shirts Approval »
= ﬁ 18210ME Enable group for workflows

p -\ 182121 B

g - 18213M O Revive
] E 1821610 Revive Recursively
E E InDesign

= [ [7] Digital Asset Review Truncate log...

EE,I F#- [5 Flashlight Collection

@ - (5 Group2 Migrate Attribute Values

For more on creating searches, see the Navigating and Searching documentation.

For more on how to use bulk updates, see the Bulk Updates documentation.
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Edit Search Criteria

Collections created from searches can be edited if needed to reflect the needed objects in the collection.

1. Todo so, right-click on the collection and select Edit Search Criteria.

Tree
-3 Collections
-- [ Assets made with Search
-- 5 Copy Writing State

a 182 @ Run Bulk Update
-E 12| ik Export Data Below

WM 182 Republish..

_ E 182
. 5 Digital A Refresh

. § Flashiig Edit Search Critena...
B 5 Group2
.. 8 Party H . Delete

- [J) PetHat:
[F}- 5 Product

Search Below

2. Once selected, the user will be brought to the Search tab where they can see the original search criteria, and
modify the search criteria if necessary.

IVSean:h Eielcnw Cotton T-shirts
= Db_]El:t Type = Item Family
(g | Save | | Reset || Search |
Show Detailz
I Name > |
-Operations on Entire Result

Alternatively, if a collection was created using a search criteria, the 'Search URL' will appear in the collection's
Description flipper under the Search URL field. The user just needs to copy and paste this information into a
browser, and they will be brought to the Search tab with the original search criteria on it where they can make
adjustments if needed.
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Cotton T-shirts - Collection

a4 | ISE T | Diaka Profile || Log

E Product Overrides ~
I Pecagns @ Desipton
[+l GDSN Products ] > Val
=[5 Collections Mame Value
[ [ Assets made with Search > ID 112303
[#- [ Copy Writing State > Name Cotton T-shirts
= B Cotton T-shirts| > Estimated Amount of Obje...| |5
. 13210 MB
* Bearch URL step: /fsearch?args0. 0=topnodetype ¥:3dproduct ¥ 2ctopnodeid %63
* Last edited By 2017-08-17 16:48:25 by USERL
& statistes
: W
£ > £ >

For more information on searches, see the Navigation and Search topic in the Getting Started / User Guide
documentation.

Export Data Below

The Export Manager wizard allows a user to export data on demand and to create or modify an export
configuration.

1. Ifauser wishes to export all objects in the selected collection based on the selected format and the mapped
data, they can right-click on the collection and select Export Data Below.

=[5 Collections
[+ [0 Assets made with Search
- [3 Copy Writing State

&

&* Run Bulk Update

g Export Data Below
Republish...
Refresh

[+ [ Digital Asset R
- 8 Flashlight Coll Edit Search Criteria...
[} Group2
B} [J Party Hats . Delete
- |7 PetHats

Search Below

2. Selecting this option will launch the Export Manager where a user can fill out the proceeding steps as needed.
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Steps Select Format
1. Select Configuration | Bl
2. Select Objects
2. Select Format Exports data in Excel format,
4. Map Data Excel version  |Excel 2007
5. Advanced
6. Select Delivery Method

|Badc||§wen§|||=nsh||::ancel|
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For more information on exporting, see the Creating a Data Export topic in the Data Exchange documentation.

Refresh Data

Collections created from search results can be updated for the most up-to-date information and object groupings,
as objects in a collection that no longer meet the search criteria will be removed from the collection.

« Tostartarefresh in workbench, right-click on the collection and select Refresh.

E1-5 Collections

B (3 Copy Writing State
=[] CottonT.

- [ Assets made with Search

E 182 E Run Bulk Update
""" ﬁ 1821 4 Export Data Below

- 132 _
E 1891 Republish...
#- [3 Digital A Refresh
- [3 Flashlight
- [ Group2 Edit Search Criteria...
B [J PartyHal X Delete
- |7 PetHats
- 5 Products Search Below

o Tostartarefresh in Web Ul, go to the collection content screen, select the desired collection, and click the
Refresh collection action.
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Collection Detail

Clear all EP Export g Refresh collection

Name - Object Type . Fath

Primary Product
Hierarchy,/Produc
Root/Apparel
/Mpper Body
Wear/T-shirts,/T-
shirts ltems/Polo
T-shirt/18210 M
B_EN

18210 M B_EN ltem

Run Bulk Update

This option allows the user to interact with the objects in the collection in a number of ways. To name a few, the
objects could be submitted into a workflow, assigned to a user group, or have an attribute updated.

1. Right-click the desired collection and select Run Bulk Updates.

=[5 Collections
[+ [0 Assets made with Search
G- [3 Copy Writing State

B
. 13210 &) Run Bulk Update
N 18212L] & Export Data Below
BB o ..

----- B 82161

- (3 Digital Asset Refresh

B i3 Flashlight Cg _ -

- 3 Group2 Edit Search Criteria...

- [ PartyHats | 2% Delete

- [3 PetHats
Search Below
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2. Complete the steps in the Bulk Update wizard to make the same updates to all objects in the collection.

[ Bulk Update >

Steps Configuration

1. Configuration
2. Operations
3. Parameters
2 Breview (®) Create New Configuration

5. Advanced

O IIse Existing Configuration

Back Mext Finish Cancel

For more on how to use the bulk update wizard, and the various operations that can be applied to collections or a
group of collections, see the Bulk Update documentation.

For information on how to schedule bulk updates for collections in Web Ul, see the Scheduling a Collection
Refresh in Web Ul topic in the Bulk Updates documentation.

Republish

The Republish action generates events on products, classifications, or assets in the collection. Common setup is
to use this option for on-demand creation of a republished event. For example, to generate events for all objects in
a collection that has never been published by an event queue.

For more information on events, see the Events topic in the System Setup / Super User Guide documentation.

1. Torepublish an event, right-click on the desired collection and select Republish....

=g Collections
B+ (] Assets made with Search
- (Z Copy Writing State

= [7] Cotton T-shirt:
aa 18210 MB @* Run Bulk Update

- {M 1821218| @ Export Data Below
E 18213 M Republizh..
1521610

- (] Digital AssetR Ei=

- (@ Flashight Coli Edit Search Criteria...

- (5] Group2

[+ [ Party Hats . Delete

- [Z] PetHats
Search Below
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2. Clicking the action launches a wizard where users can choose the appropriate event queue from the dropdown

menu.

[ Republish collection

Republish to event queue:

Process Description:

[temAdvSTEPKML
[temAdvSTEPEML s

OVEventGenerationTest

eafPublishingEx W

|F‘.E|:|ublish collection: Cotton T-shirts |

IREminsh||Eancel|

3. Users can also enter in a Process Description to give a name to the background process, which can be
monitored in the 'Republish Node'.

h Republish nodes
% Queued Processes

----- % Active Processes

E}% Ended Processes

Search Below

If a certain attribute on some of the items in the selected collection needed to be changed, a user could use this to

locate the items.

When a user right-clicks on a collection and selects Search Below, it allows the user to search only the items in

that particular collection.
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=+ (5] Cotton T-shi

@} Run Bulk Update

o [H Pat Hate

- 18210 M
a 18212 1L ik Export Data Below
- 18213 Republish...
E 18218 Refresh
E InDesigr
B [T Digital Asset Edit Search Criteria...
B[] Flashlight Cq % Delete
E- [ Group2
B3 Party Hats Search Below
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Collection Properties and Statistics

Working with and viewing the collections properties, collection statistics, Data Profile tab, or the Log tab can
provide a quick overview of the collection itself, and useful information in regards to the objects it holds.

Collection Tab

The Description and Statistics flippers provide information about the selected collection. Below the flippers are
described in more detail.

Products with Assets - Collection

5

o [T | Diata Profile || Log

..... ﬁ 114413

-\ 20801

E 0303

ﬁ 20803-03 » D 114506

E 20305 * Mame Products with Assets

""" g 31 * Estimated Amount of Obje...| |28

..... [FIEEEEEET * Search URL step: (fsearch?args0. 0=topnodetype ¥t3dattributegroup®:2ctopnodeid 3e3d Attribute
..... & 444445 > Last edited By 2016-12-05 09:36:43 by USERL

I iats and Cans TS o ababien 0
----- o (attributeGroup)

----- 7 (attributen) .

..... [T (Attrsize) Collection Content

----- [T (atrTshirtsize) 28 ohject(s)

""" [T (attwithLangDeplOY  potice: Objects in Collection may be hidden in Tree due to Context\Workspace visibility andior privilege ch
----- |]I (Color, Interior)

..... |]I {Hazmat) Content W ﬂbiﬁi Tm
----- [T (Hazmatim) Product (10)
----- (1T (Marketing Descriptia
----- [T (Referenceattribute g ::E mf:}z}
..... Em
..... (3 Releasedsy) (& ttems (1)
[T (selingprice) G ltem2 (1)
..... i {ShippingREStriCﬁﬂﬂﬂ G ltem3 (1)
..... H% E.zle} ) Il tem Folder (1)
..... alue
_____ 1t (aloed) Attribute (17)
----- [T condition Attribute Speci
..... (1T value1 pecialtypes (1)

- [7 Sample Search Collection & Attribute Group (1)

Description Flipper
This displays information about the collection:
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Party Hats - Collection

MName | > |Value >
> D 111807
* Mame Party Hats
* Estimated Amount of Ohje. .. 4
* Search URL step: fsearch?args0. 0=topnodetype % 3dproduct®t 2ctopnodeid %63d 12 11898&search0. 0=BelowCriteria
* Last edited By 2016-08-22 11:53:40 by USERS

« ID: Shows the collection ID, which is auto generated.
« Name: Shows the name of the collection.

. Estimated Amount of Objects: Displays the total number of objects in the collection based on the latest
'Refresh’ of the collection. The count is not filtered according to Context / Workspace visibility, privilege checks,
or object types.

« Search URL: Displays only on collections created from a search result. A user can copy the URL, paste it into
the URL field, press ENTER, and see the search in the Search tab. Itis possible to edit the search if needed.
For more on searching see the Navigating and Searching topics in this documentation.

» Last edited By: Displays the date and time and user who last worked on the collection.

Statistics Flipper
The Statistics flipper gives an overview of which type of objects are included in the selected collection.
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Products with Assets - Collection

0 [ EREGT | Data Profile || Log

- Hats and Caps Tter
----- £ (attributeGroup)
----- [ (attributer)

----- [T (atirsize)

----- [T (attrTshirtsize)

----- [T (attwithLangDepL

..... |]I {HazmatYM)

----- |]I {Marketing Descrip
----- [T (ReferenceAttribul
----- [T (Releasedsy)

----- [T (selingPrice)

----- [T (shippingRestrictio

----- [F valuez)

----- [1F (valuez)
----- [} condition Attribute

----- [1F value1

@ Desarptn
Mame *| » |value

> [ID 114506

» Name Products with Assets

* Estimated Amount of Obje... 28

» Search URL step:/fsearch?args0. 0=topnodetype %:3dattributegroup %t 2ctopnodeid 36 3dAttributeGrou

* Last edited By 2015-12-05 09:36:43 by USERL

@swtsts

Collection Content

28 object(s)
Motice: Objects in Collection may be hidden in Tree due to ContextWorkspace visibility andfor privilege checks

Product (10}

Itern i4)
' ltemd (2)
& ltems (1)
& 1tem2 (1)
& item3 (1)
Il 't=m Folder (1)

Attribute {17}

Special types (1)
& Attribute Group (1)

In addition to breaking down the objects by type, it will also display the exact number of objects in the entire
collection based on the latest 'Refresh’ of the collection.

Data Profile Tab

The Data Profile tab can display a dashboard to provide a graphical representation of the objects that are in the
collection. This can be modified based on the user's requirement.
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3 Collections

i [ Al PPH

- [7] Backplate

- [7] Baskets

- [ Pottled Water
- . By -08

- | EVN-06

-\ EVN-12

- [4 Collection ¥LS

L[5 CommDatalist

- [3] CommDataProducts

- [3 Copy Writing State

- {3 Cotton Shirts with DK D
- |5 Data Quality Collection
- |5 Digital Asset Review 5t
- |5 Flashlights

- |3 Hats

- [7] Hats & Caps

~ [3] OrderProcess2

i [ Sample Search Collectio
- |7 Shoes

mf’a Temporary Collections

Generated: Mon Mov 28 2016 14:24 Update Profile

(@) Dashboard () Value Details

Ohject Count

4

(") Reference Details

Translation Status

. ot T sl tescd (<43

ohjects

Jattribute * Completeness >
IHarmunizatiun ver | 0%
IDismnﬁnued 0%
IProduct Name 0%
0%

Width (range)

]

v

Approval Status

Pty Mol (3
. ot A e (13

Most Complete Attributes

Attribute »

Completeness

>

Selling Unit of ...

100%:

Manufacturer ...

100%:

|Country of Crigin

100%:

|Erand Name
| |

100%:

~

Ohject Type Count

- e ()

If a profile has never been created, a user can click on the Generate Profile link to create the collection's

Dashboard.

Collection [ Log ]

Generate Profie

Diashboard

Value Details

Reference Details

If it has already been created, it is recommended to update the profile when viewing if it has not been updated

recently.

Collection [ Log ]

(@) Dashboard () Value Details

Generated: Mon Mov 28 2016 14:24]Update Profile

() Reference Details

For more information on how dashboards and data profiling work, see the Data Profiling documentation.
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Log Tab

The Log displays details about the creation and modification of the collection, details about which user performed
what actions, and the number of objects in a collection when a collection is refreshed.

Tree 4 Bottled Water - Log
Fj Primary Product Hierarchy | | collection || Data Profile m
El@ Collections Showing page 1of 1
(- @ AIPPH 2016-09-15 15:14:45 'USERJ: Created
[+ [J Backplate 2016-09-15 15;14:45 'USERT': Mame modified from ‘null
- ] Baskets 2015-09-15 15:14:45 'USERT": Collection refreshed, number of objects: 4
E | Bottled Water 2016-11-23 15:25: 24 'USERL" Collection refreshed, number of objects: 4
e
- EVN-06
- | EVN-12
| EVN-24
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Entities

This topic covers information specific to the Entity super type that is important to know when working with entities.
For general object maintenance information (applicable to all object types rather than specific to entities), see the
All Objects topic within this guide.

A STEP entity can be any object not defined as a product. Entities are commonly used to model customer-related
data, such as contacts, addresses, markets, or customers, though they can be used for any number of data
modeling scenarios, including modeling of reference data.

Entities differ from products in that they do not contain all of the product-specific functionality like specification
attributes, value inheritance, or tables. As entities can only use description attributes, the application of category-
specific attributes is not supported. Therefore, attributes are applied to entities strictly via object type validity and all
entity instances of a particular object type will have the same attributes available for population. Additionally, entity
handling is limited for publishing (e.g., as part of print publishing solutions as defined in the Publisher (Adobe
InDesign Integration) documentation), and you cannot translate entities using a background process.

Entities may or may not be subject to approval, dependent upon the revisability settings (globally revisable entities
are the same in the Main and Approved workspaces, while workspace revisable entities adhere to standard
approval concepts). This provides a great deal of freedom in determining how entities are handled, specifically in
terms of how events are generated and processed. For more information, see the Revisability on Entity Object
Types section of the Getting Started / User Guide documentation or the Events section of the System Setup
ISuper User Guide documentation.

Entities cannot be linked into classifications, though configuration of entity references allows for determination of a
hierarchical display (with source displayed as child to target, or vice versa). In effect, this makes classifications
unnecessary for use with entities as entities can be classified via entities. Additional information on this is available
in the Entity Reference Types section of the System Setup /Super User Guide documentation.

However, entities do retain the standard data modeling capabilities and provide even more configurability. The
Revisability parameter allows you to define an entity object type that does not have to be approved and also
determines how events are processed.

Entity Hierarchy

Any number of entity hierarchies can be added to any system. For example, you may set up address hierarchies,
customer hierarchies, market hierarchies, and so on. Entities are represented by icons chosen as part of the
implementation process and will likely differ on each system. The following is an example of an entity hierarchy.
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=il Entity Root

E}Em Customer Hierarchy
-8 Customer A

o Axel Kiers Vej 11

..... 3 Customer
t'g Key Accounts

For more information on hierarchy setup, see the Object Types and Structures section of the System Setup
ISuper User Guide documentation.

Entity Editor

Once the entity hierarchy is created and description attributes are applied to the entity object types, the next logical
step is to start entering values.

bl [T Assets References | Referenced By | Status || Statelog || Tasks

&l 0 Confuations ® Desapton
" r_=| Index Words Name 3|5 Value

£ | [ 7] Merchandising Hierarch

o B0 s ! > ID ADD_101571

wil | {7 Suppliers
7= [ Web Sites > Name Al Kiers Vej 11

2] =i Entity Root > Object Type Address

w i -

2 E% Customer Hierarchy > Revision 0.1Last edited by USER on Fri Aug 14 10:59:02 EDT 2015

o =8 Customer A - _ _ |

n% Q el Kiers Vej 11 » Path Ent‘qr hierarchy root/Entity Root/Customer Hierarchy/Customer AfAxel Kiers Vej 11
B Jesper Jensen > City abe Hajbjerg
N B g Customer B * Country abe Denmark

El i 4% 3550 George Bushee Pkwy

5 ) * Gtate abe

Vi John Smith :

E g Customer C » Gtrest abe Axel Kiers Vej 11

&‘ fg Key Accounts > Fip 123 DK-8270
—j [T Publications

For example, the image above shows an entity modeled as an address. The entity object has several description
attributes: City, Country, State, Street, and Zip. In addition to the Name attribute, these attribute can be modified
and maintained. Since this entity object type has been modeled to be globally revisable, approval is not applicable.
Therefore, the Approval Status field is not shown.
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Entity References, Referenced By, and Status Tabs

Every entity editor includes a References, Referenced By, and Status tab. The labels on these three tabs remains
constant, while the label of the first tab differs based on the object type. Each is defined below.

References Tab
You can view associated references of an Entity object by selecting the References Tab. In this tab, you can
maintain references from the selected entity to other objects.

Selecting the References tab on an Entity Object will list valid References. In this tab it is possible to maintain
references from the selected entity to other objects.

See Reference Types topic in the System Setup / Super User Guide documentation for more information.
An entity can reference a number of different objects. It is possible to create:

« Entity-to-Entity references

« Entity-to-Product references

» Entity-to-Classification references

« Entity-to-Asset references

In the example below, one Entity-to-Entity reference type is valid on the selected entity object. Clicking the plus

sign (+) will open a large editor where you can select objects to be referenced. Alternatively, you can type the
name of an object in one of the white target fields and press 'Enter.’

[T Assets | Customer Referenced By || Status | Skate Log

- 7] Configurations 3 Ungrouped Entity References

r_=| Index Waords Reference Type w| ® [Target > x>
[ ] Merchandising Higrarchy -

P[] Suppliers » | Affilate O + [*3)| & customer C <]
[#-{ ] Web Sites

Eli Entity Foot

&H-£43 Customer Hierarchy
) Axcel Kiers Vej 11

« Targets can be unlinked by clicking the delete button .

« Metadata attributes can be linked on to the target reference in References Tab.
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« The attributes that are linked on to the target reference will be editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

For the meta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in System Setup > Reference Type.

Reference Type |R'E(:[1"BRN.T

* Mame Contact to Contact
» Last edited by 2016-07-26 15:26:27.0 by USER.
» Externally Maintained Mo
* Dimension Dependencies
* |Allowe multiple references fes
* Mandatory Mo
» Parent/Child relation Maone
* Inheritance Mone
* Completeness Score 1 K&
* Purpose abe
7
Component » |Mame » |Description
9
1] ¥ |Name >
* | Add Attribute Group
9 vdidatbutes |

D * [Mame
> ContactMame Contact Mame
* PhoneMumber Phone Mumber

» Completeness Score Completeness Score

Add Attribute

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021)

208



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Referenced By Tab

Selecting the Referenced By tab on an entity will list valid Reference Types. In this tab, you can maintain
references from other objects to current entities.

See Reference Types in the System Setup / Super User Guide documentation for more information.
An Entity Object can reference a number of difference objects. Itis possible to create:

» Product-to-Entity reference

« Entity-to-Entity reference

« Asset-to-Entity reference

» Classification-to-Entity reference

In the example below, one Entity-to-Entity reference type is valid from an Entity to the current selected Entity
Object. Clicking the plus sign (+) will open a large editor where you can select objects from where a reference to
the current selected Entity Object should be made. In the example, a reference from an entity named 'Customer A’
is made to the current selected Entity Object.

-7 Assets [ Customer ” References ] Referenced By [ Status " State Log ]
r_=| Configurations Q

r_=| Index Words Reference Type w| * |Source >

[#-{ 7] Merchandising Hierarchy

Fe- [ Suppliers @ ReferencedbyObjects
r_=| web Sites Reference Type w| * |Source t

- fill Entity Root > | affiiate OF + 1|8 customer A X

E}QB Customer Hierarchy

=8 Customer A

4y Axel Kiers Vej 11

Jesper Jensen

[—]3 Customer B

- £% 3550 George Busbee Plwy

John Smith
-8

IN] > |Mame *

» Metadata attributes can be linked on to the target reference in Referenced By Tab.

? Referencedby Objects
Reference Type w| * |Source A
> | Affilate O + 1)

« The attributes that are linked on to the target reference will be editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

« Forthe meta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in System Setup > Reference Type.
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nfirmed Duplicate Contact - Reference Type
Reference Type RN [a W)

Mame *| » |Value
> [D ConfirmedDuplicate Contact
* Mame Confirmed Duplicate Contact
* Last edited by 2016-08-31 13:38:24.0 by USERA
» Externally Maintained Mo
* Dimension Dependendies
* WAllow multiple references Yes
* Mandatory Mo
» Parent/Child relation Mone
* Inheritance MNone
* Completeness Score 1
» Purpose abe
’LF
Component > |Mame * |Description >
7
D ¥ |Name ¥
> | Add Attribute Group

Status Tab

A record of all the changes that have been made to a currently selected entity will be displayed. This record will
allow you to see the user that made the change and when the change was made.

Tree

4 Customer A rev.0.1 - Status

- 7] Assets Customer || References |ReFerenced By @ State Log | Tasks

m
o

#0 Confurators | o

{7 Index Words Revision » |Created > |Edited > Major > |User

-] Merchandising Hierarchy | {75 5 Thu Jul 30 14:53:26 EDT 2015 Fri Aug 14 10:58:36 EOT 2015 USER
& supplers chdnvakes
Fi-[ =] Web Sites

- Entity Root ®Diagnestics

E}Em Customer Hierarchy

=8 Eustomer ]
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You can purge past revisions or revert the old revisions. There will be no Workspace, Translation, or Approval
Status flipper as Entities can be created as globally revisable, meaning they are the same in both the Main and
Approved workspaces.

However, Workspace, Translation, and Approval Status flipper will be displayed if we create entity object type as

'Workspace Revisable' as illustrated in below images.

Example of object type definition

obiect 1voe |EEETTEg

@ Desgipton
Mame | |Value

> D Account

» Mame Account

* Last edited by 2017-10-15 16:25:44 by USERE

* Mame Pattern

» [D Pattern

* Enable Profiling Mo

> [Icon

» Dimension Dependencdes
Revisability

» |Description

| > |Add Attribute

Example status tab for workspace revisable object

] Assets
----- i Classifications
- {7 Configurations
ﬁ eClass 10
r‘_=| ETIM Hierarchy
--@ Index Words
r_=| Merchandising Hierarchy
&[] Offers
1j Suppliers
B[] Web Sites
() Customer Root
- -[d] Customers
@ Entity Root

skem Setup H BG Processes ” Search ]

-~ (0 /Account Group 1

Account || References || Referenced By - State Log

[T1STIBOSYSTEMS
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Rewsum ¥ [Created » [Edited ¥ [Major User Comment »
* 0.1 Mon Oct 16 16:28:55 EDT 2017 Mon Oct 16 16:28:55 EDT 2017 USERE
?

D » |Name » |Path » »
> Main Main Main 0.1
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Products

This topic covers information specific to the Product super type that is important to know when working with
products. For general object maintenance information (applicable to all object types rather than specific to
products), see the Object Maintenance in Tree topic within this guide.

In STEP terms, a product is a part number, a stock number, an order number, a catalog number, a product
number, etc. In other words, any item that a company sells that can be ordered.

Product Hierarchy

The foundation for a product-centric STEP installation is the Product Hierarchy / Primary Product Hierarchy. The
product hierarchy consists solely of objects of the product super type. The product hierarchy is an organized
hierarchy where all products in the workbench are stored. This is also where products and product attributes are
linked. Although configurable, the product hierarchy is usually a multi-level hierarchy—each level controlled by its
own unique object type. Super users can control the naming convention(s) used to categorize the products at their
different levels.

Inheritance of attributes and values is supported within the Product Hierarchy and the hierarchy is usually
designed to take advantage of this capability, with objects classified according to similar characteristics. More
information on inheritance is available in the Inheritance in the Product Hierarchy topic in this guide.

A portion of a sample hierarchy is shown below. Categories are represented by folder icons, while discrete objects
are represented by cubes.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 212



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

[#-{ 7] Assets
r_=| Configurations
r_=| Index Words
r_=| Merchandising Hierarchy
r_=| Suppliers
[-[7) Web Sites
E Publications
E|r_=| Primary Product Hierarchy
E}Fj Products
[L]r_=| Apparel
=[5 Head Wear
[+-[[T] Hats and Caps
E}|__=| Upper Body Wear
-7 T-shirts
=gl T-shirts Items
E}- =) T-Shirts Sales Ttems
=/ T-shirts

|l 18214-012
-\ 18215012
|l 18217-012
‘- |a] Red Shirt

All objects of the product super type must exist in the product hierarchy, and may exist only once (e.g., each object
can have only a single parent). The primary purpose of the product hierarchy is proper attribution of products. That
is, in the product hierarchy, products should be grouped according to their similar properties so that inheritance of
attributes, attribute values, and references can best be used. Based on this, it is evident that the Product Hierarchy
is not intended to be used for modeling website hierarchies or other taxonomies (e.g., merchandising hierarchy,
sales hierarchy, etc.) where an object can be represented multiple times. When a product needs to "live" in more
than one location, that can be accomplished using classification hierarchies. In this case, the product continues to
exist in the product hierarchy (and this is considered its true place of residence). It is then linked into one or more
classification hierarchies using references.

Product Editor

The Product Editor is displayed when an object of the product super type is selected in Tree.
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20808-013 rev.0.7 - Product

- G0 Publications G ables || Category Profile || Proof View || Status || StateLog || Tasks
E1-{I5) Primary Product Hierarchy Product 1 Sub Products ” References ” Referenced By ” Images & Documents ]
[—"_}- Products -
=-15) Apparel
5[] Upper Body Wear Mame >| > |Value
. B3 T-shirts > ID 101567
=[] Head Wear > Name 20808-013
[=-{{7] Hats and Caps
- > Object T Sales Ite
[+l Hats and Caps [ter Obiect Type es Em
E}- Hats and Caps Sale * Revision 0.7 Last edited by USERS on Wed Jan 18 08:38:58 EST 2017
2 o > Japproved 3¢ Last Approved on Mon Aug 10 09:47:21 EDT 2015
m 20803-04 » [Translation Not Translated
|l 20808-08
E 20808-09 > Path Primary Product Hierarchy /Products/Apparel/Head Wear Hats and Caps/Ha...
E 0111 > Categor £ Primary Product Hierarchy | Products | Apparel | Head Wear | Hats and Caps
E A ¥ | Hats and Caps Sales Items | 20808-013 | 20808-013
Nl 1112121 > Parent # Hats and Caps Sales Items
|l 20808-012 oo
E B
m C 4
m D
|l 1111111 i
- [[5] Footwear MName >[ > |value >
-7 Safety » Manufacturer Name abe
[H-{IT] Hardware * Product Width 123
=-{I Displays > Product Height 123
[T Furniture : :
(-] Automotive » Belling Price 123 12,99 % 6
[H-{IZ] Building Products > Product Depth 122
(#-{17] Electrical & Electronics » Wnnual Sales Forecast, Maxin 123 (250
[+-{7T] Food and Beverage
[]__= Kitchen = > \annual Sales Forecast, Minim|123 100
(&[] Party Supplies |100%: Cotton, Unstructured, Soft Crown, Low-Fitting, 6-panel cap, Seamed Front Panel without
- . > Description, Long abe Buckram, 6 Rows Stitching on Visor, Matching Fabric Undervisor, Matching Fabric Adjustable Hook
[ Discontinued Products and Loop Closure, One size fits most,

1. The Product tab (known as the Product Editor) is the primary interface for working with product objects in the
workbench.

2. The Description flipper displays basic information about the object. Additional information about the data
displayed is described in the Editing Objects in Tree topic within this guide. Note that some information
displayed is common for all implementations, while other information is specific to the data model and
configuration of each system.

3. Ifthe object has a primary image referenced, a thumbnail version of it will display. The reference type to be
used for the thumbnail display is controlled in System Settings (on the Users & Groups node), and additional
information on this is available in the Primary Image Type topic in the System Setup / Super User guide.
Additional information on references in general is available in the Reference and Link Types topic in that same
guide.

4. Specification attributes are displayed in flippers, with the flipper name matching the attribute group. Flippers
can be expanded / collapsed by clicking the magnification icon. Note that when attribute groups have sub-
groups, configuration determines whether the parent group or the child sub-group is displayed as the flipper
name. This is set via the 'Product Editor, Group attributes by top group' parameter in System Settings (on the
Users & Groups node), and additional information on this is available in the Product Information Manager
Default Settings topic in the System Setup / Super User guide. More information on attributes in general is
available in the Attributes section in that same guide.
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Attribute values can be edited by clicking into any editable field. Additional information on the various editing
options is available in the Editing Objects in Tree topic within this guide. By default, attributes are displayed in
alphabetical order within each flipper. However, if an attribute display sequence has been configured, this will
override the alphabetical sorting. More information on attribute display sequence is available in the Attribute
Display Sequence topicin the System Setup / Super User guide.

Additional Editors

See the additional topics listed below for information on the other editors available on products.

Category Profile: Allows users to configure and view profiling data and dashboards for the objects under the
selected node. See the Data Profiles topic in the Data Profiling documentation for more information.

Commercial: Allows users to add and edit commercial terms for the object. Commercial data / terms lists are
often used to store pricing information. See the Commercial Data section of the STEP Publisher (InDesign)
guide for more information.

Images & Documents: Allows users to view and edit assets referenced by the object (or inherited from
parental objects). See the Images & Documents Tab topic within this guide for more information.

Product Variants: Allows the user to generate and manage a family of products, which are basically the
same, only varying on the values of a small sub-set of their attributes. For example, clothing and shoes both
offer good use cases for product variants as shoes or clothing items may come in multiple sizes and colors, but
are otherwise identical. The product family holds all data for the item, e.g., a particular shoe, while the variants
would hold only the various combinations of the color and size varieties (e.g., size 7 red, size 8 blue, etc). The
Product Variants tab is only present if the system has been configured to support variants. For more
information on this, see the Product Variants documentation in the System Setup / Super User guide.

Proof View: Allows users to preview a close representation of how a product will look when mounted onto an
InDesign page based on a selected publication version and product template. For more information, see the
Proof View section of the STEP Publisher documentation.

Referenced By: Allows users to view all objects referencing the current object, and add / remove / edit these
references. See the Referenced By Tab topic within this guide.

References: Allows users to view all objects that the current object references, and add / remove / edit these
references. See the References Tab topic within this guide.

State Log: Allows users to view the recent history of the object across all workflows in which it has been
entered. See the State Log Tab topic in the Workflows documentation for more information.

Status: Allows users to view basic information about the object, including revision history, translation status,
and approval status. See the Status Tab topic within this guide for more information.

Sub Products: Allows users to view and edit all child objects of the selected object in a table form. See the
Sub Products Tab topic within this guide for more information.

Tables: Allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data across multiple objects, such as object name, part number, and price. For more information,
see the Tables guide.

Tasks: Displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place,
the user is able to act on the tasks from this editor, including to edit data and move tasks through the workflow.
More information on the Tasks tab is available in the Moving Tasks through a Workflow in Workbench
topicin the Workflows guide.
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Inheritance in the Product Hierarchy

Inheritance in STEP is the concept that when the value of an attribute is defined in a parent product, all the child
products that exist under the parent product can inherit the value - meaning that the value is present on the child,
as well as the parent. If the attribute is also valid on the child (in addition to the parent), then the value can be locally
edited on the child (e.g., a different value supplied so the child no longer inherits the value from the parent). Note
that value inheritance also applies to references, meaning that if a reference is populated on a parent, it is also
available on the child in the same way as an attribute value. However, references must be explicitly configured for
inheritance to be in place, while attribute values will automatically inherit to child products.

In addition to value inheritance, attribute inheritance is also available in the product hierarchy. This means that
attributes can be linked to specific nodes / categories so they only appear for those categories and their children.
For example, consider a company that manages data for both batteries and clothing. Size might be applicable to
both categories of objects since both batteries and apparel have sizes assigned. However, sleeve length and
voltage are characteristics applicable for clothing and batteries, respectively, and it could be confusing to see a
'Voltage' attribute on a clothing item. To avoid this, the 'Voltage' attribute could be linked to the 'Batteries' category,
while the 'Sleeve Length' attribute could be linked to an 'Upper Body Apparel' category.

Inheritance perpetuates throughout the hierarchy, no matter how many levels are present (e.g., inherited
attributes and values appear on children, grandchildren, etc.). When attributes are considered applicable to all
products, regardless of category, they are called 'global attributes'. For example, attributes such as Price,
Description, and Manufacturer Name. Thus, these attributes are linked to the top level in the product hierarchy and
are inherited down to all products beneath, no matter how many levels there are.

Attribute inheritance only means that the attributes are available for all of the products beneath where they are
linked. The process of linking attributes to different levels does not have anything to do with the actual values that
will go into the attributes for any particular product. In the 'Voltage' example, when linking that attribute, you are
only concerned with making that attribute available to all the battery products—not with the actual voltage for any
given product. However, if many batteries under a parent shared the same value, the value could be populated on
the parent to inherit down to the children. Any children varying from the parent value could then be edited
individually, while those having the same value as the parent do not need to be updated further. Note that attribute
inheritance within the product hierarchy is only available with specification attributes, and is not available with
description attributes. Further note that this topic focuses on inheritance solely within the product hierarchy.
However, it is important to be aware that attribute inheritance can also be used within classification hierarchies
that are used to organize product objects. Attributes can be linked to a classification, making them available for all
products linked into that classification (or a child classification). More information on attribute inheritance with
classifications is available in the Classifications topic within this guide, and within the Attribute Links topic in the
System Setup guide.

Important: Value inheritance is a powerful feature, but care should be taken not to maintain values at a level
too high in the hierarchy. With such a setup, a single change could mean that thousands or millions of products
would have to be updated in downstream systems and many systems are not geared to handle massive feeds
like that.
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When working with products and/or creating new products, users should be mindful of inheritance, considering
both the inheritance of the available attributes, as well as their specific values or references. It may be helpful to
consider the following:

« Isthe hierarchy granular enough to allow products within the category to be grouped so that all products only
have the relevant attributes, or are additional category levels required to obtain this granularity?

« Which attributes are required for the products in the category and/or subcategories?

« If product variants are used, which attributes should be maintained at the family level and which ones should be
maintained at the variant level?

Linking Attributes to Products

To make attributes valid for products, they must be linked to the appropriate tree nodes in the product hierarchy.
Some attributes will be global attributes (applicable to all objects in the product hierarchy) and are linked to the
“Product Hierarchy” root node. These global attributes are then valid for all products. Other attributes apply only to
specific categories of objects, and are then linked directly to those categories, making them available for all objects
within that category (if also set as valid for those object types). Attributes should not be linked to individual leaf
objects, as each one would have to have the link individually applied. Instead, attributes should be linked to some
parental folder in the hierarchy above the objects needing to use the attribute.

Before proceeding, be aware of the following:

« Attributes can be linked to objects of the product or classification super type. In either case, the steps are
comparable and the attributes are made available for the children "under” the node at which they are linked
(being mindful that "under" means "actual children" in the product hierarchy, whereas it means "objects with a
reference to" when dealing with classifications).

« Linked attributes apply only to objects of the product super type. For example, linking attributes to a
classification object that holds assets does not make those attributes available on the child assets.

« Only Specification attributes can be linked to products or classifications. Description attributes cannot be linked
attributes.

Linking Attributes
1. Select the product group or classification and click the References tab.

2. Expand the appropriate flipper (Linked Attributes from Product Hierarchyon product objects or
Attributes on classification objects), then click Link to Attribute.
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Mame

AirTransportationF.estrictions

Air Transportation Restrictions

AnnualSalesForecastMaximum

Annual Sales Forecast, Maximum

AnnualSalesForecast, Minimum

Annual Sales Forecast, Minimum

WyailabilityEnd

Wyailability End

WailabilityStart

Wvailability Start

¥
=

=

=

=

¥ BaseUnitOfMeasure Base Unit of Measure
¥ BrandMame Brand Mame

¥ BrandOwner Brand Owner

¥ Color Color

¥ Cost Cost

¥ CostEffectiveDate Cost Effective Date
¥ CostExpirationDate Cost Expiration Date
¥ CountryOfOrigin Country of Origin

¥ DescriptionLong Description, Lang

¥ TawClassification Tax Classification

¥ TshirtSize T-shirt Size

>

Link to Attribute |

3.

Localizing an Attribute Link

Local attribute links can be created to override inherited attribute links.

1.

2. Selectthe Create Local Link option.

¥ Linked Atfributes from Product Hi

DisplaySequence

¥

Con

Hide

Show All Columns
Rotate Table

Link to Attribute

Remove Link to Attribute

Create Local Link
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Target | »

* |Related Web Cla... +
g

Applies to
Add Privilege

» |Action 5et > |Atiribute G... * (Object Type *

O-Visble Objectsin Other Contexts
?

Completeness Score > (ID
> Color
| Link to Attribute

In the standard search / browse window that displays, locate the appropriate attribute(s) and click Select.

Select any existing inherited attribute link and right-click on the row indicator.
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This creates a local version of the link where attributes on the reference can be locally edited. Local links are
removed the same way as inherited links, though removing a local link re-applies the inherited link.

Unlinking a Linked Attribute

Unlinking an attribute does not delete the attribute from STEP; it removes the link so the attribute is no longer
available for population on the selected node (and child nodes, if applicable). Note that attribute links must be
removed from the same node to which they were added. In other words, trying to remove an inherited attribute link
is not possible and the 'Remove Link to Attribute' option will be disabled. To remove an inherited link, it must be
removed on the parental object that holds the link. However, care should be taken in doing this as it will remove the
link for all child groups, and will need to be re-linked at those lower child levels if it is still needed there.

1. Onthe References tab of the object, expand the appropriate flipper (Linked Attributes from Product

Hierarchy on product objects or Attributes on classification objects).

2. Right-click on the row indicator and select Remove Link to Attribute from the context menu (or use Ctrl +

-”). Multiple attributes can be unlinked simultaneously by multi-selecting.

[ Praoduct ” Sub Products ][ Referenced By ” Images & Docur

@ Linked Attributes from Product Hierarchy

Completeness Score *|ID

Hide

Show All Columns

Rotate Table

Link to Attribute Ctrl+Plus
Rermowve Link to Attribute  Ctrl+Minus

Create Local Link

M E R R T T

Jnit

aleUnit

Description

urersPartMumber

drerMame

Additional methods for maintaining attributes links

Attribute links can be added and removed in a number of ways, in addition to what has been described above.

These include:
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« References tab of the attribute itself
» Maintain > Link menu when a product or classification is selected
« Edit> Link to Attribute / Remove Link to Attribute menu when a product or classification is selected

All methods for adding and removing attribute links are equivalent, producing the same end result.

Working with Inherited Values

There are many advantages to setting common values:

o When an update is needed, the value is only entered once in the product group instead of — potentially —
separately, across hundreds of products.

« When new products are added to the group, they automatically inherit the product group’s values.

« The translation of product group values only need to be performed once, as opposed to translating the same
value every time for individual products.

As mentioned above, it is possible to set attribute values for an individual product, but consider a situation where all
products within a product group share common attribute values. For example, a set of hats that share a common
description and features.

There are two ways to approach this: 1) keep all common values with the individual product or 2) set the common
value at a higher level in the product hierarchy. By setting the value higher in the hierarchy, the attribute value is
inherited down to all products beneath.

20808-013 rev.0.7 - Product

:-Hj Primary Product Hierarchy ~ Commercial [M] Category Profile W}mmm
EE Products Product [ Sub Products References " Referenced By
=] Apparel
|“_=| Upper Body Wear @ Display
Elj Head Wear Mame *| » Value >
[E1{IT] Hats and Caps » Manufacturer Name abe

- Hats and Caps Items » Product Width 122

EH:_] Hats and Caps Sales Items > Product Height 123
L] 20803-04 » Selling Price 123 12,99 §
|l 20808-08 > Product Depth 123
li 20808-03 > Annual Sales Forecast, Maxin 123 250
{lwl 20111 =
L A > Annual Sales Forecast, Minim|123 100
l: 1112121 o . JL00% Cotton, Unstructured, S_oﬂ Crown, Low-Fitting, G-palnel mp,lSeanl'led Front Panel without Budaram, &

= > Description, Long abe Fows Stitching on Visor, Matching Fabric Undervisor, Matching Fabric Adjustable Hook and Loop Closure, One

ll 20808-012 ize fits most.
li B > Description, Table abe
{L c » Description, Web abe:
L D * Feature Bullet 1 abe Puiltin sweatband wicks away sweat to keep you cool & dry
li 1111111 > Feature Bullet 2 _£ Etretch construction provides a comfortable fit

The image above shows three inherited values, which are designated by a green down arrow (+).

The value is set at the product group, or in this case, 'Hats and Caps Sales Items'. Therefore, all products beneath
will inherit the same value.

Itis possible to override an inherited value by setting a different value at any subordinate level, e.g., the product
level. This is called a localized value. However, this requires that the attribute be valid for the child object type (as
is the case for the inherited values shown in the screenshot above). Attributes that display as inherited (indicated
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by the green arrow) but not editable (e.g., value field is yellow rather than white) are not valid for the object, so they
can only have a common value with all sibling products, which is inherited from a parent higher in the hierarchy.
Detailed information on setting validity of attributes is available in the Validity on Specification Attributes topic
in the System Setup / Super User Guide.

If a value is localized, then subsequently deleted, the product will again automatically inherit the parental value.
Therefore, it is impossible to have null (blank) values for inherited attributes (unless the parental object has the null
value).

For information on working with and/or setting up inherited reference values, see the Inheritance Example for a
Reference section of the System Setup / Super User Guide.
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Images & Documents Tab

When working with products, the Images & Documents tab displays thumbnails of all assets that are referenced by
the selected product, or inherited from a parental object referencing the asset. When working with classifications,
this tab displays all assets that are child to the selected classification. The functionality for working with the
displayed assets is the same, regardless of whether a product or classification has been selected.

Tree
m

Blue Hat rev.0.16 - Images & Documents

E (120170) (120170) “ ||| Commercial || Tables || Category Profile || Proof View || Status || State Log
ﬁ (120666) (120666) | Product ” Sub Products ” References ” Referenced By ] Images & Documents
E Eii::i; Ez::i: << Previous Filter 1-20f2 Next >3
- (179866) (179866)
- (179868) (179868)
- 109308 (109308)
E Baseball Hat (20805) E
- Gray Hat (114509)
@ Industrial Hard Hat (208C
-~ Industrial Hard Hat (1811
m Ski Hat (179857) purple cap Yellow cap
E Ski Helmet (179358) 300 x 215 px 283 % 178 px
[+ Hats and Caps SalesItems (2 - SKB 3ZKB
] T | b Primary Product Image Product Image

If more than 50 assets are present, the Next / Previous buttons are enabled at the top of the screen, allowing
users to page through sets of assets (50 at a time). Filtering functionality is also available and is especially useful
when working with large sets of assets. The options for filtering are described below.

Along with each thumbnail, basic information about the asset is displayed, including asset name, pixel size, file
size, and reference type used to link the asset to the selected object.

Interacting with Assets

From the Images & Documents tab, several actions can be taken with the displayed assets.

Edit asset

By right-clicking on the asset, users can edit any assets on the page, open an external viewer, save the image to a
disk or local PC, and view the image on a larger scale.
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[ Referenced By ] Images & Documents

Edit Asset
External Viewer
Save to disk

Image Viewer

Product Image -

Edit reference type

The type of reference that links the object and the asset is displayed in a dropdown below the asset thumbnail.
Selection in the dropdown will be disabled (grayed out) if there is only one valid reference between the object type
and asset type. If multiple valid reference types are available, selection of the reference type is enabled and can be
edited from this location. More information on references is available in the Reference and Link Types topic in
the System Setup / Super User Guide.

Filter the displayed assets

A user can filter the displayed assets by entering the name of the asset in the Filter filed. This action displays
assets that have the entered value as part of the asset name, as shown below.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 223



1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Industrial Hard Hat rev.0.33 - Images & Documents

Sub Products | Commercial || Tables || Category Profile State Log

Product " References " Referenced By ] Images & Documents

<< Previous Fiter [ | 1-250f25 Next >>

l

Proof View || Status || State Log || Tasks

ub Products " References " Referenced By ] Images & Documents

Commercial

[ 1 << Previous \ _ 1-40f4 (@5 tota) lext =2
orange cap Orange latex gloves purple cap
138 x 153 px 544 x 580 px 300 % 215 px
104 KB 345KB S5KB

ProductImage - ProductImage - Primary Product Image

. . .

[ ]
L orange cap purple cap purple cap “elow cap
5 188 % 153 px 300 % 215 px 300 % 215 px 283 % 178 px
& 104KB SKB S5KB 32KB
purple cap wire spool Yelow & Pink Hat Product Image - | |Primary Product Image ~ | |Pr0duct Image - | |Pr0duct Image -
300 x 215 px 3B1x322px 1229 x 1888 px
SKE 202KB 877KB

To remove the applied filter, delete the characters in the filter field and press the Enter key on your keyboard.

Navigate to asset

The asset name is shown directly below the asset thumbnail as a hyperlink. Clicking the hyperlink navigates
directly to the asset in the classification structure.
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Product Overrides

Product overrides are alternate versions of products and product families that may have differing values,
references, links, and structures. Attributes and values applied to the product family are inherited to the product
override and can be replaced with local values and references on the product override. Product overrides allow
product objects to exist in multiple locations in the product hierarchy and are the primary building blocks for many
print product presentations. A product override allows for the creation of 'pseudo’ product families that are flexible
to ever-changing print presentations. They can be thought of as a workaround for when an existing product family
does not contain the exact products needed for a publication layout and/or its accompanying STEP table(s).

A product override folder can include products from various "standard" (e.g., non-override) product families.
Similarly, a product override leaf object can live under a different product folder (override or standard) than the
folder in which its corresponding standard object resides.

Tree 101609 — SKU 00001 rev.0.1 - Product
- Assets m Sub Products || References || Referenced By || Images & Documents || Commercial || Tables || Stah
& 5 Confprtons P ooplon
----- i-[7] Index Wards Name 1> Wale
- ] Merchandising Hierarchy
-] Supplers > D 101609
- 7] Web Sites > Name 101609
i Entity Root * Ohject Type Product-override
[+ Publications
E'E Primary Product Hierarchy > Revision 0.1 Last edited by USER on Tue Aug 04 11:18:17 EDT 2015
i Products » Approved x Mever Been Approved
[+ Discontinued Products » [Translation Mot Translated
Product Qverrid

[Tj ES Lu | :errl = » Path Primary Product Hierarchy/Product Qverrides/Level 1/level 2/101609 — 5K 00001

g eve

i » Dverridden Product SKIJ 00001 (SKU 00001)

E Level 2
| 101609 — SKIJ 00001| || | > Product Variant Priority
: = E‘adaglr;gp ducts > |Cnmuare thiz with Overridden product
T | Dawbiteow

(3 Collections
[]__g eCatalogs MName »| > |Value
[]"‘t'} Recyde Bin > Bize abe Medium

1. Tree Structure: For clarity, it is recommended to house product overrides in a separate sub-hierarchy from
standard products.

2. Override Interface: The product override object makes it possible to override the children, attributes, and
references of a product / product family. This is useful in order to publish a limited version of a product family
without modifying the object itself.
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E}ﬁ Product Overrides

Elﬁ Lewel 1
=[5 Level 2
= | [10406 1 — Ski Jacket Pro]
- g 5K 00001
@ 5K 00002

&+l Packaging

=[] Regional Products

E|r_=| Apparel
=) Winter
=) Winter Coats
=[[7) Ski Jacket Pro
- g SKU 00001

@ SKLU 00002

------ g4 SKU 00003

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

In this example a product family Ski Jacket Pro has three products. A product override 104061 is created and
based on the product family Ski Jacket Pro. Attributes, values, and references are inherited from the product
family Ski Jacket Pro to the product override folder and can be replaced with local values and references on the

product override.

Two products from the product family Ski Jacket Pro are linked into the product override folder (SKU 00001 and
SKU 00002). The product override only contains a subset of the products included in the original product family

Ski Jacket Pro, as SKU 00003 is not included.

Important: Values and references inherited to a product override will not be inherited to products linked into
the product override. These products will have their values inherited from their original structure instead.

Selecting the Product tab or References tab on the product-override will indicate with a yellow icon (), if an

attribute or reference is inherited from an overridden product. Inherited values and references can be replaced
with local versions, assuming the relevant attribute and/or reference is valid on the relevant product override object

type.

Creating a Product Override

In Tree, select an object for which an override should be created.
2. Right-Click and select New Product-Override

In the Create Product-Override dialog,

1.

3.

o Clickan Object Type
» KeyinID and Name

« Optional: Click the ellipsis button (|...)) to select a product family to adapt values, references, and links from.
The product-override will inherit all values, references, and links from the selected product family.
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« Optional: Click 'Adopt Children' if the product-override should also include all products from the overridden
product family.

4. Press Create to create the product-override.

Linking Products into a Product Override

1. InTree, select the product override

2. Right-click the product override and select Add Children to Override
3. Search or Browse for the products to be linked into the product override

Removing Products from the Product Override

1. InTree, select the product override

2. Expand the product override and select the product to be removed
3. Right-click and select Remove Child from Override

Creating a Subordinate Product Override

1. InTree, select the product override

2. Select a product linked into the product override

3. Right-click the product and click Convert to Product-Override

The product will be converted into a product override. Values, references, and links will get inherited from the
overridden product.
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Referenced By Tab

The Referenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by product overrides, has a match code acting on it, or is used by any publication, that
information can be viewed on this tab. Finally, privileges assigned to the product can be added and edited from this
location, and subproducts that are present only in other contexts can be viewed (if the object is of a dimension-
dependent object type).

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

114613 rev.0.3 - Referenced By

Product || SubProducts || References |BRETSEGEGNY Images & Documents || Commercial || Tables || Category Profile || Proof View

Tree
Eli Frimary Product Hierarchy
EH[F Products

i#-5) Apparel
&) Footwear Reference Type v| > |Source > |Qty
Bi Shoes » |Bill of Materials + \ﬁ
E‘i Pumps > |Supplier Replacement Ttem 4 %
=il Pumps Ttem:
it @-Padaging Hierarchy References
@ SalesltemReferences, Product
@ Referenced by Products, Classificstions or Enfites
Reference Type w| » |Source |2
Packaging Link + 'y

» |Name > Path >

=T Pumps Sales Items 4

» |Name > Path >

=8 i Jinch heels
] 20709012
----- | 20738-012 > Name >
-l Translation
[T Boots.
(o 6 Publication > |Version » |Page > |Area Used > |Page Type >

{17 Safety i
[#-{77] Hardware ¥
[+-{T7] Displays ? Applies to > |Action Set  * |Attribute G... * |Object Type * |Group > |Language > [Country >
BT Furniture Add Privilege
i Auomotve P shoccnome cantets
[#-{Z7] Building Products »

1. Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a source for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the System Setup / Super User Guide documentation.
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. Referenced by Products, Classifications or Entities: The functionality is identical to what is described for
the Reference Flippers section above. The only difference is that this area displays references that have not
been placed in attribute groups for display purposes.

. Used By Product Overrides: Displays product override objects that are based on the selected object. More
information on product overrides is available in the Product Overrides topic in this guide.

. Linked into Product Overrides: Displays product override objects that have the selected object as a child.
More information on product overrides is available in the Product Overrides topic in this guide.

. Used by Match Code Objects: If the selected object is the Category indicated in a match code, the match
code will display. For example:

System Setup Find Similar - Match Code

E‘E Global Business Rules g ELL O NGT N | Match Code Walues | Statistics
[#-{%] Inbound Integration Endpoints ® Definition
-|-[75] Match Codes and Matching Algorithms |

: > »

» wil Find Simil Mame Value
- efo Find Similar > D FindSimilar
- Outbound Integration Endpoints 5 Name Find Similar
+-[55] Web UL
£ Web Uls » Last edited by 2017-01-19 13:55:37 by USER®
-] Workflow Profiles
'. 3 Workfows * Category Shoes (20689)
""" | Derived Events > Match Code Window Size 1
.75 Ahiart Tunae B Stk rae

Tree Shoes rev.0.2 - Referenced By

E|r_=| Primary Product Hierarchy A ||| Tables || Category Profile || Proof View StateLog || Tasks
(-0 Products | Product ” Sub Products ” References | REfEI‘EI'IEEd By [ Images & Documents ” Commercial ]
[+ Apparel
EJ g Footmear - Referenced by Products, Classifications or Entities
{77 Shioes - Used By Product Overrides
=[5 Pumps = Linked into Product Overrides
- Pumps Items @ Used by Match Code Objects
rj Pumps Sales Ttems D s |Name » [Edited by »
~-[[7] Boots » FindSimilar Find Similar 2017-01-19 13:58:41 by USERS
[ e =E o8

More information on match codes is available in the Matching, Linking, and Merging documentation.

. Used on Page: Displays publications that the selected object is used in. Additional information about working
with publications is available in the STEP Publisher (Adobe InDesign Integration) documentation.

. Applied Privileges: Displays the privileges that have been applied to the selected node. Privileges can be
added using the Add Privilege link, and can be removed by clicking on the row indicator and selecting 'Remove
Privilege'. Existing privileges cannot be edited from this interface. Detailed information on creating and editing
privileges is available in the Privilege Rules section of the System Setup / Super User guide.

. Visible Sub-Products in Other Contexts: Displays subproducts that are visible in another context, which is
only applicable if the object type is dimension-dependent. Note that it is not recommended to make product
object types dimension-dependent; instead, it should only be data on objects (e.g., attributes and references)
that are dimension-dependent. As a result, this flipper is rarely used.
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References Tab

The References tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has associated index words, is used by any
publication, or has any linked attributes, that information can be viewed and edited on this tab.

The display of the References tab on a product will vary slightly from system to system, based on the data model.

‘ Product || Sub Products Referenced By || Images & Documents || Commercial || Tables

il [ Assets

8-{2) Configurations ¢~ Discontinued Product Maintenance
5 T e Coometems
3 index Words C-ImageReferences
e endeng Herarchy o lemRsferences, Chssfaton
-] Suppliers
r_=| Web Sites ' Item References, Product
- Entity Root Reference Type v » ’Target 3 |0ty 3|
[ ([T GDSN
ﬁ Publications > |Bill of Materials + \? m 1821218 ! El
; : _ "y ™ 18213M0 1 x|
[I-[I] Primary Product Hierarchy o
Ei Products » |Supplier Replace... + |t
=) 0] Appare C-Packaging Herarchy References
= 0 Upper Eody Wear C-Sales Item References, Classificaton

=3 T-shirts o
g T-shirs Items SalesItem References, Product
+- il Cotton T-shirts | © Unareuped Product References

E Mew Shirt Reference Type w| ¥ [Target H H
5 G-l Polo T-shirt » |Padkaging Link + [
[+-[[Z] T-Shirts Sales Item .
() ) Head Wear BL_
[+-{T] Footwear Inherited From ¥ [Index ¥ [Level 1 »
-7 Safety > Locally defined Indexdoc_Test Index Words/Indexdoc_Test/consequati
E= ;Z:“are > Locally defined Indexdoc_Test Index Words/Indexdoc_Test/doluptatus
) ays
-] Furniture * Locally defined Indexdoc_Test Index Words/Indexdoc_Test/polyester
#-{1T] Automotive | > |Add Index Word
i i Buiding Products el_
[]i Electrical & Electronics D > [Mame »
-{7=| Food and Be
S= o RIS > 108494 Autopage Publications/Acme Wholesale Clothing/Caps and Hats
[+ Party Supplies * (111845 Autopage PublicationsfAcme Wholesale Clothing/Shirts
[+ Discontinued Products > 111512 Autopage Publications Beta Tools/Power Tools
-3 Product Overrides > |Link to Publication or Section
e il Packagns C-linked Atbutes from Product Herarchy
[ 2 GDSM Products
- C-linked Attributes from Classification Hierarchy
-3 Collections
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Reference Flippers: References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groups will display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created from the currently selected object to the object selected in the dialog (e.g., current
object = source, dialog selection = target). If any attributes are available on the reference and editable, they can
be edited within this interface. References can be removed by clicking the (X) on any existing reference.
Additional information on configuring and working with references is available in the Reference and Link Types
topicin the System Setup / Super User guide.

Ungrouped References: The functionality is identical to what is described for the Reference Flippers section
above. The only difference is that this area displays references that have not been placed in attribute groups for
display purposes. If all references that are valid for the selected object have been placed in attribute groups, the
Ungrouped Classification Links and Ungrouped Product References flippers will not be present.

Index Words: Allows users to view index words linked to the currently selected object, and to link index words
using the Add Index Words link. Index words are maintained in a dedicated hierarchy where it is possible to
maintain the word itself along with a sort word. More information is available in the Creating an Index Words
Structure topic in the STEP Publisher documentation.

Publications: Publications that the currently selected product is linked to are displayed, and new links can be
created using the Link to Publication or Section link. Additional information about working with publications
is available in the STEP Publisher (Adobe InDesign Integration) documentation.

Linked Attributes: Attributes that are linked directly to the selected product or inherited from a parental node
in the hierarchy display under the Linked Attributes from Product Hierarchy flipper. The exact columns
available will depend on the data model and the attributes that have been made valid on product attribute links.
Whether or not the various attributes are editable will also depend on the setup of the data model. However, an
ID and Name field are always shown, with the attribute name being a hyperlink that can be used to navigate
directly to the attribute. An Attribute Groups column is also present, displaying the attribute group(s) that the
attribute is in. A Mandatory column is present and if checked, the object cannot be approved until a value has
been provided for the attribute. Note that mandatory settings on the attribute itself apply globally, while
mandatory settings on the attribute link apply only to objects that are child of the node at which the attribute is
linked. More information on mandatory settings is available in the Mandatory Attributes topic in the System
Setup / Super User guide. If the attribute link is inherited (indicated by a green down arrow, =, in the row
indicator), the 'Inherited from' column will display the parental node where the attribute has been linked, which
is hyperlinked for easy navigation. More information on linked attributes is available in the Inheritance in the
Product Hierarchy topic within this guide and in the Attribute Links topic in the System Setup / Super User
guide.

The Linked Attributes from Classification Hierarchy flipper is comparable to the product hierarchy
counterpart described above, though shows attributes linked to a classification that the object is a member of
(e.g., has areference to), rather than attributes that are linked to a parental product. The same considerations
apply in that the exact columns available will vary based on the data model, with ID, Name, Attribute Groups,
and Mandatory columns always being present and functioning in the same way as for product attribute links.
Note that objects shown in the 'Inherited from' column in this case are parental objects not of the selected
object itself, but instead of a classification that is parent to the classification that the selected object references.
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The Status Tab provides general information about objects, including revisions, translation status, and approval
status. For products and classifications, the Status tab displays the same information, regardless of the object
type. Publications, attributes, entities, and assets have slightly different information available, though much of it is
common to what is described below.
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[ Product ” Sub Products ” References ” Referenced By ” Images & Documents ” Commercial ” Tables ” Category Profile ” Proof View ‘ State Log m

¢

_Reuision ¥ |Created » |Fdited » Major 3 |User » |Comment H
0.4 Fri Oct 23 16:49: 30 EDT 2013 Tue Jan 13 15:42:51EST 2016 LJSER Huto Generated

0.3 FriOct 16 09:39:06 EDT 2015 Fri Oct 16 09:39:06 EDT 2015 LJSER Complete approval

0.2 Tue Sep 22 14:14.02E0T 2015 [Tue Sep 22 14:14:02 EDT 2015 USER Wuto Generated

01 FriFeb 13 11:36:40 EST 2015 FriFeb 13 11:36:40 EST 2015 STEPSYS

Context » |Approval Status H
» Danish DK xLastAmouedonFnDctlﬁﬂs:ﬂs:UﬁEJTMIS
> English LK € Last Approved on Fri Oct 16 09:33:06 EDT 2015
3 English US x Last Approved on Fri Oct 16 09:3%:06 EDT 2015
» French Belgium x Last Approved on Fri Oct 16 09:39:06 EDT 2015
» French Canada 3¢ Last Approved on Fri Oct 16 09:33:06 EDT 2015
> French FR x Last Approved on Fri Cct 16 09:3%:06 EDT 2015
* fGermany German x Last Approved on Fri Oct 16 09:3%:06 EDT 2015
} |Israel Hebrew 3C Last Approved on Fri Oct 16 09:33:06 EDT 2015
Attribute > |Visble in workspaces # |Visible in dimensions 3 Value
* Lang Item Description )ﬂwoued, Main Country=AlCountries, Lanquage =en-U5 Red carpet worthy pumps in scarlet suede is sure
» Packaging Type )ﬁmoued, Main Country=AlCountries, Language =std.Jang.al Box
> Supplier Name )»woued, Main Country=AlCountres Products Galore

No problems found

9_

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021)

232



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

. Revisions: In STEP, historical versions of objects are stored as revisions. A revision thus represents a
historical "snapshot" of an object. The Revisions flipper provides a record of the revisions that have been made
to the currently selected object, including when changes to the object were made and who made them. Via
right-click, users are able to purge old revisions or revert to previous revisions. For more information on
revisions, including how they are generated and how they should be managed, see the Revisions topicin the
System Setup / Super User Guide.

. Workspaces: All the workspaces that the selected products are in will display, as well as the revision number
that exists in that workspace. Generally speaking, if the object has been edited since it was approved, the Main
and Approved workspaces will hold different revisions. However, it should be noted that not all changes to an
object generate a revision. More information on this is available in the Revisions topic in the System Setup /
Super User Guide. For more information on workspaces in general, see the Workspaces topic in the
System Setup / Super User Guide.

. Translation: Translation relations (sources and targets) and status (e.g., Up to date, Re-translation needed,
etc) of the translations display. For more information, see the Translations documentation.

. Approval status in all contexts: Displays the approval status of the object in each context on the system.
More information on approvals is available in the Approval of Objects topic in the Getting Started / User
guide. More information on contexts is available in the Contexts topic in the System Setup / Super User
Guide.

. Hidden values: Displays hidden inherited values on the object. Hidden values are those that are inherited
from another dimension (e.g., language or country) rather than from a parental object. More information on this
is available in the Dimension Dependent Data section of the Contexts topic in the System Setup / Super
User Guide.

. Diagnostics: Displays any issues with the object found by system diagnostics. If a problem has been found,
the information can be copied by clicking the file link.

% Diagnostics
Prnblems found. Press button to copy information to dipboard. Please supply this information to Stibo System.
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Sub Products Tab

When the Sub Products tab is accessed on an object of the product super type, all direct children of the selected
node are displayed. If privileges allow, data can be edited on the displayed objects by clicking directly into any
editable field. Standard editing capabilities are available within this interface (as described in the Editing Objects
in Tree topic within this guide) including copy / paste functionality using Ctrl + C and Ctrl + V.

Tree
Product || Product Variants |REUINLOTITWEN | References || Referenced By || Images & Documents || Commercial || Tables || Category Profile

F{ ] Assets
r_=| Configurations
|'_'=| ETIM Hierarchy
|'_'=| Index Words
|'_'=| Merchandising Hierarchy
|'_'=| Suppliers
[#-[) Web Sites
&[] Entity Root
[l () GDSN
ﬁ Publications
EI|“_=| Primary Product Hierarchy
[ Products
EI|_'_=| Apparel
E]|"_=| Upper Body Wear
=[] T-shirts
E}-i) T-shirts Items

18 new shirt

[#-[[7] Head Wear
[+-{I7) Footwear
-] Safety
[#-{7) Hardware
[+-{{T) Displays
[-{I3) Furniture
[T Automotive

(-] Building Products
[+-[{T] Electrical &Electronics
{7 Food and Beverage
{13 Kitchen

[#-{IT] Party Supplies

[#-[ Discontinued Products

il Cotton T-shirts

: [-{ill Polo T-shirt
1[5 T-Shirts Sales Ttems

View: Show all -
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T-shirts rev.0

| 18217-054 > |18207-012 »|18214-012 >
iin} > 100305 18207 18214
Mame »|18217-054 15207-012 18214-012
Object Type > Bales Item Sales Ttem Sales Item
Revision > 10,23 Last edited by USER& on Thu Ja...[0.4 Last edited by USERS on Mon ... 0.5 Last edited by USERE on Thu Ja...
Path » Primary Product Hierarchy/Products/... Primary Product Hierarchy Produc. .. Primary Product Hierarchy/Products/...
Approved > x Last Approved on Fri Sep 16 10:... x Last Approved on Mon Jun 15... x Last Approved on Mon Jun 15 1...
Translation > Not Translated Mot Translated Mot Translated

Classification 1 root | Web Sites | Acme Classification 1 root | Merchandising Classification 1 root | Web Sites | Acme
cateaor Retail Web Site | Apparel | Mens CasualHierarchy | Apparel | Sportswear | Retail Web Site | Apparel | Mens

gary | T-shirts and Sweatshirts | 18217-054 [T-shirts | 18207-012 Casual | T-shirts and Sweatshirts |
18214-012

Parent > T-shirts T-shirts T-shirts
Selling Price > 3.57% 3.57%
Annual Sales Forecast, Maximum > 5000 5000
Annual Sales Forecast, Minimum > 2000 12000

Description, Long

The best-selling T-Shirt For over 35
years, it has set the standard for

N T-shirt comfort and guality. Today it's

better than ever, offering areater
durability and less shrinkage than you'l
get with ordinary tees.

The best-selling T-Shirt For over 35
years, it has set the standard for
T-shirt comfort and quality. Today
t's better than ever, offering
greater durability and less shrinkage
than you'll get with ordinary tees.

The best-selling T-Shirt For over 35
years, it has set the standard for
T-shirt comfort and guality. Today it's
better than ever, offering areater
durability and less shrinkage than you'l
get with ordinary tees.

Description, Table

Feature Bullet 1

N Fiber Content: Fabric: 100% Ring-spun

Cotton

Fiber Content: Fabric: 100%
Ring-spun Cotton

Fiber Content: Fabric: 100% Ring-spun
Cotton

Feature Bullet 2

v

Lltra-soft premium cotton feels great
against your skin. ENG value test

Ultra-soft premium cotton feels
great against your skin.

Lltra-soft premium cotton feels great
against your skin.

Feature Bullet 3

N Mon-chafe fabric taping reinforces neck

and shoulders.

Mon-chafe fabric taping reinforces
neck and shoulders.

Mon-chafe fabric taping reinforces neck
and shoulders.

Feature Bullet 4

. Lay Flat collar keeps its shape wash

after wash,

Lay Flat collar keeps its shape wash
after wash.

Lay Flat collar keeps its shape wash
after wash.

Feature Bullet 5

N Durable double stitching trims sleeves

and bottom hem.

Durable double stitching trims
sleeves and bottom hem,

Durable double stitching trims sleeves
and bottom hem.

Frimary Color > Blue Orange

Sales Item Short Description > T-shirt, Blue, M, cotton T-zhirt, Orange, L, cotton
Selling Price UOM > EA EA

Size > Medium

Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and
Mark Different selections - all of which are self-explanatory and can be especially useful when editing multiple

objects.

Note that two views are available using the Rotate Table option. As shown above, the view can be organized to
have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Also
note that right-clicking within the header field exposes different options than within the data fields, including an

option to add a product.
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-
Product || Product Variants |REINGETLITEEN | References

View: Show all
Object Type * [Revision > |P
18217054 » Sales Item P.Blmlﬂﬁ!dbrlﬂill... P
Hide
Show All R
18207 ow ows ted by USERG ... P
Rotate Table
Add Product Ctrl+Plus
Rernove Row(s) Ctrl+Minus
T T

Selecting Add Product opens a Create Product dialog allowing the user to input data to create a new object,
which will be added as a child to the currently selected node. The options available in the dialog are based on the
data model defined in System Setup. For example, the object type selection will vary based on the allowable object
types under the selected parent, and ID will only be available for population if the object type being created does

not have autogenerated IDs applied.

[ 1 Create Product >

Object Type

D |115206 |

Mame | |

|{:raal§:||ﬂmcel|
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Recycle Bin for Tree

This topic describes the functionality available for objects within the Tree Recycle Bin. For information on the
System Setup Recycle Bin, see the Recycle Bin for System Setup topic in the System Setup / Super User
Guide. For information on deleting objects from Tree, see the Deleting Objects in Tree topic within this Getting
Started / User Guide.

Important: Objects in the Recycle Bin are not searched when a user performs a search in workbench and
Web Ul. This limitation also applies to searches done using the workbench Goto functionality. Additionally,
attribute values of objects in the Recycle Bin cannot be edited. If editing is required, the object needs to be
revived.

When an object is deleted from Tree, it is moved to the Recycle Bin located on the Tree tab.

In Web Ul, attempting to display an object that exists in the Recycle Bin, as shown below, recycle bin images fill the
background of the object that is no longer in the primary product hierarchy. When the 'Show Recycle' parameter is
checked in the Tree Navigator component, this background is displayed when viewing objects in the Recycle Bin.
For more information, see the Tree Navigator Component topic.

The user can use the revive or permanently delete steps below to remove this background and resolve the object's
status.

A Anan Main  English & E ﬁ
s Deleted PDLs : 20000805984 X
» .
Customer Details * Customer Specific data to PDL references
Customer » CONVEMIENCE » FOODS INC. » 200 removed for : 2000080964
Customer Data Sales Organisation List of Child Customer PDL
P Delete
F o Name . 4
© | Master_2000080964 o

Mumber of items: 1

GTINs on Clavis PDL
Customer > CONVENIENCE > FOODS INC. > 2000080964

ﬂ] Select all
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Revive or Permanently Deleting Objects

To revive or permanently delete an object, right-click on it in the Recycle Bin and choose one of the options
described below.

El!g Recyde Bin

@ (isc—
P (11484 ». Purge

E (1148 Approve Deletion
E (1148 Approve Deletion Recursively

E (abcde Revive
@ 12119 Revive Recursively
- 1821750

« Purge: Permanently deletes the object, with no subsequent option for revival.

« Approve Deletion: Deletes the selected object from the Approved workspace, and passes a deletion event
for that object. This option is only enabled on objects that are workspace revisable.

« Approve Deletion Recursively: Deletes the selected object and all of its children from the Approved
workspace, and passes a deletion event for allimpacted objects. This option is only enabled on objects that are
workspace revisable.

« Revive: Revives the selected object, returning it to the location in Tree from which it was deleted. Note that
object revival has some dependencies and objects may not always be revived exactly as they were prior to
deletion. For example, if an object had references to other objects which have subsequently been deleted,
those references will not be present upon revival.

« Revive Recursively: Revives the selected object and all child objects to their previous location in Tree. Note
that object revival has some dependencies and objects may not always be revived exactly as they were prior to
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deletion. For example, if an object had references to other objects which have subsequently been deleted,
those references will not be present upon revival.
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Schedule Empty Recycle Bin

Objects within the Tree Recycle Bin can be automatically deleted and/or purged on a scheduled basis by using the
Schedule Empty Recycle Bin feature. Recycle Bin emptying can be scheduled in a similar manner to how other
processes are scheduled in STEP (e.g., data imports, data exports, and bulk updates). The ability to schedule
Recycle Bin emptying at designated times, e.g., overnight, can help free users from time-consuming, manual
Recycle Bin emptying tasks, allowing the Recycle Bin to be regularly emptied with minimal or no user intervention.

Configuring a Schedule Empty Recycle Bin Operation

To set a schedule for emptying the Tree Recycle Bin, follow these steps.

1. Right-click on the Recycle Binin Tree and select Schedule Empty Recycle Bin to display the Schedule
Empty Recycle Bin wizard.

[+ Customer Root
[+-- 2= Entity Root
(] GDSN

| -] GOSN Receiver

L :

o &+-{] Merge_Golden_Root

G| -] Prometions
— -] WSEP

w | [l Publications

E --i Primary Pro Search in recycle bin

[ E) :

EI @ Collections | (4} Empty Recycle Bin

B eCatalogs .

] :

D | G~ Redjde B E Empty Recycle Bin Before...
gy B — @ Schedule Empty Recycle Bin

Approve Deletion Recursively

2. Onthe Delete Options screen, choose the number of days that an object must be in the Recycle Bin before it
is deleted, as well as whether you would like to approve deletions or attempt to force purge objects.
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[ 1 Schedule Empty Recycle Bin *
Steps Delete Options

1. Delete Options Delete ohjects after 7= daysin the Recyde Bin.

2. Select Contexts

3. Scheduled Execution Delete objects and their children from the Approved workspace,
4. Mame Process

[] Approve Deletion

|:| Force Purge
Attempt to forcefully delete objects that cannot be deleted via the

standard Empty Recyde Bin operation.

Back Finish Cancel

The available parameters are:

« Delete objects after __ days in the Recycle Bin: Enter the number of days that an object must be in the
Recycle Bin before it is deleted. The default value is 7.

« Approve Deletion: Select this option to remove objects and their children from the Approved workspace,
which will send a DELETEAPPROVAL event.

The following considerations apply to the Approve Deletion parameter:

The 'Approve Deletion' parameter is not affected by the value provided in the 'Delete objects after
days...' parameter. As a result, when the Schedule Empty Recycle Bin operation runs, if 'Approve
Deletion' is selected, all objects in the Recycle Bin will be removed from the Approved workspace, even
if they have not been in the Recycle Bin for the specified number of days.

When an object is removed from the Approved workspace via 'Approve Deletion,' a
DELETEAPPROVAL eventis generated for that object. However, if the object is subsequently purged
from the Recycle Bin as part of the same Schedule Empty Recycle Bin operation, the event is also
deleted, since the object that the event is related to no longer exists in the system.

Therefore, if you have an event-based OIEP set up to capture DELETEAPPROVAL events, itis
recommended to schedule this OIEP to start at more frequent intervals than the Schedule Empty
Recycle Bin process, since the DELETEAPPROVAL event may disappear before the OIEP has been
invoked. For example, schedule the OIEP to start every minute and configure the Schedule Empty
Recycle Bin process to run once a week.

» Force Purge: Select this option to attempt to forcefully delete objects from the Recycle Bin that cannot be
deleted via the standard Empty Recycle Bin operation. For example, with this option enabled, objects in the
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Approved workspace can possibly be force purged from the Recycle Bin without having first been removed
from the Approved workspace through Approve Deletion.

3. Onthe Select Contexts screen, choose the contexts from which to delete objects.

[ Schedule Empty Recycle Bin >
pty Recy

Select Contexts

Select the context(s) from which objects should be deleted.

Available Selected
English UK Danish DK
French FR. English US
Germany DE

2=E=

2 context(s) selected

[(eack | [ Meet | [N [ Crcd ]

4. Onthe Scheduled Execution screen, determine when and how often to empty the Recycle Bin.
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[] Schedule Empty Recycle Bin >
phy Recy
Steps Scheduled Execution
1. Delete Options Start
2. Select Contexts
() Now Start at (hh:mm): 15:45
3. Scheduled Execution
4. Nama Process () Later Start on {yyyy-mm-dd): [2019-05-15
(@) Weekiy End on {yyyy-mm-dd): |-
() Monthly Every: Mon []Sat
(") Later and repeat [1Tue []sun
[ wed
[ Thu
[] Fri
Start every Mon 15:46:00 ET, starting Wed May 15 2019
Back Mext Finish Cancel

5. Onthe Name Process screen, give the batch process a name if desired, then click Finish to complete the
setup. To create more than one scheduled process, complete all steps in the wizard again.

[1 Schedule Empty Recycle Bin et

Steps Mame Process

1. Delete Options
2. Select Contexts
3. Scheduled Execution
4. Name Process

Batch Process Mame:  |Weekly Scheduled Recyde Bin Purge

Back Mext Finish Cancel

6. Scheduled Empty Recycle Bin processes are stored on the BG Processes tab under Scheduled Processes >
Queued Processes and display a status of 'waiting.' They can be edited by clicking the 'Edit' button in the
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; % Revive Recursively

% RuleSetExporter

% RuleSetImporter
% STEP Workflow Profiling

; Scheduled Empty Recyde Bin
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Weekly Scheduled Recycle Bin Purge - Background Proce

Background Process

5

@Propertes

Scheduled Processes
E]% Queued Processes

) y Scheduled Recyde Bin Purge

; % Seal Change-Package

% Smartsheet Expart

i :':ﬁ Smartsheet Impart

% StateflowDeadline

; % SuspendBGPs

% Translation

% Translation Import

% Unigue Key Processes

&l Unlink Object Type

:':ﬁ Update actual page from plan
% UploadDTPDocument

% Web UI Asset Pipeline Download
: % Web UI Download

- Web UT Upload

£

Property > [Value >
Started by IUSER4
Id BGP_312240
Description Weekly Scheduled Recyde Bin Purge
Schedule Every Sun 01:00:00 ET, starting Fri Jun 21 2019
Execution Server doc-dev
Status waiting
Created Fri Jun 21 11:26:28 EDT 2019
Started Fri Jun 21 11:26:30 EDT 2019
# of warnings 0
# of errars 0
Mext Run Bun Jun 23 01:00:00 EDT 2019
§ BeatonReport
1 Context ID(s). Context (Fri Jun 21 11:26:28 EDT 2019)
= Workspace 1D(s): Main (Fri Jun 21 11:26:28 EDT 2019)
> Delete Objects after limit: 7 (Fri Jun 21 11:26:28 EDT 2019)
< Approve deletion: true (Fri Jun 21 11:26:28 EDT 2019)
= Force Purge: false (Fri Jun 21 11:26:28 EDT 2019)
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Navigating and Searching

This section describes the many different ways you can access specific data in the workbench. STEP Workbench
offers rich functionality for finding both System Setup and Tree objects based on various criteria. Whether it be by
standard navigation, Bookmarks, searches using basic, advanced, or drill-down functionality, STEP provides
many ways to locate the required data.

This section will allow users to:

« Navigate hierarchies

« Find data quickly using the Goto function

« Find data using basic and advanced searches

o Perform drill-down searches using the Search Result Profiling page
» Use standard and Search Bookmarks

For information on search functionality in the Web Ul, see the Homepage Widgets topic and the Advanced
Search topicin the Web User Interfaces / Web Ul Setup and User Guide documentation.
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Navigation

You can navigate the STEP tree structures in the same manner as you navigate Windows folder structures. Basic

desktop computer skills are prerequisites for all users of the STEP system.

Expanding a Folder

Use one of the following methods to display the contents of a folder:

« Click the plus sign (+) to the left of a folder

» Double-click a collapsed folder

Collapsing a Folder

Use one of the following methods to hide the contents of a folder:

« Click the minus sign (-) to the left of a folder
» Double-click on an expanded folder

Collapse Tree

When folders in the Tree hierarchy are expanded, all can be collapsed by using the 'Collapse Tree' option from the

'View' menu.

= 7] Assets

rj Icons

rj Hlustrations

rj Installation Manuals
rj Logos

[#-[[T] Owners Manual
rj Product Images

' [C] Product Videos
Transformation Lookup Table
+|-{—] Configurations

+-[ ] Web Sites

£
£
-] Addresses
[
£
£

+- [0 Customers

+]- (0] Entity Roaot
+- {5 Publications

[=-{IT] Primary Product Hierarchy
E}|__=| Products

r_=| Apparel

r_=| Footwear

=-IT] Hardware

: E}Fj Toals

o
Mode -] Assets
Context r_=| Configurations
Workspace ID:I eClass 10
[#-{T] ETIM Hierarchy
Target --@ Index Words
Filt [#-{ 7] Merchandising Hierarchy
o &[] Offers
Prirnary Hierarchy r_=| Suppliers

Select version

Mew Wiew
Remove view

Product views
Show Source Context

Rotate Table
' Reload

a Collapse Tree

nicﬂhllﬁ I"HII"IIIH"'F‘II" LI'HIIIF'IE

F5

[-{ "] Web Sites
---@ Addresses
[0 Customer Root
---@ Customers
(0 Entity Root
() GDSN

ﬁ Publications
r_=| Primary Product Hierarchy
(3 Collections
[ﬁ eCatalogs
'ﬁ Recyde Bin
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Navigating and expanding folders and sub folders can be done in any tab. However, when in the Workflow tab,
first open a flipper to display the processes.

;I ?

K TESIE
g

b |Fi|ter by Collection "ZI
@ Start 1
% Update

(¥

[=]

& | End

o | e

— o

=]

E (o]

= | &=

I

) [0

| e

g o

g

g (O

= |

z o

= K5

-

& Rog

= o

&

~ Rog

(7]
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Goto

The Goto functionality allows the user to locate an object in STEP in a quick and efficient manner. There are two
'Goto' features:

« Goto - A quick way to jump to a particular object in the database based on the name and/or ID. If there are
multiple hits, it displays the first one. Press 'Ctrl+G' to move the cursor to the Goto parameter.

o Goto Next - When there are multiple hits from the 'Goto' function, the user can opt to select Goto Next to
continue on to the next hit. Press 'Ctrl+E' to display the next Goto Next item.

Type in the Name or ID of an object in the Goto field, press Enter or click the Goto next object button to the right
of the field, and the system will take you to the object without displaying a list of search results.

Once you start typing in the Goto field, the system will suggest objects matching the typed-in text (case insensitive)
and display them on a dropdown menu as shown below.

Goto | ID/Name vla

. A
L. A (12345-001) - u
[ A(8783) b
(1T asset.dass (asset.dass)

[IT asset.colors (asset.colors)

[IT asset.colorspace (asset. colorspace)
|]I asset. compression (asset. compression)
(1T asset.creator (asset.creator)

|]I asset,depth (asset.depth) -

i

When typing in the 'Goto’ field all objects are searched not just products. This includes but is not limited to
classifications, assets, attributes, user names, etc.

Itis important to keep in mind that:

o Object IDs and Names are both searched.

o Object IDs are searched case-sensitive.

o Object Names are searched case-insensitive.
o Wild Cards are not allowed

Items can be selected from the menu using either the mouse or the keyboard up arrow and down arrow keys. A
maximum of 20 items will be displayed.

Another way to find the Goto and Goto Next options is in the Navigate menu.
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Mavigate Format Maintain Window
@ Search Ctrl+F
Search Below

Goto Ctrl+G
Goto Mext Ctrl+E

Back

S o B

Forward

Bookmarks »

Find Similar Product

Keys in the Goto function dropdown

The ID/Name dropdown list in Goto function will have any created keys as part of the dropdown list.

Goto |ID/Name + |Red

IDYName
Supplier Part Mumber

Selecting a key from this dropdown can be used to identify and delete objects, parents, referenced objects, and
assets. The system will take the user to the product that has the unique key value stored on that object.

Setting the Primary Hierarchy for '‘Goto' searches

A user can set the Primary Hierarchy to be either a Primary Product Hierarchy, Classification folder, Asset Folder,
etc, through the View > Primary Hierarchy Menu. Once the primary hierarchy is selected and an object is
searched, first priority is given to the folder that is selected and then the other folders will be searched.
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View Mavigate Format Maintain Window Help

Mode | v | € > O urL [editor
Context

Workspace

Target ﬁ

Filter > Spedfic Attriutes

Primary Hierarchy I Assets

Select version Classifications

Primary Hierarchy

Configurations

Index Words

Mew View

Remove view

) Merchandising Hierarchy
Product views

Suppliers
Show Source Context Web Sites US
Rotate Table Primary Product Hierarchy
' Reload F5
Other

Crollance Tree

For example, if the View > Primary Hierarchy is set to Assets, the product will first be searched under Assets.
Then when clicked on Search again, the user will be shown in the actual hierarchy where the product was initially
created. In normal circumstances, the product will by default be searched in the actual hierarchy where it was
initially created.

Important: Objects within the Recycle Bin are not searched as part of the Goto functionality.
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Bookmarks

Bookmarks in STEP are placeholders created by the user that serves as a shortcut for previously viewed objects.
In the STEP system, there are two types of bookmarks:

1. Standard Navigation Bookmarks
2. Search Bookmarks.

Standard Navigation Bookmarks

Standard navigation bookmarks are used for quickly accessing specific nodes in the Tree and System Setup
hierarchies.

You can add a standard navigation bookmark by selecting a node in the hierarchy and clicking Add Bookmark in
the Navigate: Bookmarks menu or alternately by using the Ctrl+D keyboard shortcut. The bookmark will
afterward be accessible in the left side Bookmarks tab.

Search Bookmarks

Search Bookmarks are used for storing specific searches that can then easily be re-run.
Steps to add a Search Bookmark:

1. Create a search criteria in the Search tab.

[=]

=

& | Reset || search |
Displaying 3 of 3 results Show Details

ﬁ Mame >

© || » = T-shirts D = 18454

&1|| > p= T-shirts D = 18206

B £T—5|ir|5 I = 1820

2. Go to Navigate > Bookmarks
3. Select'Add Search Bookmark'
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File Edit View Mavigate Format Maintain Window Help

D Context E @ Search Ctrl+F e |E’ e é

> Goto Ctrl+G
i[> Goto Next cti+E ' Search Result Profiling
€ Back 3 hit(s)
Click links to narrow down search
= Forward

Mame

[ Add Bookmark _ Ctrl+D
|@ Add Search Bookmark

Processes

T-sh
-T—sIJ Find Similar Product

L

4. Adialog will be displayed to type in the bookmark name.

Enter Bookmark Mame

@ Enter the bookmark name
Search #1 |

5. Click on OK button.

Accessing the Saved Search Bookmark

When you click on a stored search bookmark, the search parameters will be populated. Select Search to rerun the
search.

B

=1 | | Search: T-shirts

T; IVDI::IjectType = Sales Item

m

bl (s~ | Reset | Search |
- Show Details
% [ Mame |
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Bookmarks

w |5 Brand Logos (BrandLogos)

1|21 Export Configurations (stibo.EMConfigFol
5 Copy Writing State (100100}

S & Search #1

Saved bookmarks can also be found in the under the Navigate > Bookmarks.

Mavigate Format Maintain Window Help

& Search Ctrl+F v | 6
»  Geoto Ctrl+G
[{> Goto Next Ctrl+E
€ Back
< Forward
Bookmarks 3 IZE Add Bookmark Ctrl+D
Find Similar Product e
(3 Brand Logos (BrandLogos)
O Export Configurations (stibo.EMConfigFolder)
0 Copy Writing State (100100)
@. Search #1

Editing a Bookmark

Both standard navigation and Search Bookmarks can be edited in the Bookmarks tab by right-clicking the
bookmark and selecting Edit Bookmark in the context menu. Itis possible to edit the name of the bookmark and
also the object/ search URL if the Edit URL checkbox is activated.

Removing a Bookmark

Both standard navigation and Search Bookmarks can be removed from the Bookmarks tab by right-clicking the
Bookmark in the tab and selecting Remove Bookmark on the context menu.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 252



[T1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Search

The Search tab, in combination with the Search Result Profiling page, offers extensive methods for locating
objects in STEP quickly and efficiently.

Generally, there are two approaches to performing searches:

1. If you know specific details about the object you wish to find, use the Search tab. For example, all products
where the value for the attribute 'Weight' is less than '5 kg', the object is located below the product folder 'Office
Chairs' and is not of the object type 'ltem’.

2. Ifyou do not know details, start with a broad search and then narrow it down using the Search Result
Profiling.

Search Elements

The elements on the Search tab work together to create and refine a search for objects in STEP. The numbered
elements in the following image are described below.
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Search

|search: 20%

[Search:

| = Chiect Type = Asset

@ Advanced

=0

Displaying 100 of 127 resull@
ame

osnuw Details

2 1D = 206595

E

45 I = 20855

20 I = A0555

m

>
>
»[719 ID = 2013
>
>

] 20-68204 D = 2055: e
» W 050-42151 [ = 7875

*191 ID = 20140

i- 200 ft. Medium Voltage Cable (Pallet) 1D = 775:

W

w 7832-200 [0 = 755z

w

w 18207-012 [0 = 18207

el 18210 M B [ = 15210

* N 18214-012 [0 = 18214

* |w 18215-012 [0 = 15215

-Operations on Entire Result

Search Result Profiling

Search Result Profiling

127 hit(s)
Click links to narrow down search

Motice: Profile is notfiltered according to contest visibility / privilege check

Results by Object Type
Product (107) - exclude

EHEW’I (41) - exclude

| Salesltem (18) - exclude
.CESEHU} - exclude
[CiLevel? (7} - exclude
[olLevel2 (B) - exclugs
-HEI’HFDMEHE} - exclude

[T SalesltemFolder (B - sxclude
Wl Pallet (4) - =cluce
r_=||_8'u'9|1 (3 - exclude
[CLeveld (3) - exclude

[ SalesltemFamily (2} - exclude
N temFamily (1) - exclude
I_F'EICK 10 - exclude

Classification (20} - exclude

[CJAssetlevel 2 (7} - exclud
[CJAsset Level 1(4) - exclud
[C]Department (3} - sxclude
[ MerchandisingClass (3) - exclude
[T SubDepartment (3} - sxcluce

=
=

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most comman)

r_=|F'I'UdLIIDTS EQQ} - exclude

iEIU‘u" Side Packaging (15} - exclude
er'I'UdLIETS (1) - exclude

Il Crinking ltems (5] - excluge

[C] T-shirts and Sweatshirts (4} - =scclude

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

m

1. Search criteria type selector - Click the text to display a list of available search criteria options. See the Search

Functionality topic for more information.
2. Add criteria / operator button - Click the green plus button () to add a new search criterion or hover the

mouse over and hold down the green plus button () to display a sub menu and choose an OR operator or an

Exclude operator. See the Search Functionality topic for more information.
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Remove search criteria button - The X button clears an individual criteria from the search. Click the Search
button to refresh the Results Area.

Reset button - Clears all results and search criteria from the Search panel and Search Result Profiling page.
Search button - Runs the defined search.

Search result counts - The number of items currently displayed and total number of items found by the search.
If the search finds objects not visible in the current context or objects that you are not privileged to see, a
message is displayed and the objects are not displayed in the search result.

Show Details / Hide Details toggle - Hyperlink shows or hides search result details. The details view displays
asset thumbnails. The asset thumbnail is displayed when the search is under a classification folder and there
are assets. Similarly, if the search is for the products and the product is linked to an asset, the thumbnail is
displayed. If noimage is linked, 'No Primary Image' is displayed.

Search results list - When a search has been executed, the results are shown in a list below the search box.
Clicking one of the results will open the object editor for that particular object in the Search Results Profiling
pane, while continuing to display the search results list. It is also possible multi-selection from this listand a
maximum of 100 results are displayed. The complete result set can be viewed, exported, or updated using the
'Operations on Entire Result' options below.

Save as Collection button - Click to open the 'Save as Collection' dialog and save the entire result setas a
collection. Collections are available on the Tree. See the Search Operations on Entire Result topic for more
information.

Export button - Click to open the Export Manager wizard and export the entire result set to a specified file type.
See the Search Operations on Entire Result topic for more information.

Bulk Update button - Click to open the Bulk Update wizard and modify a variety of elements on each item for
the entire result set. See the Search Operations on Entire Result topic for more information.

Search Result Profiling - Panel displays profiling information about the search including categories and
provides a convenient way to further refine the search. See the Search Result Profiling topic for more
information.

Search Options

The Search tab dropdown includes a number of options. Each is described in greater detail in the topics that
follow.

———

S ﬂ

& Advanced
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o Object Type

o Search Below

» Referenced Assets

« Revised Objects Changed Since
« Data Containers

o Search from List

» JavaScript Search

« Missing Mandatory Values

o Unapproved

o Product Override Search

o Search in Publication Hierarchy
« References

« Referenced By

o STEP Workflows

o Sample Result

« Translation Status

o Unpushed or Failed Assets

For information on performing optimal searches, see the Scheduled Process Recommendations topic in the
System Administration documentation.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 256



[T1STIBOSYSTEMS

e MASTER DATA MANAGEMENT

Search Functionality

This section describes the different types of search criteria available in the STEP system as well as some basic
search functions.

Important: Calculated attribute values are generated on-the-fly. Searching for the value of a calculated
attribute is not allowed since generating all possible calculations would cause substantial performance issues.

Standard Search Criteria

The standard search criteria named 'Search' allows you to find objects based on name, ID, attributes and their
values.

A text string entered in the search field will search for object names, IDs, or attribute values where the text occurs.

[Sezrch =

Hats! |

&= advanced

[k ~ | Reset || search |
Show Details

| Name >

If you enter a text string and click the Search button, search finds objects with an ID, and/or a name and/or an
attribute and/or their values matching the entered string. You can further refine standard searches as shown
below.

Search Field Typeahead

Once you start typing in the standard search criteria text field, the system suggests possible entries matching the
typed in text (case insensitive), and displays them on a dropdown menu as shown below.
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[Search
Haﬂ

|- Hat123 (110150)

[T Hats and Caps (20435)

[l Hats and Caps Items (20438)

[T Hats and Caps Salesltems (20433)
[T Hat Size (HatSize)

[E Hat Workflow (Hat Warkflow)

|l |

In the typeahead menu, objects are displayed with their relevant icon, then name, and then ID in brackets.
Attribute values are shown as text.

Items can be selected from the menu using either the mouse or the keyboard 'arrow up' and 'arrow down' keys. A
maximum of 100 items will be displayed.

Limiting Results to Matches on IDs

You can limit standard searches to match on ID only by entering 'ID =" at the beginning of the text field as shown
below.

Search

e

'id"and 'ld" will also work, as the spaces on each side of the equals sign are optional.

Limiting Results to Matches on Name

You can limit standard searches to match only on name by entering "Name =" at the beginning of the text field as
shown below.
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Search
]

Mame = hat]

li Mame = Hat123

[T Mame = Hats and Caps

[l Mame = Hats and Caps Items

[[C] Mame = Hats and Caps SalesItems
DI Mame = Hat Size

[E Mame = Hat Waorkflow

 —

"name" and "NAME" will also work since the spaces on each side of the equals sign are optional.

Attribute Value Searches

Using a standard search, you can limit the result to only match on values for specific Attributes.

Important: Calculated attribute values cannot be searched since they are generated only when viewed or
processed.

There are at least three ways to construct an attribute search query:

1. Start entering an attribute name or ID, then select the relevant attribute from the typeahead menu, after which
"Attribute Name (Attribute ID)" is inserted in the text field, then enter a search operator or enter a SPACE and
select an operator from the typeahead menu and enter the value to search for.

Search ™
g 123 (110190)

TR Hat123 (110190)
[T Hats and Caps (20435)

[l Hats and Caps Items (20438) l
[T Hats and Caps Salesltems (20438) ;
|]I Hat Size (HatSize) |

[E Hat Workflow (Hat Workflow)

2. Enterthe attribute ID (case sensitive), enter a search operator or enter a SPACE and select an operator from
the typeahead menu, then enter the value to search for.
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[Search
Hat123 (110190) |
Hat123 (110190) !

| |Hat123 (110190) 1!
Hat123 (110190) <
THat123 (110190) <=
Hat123 (110190) =
Hat123 (110190) =
Hat123 (110190) ==

— e |

3. Enter the attribute name (case insensitive), enter a search operator or enter a SPACE and select an operator
from the typeahead menu, then enter the value to search for.

Search
Search ™
Salesltem = |
Salesltern = 120-Volt Portable Tire Inflator, Campbell Hausfe »
| |Saleslterm = 120-Volt Portable Tire Inflator, Husky E|

Salesltem = Battery, All purpose, A4, 2 pk

“|salesItem = Bed, Expresso, Comfy, Queen

Salesltem = Bottled Water, Evian, 8 oz 12-pk

Salesltem = Bottled Water, Evian, 8 oz 24-pk

Salesltem = Bottled Water, Evian, 8 oz 6-pk

Salesltem = Cap, Orange, One Size, Cotton 7

| — el |

Attribute Value Search Operators

The following search operators that can be used when performing attribute value and reference metadata
attribute value searches.

Operator Description

< Less than operator. Only works for number validated attributes (Validation Base Type = number,
integer or fraction)

<= Less than or equal to operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)
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Operator Description

= Equal to operator.

> Greater than operator. Only works for number validated attributes (Validation Base Type =
number, integer or fraction)

>= Greater than or equal to operator. Only works for number validated attributes (VValidation Base
Type = number, integer or fraction)

! Operator used for finding objects where the specified attribute does not have values in current
context. Note that the search does not check whether the attribute is valid for a given object. Also,
if the specified attribute has an inherited value (not a local value), then the object will be listed in the
results set even though the value field is not empty.

! Operator used for finding objects where the specified attribute does not have local values in any
context. Note that the search does not check whether the attribute is valid for a given object. Also,
if the specified attribute has an inherited value (not a local value), then the object will be listed in the
results set even though the value field is not empty.

Wildcards in Searches

Two following two wildcards are available for performing searches on partial text strings:

« *(asterisk ), multi-character, represents any number of characters in a string
« ?(question mark), single character, represents exactly one character

Wildcards can be used anywhere in the text string.

Searches in 'Full Text Indexable' Attribute Values

Searches in values for attributes configured with the 'Full Text Indexable' parameter set to 'Yes' do not work in the
same manner as searches in other attribute values. Apart from common English words like 'in' and 'as,' each word
is indexed as a separate element. For more information about the words that are not indexed, search the Oracle
website for the 'English Default Stoplist.'

For example, consider an attribute named 'Description’ that has the following value on a given product:

Black powder coated die-cast aluminum enclosure. Textured surface. Bulk version: Enclosures may possibly
have flaws in the finish such as scratches, dents, discoloration, etc.
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« Ifthe'Full Text Indexable' parameter is set to "Yes' for the attribute, a search for 'Description = aluminum'
returns the product.

« Ifthe 'Full Text Indexable' parameter is set to 'No' for the attribute, a search to find this product would require
a wildcard on both sides of the "aluminum' text like this: 'Description = *aluminum®.

By default, if you have not specified an attribute, typeahead for Full Text Indexed attribute value entries is turned
off. If you have specified an attribute, you will first get typeahead suggestions after having entered three (3)
characters of the value entry. See the 'Search Field Typeahead' section above.

Numeric Value Searches for Attributes with Units

Values for numeric searches with no units are assumed supplied in the default unit for the attribute. For example, if
kg is the default unit for the 'Weight' attribute, 'Weight = 1' will match '1 kg' and '1000 ¢'. If no default unitis
configured, the search 'Weight = 1" will only match the value '1' with no unit.

ISO Date Searches

If an attribute with the validation type of 'ISO Date,' where the date populated in the field is in the YYYY-MM-DD
format, a search on the populated attribute on objects can be performed using the following key words in the
Search tab: now, today, tomorrow, yesterday.

While it does not matter if the 'I1SO Date' is set to 'Strict Validation' or not, it does matter that the date is written in
the YYYY-MM-DD format. Any other format, including using slashes '/ ' instead of dashes '-' will not work since
searches work by matching only values conforming to the ISO standard (with dashes). For this reason, itis
recommended that 'Strict Validation' be set to Yes, otherwise, the stored values are not guaranteed to be
searchable.

In the example below, a user searched for an object that has a particular date. The user typed in the name of the
date attribute 'ISO Date', and then used an 'attribute value search operation' followed by the keyword 'tomorrow.'
Then they narrowed their search even further to just under one particular node, giving them the desired results.
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Coarch

I50Date (ISCDate) = tomorrow T
& pdvanced

[Search Below = Flashlights Ttems =]

[
Displaying 1 of 1 results
Mame

> | flashlight case I = 129565

Search
Show Detailz

Reset

Search Result Profiling

1 hit{s)
Click links to narrow down search

Results by Object Type
Product (1}
Eltem (1) - exclude

- exclude

Results by Position in Tree Hierarchy
Results below child nodes of Flashlights ltems
E®flashlight case (1) - =xclude

Results by Parent
Bl Flashlights ltems (1) - sxclude

Combining Search Criteria

You can combine different search criteria to create advanced searches. Except for cases where one or more 'OR'
operators are used, the sequence of the criteria does not matter.

The search shown below:

|Search: Name = Hat123

E‘

| Search Below = Apparel

Ofbject Type ™|
’VProduct

o ¥

| Reset |f

Displaying 1 of 1results

Show Details

Mame

>

v

w Hatl23 I = 1101590

...will generate the same results as:
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Search
| Search Below = Apparel
| Object Type = Product
[Search
Mame = Hat123
&= Advanced

EX | Reset ||
Displaying 1 of 1 results Show Details
Mame >
> || Hat123 D = 110190

When not using 'OR' operators or 'Exclude' search criteria, all criteria are combined with an implicit
'AND' operator.

Click the add criteria button (/5 ) to construct a query that includes more than one criteria. By default, the criteria
will be '"AND," meaning that all criteria will be met for the results.

As an example, the search shown below will find objects that have the value 'Black’ for the 'Color" attribute AND
that are present below an 'Audio Visual Equipment' hierarchy node. The order of criteria does not impact the
results.

|Search: Color (Color) = Bladk (Bladk) E‘
Search Below ™
’VEIech'iEI & Electronics (3302) Eﬂ
2 v Reset Search
Search Result Show Details
[ Mame > |
-Operations on Entire Result
9 @& &

For information on constructing your search using 'Exclude’ search criteria and 'OR' operators, see below.

Using 'Exclude’ Search Criteria

Itis possible to negate all the different types of search criteria using the 'Exclude’ search criteria functionality.

You can add 'Exclude’ search criteria to search either by clicking and holding the add criteria button (58 =), then

selecting 'Add Exclude' from the menu that displays (shown below). Criteria can also be excluded by clicking an
'exclude' link on the generated 'Search Result Profiling' panel.
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| Search Below = Apparel =1
|Obiject Type = Product =]
|Search: Name = Hat123 =1
Add Criteria | Reset || search |
Add OR Show Details
>
Add Exclude 10190

'Exclude’ search criteria appear with a red minus icon on the left side of the criteria panel (shown below).

| Search Below = Apparel k=
| Object Type = Product =
|Search: Name = Hat123 &
Search ™
= |Culur = Gray |
- pdvanced
3k ~ | Reset || search |
Displaying 1 of 1 results Show Details
Mame >

> |l Hat123 D = 110190

When no 'OR' operators are used, the sequence of 'Exclude’ search criteria does not affect the results.

Continuing with the example above, the search finds objects where all the 'positive’ criteria are met, minus objects
where the attribute 'Color' is 'Gray.'

Using the 'OR' Operator

Add an'OR' operator to search by clicking and holding the add criteria button ((58_*), then selecting '"Add OR' from
the menu that displays (shown below).
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| Reset || Search |
Add Criteria Show Detﬂil:-'-l
9 Add OR
Add Exclude

When using 'OR' operators, search is divided into separate parts containing one or more criteria. Each partis, in
effect, executed separately and the results are then added before presenting the final result.

As itis not possible to work with parenthesis, when working with 'OR' operators it is often necessary to configure
the same criterion on both sides of an 'OR' operator. As an example, the search shown below will return all objects
where the name starts with the text 'Hat123' and the color is 'Black,’ plus all objects where the name starts with the
text 'Hat123' and the color is 'Gray.'

Search
|Search: Name = Hat123 =1
[Search: Color = Black =]
OR.
|Search: Name = Hat123 =1
(Search ¥
|Culur = Gray |
@ pdvanced j
EEE [ Reset ” Search ]
Show Details
[ Mame >
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Search Result Profiling

The Search Result Profiling page appears when you have run your search. The page displays statistics about
the search grouped under the headers Results by Object Type, Results by Position in Tree Hierarchy and
Results by Value. Apart from giving you information about the results of your search, you can use the page to
further refine your search. Thus, if you start by running a broad search, you can refine it by clicking the links
'Exclude’ in the profile - thereby adding additional criteria to your search. See the example below:

Search Result Profiling

a7 hits
Click links to narrowy down search

Results by Object Type
Product (78) - =:clude

g4 Product (78 - esclude

Asset [B] - exclude

B TIFF Image (7) - exclude
I PG Imadge (1) - exclude

Attribute (1) - =xclude

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

When exclude option is clicked, an additional search criteria called 'Add Exclude' is added as shown below:

|5ear|:h Below = Primary Product Hierarchy

E‘

| = Search: Object Type (getChjectType)

|§1

Search =
= |Excellence (I-Excellence)

&= advanced

T

[

Displaying 100 of 1232 results

Reset

Show Details

Mame

> ). 7130-03-FR ID = 5554

v

w F132-06 [0 =8085

W

|.. 7133-12 D = 5051
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For all types of searches, the Search Result Profiling page will display the results sorted by Object Type. The
screenshot above shows the Results by Object Type. The search result includes 78 Products of the Object
Type "Product”, 8 Assets (where 7 are of the Object Type "TIFF Image" and 1 is of the Object Type "JPG
Image") and finally 1 Attribute.

If you click TIFF Image, an Object Type Search Criteria is added to the search. The search runs again, finding
only objects with the Object Type "TIFF Image."

If you click exclude next to TIFF Image, an Object Type Search Criteria is added to the search, but this time as
an Exclude Criteria. Hence, all objects of the Object Type "TIFF Image" will be excluded from the search result.
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Search: Advanced Options

Additional options for narrowing a search can be accessed under the Advanced flipper in Search.
Each of the following advanced options is described in the following sections:

Match Case on Names and Values
Include Inherited Values

Exclude Values

Regular Expression

o Mo Dd =

Include Data Containers

M| Search = =]

¢ Advanced
[ ] Match Case on Mames and Yalues

[ ] Indude Inherited Values
[] Exdude values

[ ] Regular Expression

[ ] Indude Data Containers

g Reset Search

Show Details
| Name »|

1. Match Case on Names and Values - \When selected, Name and Attribute value searches are not case
sensitive.

For example, this is a basic search with search criteria of 'Search = T-Shirt.'

&= advanced

Search
T-shirt T

| g v Reset Search |
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The search results are displayed with all the objects in STEP that match the search criteria, in this case 'T-
shirt.'

STEP objects in the search result includes:

» Classification / Asset/ Product/ Entity objects
« Special Types objects
o System Setup Tab objects

Search W
t-shirts j

&= Advanced

I3 |

Displaying 3 of 3 results

Search
Show Details

Reset

Mame >

>

T-shirts 1D = 18454

>

T-shirts 1D = 18205

>

T-shirts 1D = 18202

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Product (2] - exclude

r_=|LE'I.|'E!|3f'1':I - exclude
[l Sales Item Family (1) - zxclude

Classification (1] - exclude
[ MerchandisingClass (1) - ssxclude

Results by Position in Tree Hierarchy
Results by Parent

[C1T-Shirts Sales ltems (1) - sxclude
[T Sportswear (1) - sxcluds
[C1Upper Body Wear (1} - exclude
[C1T-shirts {1} - =xclude

Results by Value

Hame matching "t-shirts"

Mame (3] - exclude

Now, on the search, select the Advanced option 'Match Case on Names and Values.'
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‘tshirts |
@ advanced
[+] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exclude values
] Regular Expression

[] Indude Data Containers

. | Resst || Search

Show Details
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With this option selected, the search result will only include attribute values and all the object names in STEP
that match the search criteria in the correct case. Since the previous search results were all a different case,

this search will return no results.

Search
| Search = ]
|tshirts |
@ advanced
[+] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exclude values

[ ] Regular Expression

[] Indude Data Containers

qR Reset || .
Displaying 0 of 0 results Show Details
[ Mame >]

-Operations on Entire Result

Search Result Profiling

Search Result Profiling
0 hit(s)

_.'.|
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Include Inherited Values -When selected, attribute value search results will show objects where the match
includes inherited values as well as objects where the match includes locally defined values.

Attribute values with hierarchical inheritance (values with green triangle) will only be included in the search
result when Include Inherited Values option is selected.

| > Fruduct Weight |! [ |

Dimension dependent Attributes — Specification or Description attribute values inheriting from other contexts
(values with a red triangle) will also be displayed in the search result even when the user does not select the
option Include Inherited values.

» Ewclusive? |E'liE
» Mew Product |E"l:ﬂ

Exclude Values - When selected, attribute values are not searched for the entered search term. If unchecked,
attribute values are searched for the entered term and objects with the search term populated as an attribute
value are included in the search results.

The Exclude values in advanced search are useful for neglecting objects which are having search content as a
valueinit.

For example, assume there are attributes which has value 'Red' in few objects and there are objects which has
Object Name/ID as 'Red.’

If a normal search is performed, the results for 'Red' are shown below.
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Search
Red

&= advanced

Displaying 11 of 11 results

= =

Show Details

Mame

>

18212 LB ID = 1821z

BBF23-12 ID = 100214

w| A ID = 12395-001

I Cosmic Party Hat - Gold and Red D = 134422

N Cosmic Party Hat - Green JD = 139414

e Mens T PBO 2 10 = MT 18400

I Pink & Blue Giraffe Party Hat [D = 127185

¥™ Red Baseball Cap 1D = 20805

jl Red Cotton T-Shirts [ = 75205

I Rustic Bed Frame I = 132495

il T-shirts Items [ = 18203

-Dperations on Entire Result

B A& &
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< Search Result Profiling ~pm

Search Result Profiling

11 hit(s)
Click links to narrow down search

Results by Object Type
Product (11} - exclude

8 Active Products (7) - esxclude
‘HEH"I Family (2} - exclude
| Sales ltem (1) - exclude
Il tem Folder (1) - =xcluds

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most commaon)

[C]Products (3} - exclude

Bl T-shirts ltems (3) - =xcluds

Bl Children's Hats (2) - =xcluds
- Red Cotton T-Shins (2] - =xclude
|__=|HEltS (1) - exclude

Results by Value

Values matching "Red”
(Walues are displayed in lowercase)

red (111 - exclude

Attributes with values matching "Red"

[T secondary Color (7) - exclude
I]I Color {2) - excluds

[T Available Colors (1) - exclude
[T attribute B (1) - exclude

If the same search is performed but with 'Exclude Values' selected under Advanced, only attribute IDs and

Names matching the search are turned.
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Search Result Profiling

M| Search w =
Red Search Result Profiling
Ad d
¥ Advance 2 hit(s)
[] Match Case on Names and Values Click links to narrow down search
[] Indude Inherited Values
Results by Object Type
Exclude values
Product (2} - exclude
Regular E i
[]Regular Expression B Active Products (1) - =xclude
] Indude Data Containers Bl tem Family (1) - excluce
L Reset Results by Position in Tree Hierarchy
Displaying 2 of 2 results Show Details || Results by Parent
Mame > (Displaying the 5 most commaon)
> = X80
:Eﬂﬁd D & r_=| Products (2} - exclude
> MllRed D = 15205 1181167 — Hats and Caps ltems (1) - exclude
[ Hats (1) - exclude
Il Hats and Caps ltems (1) - sxclude
Bl T-shirts ltems (1) - sxclude
Results by Value
Hame matching "Red"
Mame (2} - sxcluds
-Qperations on Entire Result
0 @ &

4. Regular Expression - When selected, attribute values are searched using the regular expression entered in
the Search text box. Although establishing an attribute with Validation Base Type of Regular Expression allows
more than 2000 characters (for example, [A-Z]{1,3000}), searching via a Regular Expression only returns
results for matches within the first 2000 characters. For more information, see the Regular Expression topic
in Resource Materials online help.

5. Include Data Containers - Include any search terms contained inside data containers.
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Search Operations on Entire Result

There are three operations that can be found at the bottom of the Search Tab.

Mame
| .. Hat123 [D = 110190

W

a4 | m r

-Operations on Entire Result

Exporting a Search Result

After conducting a search it is possible to export the search result by clicking the Export Search Result button at
the bottom of the Search tab.

When clicking the Export Search Result button, STEP will attempt to use all the objects in the result as root
objects for the Export Manager (equaling selecting the objects on the Product Selection step of the Export
Manager). Which objects are exported is thus determined by the selected Export format and the selections made
in the Export Manger. For more information using the Export Manager, see the Export Manager topic in the
Data Exchange documentation.

[ Export Manager >
Steps Select Objects
1. Select Configuration Product selection made by search URL,
2. Select Objects
£ >
3. Select Format
4. Map Data Only export selected objects

5. Advanced Only export leaf objects Export: |Product ~

6. Select Delivery Method 1, 4 object types <Al ohiect types>

Back Mext Finish Cancel

Saving a Search Result as a Collection
After conducting a search it is possible to save the entire search result as a Collection.
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When clicking the Save as Collection button, a dialog is opened where it is possible to specify the ID, Name, and
location of the new Collection. For more information on collections, see the Collection topic in the Getting

Started documentation.

[ 1 Save as Collection in Background Process et

[#-[E Collections
- [S eCatalogs

®Dewls

Collecton ID 411232

Collection Mame |

RO | cnt |

Bulk Updating a Search Result
When having conducted a search it is possible to Bulk Update the entire search result.

When the Bulk Update Search Result button is clicked, the Bulk Update wizard appears with the search result
selected as the dataset. For more information on bulk updates, see the Bulk Updates documentation.

[ 1 Bulk Update

Steps

x

Configuration

1. Configuration
2. Operations

3. Parameters

4. Preview

5. Advanced

(") Use Existing Configuration | ||Z|

{®) Create Mew Configuratior

MBS | tec | RSN | conce
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Search: Data Containers

The Data Containers search criterion allows users to limit search results to only objects for which data containers
exist for the specific data container types, or those objects for which specific attributes are linked via data
containers.

Searching for objects with information in data containers is available using the standard search criterion and also
using the specific Data Containers criterion. Each method is defined below.

For more information on data containers and the terminology used in this topic, see the Data Containers topic of
the System Setup / Super User Guide documentation.

Standard Search Including Data Containers

This option searches data containers and other identified objects for the defined values. For more information, see
the Examples section below.

Search

1. Click the Search tab, and select Search from the dropdown.
2= Advanced

| IEEN Reset Search

aarch Result Show Details

2. Open the'Advanced flipper and check the 'Include Data Containers' option.

M| Search = E3

@ Advanced
[] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exclude values

] Regular Expression

I Indude Data Containers I
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3. Ifneeded, click the green plus button () to add additional search criteria.

4. Click on Search to run the search and view results.

Data Containers Only Search

This method requires that the searched data exist in a data container. Matching data outside of data containers is
not displayed. For more information, see the Examples section below.

Search

1. Click the Search tab, and click the Search dropdown.
- Advanced

g v Reset Search

aarch Result Show Details

2. Inthe Search Criteria Type Selector, select the 'Data Containers' search criterion.

Search

Search

Search

Object Type

Search

Search Below
Referenced Assets

Revised Objects Changed Since
Data Containers

Document Content
Search from List
Javascript search

Missing Mandatory Values
Unapproved

Product Owverride Search

[ Systemn Setup H BG Processes (2) ]

Search in Publication Hierarchy

3. Supply the Data Container Type parameter and the additional text input parameter as needed:

» Continue to the next step without populating either parameter to return all objects for which any data
container of any data container type that has been added.
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« Click the ellipsis button (|...|) for the Data Container Type parameter to limit the search results to only those

objects for the selected data container type. Click Select and then click Search. The search returns a list of
objects for which the data container type has been added, even when no attribute values exist in the data
container. For more information, see the Examples section below.

Search [ | Data Container Type *
Data Containers 1
I VECN | Search
Data Container Type -
=3 Attribute Groups P

- Advanced

g5 - Reset Search ' """ El contacts
Search Result Show Details El Ermail
[ [Name - [E] Main Address
E FPhone
[El[shipping Address|
E Vitals
-0 ETIM Attributes w
< >
& Details
Select Cancel

-3 Attribute Group
F-E0 Data Containers

« If necessary, narrow the search using additional search terms in the text input parameter. Type the selected
‘Data Container’ attribute to display typeahead suggestions. Once selected, the available operators =, <, >,
<=,>=1 llare displayed. If the selected attribute has a value in the ‘Data Container’ tab, the values display
as a dropdown. However, the search result will be displayed only for the attribute value which is present for

the attribute in the Data Container tab. For more information, see the Examples section below.

Search

Dats Contsiners
Data Container Type

Country Code (CountryCode) =

Shipping Address (ShippingAddress)

Datz Contziners =
Data Container Type

Shipping Address (ShippingAddress)

Country Code (CountryCode) = BAHAMAS (BS)

Country Code (CountryCode) = ANGUILLA (AL)

Country Code (CountryCode) = ARGENTIMNA (AR)
pj/Country Code (CountryCode) = ARLUBA (AW)
Country Code (CountryCode) = AUSTRALIA (AL)
Country Code (CountryCode) = ALISTRIA (AT
Country Code (CountryCode) = BAHAMAS (BS) I
|Cn::nun1:ry Code (CountryCode) = BARBADOS (BE)

Country Code (CountryCode) = ANTIGUA AMD BARBUDA (AG

]

& Advanced

15k

-Operations on Entire Result

0 @ &
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4. If necessary, open the Data Containers Advanced flipper and set the following parameters:

Search
- | Dat= Comzinars = ]
Data Container Type  shipping Address 2 (211422) ...

2 Advanced

Instance count |:> v| |1 |

[ ] Match Case on Values

[ ] Regular Expression

(g | Reset || Search |

« Instance count - specify a number of data container instances an object must have.
o Match Case on Values - makes the search case sensitive.

« Regular Expression - search data containers using a regular expression. For more information, see the
Regular Expression topic in Resource Materials online help.

5. Ifneeded, click the green plus button () to add additional search criteria.

6. Click on Search to run the search and view results.

Examples

The following examples show a variety of searches for values in data containers.
Standard Search for Product Data Container Value

The dataset includes an object with a Flat Crush Test value of '10 kN'. This value is in a product data container.

Tree C ::nnugat:nd Box rev.0.1 - Data Container
--i Apparel | Praduct Sub Products | References || Referenc
Eli Hardware
i Took '? Industry Standard®
(+-[[F] Doors and Doorknobs
. 7] Hardware Kit * [ID » [Attribute Mame #| > (Value >
= ﬁ Packaging Supphes IndustryStandarde_271889  Edge Crush 12a 43-47
----- BE .| IndustryStandards 271889 Flat Crush 12a 10 kN
[#-[Z) Displays IndustryStandardB_271889  Pin Adhesion 123 [11.05
[+-T] Furniture IndustryStandardB_271889  Scuff and Abrasion 12a FOM

Searching for the value '10 kN' with the standard Search criterion returns O results.
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Search w
10 kM

&= advanced

T

15~

Displaying 0 of 0 results

Reset

Show Details

| Mame

> ]

Search Result Profiling
0 hit(s)
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Search Result Profiling -

Checking the Advanced option to 'Include Data Containers', and searching again, displays the object as a result.

Search

M| Gearch =
10 kM

9 Advanced
[ ] Match Case on Mames and Values

[] Incude Inherited Values
[ ] Exdude values
[ ] Regular Expression

Indude Data Containers

Search Result Profiling -

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type
Pdell[:t“} - exclude
ﬁltem (1) - exclude

156~

Displaying 1 of 1 results

Reset

Show Details

Results by Position in Tree
Hierarchy

Results per Parent

Mame

>

> ™ (245934) 1D = 245935

O Tools (1) - exclude

Standard Search for Entity Data Container Value

In this example, a user searches for all instances of the value 'BAHAMAS' in STEP. Select the standard 'Search'
from the dropdown, add 'BAHAMAS' into the text input parameter, open the advanced flipper and check the
'Include Data Containers' option, and click Search. The results includes Customer A and Customer B entity
objects where 'BAHAMAS' occurs inside a data container, and also includes the 'BAHAMAS' values that appear

outside of data containers.
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BAHAMAS
9 Advanced
[ ] Match Case on Mames and Values

[] Include Inherited Values
[ ] Exclude values
|:| Regular Expression

Include Data Containers

T ISTIBOSYSTEMS

Ha Feset

Displaying 5 of 5 results Show Details

Mame

>

* 18210 M B_EN [0 = 15210

£ Axcel Kiers Vej 11 ID = ADD 101571

2 Customer A ID = CLS_I01545

W I‘l'l"i'l

2 Customer B I = CLS_107835

> ™ InDesign modified ID = 123216

-Operations on Entire Result

9 @ &

Data Container search for Entity Data Container Type

e MASTER DATA MANAGEMENT

In the example below, a user searches for a data container type called 'Shipping Address' without refining the
search any further. If the user selects 'Shipping Address' as the Data Container Type and clicks Search, a list of
entities for which a data container has been added to an entity under the data container type 'Shipping Address'

will display. In this instance, four entities are listed.
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[ Data Containess 1

Data Container Type rghipping Address (ShippingAddress)

=

—

& pAdvanced

b - Reset |E Search i

Displaying 4 of 4 results Show Details
Mame

id 2 Customer A ID = (LS 101545

_> 2 Customer B ID = (US 107835

_> 3 Customer D [0 = (LS 114565

> |8 Customer E ID = CUUS_114565
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The entity with the ID 'CUS_107835' has an attribute 'Country Code' with the value of'ARGENTIAN' in the

Contact tab, but with the value of ' BAHAMAS' on the Data Containers tab.

Customer B rev.0.4 - Customer

o ==

% (18212) ™ Referenced By || Status || State Log || Tasks
- [ Acrount Group 1 Customer [ Data Containers ]
-1 2 allen P
-|8F CON_124334 Name >| > Value >
[—}--ﬁ Customer Hierarchy > I CUS_107835
=8 Customer A
ﬁ Axel Kiers Vej 11 * Name Customer B
Jesper Jensen » Dbject Type Customer
E- g _ * Rewision 0.4 Last edited by USER.J on Tue Sep 26 17:1...
i 3550 George Busbee Pk — - -
John Smith » Path Entity hierarchy root/Entity Root/Customer Hi...
#- 8 Customer C » Completeness Score 1683
{;3 Key Accounts > |available Sizes Eﬁ
1l GDSN ¥ -
= = I * Country Code | ARGENTIMA o

A

B 2 allen

[—}-% Customer Hierarchy

| Customer

l

£ Customer B rev.0.4 - Data Co

| Referenced By || Status || State Log

Data Containers

tainers

e

=-a C““’"‘Tr Ao D > |attribute Name value
% el Kiers Vej 11 e o]
Jesper Jensen T———
i ountry
=8
: > hddress Country IS0 Code
. £ 3550 George Busbe e
...|22| 3ohn Smith hd = ~ E, hd
£ > £ >
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When a search is performed on the ‘Shipping Address' data container and the attribute 'Country Code' is selected,
all of the values are displayed. The search result will display the entity ‘Customer B’ only if the value is
‘BAHAMAS.’ The search result will return ‘0’ if the value selected is ‘ARGENTINA’

Search

Dratz Contziners W
Data Container Type | Shipping Address (ShippingAddress)

Country Code (CountryCode) =

Country Code {CountryCode) = ANGUILLA (AI)
Country Code {CountryCode) = ANTIGLIA AND BARBUDA (AG
Country Code {CountryCode) = ARGENTINA (AR)
Country Code {(CountryCode) = ARLUBA [(AW)
Country Code {CountryCode) = ALUSTRALIA (A1)
Country Code (CountryCode) = ALISTRIA [AT)
Country Code {CountryCode) = BAHAMAS (BS) |
|Counh’}' Code {CountryCode) = BARBADOS (BE)

i

Search Nz

Datz Contziners

Data Container TYpe | shipping Address (ShippingAddress)

Country Code (CountryCode) = BAHAMAS (BS)

& Advanced

-Jperations on Entire Result

9 @ &

Ex

Displaying 1 of 1 results

Show Details

Mame >

*| B Customer B ID = CLS_107535

-Operations on Entire Result

J E

Data Container search for Entity Data Container Type and Value

To continue the previous example, if the user refines the search for entities with a 'Country Code' data container
type to only include those data containers containing the value 'BAHAMAS', the user would enter' BAHAMAS' in
the input field. In this example, results returned from the search show two of the original four entities. This means
that a 'Shipping Address' data container has been added to these two entities, and an attribute within those data

containers also contains the value 'BAHAMAS'".

| Data Contziners L
Data Container Type | shipping Address (ShippingAddress)
BAHAMAS
W
=
Displaying 2 of 2 results Show Details
Mame >
» 8 Customer A 1D = LS 101595
* | B Customer B ID = CLS_ 107835

-Operations on Entire Result

g @
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Search: Document Content

With the Document Content search criteria you can search for a specified word / text string in text documents
stored as Assets in STEP.

1. Click the Search tab.
2. Click the Search dropdown and select Document Content.

T Search

Search
| Search

Show Details

Tree

|7'3" Advanced

o ™

Search Result

[ Mame

Object Type

Search

Search Below
Referenced fssets
Revised Objects Changed Since

Data Containers
Document Content
Search from List

[ BG Emc%es (41) ]

Important: A prerequisite to searching in documents is that they are indexed. Document Content displays as
a search option only in systems that have full text indexable functionality enabled and are not running In-

Memory.

3. Enterthe word/ text string into the text field that appears.

[ Document Content |
’VFind 9

EEE B [ Reset ] Search
Displaying 0 of 0 results Hide Detailz
[ Mame ¥]

4. Click the green plus sign () to add additional search criteria. (Optional)

5. Clickon'Search' to run the search and view results.
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Search: JavaScript Search

The JavaScript search criteria searches through all JavaScript in STEP. It can match items according to
Business Rules, Match Algorithms, Decision Tables or any other structure programmed through JavaScript.

Follow the steps below to set up a JavaScript Search:

1. Click the Search tab and click the Search dropdown.

& Advanced T

g v Reset Search

aarch Result Show Details

2. Select JavaScript search.

Search

Jawasoipt search
Find |5

[] Match case
[] Match whale word only

| Reset ||

Displaying 59 of 59 results Show Details

Mame
> |=ﬁ (acn-88fdd33c-fceb-4754-a118-a9103b7 59 I
» ## (acn-b35434c0-5c7a-4413-ad89-ecad7e6cd3 |

JavaScript Checkbox Options

Search Result Profiling

54 hit(s)
Click links to narrow down search

Results by Object Type
Special types (55)

_JBusiness Action (47) - exclude
_1Business Condition (8 - =sclude

These checkbox options are available with JavaScript search criteria:

« Match Case: If you select this, the search will only return results that match the upper or lower case letters that

are in the search criteria.
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Find |a

Match case
[ Match whale word only

Y ==
Displaying 38 of 38 results Show Details
Mame

> |@ (acn-88fdd33c-fceb-4754-a118-a2103b75%e s
> i (acn-b35434c0-5c7a-4413-adB9-ecad7e6cal |

« Match whole word only: will return only results that are the exact criteria that were put in that standalone. An
example would be if the letter 'a' were typed into a search, and only results that had 'a' in it that standalone
somewhere in the JavaScript were returned.

Search
Jawascript seanch
Find |
[] Match case
Match whole word only

G | Reset ||

Displaying 1 of 1results Show Details

MName

> @ BsssPackaginglibrary (final) I7 = A555Fack=mingl.,
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The Missing Mandatory Values search criteria is used for finding Product objects that have valid Mandatory

Specification attributes without values.
To set a criteria as a Missing Mandatory Values search:

1. Click on the Search tab and click the Search dropdown.

& Advanced

g v Reset Search

aarch Result Show Details

2. Select Missing Mandatory Values from the dropdown.

[ Missing Mandatory Vakes =
|-Missing Mandatory Values ﬁ"""" E1
ERE [ Reset ][ Search ]
Show Details
|_Name > ]
Use Cases

1. Product object which has specification and description attribute as mandatory with empty values.

The 'Product Name' attribute is set as mandatory for Iltem Object Types. For Object 22200, the attribute value
is left empty. In the Search tab, Missing Mandatory Values search criteria is used with Object Type

‘ProductsRoot’ search criteria. 22200 is included in the search results.
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m Sub Products || References || Referenced By |

| Praducts (ProductsRoot) .. 1
Missing Mandatory Values = E1 2 Description
Missing Mandatory Values Mame s> Ivalue
e v Reset Search > D 22200
Displaying 100 of 194 results Show Details » Mame 22200
Narme > Object Type Ttem

il 3 inch heels 1D = 20594 L]

» Rewvision 0.1 Last edited by STEPSYS

el 12-GGK799 [ = 100705

050-4215I ID = 7575 » \Approved x Mever Been Approved
IO - -

M 555-22346 ID = 6506 * [Translation Mot Translated
PR18213 M O ID = 18213 » Path Primary Product Hierarchy/
Nzl 20883 1D = 0555 ) Manufacturer Information

el 20888 AAA Batteries 1D = 109005 Name s |3 |value

m 20888 AAA Batteries RECHG 1D = 109007 s Manufacturer's Part Mumber 33 IROEY
21873 (box of 5 pair multi-color) ID = 21875 » Manufacturer Name abe
I 21882 (sellable case of 20 boxes of 5 pair oranc > Country of Qrigin [SCHINA
¥ 22126 (box of 20 pair orange) ID = 22125 » Product Name e

22200 ID = 22200 - abe
W= 0262119 11 = 250 » Bupplier Part Number abe (443291

2. Description attribute is mandatory and is left blank on entity object.

In this example, the 'Available Sizes' description attribute is set to mandatory. On the address entity ADD _
107837, the 'Available Sizes' attribute is empty. A search is performed that has a 'Missing Mandatory Values'
search criteria with Object Type ‘Entity root’ search criteria. The ADD_ 107837 object is returned as a result.

| Entity hierarchy root (Entity hierarchy root) 1 | References || Referenced By || Status || State Log | Tasks
Missing Mandatory Vahkes = ¢ Desciption
|-I'~"Iissir1g Mandatory Values E1 Mame | » |Value
E:}i - Resat Search » D ADD_107337
Displaying 100 of 10049 results Show Detailz ||| * MName 13550 George Busbee Pkwy
Mame » Dbject Type Address
-‘H““H' = 3 ]
> |0 64TH MED DET (VS) D = DB 116535 » Revision 0.1 Last edited by USER. on Fri Aug 14 16:32;
22250 South Hamptoo De D = 400 [ 14355
» Path Entity hierarchy root/Entity Root/Customer H
> Qmmmm ID = ADD 107837
T 114550 1= J0CRTEEATEATE 1T = 7o —Complctencss Score =
> 114883 | 3550 George Busbee Pkwy [ » Available Sizes (55|
»|[JJ AB.C.UN |D= ADD_107837 511655, Tty ST e
s A RD I-'V'II-'CITI-'DI_ M — NRRTIsnss % Mamtzrt Blama :hn’\-l
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The search criteria requires no data input or selections to be made. However, it is encouraged to use in
conjunction with another search criteria (by clicking the green + sign) to help further refine the search.

The Missing Mandatory Values search criteria can also be set to exclude Product objects with missing Mandatory
values. This functionality is described in Using Exclude Search Criteria within the Search Functionality topic.
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Search: Object Type

With the Object Type search criteria you can limit your search result to items of a specific Object Type. These
objects are maintained in the workbench System Setup > Object Types & Structures folder.

1.

Click on the Search tab and click the Search dropdown.

Search

& pAdvanced

&

aarch Result

Reset

Search

Show Details

2. Select Object Type from the dropdown.

3.

Search

" Object Type ™

Product

-]

T ISTIBOSYSTEMS

I3 |

Reset Search
Show Details

[ Mame

e MASTER DATA MANAGEMENT

In the dropdown that displays 'Product' by default, select an object type. See the System Setup Object
Types section below for more information.

« Hover on an object type to display a sub menu when available.

o When an Other... option is available, click it to display a selection dialog. Use the Browse or Search tab to

select the object type. Click Select to confirm.
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[ 1 Please Choose Object Type >
[oues e~ : rows |2
Product
(- Boards
Asset 1 Sales [tem --i Business Unit Root
Classification ; S [#-I8 Discontinued Products
reduct Folder :
Attribute i External Products
Lict of Val Dltem (- Jill GD5M Products
Et_ e External ltem Enric Eﬁ Packaging hierarchy

Unit X X [+ Packaaging Hierarchy

Discontinued Prod| : ) ) ]
Publication Group : ) i Primary Product Classification

o | Buy Side [+-[5 Product Folder

Publication 3 : '

Level 1 -3 Product Hierarchy Root
Publication Section : o ;

NewObj = Product Overrides
Entity ; .

Product QFerides | o b
Special types ;

| Other... | Select || Cancel |

If needed, click the green plus button () to add additional search criteria. For example, return only products
with the text'ACME".

Search
| Object Type = Level 1 =]
Search =

|A,E1'¥1E A — |
&= Advanced

e |
(o Reset Search
Search Result how Details
| Mame >

Click Search to run the search and view results.
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s [

|DbjectType = Product

E‘

Cearch ™
ACME

&= Advanced

=3

(o -

Displaying & of & results

Show Details

Mame

>

e 21933 [0 = 21955

N 27244 ID = 27294

¥ Comfy Bed 1D = 22155

¥ Comfy Footboard ID = 22155

I Comfy Headboard D = 22787

¥ Comfy Side Rail ID = 221565

System Setup Object Types

Search Result Profiling

6 hit(s)
Click links to narrow down search

Results by Object Type
Product {6
EHEH"I (6) - exclude

- exclude

Results by Position in Tree Hierarchy
Results by Parent

-BEUS ltems (4) - exclude
[C]Products (1} - =xclude

Il Refrigeration Items (1) - =xclude
[C]Products (1} - sxclude

Bl Crinking Items (1) - sxclude

Results by Value

Values matching "ACME"
MWalues are displayed in lowercase)

acme (7) - excluds

Attributes with values matching "ACME"

[T Brand Name (5) - sxclude
(I Manufacturer Name (1) - exclude
[T supplier Mame (1) - exclude

The following object type selections require further information.
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"| Object Type ™
Attribute
Product ]
Asset >
Classification b
Attribute
List of Walues
Unit
Publication Group >
Publication b
Publication Section ]
Entity *
Special types >

Attributes, Lists of Values, and Units

The Attribute, List of Values, and Unit object type categories do not include sub selections. All of the selected
object types available will be searched for each of these categories.

Special Types

Special Types includes Table Type, Business Rule, Business Library, Business Condition, Business Action, and
Business Function object types.
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Search: Product Override Search

With the Product Override search criteria you can locate and identify any product overrides present in your
system. You can search for all overrides in STEP or you can narrow your search to overrides of a specific product.
If more concise results are required, you can specify sub-products.

1. Click on the Search tab and click the Search dropdown.

Search

2 Advanced j

1 ERR Reset Search

aarch Result Show Details

- Owverridden Product
() Find Al

(@) Find by Overridden Product
Overridden Product

-5ub Products
(] Exact Match an Child Products

|5u|:| Product » |
> | Add Child Product

oa v Reset Search

Show Details
[ Mame

3. Inthe Overridden Product group, select a radio button :

o Find All - Searches for all product overrides.

« Find by Overridden Product - Searches for the specified product, as shown in this image. In the text box,
either type the product's name, or click the ellipsis button (|...|) to browse or search for a product.
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D Cwerridden Product -

| Product Ovemide Search ™
- Overridden Product

[

(O Find Al [E-{I3) Primary Product Hierarchy
[+-[Ji Discontinued Products
Find by Overridden Product / ;
(®) Find by Overridden Produ y [+l External Products
Overridden Product  |Batteries (20878) i Packaging
[+-[[5) Product Overrides
-Sub Products E”__:I Products
[ ] Exact Match on Child Products [+-{15] Displays
|Sub Product > | &= Electrical and Electronics
ﬂ,q.j.j Child Product =3 Electronic Accessories
: E|r_=| Power
-- Batteries
g v| Reset Search =
~ ] Type 5 Contactors and Starters
Show Details

[ Mame

= Details

canc

In the Sub Products group, set the following options as needed:

« Exact Match on Child Products - WWhen checked, search results must have every sub-product specified.

« Add Child Product - Click the link to select sub products that will narrow the search further by requiring
search results to have exactly the specified sub-products linked to them.

Click the arrow button ([*> |) on one or a group of rows to display the following menu and perform the action:

Sub Products
[ ] Ewact Match on Child Products
ub Product >
Hide
— Show All Rows
ah Rotate Table Search

Displa Add Child Product  Ctrl+Plus Show Detaile
[N Remove sub product Ctrl+Minus 3]

Hide - Hides an added child product from list.

Show All Rows - Show all hidden child products.

Add Child Product - Does the same operation as the ‘Add Child Product' link as stated above.
Remove sub product - Removes the selected child product.
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5. If needed, click the green plus button () to add additional search criteria.
6. Click on Search to run the search and view results.

This image shows products with the specified child product, but others child products could exist as well.

- search ] SearchResultProfiing

| Product Overide Search ¥ [#]
-Owerridden Product Search Result Profiling
() Find Al 2 hit(s)

@ Find by Overridden Product Click links to narrow down search
nd oy Lverndden Frodu

Overridden Product | Batteries (20878) Results by 'Dh-p(:t Type
rSub Products Product(2) - sxclude
[] Exact Match on Chid Products gl Product-override (2) - esclude
Sub Product * T
» Batteries Rechargeable ItemFolder Results by Position in Tree
» Batteries Items Hierarchy
> | Add Child Product

Results per Parent

Cllevel 2 (2) - exclude

Ha Reset

Displaying 2 of 2 results Show Details
Mame >
> Batteries Override 1 — Batteries [D = 174055
> Batteries Override 2 — Batteries [D = 179577

This image shows there are no overridden products with only this exact sub product.
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| Product Ovemide Search ™
- Overridden Product

Search

() Find Al
(®) Find by Overridden Product

Overridden Product | Batteries (20878)

-Sub Products

Exact Match on Child Products

Sub Product >

» Batteries Rechargeable ItemFolder

> | Add Child Product

=

Displaying 0 of 0 results

Search
Show Detailz

Reset

Mame > |

€ Search Result Profiling i

Search Result Profiling
0 hit(s)

This image shows overrides regardless of sub products.

r | Product Ovemide Search ™
- Overridden Product

Search

(O Find Al
(®) Find by Overridden Product

Overridden Product | Batteries (20873)

-5Sub Products

[[] Exact Match on Child Products

|Sub Product
> | Add Child Product

156~

Displaying 3 of 3 results

Search
Show Details

Reset

Mame >

>

Batteries Owverride 1 — Batteries [0 = 174055

Batteries Owverride 2 — Batteries D = 170577

Batteries Owverride 3 — Batteries ID' = 179555

€ Search Result Profiling s

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Pdelll:t[3} - exclude

&l Product-override (3) - sxcluds

Results by Position in Tree
Hierarchy

Results per Parent

CCiLevel 2 (3) - exclude
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Search: Referenced Assets

The Referenced Assets search criteria is used for finding product objects which has referenced assets to the

specified product.

By default, all local referenced assets for the specified product are displayed.

To set up Referenced Assets search criteria:

1. Click on the Search tab and click the Search dropdown.

Search

- Advanced

T

g v Reset Search

aarch Result Show Details

Reset

Search
Show Details

]

Referenced Assets
Search

E Object Type

A Search Below

@ Referenced Assets

ﬁ Revised Objects Changed Since
EI Data Containers

& Search from List

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

3. Specify a Product Name in the input field by either tying in the actual product name or the product ID. By
running a basic search, it will return results of all referenced assets of the product specified.
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|Referenced Asers W

Product Mame |Dress Shoes

Indude Inherited Assets ]

arch Result Profiling

Search Result Profiling

3 hit(s)
Click links to narrow down search

W

| 20695 back I = 20700

W

'wm| 20695 main 1D = 20701

W

' 20695 side D = 2070z

Match Case on Mames ]
Cr . .
Displaying 3 of 3results Show Details Asset (3]} - exclude
Mame >

(w| Product Image (3) - sxcluds

Results by Parent
r_=|2|:| !3! - exclude

Checkboxes for Referenced Assets Search

When performing a search, there are two search checkbox options that can be selected.

« Include Inherited Assets - This option is used when the inherited referenced assets on the specified product

are to be included in the search result.

& Fashion Board
Il GOSN Products
Bl Packaging
#-[Z] Product Overrides
E}i Products
E|i Apparel
E}i Upper Body Wear
(-1 T-shirts
=il T-shirts Items
2
PR 235915-2

- Jjil] Cotton T-Shirts
: ‘ So Many T-shirts
[T T-Shirts Sales Items
[-[[7] Head Wear
({15 Electronics
BH-[IT] Footwear
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- References

Category Profile || Proof View || Status || State Log || Tasks
I

Referenced By

Images & Documents Commercial Tables

Product ”

Product Variants " Sub Products

Reference Type w| » [Target > [Thumbnail > ImagePrior
» |Brand Name Logo  + B
* |Tlustration + m
> |Primary Product Image EEBIUE cap -
¥ |Product Images + m
> |Video + n
4 >,
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« Match Case on Names - This ensures that the specified product name is searched matching the case (case
sensitive) and all local referenced assets are displayed in the search result.

: s
+- [ External Products Search < Search Result Profiling
+-{] Fashion Board
-l GDSM Products [Referenced Assats | .
i ) Packaaing Product Name Search Result Profiling
-] Product Overrides 1 hit(s)
H Include Inherited Assets
EiFj Products e fner sse [ Click links to narrow down search
E|r_=| Apparel Match Case on Mames
EH[IT) Upper Body Wear -
B Teshirts Results by Object Type
= Il T-shirts Items (g = | Reset |[ Seardh | Asset(1) - exclude
Bl 2359141 Displaying 1aof 1 results Show Details
-E 3350152 Mame 'E Product Image (1} - exclude

g 8872312 > | Blue cap D = 107525

E _} Results by Position in Tree Hierarchy
Results by Parent
L0101 - exclude
< >
-Operations on Entire Result
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Search: References and Referenced By

The References and Referenced By criteria work similarly.
To navigate to either of these searches:

1. Click on the Search tab and click the Search dropdown.

Search

- Advanced T

g v Reset Search

=arch Result Show Details

2. Select References or Referenced By from the dropdown.

Search

Search
Object Type
Search Below
Referenced Assets
Revised Objects Changed Since
Search Data Containers
Search from List
T Javascript search

Missing Mandatory Values

&= Advanced

e 1r| Unapproved
Search Result Product Override Search
| Mame

Search in Publication Hierarchy

Referenced By

References

Both options require a reference type selection to begin. Reference types are setup in STEP Workbench System
Setup tab in the Reference Types folder, and the Web Ul Advanced Search allows you to pick from image and
document reference types, classification reference types, and product reference types.
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Once a reference type is entered, no additional options need to be filled in to start a search. Use the information at
a high level or fill in the other values to drill down further (e.g., multi-supplier item references). Select a reference
source under Referenced By and a target under the References. Plus enter specific attributes and values to
search reference metadata.

References

For References, there are three boxes that can be checked: Include Inherited References, Include Data
Container References, and Finding Missing References.

Include Inherited References: When this is selected, it will show items that have the particular search criteria
passed down to them from a parent folder or level.

References ;] = =
RE'FEFEFICE Type Jwners Manua| {DW”EFSME”UE'} E] S'EE rCh RESU" Frﬂ'ﬁling
I Indude Inherited References I 4 hit(s)
) Click links to narrow down search
[ Find Missing References 5
Reference Target Results by Object Type
rm L T || Producti4) - exciude
Product f2]| - exclude
=
Advanced g ltem (2} - exclude
il — .
T = Results by Position in Tree Hierarchy
] Results by Parent
Reset :
58 [ == ] é d (Displaying the 5 most commaon)
Displaying 4 of 4 results Show Details
MName > Il Tire Care ltems (2) - =xeclude
» W™ 20-68204 D = 20652 |_=_|Ski,_|ElC|{Et Light (1) - sxclude

N I 104061 — Ski Jacket Xtreme (1) - exclude
N 555-22346 ID = 5605 [C]Products (1) - exclude

> | 4@ SKU 00001 ID = SKU 00001 51 Ski Jacket Xireme (1) - sxclude
> | g SKU 00011 ID = 5K 00011

Include Data Container References: When this is selected, references that appear on data containers may
appear in the search results.
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r Referances =

Reference Type  |SAP Account Group (SAPAccountRef) ||Z|

[] indude Inherited References

Indude Data Container References

[] Find Missing References

Reference Target

Search

& Advanced

Reference Metadata

8| H L
g | L L

dh | Reset |
Displaying 1 of 1 results Show Details
Mame

Bilka Tilst I = 137800

W

Search Result Profiling

Search Result Profiling

1 hit{s)
Click links to narrow down search

Results by Object Type
Entity {1} - exclude

Organization Customer (1) - exclude

Results by Position in Tree Hierarchy

Results per Parent

ﬁlDruanisatinn Customers (1) - exclude

Finding Missing References: When the reference type is selected, and this box is checked, the populated
results will show all items that have that particular missing reference.
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| References ;]
Reference Type | video {Videa)

[] Indude Inherited References

Find Missing References

Rewget

EX

(-]

e
Reference Metadata
o
B | Reset || _
Displaying 98 of 98 results Show Details
Mame

| 355-22346 1D = 6806

> | 6642 1D = 6642

> ). 7130-03 ID = 5854

v

w F133-12 ID =58081

Reference Target

Search Result Profiling

a3 hit(s)
Click links to narrow down search

Results by Object Type
Product (98} - exclude

ﬁltem (46} - exclude

|| Salesitem (43) - =xclude

[l SalestemFamily (5) - sxclude
Bl temFamily (4) - =seclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most common)

[T Products (21} - exclude

[ Products (8) - exclude

[T/ Hats and Caps Salesltems (7} - sxclude
Il Crinking ltems (5) - sxclude

Bl Hanes T-shirts (5) - seclude

The user has to type the ID/Name of the target in the ‘Reference Target’ field and click on the ‘Search’ button. This
will display all the Source / Products which uses the Target reference specified in the ‘Reference Target’ search

field.

In this example, the ‘Reference Type’ field is empty. Hence the result is irrespective of the reference type.
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| Referemces ™= ]
Reference Type Search Result Profiling

18 hit(s)

Indude Inherited Refe
[ tnclude Inher SlErencEs Click links to narrow down search

[] Find Missing References

Reference Target Results by OM Type
Search Product (17} - exclude
imagefj
gelipeg ltem Family (9) - sxcluce
€~ Advanced Item (6) - exclude
= | Bales ltem (1) - exclude
[Tl Sales Item Family (1) - exclude
Reference Metadata Entity {1} - e=zclude
B customer (1) - sxclude
Results by Position in Tree Hierarchy
dh - Reset || ||| Results by Parent
Displaying 15 of 18 results Show Details (Displaying the 5 most common)
Name . Il Pull-Down/Pull-Out Kitchen Faucets (8) - sxclude
* N B225 ID = 8225 rj Products (4) - sxclude

[CITire Accessories (1) - exclude
Bl T-Shirts Family (1) - =eclude
[T Tire Care Salesltems (1) - sxclude

| 123857 G ID = 123557
N 0726222 D = 111204
N Acme Automatic Drip Coffee Maker I = 22795

The search result will differ when we specify the ‘Reference Type'.

In this example, the ‘Reference Type’ is selected and shows all the results for that ‘Reference Target.'
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T N

| References = = A
Reference Type  |product Images (Productimage) ||... Search Result Profiling
[] Indude Inherited References 7 hit(s)
Click links to narrow down search
[] Find Missing References
Reference Target Results by Object Type
5eard‘:] i Product - exclude
image fipeq
- E”Eﬂ"l (6) - exclude
Advanced B ltem Family (1) - sxclude
o
Results by Position in Tree Hierarchy
Reference Metadata
v Results by Parent

(Displaying the 5 most common)

o '| Reset E Search il [C]Products (4) - sxclude

Displaying 7 of 7 results Show Details __1Flashlights ltem Override — Flashlights ltems (1} - exclude
Mame > [T Dress Shoes (1) - exclude

Ef 123857 G [D = 123557 Il T-Shirts Family (1) - =zeclude
¥ 0726222 D = 111204 [C]Pary Hats (1) - =ssxcluds

I Acme Automatic Drip Coffee Maker ID = 22195
i Cotton T-shirts /D = 18205

¥ Dog Party Hats Assortment ID = 115305

¥™ Dog Party Hats Assortment D = 121190

L m Yellow & Pink Party Hat ID = 12717

If a narrowed search is needed, use the advanced option. To use this option click the ‘Advanced’ flipper and select
the appropriate option. For more details on the advanced options, see the Search: Advanced Options topic.

[Search = £

image fjpeg
2 Advanced
[ ] Match Case on Names and Values

[] Indude Inherited Values
[ ] Exdude values
[ ] Regular Expression

[] Indude Data Containers
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The user has to type the ID / Name of the source wish to search. It will list the items which have been used as a

source.

- [ Referenced By | =]
Reference Type Search Result Pr
615 hit(s)
Reference Source Click links to narrow do
Cearch Below = Motice: Profile is not filte
’VF‘rimar}-I Product Hierarchy (Product hierarchy root) E1

gk Results by Objec
Product (456} - e=cluc

Reference Metadata

Ha Reset

Displaying 100 of 615 results S.H.DW DetaiL';."
Mame

I_ 120-Volt Tire Inflators (case of 10) 1D = 5581z ~
| 120-Volt Tire Inflators (case of 4) ID = 8515

| 120-Volt Tire Inflators (pack of 2) D = 18515

> g1 555-2033_M 1D = 8301

W

W

W

W External lter
External lter
Active Prod

|.. Sales ltem

I case 20}

| Pack(s) -
ltermn Family
Open ltem

W Pallet (2) -

Ol Level 3 (1)

[T Sales Item

W External Ilter

[C] SalesltemF

* N 7130-03-FR 1D = 5854 Asset (120) - exclude

Click the ellipsis button (|...|) to browse for a reference type for search either type in the reference type ID / Name

for more restricted search.
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- [ Referenced By | ]
Reference Type  |Product Images (Productimage) Search Result Profiling
53 hit(s)
Reference Source Click links to narrow down search
Search Below ™
’VF‘rimar}-I Product Hierarchy (Product hierarchy root) E1 .
Results by Object Type
E:}i Asset (53] - exclude
Reference Metadata 'w| Productimage (53) - =
= Results by Position in Tree
Results by Parent
da - Resst (Displaying the 5 most comman)
Displaying 53 of 53 results Show Details r_=| 15 (14} - exclude
Mame > rjACIB! - exclude
> |\ 1st Birthday_Category Image 1D = 187524 A % gf Sjts (4) - exclude
(4) - exclude
> ] 1st Birthday Boy Blue Cupcake Kit 1D = 187520 [1203) - excluse
> [m] 1st Birthday Boy Cupcake Kit ID = 157515

If the user needs a narrowed search, then the user can also use the advanced option. To use this option, open the
Advanced flipper and select the appropriate. For more details on the advanced options, see the Search:
Advanced Options topic.

- [Referenced By ™| B3

Reference Type  |product Images (Productimage)

Reference Source

[Search | )

@ Advanced
[ ] Match Case on Mames and Values

[] Indude Inherited Values
[] Excude values

[] regular Expression

[] Indude Data Containers
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References and Referenced By Metadata Attribute Value Searches

Values for metadata attributes may be searched by using the References or Referenced By search options.
Users may indicate any value to search all metadata attributes for a matching value. The following pictures will
demonstrate with References, but know that the same holds true for Referenced By.

r [References =

Reference Type |.|5.Jternaﬁ1.re (Alternative) |E]

Include Inherited References

Search

Find Missing References

Reference Target

Reference Metadata

Upsell |
L | [~
Ex [reset ][ semcn |

[ Syskem Setup ” BG Processes ]

Alternatively, users may enter an attribute /D or name, operator, and value for a more restricted search.

- D
=
Reference Type | |E]
?; Indude Inherited References
7]
wAil

Find Missing References

Reference Target

Reference Metadata

Mumber == 5 |

m Setup ” BG Processes (1) ]
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Search: Revised Objects Changed Since

With the Revised Objects Changed Since search criteria you can find recently edited objects in the workbench.
To narrow your search, enter an exact date / time to determine how old the changes can be, or you use intervals of
days, hours, or minutes. Revised Objects Changed Since criteria can be combined with any other search criteria.

1. Click on the Search tab and click the Search dropdown.

Search

ﬂ

Show Details

2. Select Revised Objects Changed Since from the dropdown.

| Revised Objects Changed Since ¥

Date v |

| 2018-07-02 09:34:24 =]
dh ~ Resst | Search |
Search Result Show Details
[ Mame ¥

3. Adropdown appears with the following options:

« Date
« Interval of Days
« Interval of Hours

« Intervals of Minutes
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For the purpose of this example, 'Date’ will be used for the 'Revised Objects Changed Since' search field. The
Date option will provide a data picker, allowing for the selection of the data and time.

Revised Objects Changed Since

Date e R

2020-11-23 09:57:28 [..]
e va Reset Qearch :I
Show Details
[ MName >

¥4 Date Picker >

Year: Month:  Day:

nov s~ | |23 s«

Hours: Minutes: Seconds:

09 57 28

4. Click the ellipsis button (|...|) and determine the date / time of the oldest objects you wish to search. Click OK.

5. Ifnecessary, click the green plus button ( ) to define additional search criteria.

6. Click on Search to run the search and view results.

[Revised Objects Changed Since |
DEtE all

2015-03-05 09:08:39

G | Reset ||

Displaying 8 of 8 results Show Details

Marne

W

@ BuySidesellSide_Internal D = SupSidesalisie_Infem

> l_GIuvewurks case (Bx of 5 pair orange) I = 21575

W

4 SKU 00001 1D = SKU 00001

W

i SKU 00011 D = 5K/ 00013

B Test11189 /I = 100705

» |55 Test docl ID = 107275

> (7] Test docl D = 107272

> [T Test document I = 10725

Search Result Profiling

2 hit{s)
Click links to narrow down search

Results by Object Type
Product (4] - exclude
EF’rndumfﬂ - exclude

Item (1) - exclude
I_CELSE (1} - exclude

Asset (3] - exclude

IF| Owners Manual (2) - exclude
Assets (1) - exclude

Special types (1)
| Poral Configuration Type (1) - exclude

Results by Position in Tree Hierarchy

Results by Parent
(Displaying the 5 most commaon)

CCIMA(3) - exclude
[C]Products (1) - exclude

[Tl SkiJacket Pro (1) - sxcluds
[T Ski Jacket Light (1) - sxclude

Bl Buy Side Packaging (1) - exclude
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« Interval in days — Specify the number value in the field.

[ Revised Objects Changed Since
Interval in days e

3

|Search: ACME =]

The search result is displayed as shown below with objects which are revised since last 3 days.

[ Revised Objects Changed Since |
“'1| ntervalin days - Search Result Profiling
< IRE 13 hit(z)
B Click links to narrow down search
1 | Search: ACME =1

4~ Reset Results by Object Type

Di ing 13 of 13 results i
isplaying 13 of 13 resu show Detalls | product (13) - exclude
Name >

_}Engssm:zmﬁ B tem (12) - excluge

% - Blilck L-ilmp m = Izzm;_ IL SE[|ES |tEﬂ"I f11 - excluds

8 slack Lamp D = 208553 I )
 Black Lamp by Mell 1D = 722905 Results by Position in Tree Hierarchy
I Black Lamp with dimmer by Mell I = 122052 Results by Parent
8 Blue Lamp by Mell ID = 127955 (Displaying the 5 most common)
] Comfy Bed ID = 22155 5 DesklLamp Items (7) - exclude
% Comfy Foothoard ID = 22156 Bl Beds ltems (4) - =xclude
M Comfy Headboard ID = 27157 r_=| SASProducts (1) - exclude
5 . [ Acme Baseball Cap (1) - sxclude
q| Comfy Side Rail 1D = 22165 £ arcimento (1) - exclude
& Purple Lamp by Mell [0 = 122915
I Red Baseball Cap ID = 20803
I Yellow Lamp by Mell I = 122914 Results by Value

Values matching "ACME"
(Walues are displayed in lowercase)

[ STEP Workflow ” Bookmarks ” System Setup ” BG Processes ]

acme (14) - exclude

Attributes with values matching "ACME"

I Manufacturer Name (7) - exclude
I Brand Name (6} - =xclude

« Interval in hours —Specify the number value in the field.
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[ Revised Objects Changed Since
Interval in hours e

a0

The search result is displayed as shown below with objects which are revised since last 60 hours.

[ Revised Objects Changed Since |
Interval in hours v Search Result Profiling

a0 4 hit(s)
Click links to narrow down search

|Search: ACME
gp v Reset | || Results by Object Type
Displaying 4 of 4 resuits Show Details Product (4] - exclude
MName >

¥ Black Lamp ID = 208555 Bitem (4) - sxclude
¥ Comfy Bed ID = 22155
¥= Purple Lamp by Mell ID = 122915 Results by Position in Tree Hierarchy

I Yellow Lamp by Mell ID = 122014 Results by Parent

[CiDesklamp tems (3) - =xcluds
Bl Beds ltems (1) - =xclude
[C]S8ASProducts (1) - excludes

« Interval in minutes — Specify the number value in the field.

[ Revised Objects Changed Since
Interval in minutes e

30

The search result is displayed as shown below with objects which are revised since last 30 minutes.
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| Revised Objects Changed Since =

| Interval in minutes

130

5 ]

Displaying 3 of 3 results Show Details

Mame

>

> |5} Asset Push 1 Queue D = Assetfushi

‘) DTP Queue ID = DTPConfiguration

>
>

AP NSUAssetpush 1D = NSII4ssetpush

1STIBOSYSTEMS
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Search Result Profiling ~pm

Search Result Profiling

3 hit(s)
Click links to narrow down search

Results by Object Type
Special types (3)
[ )Asset Push Event Queue (3} - zxclude
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Search: Sample Result

The Sample Result Search Criterion allows users to refine the search results to only those specified numbers.
When the ‘Sample Result’ criterion is selected, one input field ‘Sample Result Size’ is displayed below it. If a user
enters a random number and clicks on Search, the search result will be zero. Hence, this search should always be
appended to an existing search and entering a numeric value for 'Sample Results Size' will further refine the
search result based on the entry

For example, a user searches for a set of products below a hierarchy that displays a set of results which has 16
products. To do so they go to the Search tab > Search Below option in the Search dropdown > and choose what
node to search below. For more on how to search below, see the Search: Search Below topic.

Search L 4 Search Result Profiling .
Search Below ™ LS
{Fmd and Beverage (3303) ﬂ Search Result Profiling

H Reset 16 hit(s)

Click links to narrow down search

Displaying 16 of 16 results Show Details
Mame >
> N 7133-12 ID = 6081 Results by Object Type

* |l 7134-24 ID = 8094
> Beverage I = 5315

Product {(16) - exclude

> |ga Evian Water, Single D = 505: E ng:;sfdl-t}erh fegx}zlhce |

3 = na = EXcluge
" Ml Evian Water Family D = 5106 @ Open Sales ltem (2) - esxcluds
* 7| Evian Water Family D = 5110 BoiLevel 1(1) - excluce

PR EVN-06 [0 = 110001 [ Level 2 (1) - =sxclude
P EVN-06 [0 = 5063 CiLevel 3 (1) - =xclude

- Bl ltem Folder (1) - sxclude
| EVN-12 1D = 5105 [T Sales ltem Folder (1) - exclude
| N EVN-24 1D = 20574 Bl ltem Family (17 - =xclude
* [T Food and Beverage [0 = 8303 [C1Sales ltem Family (1) - sxcluds
’ ILHH'WE water_7F132-06 [0 = 5095
> I\ Packaged Water ID = 5315 Results by Position in Tree Hierarchy
_* [l Packaged Water Items D = 5055 Results below child nodes of Food and Beverage
» Packaged Water Sales Ttems [0 = 8071 5 15
> |44 Spring Water, Case of 24 ID = 107507 [T Beverage (15) - =xclude

-Operations on Entire Result
Results by Parent

=3
5 @ ﬁl (Displaying the 5 most common) W

Now, the user wants to append the results with the ‘Sample Result’ search criteria. To do this they will keep their
original search, but select the plus sign > Sample Results > and enter a number. In this example ‘10’ is used to
define the Sample Results Size. The search result will give random results.
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| Search Below = Food and Beverage

FW

Sample Result Size |1D

EXE Reset | _
Displaying & of 3 results Show Details
Mame >

w 7133-12 D = 85081

w F134-24 [0 = 5074
iz Evian Water, Single D = §08:

Evian Water Family 1D = 8105
4% Evian Water Family [0 = 8110
EVN-24 D = 205745
Packaged Water [0 = 8315
Packaged Water Sales Items [0 = 8071

W V| V| V|V

W VlV

-Jperations on Entire Result

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

Notice that the results will display and not go above the specified sample results size number. If this Search button
is clicked multiple times, the sample search results will change each time, though always staying below the

specified sample number.
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Search: Search Below

The Search Below Search Criteria allows you to limit your search result to objects below a specified node in the
System Setup or Tree tab hierarchy.

1. Click on the Search tab and click the Search dropdown.

| Reset || Search |
Show Details

2. Select Search Below from the dropdown.

Cearch Below w |
Primary Product Hierarchy (Product hierarchy root)

=i

@5 | Reset || search |
Show Details
[ Name >

3. Click the ellipsis button (E) to display the Search Below... dialog. By default the Primary Product Hierarchy is
selected as search criteria.
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Search

Search Below v
“F‘rimaryI Product Hierarchy (Product hierarchy root)

4. Select anode in the hierarchy and click the Select button.

[T Classification 1root

@ Entity hierarchy root
[ iy racct ey
-- (1 Attribute Groups

- [ Publications

@ Collections

®Dels

Search Below ™
“F‘rimary Product Hierarchy (Product hierarchy root)

i

Search Below...

m Search

1STIBOSYSTEMS
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L——_Ii Apparel

i Upper Body Wear

=[5 Head Wear
Eli Hats and Caps J

|| 20801

@--- Hats and Caps Items|
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. Click the Search button

Search Below
’VHats and Caps [tems (20438)

EF = Reset

Show Detailzs
| Mame *|

T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

The Results displayed includes only items at or below the selected node. Additionally, the selected node for the
search below criteria will also be included in the search results. In the example shown below, Hats and Caps

Items is also included in the search result

u Seanch Below
’VHats and Caps Items (20436)

%~ [ Reset || _
| Displaying 3 of 3 results Show Details
[ame
s 20803 [0 = 20805

(8)

Bl Hats and Caps Items [0 = 20435

Processes
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Search: Search from List

With the Search from List search criteria you can search using a list of data. This data can be manually entered
into the user field or pasted in from another source, such as an Excel spreadsheet or Smartsheet. Users may
specify whether the entered data should be used to search for object IDs, names, key values, attributes values
(with specification of the particular attribute), or other criteria. This makes Search from List an efficient and easy
way to find large numbers of objects in STEP and, in combination with other available search option, suitable for
highly complex and extensive searches.

1. Click on the Search tab and click the Search dropdown.

Search =

Tree

& pAdvanced

&

saarch Result

Reset

Search

Show Details

[Name

2. Select Search from List from the dropdown to display a text field and dropdown with a number of options

based on your system.

I | Search from List =

Y

Mumber of entries: 0

upplierPartMumber 1
tiribute. ..

In this example, we choose Search from List: ID, which allows specifying the data list in the text field and

searching by 'ID' (selected from the dropdown).

3. Use one of the following methods to enter the data list you wish to search in the text box:
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I | Seanch from List =]

17739
23345

12323

Mumber of entries; 1
e =
I [Reset |

Displaying 0 of 0 results Hide Detailz
[ Mame *|

« Manually use the Enter key to create a line break between each value.

« Copy data from Excel or any other application where line breaks or tabs are included to separate the values.
Each value must be listed on a line or be separated by a tab delimiter, without any characters (including
bullet indicators and spaces) around it. See the Using a Data List from an External Application section
below.

4. If needed, click the green plus button () to add additional search criteria.

5. Clickon Search to run the search and view results.

< Search Result Profiling

r | Seanch from List =
17735 Search Result Profiling
%igg? 4 hit(s)
Click links to narrow down search

Mumber of entries: 3

Results by Object Type
Pdell[:tI31 - exclude

D -

Gp | Reset | | Salesitem (3) - excluce
Displaying 4 of 4 results Hide Details . i
y— S Classification {1} - exclude
555 [ClAssetlevel 2(1) - excluds
>
17739 N .
Results by Position in Tree Hierarchy
| 20670-012
> Results by Parent
17739

[C1Hats and Caps Salesltems (3) - =xclude

. ILII}BDB—DII CI5(1) - exclude
20803

|.. 20808-013
101567
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Each of the 'Search from List' options available from the dropdown are described and illustrated below.

Search from List: ID

Search by specifying the ID in the list text field and selecting 'ID' from the dropdown, as shown in the example
above.

Search from List: Name
Search by specifying the object name in the list text field and by selecting 'Name' from the dropdown.

r [Saarch from List ™| =

Mumber of entries: 0

Mame v

Enter the values to search into the text field. Click Search to run the search and view results.

The search results display with the name of the objects specified in the data list.
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£Search Result Profili... -

r [Search from List ™|

[

Polo A
T-Shirts Family

Mumber of entries: 2

Mame

o

E

Displaying 2 of 2 results

Show Details

Mame

> Polo A ID = 11320:

* T-Shirts Family [ = 123553

£

-Operations on Entire Result

2| g |

Search Result Profiling

2 hit(s)
Click links to narrow down
search

Results by Object Type
Product (2] - exclude

EHEH"I (1) - exclude
Bl tem Family
1) - exclude

Results by Position in
Tree Hierarchy

Results by Parent
r_=| Dffers I,"H - exclude

[C1SAProducts
1) - exclude
Il Eolo T-shirt
1) - exclude
Il T-=hirts ltems
1) - exclude

"~

T ISTIBOSYSTEMS

Search from List: Key

e MASTER DATA MANAGEMENT

Search by specifying the key values in the list text field, and by selecting the key from the dropdown.

In this example, the search results display with the Supplier Part Number that holds values specified in the data

list.
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< Search Result Pr..._

~ [Seanch from List ™| = o~
555-21333
173911

Mumber of entries; 2

Ha v Reset

Search Result
Profiling
2 hit(s)

Click links to narrow down
search

Dizplaying 2 of 2 results 5.|-;|;|-.-.- Detaus- ¥ESI.I“S by Obp(:l
Mame ype
> W™ 179915 ID = 179915 Product (2] - exclude
> M Item >1 D = 1821: B e
@ - exclude
Results by Position
in Tree Hierarchy
Results by Parent
Il Cotton T-shirts
@ - exclude
- > [T BA Products
-Operations on Entire Result % r; Engce |
5 wiens L.asua
= @ ﬁ' Website

]

T ISTIBOSYSTEMS

It is important to keep in mind that:

« Only active keys will be available as an option in the dropdown list.

« Active Keys that have values in products can be searched.
« Searching for active keys with empty values in a data list field will NOT return search results.

For more on keys and how to activate them, see the Unique Keys documentation.

Search from List: Attributes

e MASTER DATA MANAGEMENT

Search by specifying the attribute values in the list text field, and by selecting the option 'Attribute’ from the

dropdown.
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|
J
i
[#]

Search

Mumber of entries: 0

Attribute. ., v]

Processes (1) ]

i | Reset || Search |

[ Please Select Attribute *

m Search

=- B3 Attribute Groups ~
#2300 | Reference Metadata
-3 02 | Product Attributes
--Ifi Address Attribute Group
-3 Application Record Attributes
-1 Asset Analyzer Attributes
-3 Asset Download Attributes
--Iﬁ Asset Export Configuration
-3 Attribute Group

-1 Attributes for Web LI

-3 Autopage Attributes

--Ifi Board Essential Attributes
- E3 CalculatedAttributes

--Ifi Camping

- [£51 CASS Attribute Group

--Iﬁ Category Specdific Attributes

- E5 Clerical Review Attributes W
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D Please Select Attribute

Search

L—‘_}Fj Products

r_=| Apparel

r_=| Automotive
r_=| Building Products
E|r_=| Displays

E |__=| Displays

|1 Calours

-1} completeness Score
ﬂi Description, Long

T status

=

r_=| Electrical & Electronics

r_=| Food and Beverage

r_=| Footwear

r_=| Furniture

r_=| Hardware

Elr_=| Kitchen

: |j Major Appliances
|j Small Appliances

@ Details

Select

Cancel

e MASTER DATA MANAGEMENT

The search results display with the attributes specified, in this case it is the attribute 'Color' which holds values of

'Orange.’
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Search

| Gearch from List =

lorange

Mumber of entries: 1

Primary Color "

Displaying 1 of 1 results

Fo [ e

Show Details

Mame

ﬁ 18213 M O ID = 18215

£

-Jperations on Entire Result

9 @ &

£ Search Result Profil... -

Search Result Profiling

1 hit(s)
Click links to narrow down search

Results by Object Type

Product (1] - exclude

Eltem (1) - exclude

Results by Position in
Tree Hierarchy
Results by Parent

Il Cotton T-shirts
1) - exclude

T ISTIBOSYSTEMS

Itis important to keep in mind that:

e MASTER DATA MANAGEMENT

« Only one attribute can be selected from the Attribute Group browse / search window to be used as search

criteria.

« Inherited attribute values (hierarchical inheritance) can be specified in the data list. The result set includes the
object that contains the searched value as a local value. While this object may not match an object type
restriction, it points to the origination of the searched text.

« Attribute values inheriting from other contexts can be specified in the data list.

» Calculated Attribute value (description or specification attributes) when specified in data list, will NOT be
displayed with any search result. (This restriction is not limited to the Search from List functionality.)

Using a Data List from an External Application

Copied data can come from Excel or any other application as long as line breaks or tabs are included to separate
the values. To copy data in, each value must be listed on its own line or separated by a tab delimiter, (tab key from

keyboard) without any characters (including bullet indicators and spaces) around it.

In the example below, IDs have been copied over from an external file. Data can be horizontal or vertical as long
as the appropriate line breaks or tabs are in between the values.
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r [ Search from List ™| =

Search

r [ Search from List ™|

124143 13213

124145
15213

Mumber of entries: 2

Mumber of entries: 2

T ISTIBOSYSTEMS

D . D
o Reset || il | e "'| Reset ||
Displaying 2 of 2 results Show Details | |Displaying 2 of 2 results Show Details
Mame » Mame >

* 18213 M O 1D = 124145
* N 1B213 MO [0 = 15215

-Operations on Entire Result

9 @ &
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Search: Search in Publication Hierarchy

Objects below a specific publication hierarchy can be searched, and the status or a specific result can be
determined, by using the ‘Search in Publication Hierarchy.’

Keep in mind that this search is not used to search for different templates (such as products, publications, or page
templates) or to search number of objects / links placed in product template. It is only used to search the objects
below a specific publication hierarchy.

To search in a publication hierarchy:

1. Click on the Search tab and click the Search dropdown.

2. Select Search in Publication Hierarchy from the dropdown.

| Reset | Search |
Show Details

Se
| Seanch in Publication Hieranchy: =

Search below: | Publications

-

Searchfor:  Objects linked to Publication / Section

v

‘&b - | Reset || Search |

Show Detailzs

Mame

|
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|

3. Supply information for the following parameters:

[ Search in Publication Hierarchy |
Search below: | Publications

Search for: fibiects linked to Publication | Secton

(g | Reset || Search |
Search Result Show Details
[ Mame ¥]

« Search below: Used for choosing a node. Select either the publication group or publication. The search
result will display all matched product objects which are under the selected publication group or publication.

« Search for: Specifies what object is being searched.

Search for

The available options in the dropdown are:

| Search in Publication Hierarchy i
Search below: | Publications ||Z|
Search for:

Objects linked to Publication / Section
Crh Objects in Assortment Lists
Search Result Cbjects in Baskets

| Mame  JObjects on actual pages

Cbjects on planned pages

1. Obijects linked to Publication / Section: When this option is selected, products and assets linked to a
publication will be displayed in the result.

© Stibo Systems - Confidential - Rel 10.2-MP3 (September 21, 2021) 331



T ISTIBOSYSTEMS

e MASTER DATA MANAGEMENT

_______ seach | SearchResult Profilng

Search in Publicztion Hierarchy = o
Search below: Electronics Sale Poster Search Result F’roﬂling
Search for: Objects linked to Publication / Section 7 hit(s)

Click links to narrow down search

g Reset

Displaying 7 of 7 results Show Details Results by Obiect Type

Mame
W 21933 D = 21935 Product {7} - exclude

[ 22196 ID = 22196 E tem (6] - exclude

] 22200 1D = 22200 Open ltem (1) - esxclude
P Chardonnay Glasses - 4 JD = 8055
¥® comfy Bed ID = 22155 Results by Position in Tree
¥ comfy Footboard ID = 22155 Hierarchy

Luigi Bormioli Chardonnay Glass - 1 1D = 8053

Results by Parent
(Displaying the 5 most commaon)

r_=|F'FUI:|LIE'tS (3 - exclude
|__=|E|Ed5 fg} - exclude

P 3 er'FﬂdLlE’tS (2] - exclude

) ) Bl Irons ltems (17 - exclude
-Operations on Entire Result Bl Coffee laker ltems

0 & & ) - exclude v

2. Objects in Assortment Lists: This is a legacy component.

3. Objects in Baskets: The products saved in a Basket will be displayed in the results.
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m Spring Wedding Catalog - Plan i
: Ll Page Inspecktor || Status || State Log || Tasks

-] GDSN Receiver
; AutoPage Publication Planner ” Pagination Rules

A-Cm Golden_Root
= EFEIE_. crsn e Publication m[ Version ” Pages ” Publication Planner ” Plan Motes ” Financial Summary |

(-] Promations
El@ Publications Basket maintained locally
&+ I Templates
@ Standard Publications Column View: |Deﬁ:ult - Public > |
[l AutoPage Publications
Iﬁ Flatplanner Publications 1o

= (il Bpring Wedding Catalog B
N8 Pink & Blue Giraffe Party Hat | §

W
W

Mame

PrimaryProductImage

El@ Commercial Data 121183
=1-[=) Party Favors

[T 2-Pages 2&3 _
(7] 4-Pages 4 &5 121218 F Pink &Blue Owl Party Hat | f =

[T 6 - Pages & &7

-- DTP Documents >
== Glassware

-- DTP Documents
B- ﬁ Cards & Stationery

R {2087_25}

l'"|.hl'\ﬂ'nl'\ ______

| (NS I R | ] v ] o ) e

| Saarch in Publication Hierarchy |

Search below: | Spring Wedding Catalog /I

Searchfor: | Objects in Baskets v
& Reset f Search |
Displaying 25 of 25 results I Show Details

ame

| 18210 M B ID = IS2I0 j

P EVN-24 ID = 20574

M Pink & Blue Giraffe Party Hat ID = 121185
M Pink & Blue Owl Party Hat 1D = 121215

P9 Politics Party Hats 1D = 12119:2

4. Object on actual pages: the product and asset are used on actual pages (DTP documents) and will display
the results field.
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Galley Page - Plan

m Flanned Page || Plan Motes | References || Status || Skate Log | Tasks
EI Acme Party Supplies Flatplanner
+-[[&) Commerdial Data

=[5 Party Hats Y .. E gao
()

ﬁ 4 - Galley Page Galley Page

+-L=]) OTP Documents 4 5

=5 Party Favars

{3 4 - Confetti
ﬁ & - Mapkins
ﬁ 8 - Streamers

ﬁ 10 - Moisemakers_linked dass
F-'I--l:?m MTP Nincuiments

Flatplanner Publications
Christmas Catalog

| Eﬂx i |'-'-s': H: |'I.-'iew Prewview o

e e ey

,
2| |Pink % Green Party Hat fy

8 &
D::ug Patty Hats F\ssu:urtm#r
F f ol

a
I
=
n
L

| Search in Publication Hierarchy |

Search below: Flatplanner Publications

Search for: Ohjects on actual pages

£

HA Reset Search

Displaying 100 of 110 results Show Det
ne
Pink & Green Party Hat 1D = 121571 ~

Pink & Green Party Hat_2 /D = 1389

W

W

5. Object on planned pages: The products and assets used on planned pages will be displayed in the result.
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Search

I | Search in Publication Hierarchy
Search below: Flatplanner Publications
Search for: Objects on planned pages v
oa v Reset Search
Displaying 28 of 28 results Show Details
~
W
>
-Operations on Entire Result
3
5| A3 &

Tree

ﬁ Autopage Publications 2
[+ [ Standard Publications

Pages 2 & 3

| Skatus || Skate Log | Tasks

Flanned Page ” Flan Motes

=+ &) Flatplanner Publications
=@ Spring Party Catalog
% Commerdial Data

- [ Party Favors

AT )2-Pages2&3
{715 4 -Pages 455

5253 1

|t

(i 6 -Pagess &7

=] OTP Documents

|Christmas Party Hat

]
|Purple & White Party Ha

[+-[E8 Cards & Stationery

[+ B8 Glassware

[+ [l Spring Wedding Catalog

(- India Test

E}--ﬁ Publication Group

=1HIT) Primary Product Hierarchy

E}Fj Products

r_=| Apparel v

T <
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Search: STEP Workflow

With the STEP Workflow search criteria you can search for and monitor STEP workflows. Selecting a specific
workflow from the dropdown list will show all items associated with the workflow. You can also specify the
workflow state to narrow your search.

1. Click on the Search tab and click the Search dropdown.

Search

2 Advanced j

1 ERR Reset Search

aarch Result Show Details

2. Select STEP Workflow from the dropdown to display two additional dropdowns with options based on
availability in your system.

STEP Workflows
STEF Workflow |Sales Item Creation Y
State w
oa v Reset Search
Show Detailz
[ Mame ¥

In this example, 'Sales Item Creation' will be used for the STEP Workflow search field.

3. Forthe State dropdown, specify the state you wish to search within.

« Select a state defined in the workflow to search only items currently in the state.
o Select [any State] to search the entire workflow, as shown in this example.
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STEP Workfiow |

STEP Workflow
State

LX
Displaying 0 of 0
ame

Sales Item Creation

Jany State]

[notin STEP Workflow]
Copy Writing

Digital Asset Review
Mew Digital Asset
Sales Item Review

W/eb Categorize

"] @

T ISTIBOSYSTEMS
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o Select[notin STEP workflow] to search objects which are not present in the selected workflow.

STEP Workflow ;1

STEP Workflow | Sales Item Creation
State [motin STEP Warkflow]

o '| Reset

Displaying 0 of 0 results Show Details

[ MName

>

4. If needed, click the green plus button () to add additional search criteria.

5. Click Search to run the search and view results.
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Search Result Profiling

5 hit(s)
Click links to narrow down search

Results by Object Type
Product (5] - exclude

STEP Workflow

STEP Workflow _Eales Item Creation

State [any State]

B =1 EX8

Displaying 5 of 5 results Hide Detailz
Mame >

|..18207-012

>
13207
|..18214-012

&
153214
|..18215-012

&>
13215
|..18217-012

*
13217
l.101164

>
101164

| Salesitem (5) - exclude

Results by Position in Tree Hierarchy
Results by Parent

ro—EhiI’TS (4) - exclude
[C1T-shirts and Sweatshirts (4] - =sxciude
[T Tire Care Salesltems (1) - =xcludes
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Search: Unapproved

This criteria is used to identify objects that are not currently approved. These include classifications, products,
images and documents, and entities setup to be Workspace revisable.

Search

1. Click on the Search tab and click the Search dropdown.
B Advanced

T v Reset Search

aarch Result Show Details

2. Select Unapproved from the dropdown.

I [ Unapproved ]
i@ Mever Approved or Modified in Main

(7 Mever Approved
(7 Modified in Main

Status in Current Context

(Ep [ Reset “ Search ]
Show Details

[ Mame ¥

3. Select the appropriate radio button and set the checkbox:

o Never Approved or Modified in Main: All objects that have 'Never been approved' and have been
'Modified in main'.

o Never Approved: Objects (products, classifications, assets & documents, or entities) that are workspace
revisable and that have never been approved.
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Product

Black Lamp rev.0.1 - Product

Images & Documents || Commercial || Tables |§ategnrv Profile || Proof View || Status || Skate Log || Tasks

Sub Products References

§ Desaipton

Mame »| > |Value
» D BP208553-2
* Mame Black Lamp
* Ohject Type Wrctive Products
> Pevision 0.1 Last edited by USERM on Wed Jul 26 08:48:51 EDT 2017
Wpproved x Mever Been Approved
* [Translation Mot Translated
* Path Primary Product Hierarchy ProductsHardware Tools/Task Lighting/Desk Lamps/Desk L:

» Modified in Maintenance: Objects that are modified after the approval or added to in the maintenance

workspace.
§ Desaipton

Mame *[ > |Value »

* D 120223

* Mame 120223

* Ohject Type Open Item

* Revision 0.6 Last edited by USER] on Wed May 31 08:42: 19 EOT 2017

* \Approved x Last Approved on Mon Mov 02 10:37:35 EST 2015

* [Translation Master

* Path Primary Product Hierarchy/Products/Electrical and Electronics/\Wire & Cable/Cable/Cable Ite...

« Status in Current Context: When this box is checked, only the current context is searched. If unchecked, all

objects in all contexts are searched.
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| I Context _English us

| Unapproved
i@ Mever Approved or Modified in Main

Tree

() Mever Approved

(™) Modified in Main

(2) |

I Status in Current Context I

T ISTIBOSYSTEMS

Ei | Reset || Search |

Show Details

BG Processes

| Mame

]

4. If needed, click the green plus button () to add additional search criteria.

5. Click Search to run the search and view results.
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Search: Unpushed or Failed Assets

The Unpushed for Failed Assets search criteria allow you to identify assets that have not been successfully
pushed. These assets have an Asset Push Status of 'Never been handled', 'Asset not in workspace,' or 'Error.'

!] 3 M rev.1.0 - Status

Images & Documents || References || Referenced State Log || Tasks

Configuration * |Asset Push Status * |Relative Path * |Workspace * |Visibility »
* |Asset Push Configuration 18 | Downloaded |E| AssetPushConfiglB/88/01/8801.jpg  [Main
* raw-main Never been handled Main
* |Asset Push Configuration 1 A Asszet not in workspace Approved

1. Click on the Search tab and click the Search dropdown.

ﬂ

Show Details

[ Unpushed or Failed Assets ] |Eﬂ

Configuration: |

3. Click the ellipsis button (E) to display the Select Asset Push Configuration dialog.
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" Unpushed or Failed Assets

Configuration: | j

dh Reset Search |

Show Details

[ MName > ]
[ Select Asset Push Configuration *

m Search |

El--[ﬂ Ewvent Queues
[i Addresses
[ﬁl assetpushl
E}[ﬁl Asset Push 1 Queue

----- %] AssetPush 4 A

El Asset Push Configuration 1 A

----- El Asset Push Configuration 1B W

®petals
=

4. Select a configuration and click the Select button.

[ Select Asset Push Configuration et

m | Search

El--[ﬂ Event Queues
gl Addresses
[ﬂ assetpushl
E}[ﬂ Asset Push 1 Queue
. -] AseetPush 4 A
% Asset Push Configuration 1 A
El Asset Push Configuration 1B W

&E
[Cosee ]| coner

5. Click the Search button to display the Search Results List and Profiling information.
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Search Search Result Profiling
[Unpushed or Failed Assets ]
{ Configuration: |Asset Push Configuration 1A (AssetPushConfigl) |Eﬂ Search Result Profiling
58 hit(s)
B Reset | Search I Click links to narrow down search

Displaying 58 of 58 results Show Details

fene Results by Object Type
> |§g 555-2033_M D = 801

»

'w| 20695 back 1D = 207 Asset(58) - exclude

8|20695 main 10 = 20701 Product Image (40} - exclude
'w| 20695 side 10 = 2070: {) Owners Manual (8) - sxclude
@910335 1D = 910835 . Export Manager Configuration (2) - exclude
@'Jlﬂ&?rﬁ D = 9108% Logo (2} - exclude
lcon (2) - exclude
'w| ACME Comfy bed o = 22215

b
>
b
>
»
’ Installation Manual () - esclude

> W Battery 1D = 22325 Import Manager Configuration (2) - sxcluce
d @hlue cap I = 20805

>

»

b

>

b

>

U2 Assets (1) - exclude
& Caulk, g @] Confiquration (1) - excluge
Ui case =
'a| Caulk, single ID = 523
'w| Coffee Maker I = 22191

'w|Cupl 1D = 25052 Results by Parent
(Displaying the 5 most commaon)

& Cup2 1D = 23055

'w|Cup3 D = Cups [ Assets (17) - exclude
B N W S E 1A E?! - exclude
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STEP Workbench Keyboard Shortcuts

Within STEP Workbench there are many shortcut key combinations that allow users to quickly navigate and make
changes through the system. The following tables list and describe the options available for Shortcut Key options.

Basic Shortcuts

Shortcut Description Shortcut
Key
Copy Creates a duplicate of the information selected that can be pasted somewhere else. Ctrl+C
Cut Takes away information that can be pasted into a different location if desired. Ctrl+ X
Duplicate | This duplicates the item selected, with the option to duplicate references as well. Ctrl+J
Goto This brings the user to the Goto field in the upper right hand corner of the workbench Ctrl+ G

screen where items are looked up.

Goto Finds the next item that most closely matches what the user is looking for. The results | Ctrl+ E
Next may differ depending on what tab the user is in and working with, or what area is
selected as active.

Help When Workbench is open, it will populate another window that provides all of the F1
Online Help Documentation.

Next Shifts the focus to the next cell. Tab
Paste When information that was either cut or copied from before is placed into an alternate | Ctrl+V
area.

Previous | Shifts the focus to the previous cell. Shift +
Tab

Redo Goes to the changed sate, if the change was reversed. Ctrl +
Shift+ Z

Reload Reloads the workbench and updates to any changes made. F5
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Shortcut Description Shortcut

Key

Select All | When the desired areais clicked in or is already the active area, pressing this key Ctrl+ A
combination will choose everything in this particular area.

Undo Goes back to the original state before the change was made. Ctrl+ Z

Navigate to Main Side Bar Tabs in Workbench

Shortcut Description Shortcut
Key

Background | Unless a product is being viewed, this will bring the user to the Background Alt+P

Process Processes tab. If a user is on a product, this key combination will not transpire.

Tab

Bookmarks | Brings the user to the Bookmarks side tab. Alt+ M

System Brings the user to the System Setup tab. Alt+Y

Setup Tab

Search Tab | Leaves the user looking at what they were on in the main frame, but brings up the Ctrl+ F

Search Tab along the left hand side.

Tree Tab This will bring a user to the Tree Tab only if not viewing an item in Tree in the main Alt+T
screen, or having an item still show up in the main screen even though navigation
has been away fromit.

Workflow Navigates to the STEP Workflows tab. Alt+W
Tab

Navigate to Horizontal Tabs within Main Sidebar Tabs

To navigate to the horizontal tabs within the main tabs in workbench, press Alt + (the letter underlined on the tab).

For example, if a workflow is selected within System Setup, pressing Alt + S displays the Status tab for the
workflow being viewed because 'S' is the underlined letter for the Status tab.
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System Setup

- &= Advanced Seard = [ﬁ O
STEP Workflow Edito | Walidit Lo
@ Asset Update ¥ =g W
-0 critical ? Revisions
@ DANF Testl Revision * |Created
FEUI Discontinued State > 0.9 Tue Jan 12 10:46:57 EST 2016
- Error
* 0.8 Fri Jan 08 15:57:57 EST 2016
-/l FlatPlanner old but don't delete

1

Note that options for shortcut keys to horizontal tabs vary depending on what item is selected and in what main tab
auser is located (Tree, Search, Background Processes, System Setup, Bookmarks, and STEP Workflow). Not all
tabs have underlined letters for shortcut key options.

General Shortcuts Useful in Workbench

Shortcut Description Shortcut

Key

Add Bookmark When on an object and this is pressed, it will add the item to the Ctrl+D
bookmark list on the Bookmark tab.

Add Element When adding various elements, pressing this key combination will often Ctrl +
(notin all cases), bring up a dialog allowing the user to add to the desired | Plus
list.

Approve Object When in Main, approves an object that was previously unapproved. Ctrl +

Shift + J

Mark Different (On In Tree, when viewing multiple products at once, or when viewing the Shift +

multi-product display) | horizontal Sub Products tab for an item, selecting this key combination F12

will mark all areas that are different green.

New Window With STEP Workbench open, this will open an additional STEP Ctrl+N
Workbench window.

Remove Element When deleting various elements from lists or rows, pressing this key Ctrl +
combination will often remove the desired connection or item. Minus
Rotate Table (On In Tree, when viewing multiple products at once, or when viewing the F11

Multi-Product display) | horizontal Sub Products tab for an item, this rotates the table view if the
table is the active area.
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Description Shortcut

Key

Toggle attribute
values selection
between blinking
cursor and blue filter

When on afield that is editable, selecting F2 allows the user to write inthe | F2
field. When pressed again, the entire field turns blue, rendering it entered

and non-editable, unless F2 is pressed again or the field is clicked into

again.

Insert Options

Shortcut

Description Shortcut

Key

Insert Action Set

In System Setup, when in the Action Sets, pressing thiskey | Ctrl+ Shift

combination will create a child Action in an Action set. +S

Insert Asset The Create Asset dialog appears whenin Tree. Ctrl + Shift
+A

Insert Attribute Displays the Create Attribute dialog in System Setup. Ctrl + Shift
+T

Insert Attribute Group In System Setup, this creates a new Attribute Group if sitting | Ctrl + Shift

on the proper level. +1

Insert Background
Process to Monitor
Deadlines/ STEP
Workflow Deadline
Monitoring

This allows a user to set up a background process to monitor | Ctrl + Shift
states with exceeded deadlines in the desired time frame. +D

Insert Character Tag

When typing in a field and this is selected, a dialog appears CtrI+R
allowing the user to select from character tags.

Insert Classification

In Tree, this inserts a new yellow folder, or classification. Ctrl + Shift
+C

Insert Classification Root

In Tree, a new Classification Root or top node yellow folder | Ctrl + Shift
is created. +R
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Shortcut Description Shortcut
Key

Insert Dimension In System Setup, when sitting on the top node for contexts, Ctrl + Shift
clicking these keys will bring up the dialog to create a new +D
dimension.

Insert Dimension Point In System Setup, when on a dimension, selecting this will Ctrl + Shift
create the dimension point. +M

Insert Group In System Setup, when on the node that houses Usersand | Ctrl + Shift
Groups, selecting this key combination will create a new +G
group.

Insert List of Values In System Setup, when sitting on the top node for List of Ctrl + Shift
Values, pressing this will bring up the dialog to createanew | +L
List of Values.

Insert non-breaking space | Enters a non-breaking space when editing attribute values. Ctrl + Enter

Insert Orphan Attribute When on a product, this will insert an orphan Attribute, Ctrl + Shift
which will appear in italics. +0

Insert Product When in Tree, this will create a new object under the one Ctrl + Shift
selected. +P

Insert Special Character When in a field that allows typing, selecting this brings up a Ctrl + Shift
list of characters that can be selected and inserted into the +E
field.

Insert STEP Workflow In System Setup, when on the top node for workflows, or Ctrl + Shift
when inside the node for workflows, selecting this will bring +R
up a new STEP Workflow Designer window to create a new
workflow.

Insert Workspace In System Setup, when on a workspace, selecting this key Ctrl + Shift
combination will create a different workspace. +W
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Linking Options

Shortcut Description Shortcut
Key
Link Asset When on References or References By tab, this allows asset links or references to | Ctrl +
be selected and put into the appropriate folders. Note that the Reference Type can | Shift+ F
be changed from the drop-down menu in the dialog that appears.
Link Attribute | To link an Attribute to an item, select the item that needs the attribute and select Ctrl +
to this key combination. Linked attributes will appear in the References tab under the | Shift+Y
Classification | 'Attributes' flipper.
Link Attribute | When on a product, selecting this key combination links an attribute to a product. Ctrl +
to Product Shift+ K
Link This links a classification to a product. It can be seen under the Reference tab Ctrl +
Classification | under the 'Linked Attributes to Classifications Hierarchy' flipper. Shift +H
to a Product
Paste Link Creates a new reference (pointer or link) to an existing / copied object. An Ctrl+ L
example would be if the user copied a SKU from a blue folder and pasted it into the
yellow folders. Note that object types need to be compatible.
Link Product | When on References or References By tab, this allows product links or references | Ctrl +
/ Create Link | to be selected and put into the appropriate folders. Shift+ Q

Style Options

Shortcut Description Shortcut
Key
Bold When typing in a filed, this activates bold text. Ctri+B
Character Tag | Opens the Insert Character Tag dialog for adding character tags to CtrI+R
attribute values.
Italic When typing in a field, this activates italic text. Ctrl + 1
Non-breaking Enters a non-breaking space when editing attribute values. Ctrl +
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Shortcut Description Shortcut
Key
Space Enter
Special Opens a dialog showing the most recently used special characters, Ctrl +
Character as well as an option to select to see all special characters. Allows user | Shift+ E

to select a special character to insert when editing attribute values.

Style This key combination can be pressed to bring up the Style box, where | Ctrl+Y
there are a number of styles to choose from.

Rich Text Opens the Rich Text Editor in STEP Workbench when editing an Alt+ F2
Editor attribute value.

Paste and When in afield, if 'text A" is copied from one area and is going to be Ctrl +
Match Style pasted into 'text B' that is a different style, pressing this key Shift+V

combination will make it so the copied 'text A" will past into 'text B' with
the style of 'text B'.

Flatplanner Shortcuts

Shortcut Description Shortcut Key

Save (In Flatplanner) This save what is being worked on. Ctrl+ Alt+ S

Zoom In (In Flatplanner) This zooms in on what is beingworked on. | Ctrl + Plus

Zoom Out (In Flatplanner) | This zooms out of what is being worked on. | Ctrl + Minus
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